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Начинающему профессионалу. 

Предисловие автора. 

Спасибо, что обратили внимание на мою книгу.  

OrCAD Layout Plus – программа для разводки печатных плат от Cadence Design 
Systems, Inc. Мы будем работать с 10-й версией программы, но всё нижесказанное в боль-
шинстве своём справедливо и для предыдущих версий. 

Несмотря на то, что OrCAD Capture – программа для подготовки принципиальных 
электрических схем и также входящая в пакет OrCAD – известна всем, и уже много лет явля-
ется де-факто стандартом к использованию, OrCAD Layout не пользуется – и совершенно не-
заслуженно, на мой взгляд, – столь же широкой популярностью. Причина такой несправед-
ливости, как мне кажется, кроется, прежде всего, в том, что Layout, в отличие от других про-
грамм довольно сложен в освоении, а тем более – в самостоятельном освоении. 

Пользователь с первых же шагов сталкивается со множеством вопросов, которые не в 
силах решить самостоятельно. Прежде всего – это профессиональная терминология. Спра-
вочная система OrCAD Layout довольно подробна, но она написана в расчёте на уже подго-
товленного человека. Десятки понятий, обозначений и сокращений наслаиваются одно на 
другое, разделы справки ссылаются друг на друга, и поэтому тот, кто пытается во всём этом 
разобраться, просто тонет от обилия малопонятной, но взаимосвязанной информации. 

Я думаю, что если Вы когда-то пытались самостоятельно начать работать в Layout, то, 
скорее всего, поначалу у Вас не получилось даже просто начать проект. 

Вторая причина – интерфейс. Layout – это не Microsoft Word, который можно изучить, 
просто перебирая мышкой пункты меню. В Layout можно часами сидеть, пытаясь понять, 
почему тот или иной инструмент работает не так, как нужно, почему вдруг перестал работать 
AutoRouter, почему не передаются параметры из Capture, и почему, чёрт побери, после ко-
манды “Design Rule Check” (проверка проекта) выдаётся сообщение, что проект содержит 
полторы сотни ошибок, хотя десять минут назад всё было нормально? 

Третья причина – практически полное отсутствие сколько-нибудь внятной литературы. 
Когда-то, когда я только начинал работать с Layout, я пытался найти что-то почитать. Одна-
ко, те немногочисленные книги, которые попадались мне в руки, содержали в себе ровно 
столько информации, чтобы не понять ничего. В лучшем случае, в них были переведены на 
русский язык пункты меню и разделы справочной системы без каких-либо внятных объясне-
ний. 

Я решил написать свою книгу. Я решил написать её так, как будто бы я сам вновь на-
чинал учиться работать в OrCAD Layout Plus. Я буду вновь учить сам себя, отвечая сам себе 
на все возникающие у меня вопросы. А Вы – учиться вместе со мной. 

Моя книга называется «…начинающему профессионалу». Я обещаю, что когда инфор-
мация с этих страниц осядет в Вашей голове, Вы сможете развести самостоятельно любую 
печатную плату практически любой сложности. 

Разводка – процесс творческий, и потому интересный. Насколько красива получится 
будущая плата (а я убеждён, что хорошо работают только красивые устройства), насколько 
удобно будут расположены на ней детали, все ли дорожки в конце работы будут разведены, 
или придётся использовать перемычки – всё это зависит от Вас. 

Разводка печатной платы – процесс очень ответственный. Может случиться так, что из-
за Вашей ошибки, устройство окажется непригодным к сборке. А может – что благодаря Вам 
то же устройство уместится в корпусе вдвое меньшем, чем предполагалось ранее. 

Я также не сомневаюсь, что, освоив OrCAD Layout, Вы испытаете чувство гордости за 
себя, потому что это – сложная программа. Потому что Вы получите в свои руки новый – 
мощный и красивый инструмент. 
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А, кроме того, знание программы OrCAD Layout, умение самостоятельно выполнять 
работу по разводке плат – это целая специальность, которая всегда востребована в сфере вы-
соких технологий. Это ещё один – и очень крупный – козырь в Вашей колоде. Вот почему – я 
убеждён в этом – Вы никогда не пожалеете о времени, проведённом за изучением этой кни-
ги. 

Даже если Вы, в силу своих обязанностей, не собираетесь заниматься разводкой непо-
средственно, а отдаёте работу профессиональному разводчику, знания, полученные из этой 
книги, помогут Вам правильно описать задачу. Неважно даже, если разводчик, к которому 
Вы обратитесь, работает с другим пакетом – Allegro, P-CAD или Mentor – Вы сможете разго-
варивать на общем языке, не путаясь в терминологии. 

Мы с самого начала начнём строить нашу первую плату, по ходу разбирая возникаю-
щие проблемы и вопросы. Я буду объяснять, как сделать то или иное действие проще. На что 
следует обратить особое внимание, а на что не стоит тратить время. 

В то же время, я не собираюсь объяснять абсолютно всё, что появляется на экране и 
рассказывать про каждый параметр в каждом диалоговом окне. Я буду объяснять лишь то, 
что необходимо для выполнения текущей задачи, не засоряя и не загромождая Вам голову 
теми знаниями, которые не нужны в данный момент. Возможно, в следующей главе, мы вер-
нёмся к этому же диалоговому окну, чтобы разобраться с параметром, который пропустили 
ранее. В этом случае, экран покажется Вам знакомым, и новая информация ляжет значитель-
но легче. 

В конце книги приведены некоторые полезные практические советы. 

В комплекте с книгой может быть компакт-диск. На диске собраны все описанные 
примеры. Изучая их, параллельно с чтением, Вам будет значительно легче двигаться вперёд. 

Ещё раз спасибо! Надеюсь, что эта книга не только поможет Вам, но и на какое-то вре-
мя станет Вашим помощником и советчиком в работе. 

Кайков Дмитрий. 
Kaikov Dmitri 

Digital Electronics & Programming, Board Design. 
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1. Основные понятия. 

В этой главе мы разберёмся с основной терминологией Layout. 
Все действия, которые я буду описывать, желательно тут же повторять на компьютере, 

иначе, боюсь, Вы ничего не запомните и не поймёте. Каждая последующая глава опирается 
на предыдущие, поэтому, что-то упустив, Вы создадите себе ненужные трудности в буду-
щем. 

Будет неплохо также, если Вы параллельно будете сверяться со справочной системой. 
Данные, полученные из разных источников, приобретают объём. 

1.1. PCB, Components. 
PCB (Printed Circuit Board), Board или просто печатная плата помимо собственно ос-

нования из гетинакса или стеклотекстолита состоит из компонентов (Components). 
Вот как определяется понятие компонента в справочной системе Layout: «Элемент 

или часть. Плата состоит из компонентов, установленных на общем основании (по-
верхности) и соединённых медными дорожками (проводниками)». (An element or a part. 
PCBs are made up of components affixed to a common surface and connected by copper tracks). 

Не очень понятно, а главное – неточно. Дело в том, что компоненты могут быть элек-
трическими и неэлектрическими. 

 
рис.  1-1 

Примером электрических компонентов могут быть радиодетали, установленные на 
плате. Это – микросхемы, резисторы, разъёмы и пр. Электрическими компонентами в неко-
торых случаях могут являться переходные отверстия. Крепёжные отверстия также являются 
компонентами, и, если они выполнены с металлизацией, то могут быть электрически соеди-
нены с какой-либо цепью на плате (как правило, с корпусной «землёй»). 
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Примером неэлектрических компонентов, могут служить те же крепёжные отверстия, 
если они выполнены без металлизации, или просто не участвуют в разводке. Также – любые 
механические элементы, а также элементы оформления. 

Как видно, далеко не все компоненты принимают участие в электрической разводке 
(маршрутизации, routing). Также, не все компоненты “affixed to a common surface” – нахо-
дятся непосредственно на плате. 

Запустите OrCAD Layout Plus и откройте файл: 
“C:\OrCAD\OrCAD_10.0\tools\layout_plus 

\samples\demo\finished.max” 

Или, быть может: 
“C:\Cadence\PSD_15.1\tools\layout_plus 

\samples\demo\finished.max” 

Перед Вами – завершённая печатная плата (рис.  1-1). 
Обратите внимание: в верхней части экрана расположена панель инструментов (рис. 

 1-2): 

 
рис.  1-2 

Кнопкой, на которую указывает курсор, мы будем пользоваться чаще всего. Она даёт 
быстрый доступ к параметрам всех элементов, составляющих наш проект. 

Вот её меню (рис.  1-3): 

 
рис.  1-3 

Давайте договоримся: если будет написано «Выберите «Text»», это значит, что необ-
ходимо нажать на кнопку  «View Spreadsheet», и из раскрывшегося меню выбрать пункт 
«Text». 

В противном случае будет написано: «Выберите Tool → Text → Select From Spread-
sheet…». Это значит, что надо выбрать указанный пункт через систему меню Layout Plus 
(рис.  1-4): 
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рис.  1-4 

Пожалуйста, выберите «Components» (рис.  1-5): 

 
рис.  1-5 

Перед Вами список всех компонентов проекта. В столбце «Ref Des» (Reference Desig-
nator) указывается обозначение компонента на плате. Как правило, это один или несколько 
символов, указывающих на тип компонента, и его порядковый номер. Например, здесь, сим-
волами JP обозначены разъёмы. JP5 – разъём #5. 

В столбце «Location» указаны точные координаты компонентов на плате, а в столбце 
«Comp Rotation» – поворот компонента. Поворот указывается против часовой стрелки, если 
смотреть на плату со стороны монтажа (Component Side). 

Компоненты, не имеющие общепринятого обозначения, допускается называть произ-
вольно. Логотип, изображённый рядом с платой, имеет обозначение «LOGO» (рис.  1-6). 
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Обратите внимание, компонент LOGO не является электрическим, не участвует в мар-
шрутизации и находится за пределами платы. Это – элемент оформления. 

 
рис.  1-6 

Ещё один пример. Курсор в рабочем окне Layout имеет вид крестика. Наведите его на 
левый верхний угол платы и нажмите несколько раз клавишу <I>, чтобы увеличить участок 
платы, как показано на рис.  1-7: 

 
рис.  1-7 

Клавиша <I> увеличивает участок экрана под курсором, клавиша <O> – уменьшает, 
клавиша <C> – перемещает в центр, сочетание клавиш <Shift>+<Home> – приведёт к вос-
становлению масштаба и отображению дизайна целиком. 

Можно также пользоваться кнопками масштабирования с панели инструментов: 

 
рис.  1-8 

 
рис.  1-9 

Попозже поэкспериментируйте самостоятельно с этими кнопками. А сейчас войдите 
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опять в «Components» и найдите в таблице компонент «HOLE4». Сдвиньте немного таблицу 
компонентов в сторону, как показано на рис.  1-9 и выделите строку «HOLE4». 

Обратите внимание, что кружок, расположенный слева, стал белым. Это и есть то, что 
мы ищем. Таким образом Layout подсвечивает (выделяет) выбранный элемент. Название 
подсвеченного элемента и краткую информацию по нему можно увидеть внизу экрана в 
строке состояния. Сейчас там написано: «Component “HOLE4”». 

Это – крепёжное отверстие. Как видите, оно хоть и находится на плате, но не принима-
ет участия в маршрутизации. 

Несколько слов о работе с таблицами. 

 
рис.  1-10 

Вы можете выделять мышкой в таблице строку, столбец, всю таблицу целиком или (не 
всегда) отдельную ячейку. Чтобы выделить строку, щёлкните мышкой по самой левой ячейке 
в этой строке. Чтобы выделить столбец, щёлкните по его заголовку. Для выделения таблицы 
целиком, щёлкните по ячейке, которая находится в левом верхнем углу. В нашем случае, для 
таблицы компонентов – это ячейка «Ref Des». 

 
рис.  1-11 

Итак, чтобы увидеть свойства компонента «LOGO», щёлкните левой кнопкой мыши по 
его Reference Designator. Выделится строка, как показано на рис.  1-5. Теперь нажмите пра-
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вую кнопку мыши для вызова контекстного меню и выберите «Properties…». 

Можно изменять свойства сразу нескольких объектов. 
Выделите компонент Q5 и, не отпуская левую кнопку мыши, потяните курсор до Q7. 

Если нужно выделить несмежные элементы таблицы, используйте клавишу <Shift>. Выде-
лится три компонента, как показано на рис.  1-10. 

Зайдите в «Properties» (рис.  1-11). 
Теперь Вы можете, к примеру, набрав в поле «Location X» новое значение, выровнять 

выбранные компоненты по вертикали. Поля, оставленные пустыми, никакого влияния на 
свойства компонента не окажут. 

Обратите внимание на область «Component flags». Я установил флажок в поле 
«Locked» и снял в поле «Route Enabled». Тем самым, выбранные компоненты будут забло-
кированы на плате от перемещений и исключены из списка доступных к маршрутизации. 
Остальные флажки не изменялись. 

В заключение этой главы, попробуйте самостоятельно найти компоненты, которые не 
участвуют в маршрутизации и являются элементами оформления. Сразу скажу, что размеры, 
таблица справа от платы, текст рядом с таблицей компонентами не являются. Это всё – эле-
менты дизайна.1 

1.2. Footprints. 
Каждому компоненту соответствует его footprint. Дословный перевод слова 

«footprint» – отпечаток ноги, след. В нашем случае – это изображение компонента, описание 
его посадочного места на плате. Footprint-ы компонентов хранятся в библиотеке и содержат 
информацию о физических размерах компонента; его изображении; количестве, типе и раз-
мерах контактных площадок (padstacks); а также текст (например, Reference Designator ком-
понента). 

Нажмите клавишу <Backspace>. Экран очистится. Теперь щёлкните мышкой по селек-
тору слоёв, как показано на рис.  1-12, и из раскрывшегося списка выберите слой # 23 – AST. 

 
рис.  1-12 

То же самое действие можно совершить, нажав <Backspace>, а потом: «View → Select 
Layer…». Необходимо выбрать слой «ASYTOP». 

О слоях мы поговорим позже, а пока Вы должны получить экран как на рис.  1-13. 
Перед Вами – изображение footprint-ов компонентов, расположенных сверху платы 

(Component side). Чтобы увидеть footprint-ы компонентов нижней стороны (Solder side), вы-
берите слой «ASYBOT» (слой # 24 – ASB). 

 

                                                 
1 Это компоненты 217, 218, 219 «MOIRE» и 221, 222, 223, 224 «CROP». 
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рис.  1-13 

На рис.  1-14 я увеличил участок платы с компонентом U1. Обратите внимание на тек-
стовую информацию компонента. Мы видим его порядковый номер (Reference Designator), 
название, нумерацию выводов. 

 

 
рис.  1-14 

Дополнительно мы можем заметить, что первый вывод обозначен особым штрихом, а 
корпус микросхемы в этом месте нарисован со скошенным уголком. 

Всё это в дальнейшем значительно облегчит процесс сборки платы. Увеличьте изобра-
жение ещё немного, и Вы увидите, что каждый 10-й вывод нарисован прямоугольной пло-
щадкой, а площадки всех остальных выводов скруглённые. Создатели footprint-а позаботи-
лись даже о такой мелочи! 

Рассмотрите footprint-ы других компонентов, обращая внимание на подобные «мело-
чи». В дальнейшем Вам это очень  пригодится. 
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Я уже говорил, что в OrCAD Layout имеется библиотека footprint-ов. Причём, для од-
ного и того же компонента – микросхемы, конденсатора, резистора – может храниться не-
сколько разных footprint-ов. Дело в том, компоненты могут выпускаться в разных корпусах, 
и для каждого варианта нам понадобится свой footprint. 

Вот перед Вами чертёж оптрона (оптокаплера) PS2561 фирмы NEC (рис.  1-15). Как ви-
дите, оптрон выпускается в двух вариантах: в DIP-корпусе2 со штырьковыми выводами и в 
планарном (SMD3) исполнении. 

 
рис.  1-15 

В первом случае выводы микросхемы вставляются для распайки в сквозные отверстия 
на плате, во втором – припаиваются к площадкам на поверхности платы. Терминология, ко-
торая используется для обозначения соответствующей технологии: Thruhole4 – «сквозные 
отверстия» и SMT (Surface Mount Technology) – технология поверхностного монтажа. 

На рис.  1-16 конденсатор, выполненный по технологии thruhole: 

 
рис.  1-16 

А на рис.  1-17 – по технологии SMT: 

 
рис.  1-17 

Взгляните на рис.  1-18. Это – регулятор напряжения фирмы Hitachi HA17431 shunt 
regulator. Он выпускается в шести различных корпусах.5 

Другая причина, по которой Вам может понадобиться дополнительный footprint для 
компонента – это особенности его размещения. К примеру, конденсатор, изображённый на 
рис.  1-16, может быть установлен горизонтально (лёжа) или вертикально (стоя). Возможен 

                                                 
2 DIP: Dual In-Line Package – корпус с двухрядным расположением штырьковых выводов. 
3 SMD: Surface-Mountable Device – компонент для поверхностного монтажа, планарный компонент. 
4 Thru = Through – сквозь, Hole – отверстие 
5 В пяти, на самом деле, если присмотреться внимательней (из footprint-ов UPAK один – для 17432). 
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также случай, когда его понадобится немножко утопить внутрь платы, и в плате придётся 
вырезать прямоугольное отверстие. 

Во всех этих трёх случаях Вам будет нужен свой footprint. 

 
рис.  1-18 

1.3. Padstacks. 
Pad – это вывод, контактная площадка компонента. В OrCAD Layout padstack – это, 

подобно footprint, библиотечный элемент, описывающий тип контактной площадки и её 
свойства для каждого вывода компонента. 

1.4. Layers. 
Вы, очевидно, знаете, что печатные платы бывают однослойные (односторонние), 

двухслойные (двухсторонние) и многослойные. Подобно плате, дизайн в Layout состоит из 
слоёв. Всего возможно использование до 30 слоёв, плюс ещё один – Global Layer. 

Войдите в «Layers» (рис.  1-19). 

 
рис.  1-19 

В этой таблице перечислены все слои, кроме Global. Сначала разберёмся с общими по-
нятиями, а потом детально рассмотрим каждый слой. 
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Итак, каждый слой имеет своё имя – Layer Name. Это имя видно в первом столбце 
таблицы. 

Следующий столбец – Layer Hotkey. Нажав указанную в этом столбце комбинацию 
клавиш, Вы начинаете работать с тем слоем, который Вам нужен. Выбрать нужный слой 
можно также через меню: «View → Select Layer…». Или через селектор слоёв, как показано 
на рис.  1-12. 

Layer NickName. Это – трёхбуквенное сокращение от имени слоя. Layer NickName 
широко используется в Layout, в частности, в селекторе слоёв. 

Layer Type – тип слоя. Имеется шесть типов слоёв. 
• Routing – слой предназначен для маршрутизации. Именно по этому слою (сло-

ям) происходит разводка печатной платы. В OrCAD Layout Plus возможно ис-
пользование до 16 маршрутизируемых слоёв. 

• Plane layers – слои этого типа применяются в многослойных платах и являются, 
как правило, внутренними слоями. Они используются для соединения компо-
нентов с землёй и питанием. Контактные площадки для Plane Layers выполня-
ются обычно большими, чем для соединения с прочими слоями. Кроме того, со-
единение с Plane автоматически выполняется по типу «Thermal relief».6 

Вот перед Вами небольшая четырёхслойная плата (рис.  1-20): 

 
рис.  1-20 

                                                 
6 Thermal relief – в русском языке применяются термины «температурный контакт» или «тепловой барьер». 
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Я увеличу её левый нижний угол (рис.  1-21): 

 
рис.  1-21 

Сейчас видно два слоя. Голубой – верхний (TOP), и красный – нижний (BOTTOM). 
Компоненты J2 и J3 – это разъёмы (коннекторы). 

А вот на рис.  1-22 показан тот же участок для «земляного» слоя: 

 
рис.  1-22 

Plane Layers изображаются инверсно, в негативе. Таким образом, всё чёрное внутри 
платы – медь. Серые кружочки – это отсутствие меди. Эти участки будут вытравлены. 

Жёлтые колечки тоже будут вытравлены. В этих местах Plane Layer соединяется с вы-
водами компонентов, либо через vias (переходные отверстия) – с другими слоями. 
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рис.  1-23 

На рис.  1-23 показан тот же участок платы, на котором видны, помимо «земляного» 
слоя, слои TOP и BOTTOM. Кроме того, показан DRILL Layer – слой для сверловки. Кру-
жочки в центре площадок – это будущие отверстия. 

Вот что получится в результате: 

 
рис.  1-24 

Таким образом, Plane layer охватывает вывод колечком, которое соединяется со всем 
остальным полем четырьмя относительно тонкими перемычками. Это и есть Thermal relief. 
Сделано это для облегчения в будущем пайки компонента. Перемычки предотвращают отток 
тепла от площадки при монтаже. 

• Documentation layers. Эти слои не участвуют в маршрутизации и содержат до-
полнительную информацию для изготовления платы: данные по сверловке; дан-
ные для фрезеровки; для монтажа компонентов; для нанесения припоя; текст; 
размеры; комментарии в дизайне и пр. 
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• Jumper layer. В OrCAD Layout существует возможность проектирования плат с 
перемычками. В промышленности, особенно в производстве бытовой аппарату-
ры, широко используют односторонние платы с перемычками (zero-ohm 
resistors). Такие платы значительно дешевле двухсторонних и, тем более, много-
слойных. 

Другая причина, по которой Вам, возможно, придётся использовать перемычки – 
слишком плотная маршрутизация, наличие широких зон сплошной металлизации. Можно, 
конечно, было бы использовать дополнительные внутренние слои, но всё упирается, опять-
таки, в стоимость платы. 

На рис.  1-25 показана плата управления видеомагнитофона. 

 
рис.  1-25 

На рис.  1-26 один из участков увеличен так, чтобы хорошо были видны перемычки. В 
данном случае, дорожки и контактные площадки, к которым припаиваются компоненты, 
расположены с обратной стороны (solder side), а перемычки – с лицевой (component side). 

 
рис.  1-26 

• Drill layer – слой сверловки. Слой Drill используется для отображения отвер-
стий в дизайне. Впоследствии  из этого слоя будет сгенерированы данные для 
сверловки. 

• Unused – неиспользуемый слой. 

Рассмотрим теперь сами слои, которые перечислены в таблице. У каждого слоя есть 
номер, который виден в селекторе слоёв (рис.  1-12), имя и сокращённое имя (NickName). 
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Слой #0 – GLOBAL layer или Conn layer7. Этот слой является особым. Изменения, 
внесенные на этом слое, окажут влияние на все остальные слои. Например, если определить 
в Global layer зону, недопустимую для маршрутизации, то в этом месте не будет ни одной 
дорожки ни на одном слое. 

Именно в Global layer обозначается граница платы. Понятно, что все дорожки и все 
компоненты, участвующие в маршрутизации, должны находиться внутри этой границы. Всё, 
что находится снаружи – текст, рисунки, размеры и прочее, в каком бы слое они ни распола-
гались, будут восприняты как комментарии. 

Layer hotkey для Global – <0>. 

Слой #1 – TOP layer. Слой типа «Routing», маршрутизируемый. Верхний слой печат-
ной платы, называемый ещё «Component side». 

Слой #2 – BOTTOM layer. Нижний слой печатной платы, называемый также «Solder 
side» или «Print Side». Этот слой является парным слоем с TOP layer, о чём говорится в 
столбце «Mirror Layer» таблицы рис.  1-19. «Mirror» по-английски – «зеркало», и действи-
тельно, если смотреть со стороны TOP как бы «сквозь» плату, то все компоненты, помещён-
ные на BOTTOM, будут выглядеть в зеркальном отражении. 

Слои #3 и #4. Слои GND и POWER, предназначенные для разводки питания, о чём го-
ворит их название. Это слои типа «Plane». 

Далее следуют несколько маршрутизируемых внутренних слоёв INNER1, INNER2 и 
т.д., которые могут использоваться самым разнообразным образом. Вы можете переопреде-
лить их как дополнительные Plane layers, если Ваша схема работает от нескольких источни-
ков питания. Вы можете использовать их для обычной маршрутизации. Наконец, Вы можете 
их не использовать вовсе. В последнем случае рекомендуется ставить атрибут «Unused», 
чтобы слой не занимал место в памяти компьютера. 

Слои #17 и #18. SMTOP и SMBOT – Soldermask Top и Soldermask Bottom соответст-
венно. 

Что такое «SolderMask»? Рассмотрим плату, изображённую на рис.  1-20. После развод-
ки плата покрывается защитной краской, которая также выполняет роль изоляции. Краска 
отсутствует лишь в тех местах, где есть контактные площадки, где, возможно, будет пайка, 
где есть контрольные точки и т.д. В этих местах дорожки «выходят на поверхность» и залу-
живаются. Где будет краска, а где – нет, определяется слоем Soldermask. 

Посмотрите на фотографию этой платы (рис.  1-27). Дорожки по сравнению с площад-
ками выглядят более темными, потому что находятся под слоем краски. 

 
рис.  1-27 

                                                 
7 От слова «Connection» – слой соединений. Все неразведённые цепи показываются в слое GLOBAL в виде 

жёлтых или разноцветных нитей. 
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Для наглядности, я помещу рядом с фотографией рисунок (рис.  1-28), полученный из 
OrCAD: 

 
рис.  1-28 

А вот изображение слоя SMTOP (рис.  1-29). 

 
рис.  1-29 

Как видно, слой изображается инверсно, то есть, всё чёрное будет покрыто краской. 
Данная плата сделана так, что все vias – переходные отверстия – находятся на поверх-

ности. Таким образом, они могут служить контрольными точками. Если плата проектируется 
для какого-то экспериментального устройства или опытного образца, то это имеет смысл. 
Однако в общих случаях рекомендуется скрывать vias под изоляционным слоем краски. 

Вернёмся к плате, показанной на рис.  1-1. Рассмотрите её слои, используя селектор 
слоёв и пользуясь следующими «горячими клавишами»: 

<Backspace> – очистка экрана; 
<-> (минус) – включение/выключения слоя; 
<Home> или <F5> – обновление экрана. 

Кроме того, для быстрого перехода к нужному слою, Вы можете использовать Hotkeys, 
указанные в таблице «Layers» (рис.  1-19). Если слой выключен (невидим), OrCAD Layout 
Plus версии 10.0 включит его, а версии 9.2 – выдаст сообщение «Layer invisible». Нажмите 
клавишу <-> для того, чтобы включить слой. 

OrCAD Layout Plus 

 Стр. 21 

Слои #19 и #20. SPTOP и SPBOT – Solder Paste Top и Solder Paste Bottom. Признак 
покрытия «паяльной пастой». Назначается всем контактным площадкам планарных (SMD) 
компонентов. 

Слои SPTOP и SPBOT не нужны для производства печатной платы, зато они нужны 
при последующем автоматическом монтаже компонентов на плату с использованием pick-
and-place машин. 

По информации слоя Solder Paste изготавливается маска – трафарет. В тех местах, где 
были нарисованы площадки, в маске вытравливаются отверстия. Маска накладывается на 
уже готовую печатную плату, и отверстия заполняются паяльной пастой. Потом маску уби-
рают, а паста остаётся на площадках. Далее на плате размещаются SMD-компоненты, и плата 
помещается в печь. Паяльная паста плавится, и выводы деталей оказываются припаянными к 
площадкам. 

Слои #21 и #22. SSTOP и SSBOT – Silkscreen Top и Silkscreen Bottom. Silkscreen – это 
слой маркировки (шелкография, трафаретная печать). Поверх изоляционной краски на плату 
наносятся другой – белой – краской контуры компонентов, их обозначения, различные над-
писи. Вы можете увидеть их на рис.  1-27. Всё, что должно быть нарисовано или написано на 
плате задаётся в слоях Silkscreen. 

Сравните рис.  1-28 и рис.  1-30. 

 
рис.  1-30 

Отдельно слой шелкографии: 

 
рис.  1-31 
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Слои #23 и #24. ASYTOP и ASYBOT – Assembly Top и Assembly Bottom. Эти слои не 
используются при изготовлении платы, но зато очень могут быть полезны при её сборке. 
Распечатав из Layout Plus эти два слоя, мы получим прекрасный чертёж монтажа компонен-
тов на плату. На рис.  1-13 показан монтажный слой со стороны Component side. 

Слои #25 и #26. Слои DRLDWG и DRILL. Эти два слоя служат для обозначения от-
верстий на плате. Слой DRLDWG является слоем типа Documentation и служит для создания 
таблицы отверстий (Drill Chart).  

  
рис.  1-32 

На рис.  1-32 показан участок платы с подсвеченными слоями DRILL (слева) и 
DRLDWG (справа). На слое DRILL отверстия показаны как они есть на самом деле. На слое 
DRLDWG отверстия обозначаются особыми символами в зависимости от диаметра и типа 
отверстия. 

В окне дизайна рядом с чертежом платы расположена таблица, которая называется 
Drill chart. В ней приводится легенда символов сверления: 

 
рис.  1-33 

В столбце «DIAM» указывается соответствие каждого символа диаметру в дюймах. 
Если в качестве основной единицы измерения используются миллиметры, то рядом со значе-
нием будет написано «mm». 

В столбце «TOL» указывается допустимое отклонение (Tolerance). 
«QTY» – количество (Quantity) таких отверстий на плате. 
«NOTE» – примечание. «Non-plated» в данном случае означает, что отверстия этого 

типа не имеют внутри столбика металлизации. 
Вы можете менять изображение символов в столбце «SYM». Для этого войдите в 

«Drills» и измените значение «Symbol». Можно использовать символы от 1 до 20 или буквы 
от A до Z. Пример таблицы показан ниже (рис.  1-34): 
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рис.  1-34 

Возможно также изменять внешний вид Drill Chart или перемещать её в окне дизайна в 
удобное место. Используйте для этого меню: «Tool → Drill Chart…». 

В системе OrCAD Layout Plus возможно проектирование печатных плат с применением 
технологии несквозных vias. Несквозные vias называются «Blind»8 или «Buried».9 Blind via 
соединяет наружный слой (TOP или BOTTOM) с одним из внутренних слоёв и имеет только 
один выход на поверхность. Buried via соединяет между собой внутренние слои и на поверх-
ность выхода не имеет вообще.10 

Ещё два слоя – FABDWG и NOTE являются слоями для комментариев. 
 

                                                 
8 Blind via – «слепое» переходное отверстие. 
9 Buried via – «скрытое» переходное отверстие. 
10 Обычные via, понятное дело, называются «Thruhole». 
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2. Библиотека компонентов. 

С чего начинается работа над платой? 
В любой книге, руководстве, да и в справочной системе OrCAD Вы прочитаете, что 

сначала надо приготовить Netlist,11 передать параметры в Layout, нарисовать контур платы, а 
затем… 

Стоп, стоп! Боюсь, что ничего у Вас не получится, потому что как раз на стадии за-
грузки Netlist-а утилита AutoECO12 спросит Вас о соответствии компонентов их footprint-ам. 
На этом Ваш проект благополучно завершится, так и не начавшись. 

Работа над платой начинается с подготовки всех footprint-ов! 
Вместе с Layout поставляется около полусотни библиотек. К сожалению, этого не мо-

жет быть достаточно, в чём Вы очень скоро убедитесь. Потому что, во-первых, на любой 
плате, даже самой несложной, найдётся один-два нестандартных компонента. Во-вторых, 
особенности в конструкции платы могут потребовать нестандартного размещения даже са-
мого обычного элемента. Вспомните, что я говорил на стр. 13 про конденсатор, изображён-
ный на рис.  1-16. И, наконец, в-третьих, на рынке каждый год появляются всё новые и новые 
радиокомпоненты в самых различных корпусах. 

2.1. Library Manager. 
Запустите OrCAD Layout Plus. Откроется окно Layout Session. Теперь войдите в 

«Tools → Library Manager» (рис.  2-1). 

 
рис.  2-1 

Откроется окно Layout Plus с менеджером библиотек. 

                                                 
11 Netlist – список соединений. 
12 ECO – от Engineering Change Order. В данном контексте – утилита передачи netlist-а в OrCAD Layout. 
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Кнопка «1» в панели инструментов позволяет переключаться между Library manager и 
окном проекта. То же самое действие можно сделать, используя комбинацию клавиш 
<Ctrl-I>. 

В поле «2» показаны доступные в данный момент библиотеки. При первом запуске 
видны только библиотеки, которые поставляются вместе с OrCAD Layout. Они находятся в 
каталоге: 

C:\OrCAD\OrCAD_10.0\tools\layout_plus\library 

(Каталог по умолчанию). 
Если Вы создали свою собственную библиотеку компонентов и хотите её использо-

вать, воспользуйтесь кнопкой <Add…>. 
Кнопка <Remove> позволяет убрать ненужную библиотеку из списка, однако, это не 

значит, что библиотека также будет физически стёрта с компьютера. 
В поле «3» отображаются названия доступных footprint-ов из выбранной библиотеки. 
И, наконец, в окне «4» мы видим изображение выбранного footprint-а. 
В строке состояния «5» приводится дополнительная информация, из которой наиболее 

важной являются координаты курсора или перемещаемого объекта. Они заключены в квад-
ратные скобки и отображаются в соответствии с сеткой привязки (Grid). 

Войдите в «Options → System Settings…» или нажмите <Ctrl-G> (рис.  2-2).  
Нас интересуют два поля в открывшемся окне: «Display Units» и «Grids». В первом 

устанавливаются единицы измерения, которые будут использоваться в проекте; в правом – 
установки сеток привязки. 

 
рис.  2-2 

Сетки привязки служат для упорядоченного размещения объектов на рабочем поле. 
Таким образом, все объекты располагаются не хаотично, а «по клеточкам». В OrCAD Layout 
«клеточки» квадратные, но, вообще говоря, сетки привязки могут иметь и прямоугольную 
форму и даже, если нужно, то, скажем, шестиугольную. К тому же, для разных объектов мо-
гут быть установлены различные сетки. 

В Layout пять сеток: 
• Visible grid. Это сетка, которая отображается на экране в виде белых точек. 

Служит исключительно для удобства. 
• Detail grid – сетка привязки для текста и, так называемых, «Obstacles».13 
• Place grid – сетка для размещения компонентов. 
• Routing и Via grid – сетки привязки для дорожек и vias соответственно. 

                                                 
13 Obstacle – препятствие. Про obstacles будет подробно рассказано далее. 
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В зависимости от инструмента, с которым мы работаем, шаг сетки показывается в па-
нели инструментов рядом с буквой «G». 

 
рис.  2-3 

«X» и «Y» – координаты курсора. 

Пару слов о единицах измерения, применяемых в Layout. Мы можем работать как в 
английской (дюймовой) системе измерений, так и в метрической. В дюймовой системе ос-
новной используемой единицей является миль (m).14 В метрической – миллиметры (mm). 

2.2. Thruhole components. 
Найдите компонент «DIP.100/14/W.300/L.725» из библиотеки «DIP100T» как показано 

на рис.  2-1. 
Очевидно, что это – микросхема, выполненная по технологии thruhole, имеющая 

14 выводов. 
Щёлкните мышкой по 7-му выводу (он подсветится – станет белым), а затем нажмите 

клавишу <Esc>.15 Теперь войдите в <Padstacks>. Вот что Вы должны увидеть (рис.  2-4): 

 
рис.  2-4 

В таблице «Padstacks» полностью описывается используемая контактная площадка. В 
первом столбце указано имя площадки. В нашем случае – «DIP100T.llb_pad2». 

Во втором столбце указана форма площадки – Pad Shape. 
В последующих столбцах даны размеры площадки (Pad Width и Pad Height), а также 

её смещение относительно центра. Напомню, что все размеры приводятся в той системе, ко-

                                                 
14 Mil – тысяча. 1 миль = 1/1000 дюйма = 0,0254 мм. 
15 Во всех случаях аналогом клавиши <Esc> служит средняя кнопка мыши или совмещённое с ней колёсико. 
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торая установлена в окне «System settings» (рис.  2-2). В данном случае – в милях. 
В первом столбце ниже имени площадки перечислены слои. Разберёмся, что это зна-

чит, сопоставив информацию из других столбцов. 
Слои TOP и BOTTOM – это слои для маршрутизации. На этих слоях площадка будет в 

виде кружочка (Round) размером 58 милей.16 
Слои типа PLANE – слои для разводки питания и земли. Площадка имеет увеличенный 

размер. 
Внутренние слои – INNER. Обычные маршрутизируемые слои. Размер и форма пло-

щадки такая же, как и на наружных слоях. 
Слои SMTOP и SMBOT – слои SolderMask. Понятно, что если мы предполагаем при-

паивать вывод к площадке, то последняя должна быть свободна от маски. В столбце Pad 
Shape – «round», в столбцах Pad Width и Pad Height такие же размеры, как в TOP и 
BOTTOM, или даже чуть больше. 

Слои Solder Paste (SPTOP и SPBOT), также как и слои Silkscreen (SSTOP и SSBOT) 
нам не нужны, поэтому рядом стоит «Undefined» – «неопределено». 

Слои ASYTOP и ASYBOT – слои для сборки. Желательно указать на них то же, что на 
TOP и BOTTOM. 

И, наконец, слои DRLDWG и DRILL – слои сверления. Форма отверстия всегда 
«round», в полях Pad Width и Pad Height указывается диаметр сверла.17 

Остальные слои являются «запасными» и обычно не используются. 

 
рис.  2-5 

Теперь закройте таблицу «Padstacks», и проделайте ту же процедуру для вывода 1. Всё 
отличие вывода 1 от других выводов как раз и состоит в том, что он – первый. Поэтому его 
площадку нарисовали квадратной формы («Square»). 

                                                 
16 Когда речь идёт о «размере» площадки, – а площадки могут быть не только круглые, но и, скажем, прямо-

угольные, – то имеется в виду расстояние от края до края. Таким образом, для круглой площадки цифра «58» 
означает её диаметр. 

17 На самом деле при производстве платы будет использовано сверло большего диаметра. Связано это с тем, 
что при наращивании внутри отверстия столбика металлизации, отверстие неизбежно станет уже. Диаметр 
сверла выбирается так, чтобы компенсировать это явление.  
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Какой ещё формы могут быть Pads (площадки)? Выделите строку TOP, затем щёлкни-
те правой кнопкой мыши и войдите с помощью контекстного меню в <Properties…> (рис. 
 2-5). 

Нас интересует поле «Pad Shape». Названия говорят сами за себя: 
• Round – круглая площадка; 
• Square – квадратная; 
• Oval – овальная; 
• Annular – в виде колечка; 
• Oblong – прямоугольная со скруглёнными углами; 
• Rectangle – прямоугольная; 
• Thermal Relief – тепловой контакт; 
• Undefined – не используется. 

Будьте внимательны в выборе, иначе такого можно нарисовать! 

 
рис.  2-6 

На рис.  2-6 показана микросхема, у которой площадки на слое BOTTOM определены 
как «Annular», а на слое TOP – как «Thermal Relief». Показаны также отверстия и дорожки, 
соединяющие отдельные выводы. Как видите, получилась полная ерунда! 

2.3. SMD components.   
Найдите теперь компонент «DIP.100B/14/W.300/L.850» из библиотеки «DIP100B» как 

показано на рис.  2-7. 

 
рис.  2-7 

Практически такая же микросхема, только в планарном исполнении. 

1 

2
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Щёлкните по выводу 1, нажмите <Esc> и войдите в <Padstacks>. 
В таблице «Padstacks» описываются все доступные для данного footprint-а типы пло-

щадок. Если Вы, прежде чем войти в таблицу, щёлкните по одному из выводов, то таблица 
откроется именно в том месте, где описывается нужный Вам Pad. 

Итак, обратимся к таблице (рис.  2-8): 

 
рис.  2-8 

Заполнены поля только для слоёв TOP, SMTOP, SPTOP и ASYTOP. Поскольку планар-
ный компонент располагается на поверхности, не использованы слои PLANE, INNER и 
BOTTOM. Также не используются слои DRILL и DRLDWG. 

Итак, для thruhole-компонентов площадки описываются в слоях TOP, BOTTOM, 
PLANE, INNER (все маршрутизируемые слои), SMTOP, SMBOT (маска), ASYTOP, 
ASYBOT (слои монтажа) и слои сверловки – DRLDWG и DRILL. 

Для SMD-компонентов используются только 4 слоя: TOP – один маршрутизируемый, 
слой маски SMTOP, слой Solder Paste SPTOP и слой монтажа ASYTOP. 

2.4. Footprint properties. 
Войдите в <Footprints> (рис.  2-9). 

 
рис.  2-9 

В этой таблице даётся детальное описание footprint-а. В первом столбце приводится 
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полное название, и перечисляются выводы (pads). Название выводов может быть цифровым 
или буквенным, содержать дополнительные знаки, состоять из одного символа или несколь-
ких. Буквы разрешается использовать только заглавные. 

Примеры: «7», «+5V», «A15», «CATHODE». 
Не допускается использование одинаковых имён для разных выводов. 
В столбце Padstack name приведено библиотечное имя используемого типа площадки. 
В столбцах PAD X Loc и PAD Y Loc указаны координаты выводов. 
Что является началом координат? Взгляните на рис.  2-7. Цифрой «1» я обозначил 

Datum – специальный знак, от которого ведётся отсчёт координатной сетки. Сейчас его 
положение совпадает с выводом #1 микросхемы, поэтому координаты  Pad 1 – [0,0]. 

Datum можно перенести в другое место воспользовавшись командой: «Tool → Dimen-
sion… → Move Datum». После этого щёлкните мышкой в том месте, где нужно установить 
начало координат. 

Если вместо этого щёлкнуть правой кнопкой мыши, откроется дополнительное меню 
(рис.  2-10). 

 
рис.  2-10 

Что такое «Insertion Origin» (см. рис.  2-7, «2»)? 
Поскольку каждый компонент имеет совершенно определённые размеры и форму, мы 

выбираем на чертеже его footprint-а какую-то точку, и в дальнейшем считаем, что координа-
ты этой точки – и есть координаты нашего компонента. В Layout координатами компонента 
считаются координаты его Datum-а. 

При автоматической сборке плат, для Pick-And-Place машин координатами компонента 
является его Insertion Origin. Очевидно, Insertion Origin может совпадать с Datum, а может и 
не совпадать. С помощью меню, показанного на рис.  2-10 можно переместить мышкой Inser-
tion Origin в центр footprint-а или в произвольное место. 

 
рис.  2-11 

На рис.  2-11 показано, как изменить значение Insertion Origin с помощью таблицы 
«Footprints». 

Точкой отсчёта координат для Pad-а является его центр симметрии. Мы можем сме-
щать Pad относительно этой точки, меняя параметры «X Offset» и «Y Offset» (см. рис.  2-4 и 
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рис.  2-5). Значение параметра «Offset» должно быть меньше, чем половина размера площад-
ки. Иными словами, например, если площадка имеет размеры 50x80, то X и Y Offset могут 
принимать значения ±24 и ±39. 

Следует также помнить, что точка отсчёта координат является также точкой подсоеди-
нения дорожки. Сравните эти два рисунка: 

 
рис.  2-12 

 
рис.  2-13 

На рисунке справа видно, что площадки смещены к центру footprint-а. 

Давайте разберёмся с наиболее важными параметрами из таблицы Footprints, а чтобы 
нам это удобнее было делать, выделите Pad 1 и откройте его свойства (рис.  2-14). 

 
рис.  2-14 

Поле «Pad Entry/Exit Rule». 
Здесь описывается, каким образом к выводу могут подходить дорожки. Надо отметить, 

что это правило касается лишь компонентов с некруглыми выводами. Мы в качестве примера 
рассмотрим схему с м/с в корпусе SOIC-14, аналогично изображённому на рис.  2-7. 

На приведённых ниже рисунках левая верхняя ножка микросхемы является первой. 
Нумерация идёт против часовой стрелки. 
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(1) Standard 

 
(2) Any Direction 

 
(3) Long End Only 

 
(4) Allow via under pad 

1. Вариант «Standard». Дорожки подходят к выводу «с торца». Исключение составля-
ют лишь крайние выводы. Соединение выводов 2 и 3, как показано на (2) будет ошибкой. 

2. «Any Direction». Никакие правила подвода дорожек к выводам не устанавливаются. 
Все соединения будут обработаны без ошибок. 

3. «Long End Only». Так же, как и в варианте «Standard». Крайние выводы тоже под-
чиняются общему правилу. 

4. Поле «Additional Rules» – «Дополнительные правила». Опция «Allow via under 
pad» – разрешить переходное отверстие под контактной площадкой. По умолчанию это пра-
вило запрещено. Вы можете отменить запрет, установив флажок в этом поле. На (4) показано 
соединение вывода 7 с «землёй». 

2.5. Obstacles. 
Ещё одно понятие, с которым нам постоянно придётся оперировать в системе OrCAD 

Layout – это так называемые «Obstacles». На русский язык это слово перевести можно как 
«граница», «преграда». Фактически же это – некая очерченная область, выполняющая, в за-
висимости от установленных свойств, те или иные функции. 

Ну, например, с помощью obstacles определяется форма печатной платы, указываются 
зоны металлизации, задаются границы footprint-ов. В слое Silkscreen, используя obstacles, 
можно рисовать. 

Давайте посмотрим, как obstacles используются в footprint-ах компонентов, изображён-
ных на рис.  2-1 и рис.  2-7. На рис.  2-15 и рис.  2-16 показаны соответствующие таблицы. 
Войти в них можно, как обычно, воспользовавшись кнопкой «Spreadsheet» на панели инст-
рументов. 

 
рис.  2-15 

Как видно, obstacles имеют имена. Их можно изменять произвольно, или Layout назна-
чит имя каждой obstacle автоматически. 

В столбце «Layer» указывается, в каком слое располагается obstacle. Пользуясь случа-
ем, я хочу сказать, чтобы Вы с самого начала забыли о существовании COMMENT LAYER-а. 
Во-первых, при составлении библиотек footprint-ов разработчики использовали его как попа-
ло; во-вторых, грамотно построенный footprint не должен нуждаться в каких-либо коммента-
риях; а в-третьих, когда Вы закроете Library Manager и перейдёте в окно дизайна, то обнару-
жите, что  такого слоя – COMMENT LAYER – в дизайне нет. 
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рис.  2-16 

В столбце «Obstacle Type» задаётся тип obstacle. 

Итак, что мы имеем? Obstacles, расположенные в слоях SSTOP – это контур компонен-
та. Это просто изображение – в нашем случае – микросхемы, которое будет нанесено на пла-
ту.18 В столбце «Width or Height» указывается толщина линий. 

В слое ASYTOP повторяется всё, что нарисовано в SSTOP для создания в будущем 
монтажного чертежа. 

Вот что получается: 

 

– общий вид. Видны все слои. Видны выводы мик-
росхемы (слой TOP). Вокруг выводов видны серые ко-
лечки – увеличенные площадки PLANE layers. Виден 
контур микросхемы (слой SST – Silkscreen). 

 

– отдельно показан слой SST. 

 

– отдельно слой ASYTOP, слой монтажа. Вспомни-
те, не зря мы делали описание Padstacks в слоях 
ASYTOP и ASYBOT. Если бы мы не сделали это, наша 
микросхема на сборочном чертеже выглядела бы в ви-
де корпуса без выводов. 

Рассмотренные obstacles принадлежат к типу «Detail». 

Обратите внимание на obstacle типа «Place outline». Это – тонкая линия, которая очер-
чивает компонент по контуру, захватывая выводы. Она определяет границы, физические 
размеры компонента. Понятно, что при размещении компонентов на плате, их границы не 
должны перекрываться, иначе компоненты будут «наезжать» друг на друга, просто не помес-
тятся при монтаже. 

Я увеличу изображение общего вида footprint-а, чтобы можно было рассмотреть линию 
Place Outline. 

                                                 
18 См. описание слоя Silkscreen на стр. 21. 
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рис.  2-17 

Для SMT-компонентов obstacle Place outline находится в слое TOP. Таким образом, под 
SMT-компонентом (на слое BOTTOM) может быть размещён ещё один – тоже SMT – компо-
нент. 

 Для маленьких по размеру thruhole-компонентов obstacle Place outline находится в слое 
GLOBAL. Таким образом, место под ними с обратной стороны платы оказывается занятым. 
Если компонент велик, можно задать его границу Place outline так же, как и для SMT, только 
в верхнем слое, разрешив, таким способом, размещение других деталей между его ножек с 
противоположной стороны платы. 

На рис.  2-18 мы видим как раз такой случай. U6 – это большой, выступающий за пре-
делы платы, thruhole-компонент. Его контур в слое SSTOP обозначен белым (естественно, 
что выступающая часть на плате нарисована не будет). 

С обратной стороны платы между ножками U6 расположены несколько SMT-
компонентов. Их контуры в слое SSBOT обведены жёлтым. 

 
рис.  2-18 

На рис.  2-19 показан этот же фрагмент с дорожками. Голубой цвет – component side, 
красный – solder side. 
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рис.  2-19 

На рис.  2-20 приведён footprint компонента U6. Тонкая голубая линия, охватывающая 
выводы – это obstacle Place outline, расположенная в слое TOP. 

 
рис.  2-20 

Если бы компонент U6 находился целиком в пределах нашей платы, следовало бы ли-
нию Place outline обвести иначе. Например, так (рис.  2-21), чтобы никакие компоненты не 
оказались под его выступающей частью: 

 
рис.  2-21 

Из рис.  2-21 видно, что obstacle Place outline не обязательно должна быть прямоуголь-
ной. Форма этой линии может быть произвольной, повторять контуры компонента, включать 
в себя окружности. Единственное условие – она должна быть всегда замкнута. 

Вот ещё один пример. Мы создаём footprint крепёжного отверстия, которое будет рас-
положено у самого уголка платы. Отверстие мы очерчиваем прямоугольной линией Place 
outline (слой GLOBAL) (рис.  2-22). 
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рис.  2-22 

Пока что всё хорошо. Но что, если уголок нашей платы скруглён или скошен, как на 
рис.  2-23? 

 
рис.  2-23 

Получается, что наше отверстие выступает за границу платы, и при проверке дизайна 
будет выдано сообщение об ошибке. Поэтому правильно будет описать footprint, как показа-
но на рис.  2-24. 

 
рис.  2-24 

Obstacle Place outline очерчивает footprint по окружности, повторяя форму компонента. 

И, наконец, следует упомянуть случай, когда Вам, возможно, понадобится описать 
особый footprint компонента, в котором задать зоны «place outline» отдельно для слоёв TOP и 
BOTTOM. Такая возможность тоже существует, и иногда приходится ею пользоваться. 

Другая важная функция obstacle Place outline состоит в том, что с её помощью задаётся 
высота компонента. Если параметр «Height» равен 1 миль – высота не задана, в противном 
случае, компонент имеет высоту. 

Посмотрите на рис.  1-20 (стр. 15). Компонент U1, расположенный в центре платы – это 
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светодиодный индикатор высотой примерно 8 мм, что указано в свойствах его footprint-а 
(высота obstacle «place outline» равна 8 мм). Если зайти в «Options → User Preferences…» и 
установить флажок «Show 3D Effects», как показано на рис.  2-25, то мы увидим любопыт-
ную картину (рис.  2-26). 

 
рис.  2-25 

 
рис.  2-26 
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Какие ещё типы obstacles бывают? Чтобы выяснить это, войдите в свойства любой ob-
stacle и раскройте список «Obstacle Type» (рис.  2-27). 

 
рис.  2-27 

Board outline. Граница платы. Располагается всегда в слое GLOBAL. В проекте может 
быть только одна obstacle этого типа. Никогда не используется в режиме Library Manager. 

Insertion outline. Запрещает установку компонентов в очерченной области. В отличие 
от obstacle Place Outline, которая используется при проектировании footprint-ов, эта obstacle 
применяется только для указания зон непосредственно на печатной плате. 

Via keepout. Запрет vias в очерченной области. 

Route keepout. Запрет маршрутизации в очерченной области. 

Route-via keepout. Запрет и vias и маршрутизации. 
Возможно, Вам покажется странным существование obstacles типа Route keepout и 

Route-via keepout. В самом деле, как могут появиться vias в зоне, запрещённой к маршрути-
зации? Дело в том, что obstacle типа Route keepout ограничивает маршрутизацию лишь в том 
слое, в котором она располагается. Если плата многослойная, то в этой зоне могут быть vias, 
соединяющие между собой другие слои. 

Не забывайте об этом! Obstacle действует лишь в том слое, в котором она расположена. 
Исключение составляет лишь слой GLOBAL, который является «старшим» над всеми слоя-
ми. Если мы разместим, к примеру, в этом слое obstacle типа Route keepout, маршрутизация 
будет запрещена на всех слоях в очерченной области. 

Detail. Применяется для рисования на плате. Если Вам нужно что-либо нарисовать, на-
пример, взять в рамочку какой-то важный компонент, обведите его прямоугольником, вос-
пользовавшись obstacle Detail, размещенной в слое Silkscreen. Толщина линии будет опреде-
ляться параметром Width obstacle. 
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Obstacle Detail может быть замкнутой и разомкнутой, иметь различную толщину и 
предназначена для размещения в слоях Silkscreen, Assembly и DRLDWG.19 

Free track. Режим свободного рисования. Отличие Free track от Detail состоит в том, 
что Free track используется для рисования в маршрутизируемых слоях. 

Free track, расположенная в слое маршрутизации, станет барьером для остальных тре-
ков. Это значит, что другие дорожки вынуждены будут огибать очерченную Вами линию. 
При необходимости это можно использовать. 

Дорожка или фигура, нарисованная с помощью obstacle Free track может быть назначе-
на выводу компонента или какой-либо цепи, и станет, таким образом, частью этой цепи. 

Obstacle Free track может быть замкнутой и разомкнутой, иметь различную толщину и 
может быть расположена в любом маршрутизируемом слое.20 

 
рис.  2-28 

Поясню сказанное примерами. 
На рис.  2-28 показана простая пе-
чатная плата. На ней всего два от-
верстия с металлизацией, которые 
должны быть соединены между со-
бой. А между ними – уже нарисо-
ванная металлическая дорожка. 

Цифрами обозначены: 
1 – граница платы (Board outline); 
2 и 3 – vias; 
4 – так показываются соединения на 
ещё неразведённой плате; 
5 – obstacle Free track. 

Посмотрите, как поведёт себя ав-
тотрассировщик Layout Plus в зави-
симости от свойств obstacle Free 
track. 

Случай первый. Obstacle является «сама по себе», т.е. не принадлежит ни одной цепи. 
Более подробно о создании obstacles, их редактировании и описании свойств я расскажу не-
много позже, когда мы будем вместе создавать наш первый footprint, а пока просто посмот-
рите рисунки, приведённые ниже. 

Итак, obstacle не принадлежит ни одной цепи. На рис.  2-29 видно, что автотрассиров-
щик соединяет два vias таким образом, что дорожка огибает препятствие. На рис.  2-30 пока-
зано окно свойств obstacle. 

Цифрами обозначены: 
1 – название obstacle. Можно присвоить произвольное имя. 
2 – тип obstacle. В нашем случае – Free track. 
3 – ширина obstacle. 
4 – Слой, в котором obstacle расположена. 

                                                 
19 Layout Plus не запрещает размещение obstacle Detail в любом слое, включая GLOBAL, но делать этого без 

особой необходимости не стоит. Дело в том, что Detail не воспринимается автотрассировщиком как препятст-
вие (в отличие от obstacle Free track), и поэтому obstacle Detail, расположенная в маршрутизируемом слое, мо-
жет стать причиной замыкания. 

20 Free track, вообще говоря, можно располагать в любом слое, исключая GLOBAL. Размещённая в слое 
Silkscreen, Free track подобна obstacle Detail. 

1 

5 

2 

3 

4



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 40 

5 – Цепь, назначенная obstacle. Если в этом поле стоит прочерк, значит obstacle не при-
надлежит ни одной из цепей и будет служить препятствием для всех дорожек. 

 

 
рис.  2-29 

 
рис.  2-30 

Чтобы сопоставить obstacle какой-либо существующей цепи, воспользуйтесь выпа-
дающим списком поля 5 – «Net Attachment». 

Вот что может получиться в этом случае (рис.  2-31): 

 
рис.  2-31 

 
рис.  2-32 

В поле 5 видно, что наша obstacle является частью цепи NET_1, единственной цепи на 
нашей плате, которая соединяет две vias. Соответственно, автотрассировщик, проводя до-
рожку, не обязан огибать её. 
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Рассмотрим ещё один случай. Obstacle принадлежит цепи, но находится в стороне от 
неё (рис.  2-33). 

 
рис.  2-33 

Layout проведёт дорожку между двумя vias, однако не сделает соединения с obstacle. 
При проверке дизайна будет показана ошибка «Unconnected Electrical Obstacle» («Неподклю-
ченная obstacle»). 

 
рис.  2-34 

После того, как мы вручную соединим obstacle с назначенной ей цепью, ошибка исчез-
нет. 

Следующая группа obstacles, которую мы рассмотрим – это obstacles, описывающие 
зоны металлизации, т.е. зоны заливки медью. На печатной плате такие зоны можно исполь-
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зовать в качестве экрана для подавления электромагнитных шумов, в качестве теплоотвода 
или как барьер для маршрутизации. Во время подготовки footprint-а Вы можете, используя 
obstacles этой группы, нарисовать pad произвольной формы. Наконец, в слое Silkscreen мож-
но нарисовать просто закрашенную краской область. 

В эту группу входят obstacles Copper area, Copper pour и Anti-copper. 
Obstacle Copper area. Очерченная область будет залита медью. Зону можно назначить 

электрической цепи, и тогда все дорожки, кроме принадлежащих этой цепи будут огибать 
указанную область. 

 
рис.  2-35 

 
рис.  2-36 

На рис.  2-35 показана плата, состоящая из четырёх vias, попарно электрически соеди-
нённых. Цифрами обозначены: 

1 – колечко металлизации вокруг via; 
2 – отверстие; 
3 – электрическая цепь, назначенная зоне металлизации. 
4 – зона металлизации Copper area. Зона сплошной заливки медью. 

На рис.  2-36 показано, что у нас получится. Via (1) целиком окажется покрытой медью. 
От неё останется лишь дырочка. Дорожка (2), принадлежащая цепи, входит прямо в зону. 
Дорожка (3), не принадлежащая цепи, зону огибает. 

 
рис.  2-37 

 
рис.  2-38 

 Copper area может быть выполнена в виде сплошной заливки или заштрихованной. 
Чтобы изменить способ заливки, необходимо войти в окно свойств указанной obstacle и в ок-
не «Hatch Pattern…» указать тип штриховки. 

Obstacle Copper pour дорожки других цепей не огибают, а проходят насквозь, как бы 
«роют ходы» внутри зоны. 

1 

2 

3 

4 

1 

2 

3

OrCAD Layout Plus 

 Стр. 43 

 
рис.  2-39 

 
рис.  2-40 

На рис.  2-39 показана ещё неразведённая плата. Vias (1) и (2) электрически соединяют-
ся между собой цепью, назначенной зоне Copper pour, почти целиком покрывающей нашу 
плату. Vias (3) и (4) также имеют соединение друг с другом, что отображено тонкой жёлтой 
ниточкой (6). 

Обратите внимание, что между vias (1) и (2) такой ниточки нет. Это потому, что «ни-
точки» показывают ещё неразведённые соединения, а vias (1) и (2) уже соединены через 
Copper pour. 

Обратите также внимание, что vias (1) и (2) соединяются с зоной по типу «Thermal re-
lief». 

На рис.  2-40 показана уже разведённая плата. «Ниточка» (6) превратилась в дорож-
ку (7), которая «прокопала» себе проход прямо в зоне Copper pour. 

Давайте вернёмся к рис.  2-36 и посмотрим, что произойдёт, если obstacle Copper area 
(рис.  2-41) поменять на Copper pour (рис.  2-42). 

 
рис.  2-41 

 
рис.  2-42 

Первое. Соединение с Copper pour осуществляется по типу Thermal relief. 
Второе. Дорожки не огибают Copper pour, а проходят сквозь неё. 
И третье, что стоит понять и всегда помнить. Отрезанная от остальной цепи Copper 

pour на плату нанесена не будет, а из дизайна просто исчезнет, как это показано на рис.  2-42. 
Дорожка (2) перерезала Copper pour (3). И, поскольку отрезанный кусок оказался изолиро-
ванным от своей цепи, то Layout удалил его с чертежа. 

Давайте посмотрим, что можно сделать с платой, изображённой на рис.  2-42, играясь 
различными настройками Layout Plus. Войдите в окно свойств obstacle: 
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рис.  2-43 

На рис.  2-44 показан результат установки флажка «Isolate all tracks», на рис.  2-45 вдо-
бавок изменена штриховка Copper pour с помощью диалога «Hatch Pattern…». 

 
рис.  2-44 

 
рис.  2-45 

Параметр «Clearance» задаёт зазор между зоной металлизации и другими объектами – 
дорожками или контактными площадками. Если Clearance = 0, то зазор определяется уста-
новками по умолчанию. 

На рис.  2-47 значение Clearance равно 30 миль против 12 по умолчанию (рис.  2-46). 

Помнится, в начале книги я обещал по возможности не забегать вперёд, однако, это-
го чрезвычайно трудно избежать. Мы уже столько прошли теории, а ещё даже не начали 
рисовать свой первый footprint, не говоря уж о создании платы, пусть даже самой простой 
и лёгкой! Информация настолько взаимосвязана, что даже для самого простого действия 
необходимо очень много знать. К тому же трудно решить, что хуже – повторять за учеб-
ником или преподавателем какие-либо действия, не понимая их смысла, или впитывать 
теорию, пытаясь потом на практике вспомнить пройденное. Очевидно, что оптимальное 
решение кроется, как всегда, где-то посередине. Когда настанет время практики, Вам при-
дётся вновь и вновь возвращаться к прочитанному, закрепляя материал. Но разве я говорил, 
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что будет просто? 
Поэтому, если Вы ещё не передумали, мы продолжим. И, раз уж я упомянул о значени-

ях по умолчанию, забежим вперёд ещё раз и посмотрим, где они находятся. 

 
рис.  2-46 

 
рис.  2-47 

Войдите «Options → Global Spacing…», и Вы увидите окно «Route Spacing» (рис. 
 2-48):  

 
рис.  2-48 

Выделите слой, в котором необходимо изменить установки, и откройте окно его 
свойств (рис.  2-49). Для этого, напомню, можно дважды щёлкнуть по названию слоя, нажать 
комбинацию клавиш <Ctrl>+<E> или воспользоваться контекстным меню, выпадающим по 
щелчку правой кнопки мыши. 

Понятно, что можно изменить свойства не только отдельного слоя, но и всех слоёв од-
новременно. Для этого надо выделить либо всю таблицу, щёлкнув по заголовку «Layer 
Name», либо выделив отдельный столбец, щёлкнув по его заголовку. 
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Войдём в окно «Edit Spacing» и изменим значение «Track to Track Spacing». 

 
рис.  2-49 

Вот что получается (рис.  2-50): 

 
рис.  2-50 

 
рис.  2-51 

Если увеличить параметр «Track to PAD Spacing», мы увидим то, что изображено на 
рис.  2-51. Изменения коснутся всех obstacles, дорожек и контактных площадок на плате. 

Последнее, о чём хочется рассказать – это о том, 
как изменить толщину перемычек Thermal relief, соеди-
няющих наши vias с зоной Copper pour. Войдите «Options 
→ Thermal Relief Settings…», и здесь нам нужен пара-
метр «Spoke Width». 

Увеличив значение с 10 до, скажем, 30, получим 
картину, изображённую на рис.  2-54. 

 
рис.  2-52 
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рис.  2-53 

 
рис.  2-54 

Зона Anti-Copper. Позволяет «вырезать окно» внутри Copper pour. Пример: 

 
рис.  2-55 

 
рис.  2-56 

На рис.  2-55 цифрами обозначены: 1) – Copper pour, назначенная цепи 2). 3) – зона 
Anti-Copper. На рис.  2-56 показано, что получится. 

Внутри Copper Area obstacle Anti-Copper применять нельзя. 

Сейчас самое время разобраться с параметром «Z order» (рис.  2-43). Параметр Z order 
служит для указания приоритета перекрывающихся зон. Чем больше его значение, тем 
«главнее» зона. 

 
рис.  2-57 

1

3

2

2

1 3
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На рис.  2-57 заданы три зоны. 1) и 2) – перекрывающиеся Copper pour, и 3) – зона Anti-
Copper. Все три зоны расположены в слое TOP, поэтому не обращайте внимания, что они на-
рисованы разными цветами – это сделано исключительно для удобства. 

Если всем obstacles присвоить значение Z order равным нулю, как это делается по 
умолчанию, то мы увидим следующее (рис.  2-58): 

 
рис.  2-58 

 
рис.  2-59 

Область 1), принадлежащая обеим Copper pour, не досталась никому. 
В заблуждение могут ввести границы Anti-Copper 2). Можно подумать, что они так и 

останутся на плате. Нет, этого не произойдёт, и на рис.  2-59 показан слой TOP, как он будет 
выглядеть на самом деле. 

Ниже показаны различные варианты нашей платы. Меняется лишь значение Z order 
для obstacles, которое указано в кружочках над соответствующей зоной. На рисунках, распо-
ложенных слева – вид в Layout Plus, справа – реальное изображение слоя TOP. 

 
рис.  2-60 

 
рис.  2-61 

 

 
рис.  2-62 

 
рис.  2-63 
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рис.  2-64 

 
рис.  2-65 

 

 
рис.  2-66 

 
рис.  2-67 

2.6. SMD footprint. 
Самый первый footprint должен быть самым лёгким, поэтому начнём с SMD-

компонентов. Возьмём в качестве примера микросхему PCA9555 от Philips Semiconductors. 

Мы видим её на рисунке слева. М/с содержит два двуна-
правленных 8-разрядных регистра, которые программируются 
через последовательный I2C порт. М/с имеет выход прерывания, 
выполненного по схеме с открытым коллектором. Три входа A0-
A2 задают адрес и позволяют соединять до восьми м/с на одной 
I2C-шине. 

Вся эта информация отражена в графическом изображе-
нии м/с. 

У м/с 24 вывода. Выполняется она в нескольких вариан-
тах. Нас интересует вариант TSSOP-24. Среди библиотек Or-
CAD-а TSSOP-ов нет, поэтому я и выбрал этот корпус. 
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Взгляните на чертёж (см. рис.  2-68). 

 
рис.  2-68 

В таблице ниже указаны размеры: 

UNIT A 
max. A1 A2 A3 bp c D(1) E(2) e HE L LP Q v w y Z(1) Ө 

mm 1.10 0.15 
0.05 

0.95 
0.80 0.25 0.30 

0.19 
0.2 
0.1 

7.9 
7.7 

4.5 
4.3 0.65 6.6 

6.2 1.0 0.75 
0.50 

0.4 
0.3 0.2 0.13 0.1 0.5 

0.2 
80 
00 

Notes 
1. Plastic or metal protrusions of 0.15 mm maximum per side are not included. 
2. Plastic interlead of 0.25 mm maximum per side are not included. 

Как правило, указываются номинальные и максимальные величины. Очень важно ус-
воить с самого начала одно правило: такие размеры как расстояния между выводами, коор-
динаты крепёжных деталей и отверстий всегда берутся по номинальному значению. Длина 
выводов, ширина  площадок, размер корпуса компонента, диаметры всевозможных отвер-
стий и пр. – по максимальному. Сейчас это, возможно, не очень понятно, но скоро всё станет 
ясно. 

Итак, нас интересует количество Pad-ов, их координаты и размеры. 

Количество Pad-ов известно – 24. Теперь координаты. 

Очень правильно выбрать начало координат – «Datum». Этим вы сильно упростите се-
бе работу в дальнейшем. Я предлагаю выбрать Datum, как показано на рис.  2-69, т.е. точно 
между первым и последним выводом, посередине корпуса. 

Расстояние между Pad-ами:  e; HE. HE равно 6.6 (максимальное значение). Таким обра-

зом, координаты 1-го Pad-а будут: {e; - EH
2

}, или {0; -3.2}. Можно взять даже {0; -3.3}. 

Размер: ширина равна bp, т.е. 0.30 (максимальное значение). Длина Pad-а будет где-то 
между L и Lp, умноженное на 2. Можно взять значение 1.75. 

Insertion Origin 
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рис.  2-69 

Всё готово! Запустите сессию OrCAD Layout Plus и откройте Library Manager: «Tool → 
Library Manager». В открывшемся окне найдите и нажмите кнопку «Create New Footprint» 
(рис.  2-70). 

 
рис.  2-70 

Далее введите название footprint-а. Например, PCA9555: 

 
рис.  2-71 

В поле «Units» выберите «English». Это значит, что мы будем пользоваться английской 
– дюймовой – системой измерения. Несмотря на то, что у нас все размеры даны в миллимет-
рах, я советую выбрать именно «English». Это позволит избежать в будущем путаницы меж-
ду дюймовыми и метрическими библиотеками. Впрочем, OrCAD допускает совместное ис-
пользование как тех, так и других. 

Datum 
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Нажмите <OK>. Откроется окно Library Manager: 

 
рис.  2-72 

Не обращая внимания на его содержимое, устанавливаем теперь необходимую нам 
систему измерения: «Options → System Settings…» И далее: «Display Units → Millimeters». 

 
рис.  2-73 

Поставьте также для удобства в поле «Grids» значение «Visible grid» равным 1. 

Теперь создаём необходимый нам Pad. Выберите «Padstacks»: 
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рис.  2-74 

Щёлкните правой кнопкой мыши в произвольном месте и выберите «New…» (рис. 
 2-74). 

Задайте имя Pad-а, в поле «Padstack», как это показано на рис.  2-75. 

 
рис.  2-75 

В таблице площадок появится заготовка для нашего Pad-а, в которой все слои будут 
иметь тип «Undefined». 

Поскольку мы создаём SMT-Pad, нас интересуют слои TOP, SMTOP, SPTOP и 
ASYTOP. Я напомню: один – верхний – слой маршрутизации; слой маски; слой покрытия 
паяльной пастой, который используется только для SMT-компонентов; а также монтажный 
слой. Удерживая клавишу <Shift>, выберите мышкой указанные слои и, продолжая удержи-
вать <Shift>, щёлкните правой кнопкой мыши. Откроется окно «Edit Padstack». 

Если в Вашей версии Layout это окно не открылось при удержании клавиши <Shift>, 
Вы можете его вызвать с помощью контекстного меню или используя комбинацию клавиш 
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<Ctrl+E>. 
Задайте параметры Pad-а в указанных слоях, как это показано на рис.  2-76. Форма – 

(Pad Shape) прямоугольник (Rectangle), размер Pad-а – 0.3х1.75 мм. 

 
рис.  2-76 

Вот что должно получиться: 

 
рис.  2-77 

Следующий этап. Необходимо расположить по своим местам все 24 Pad-а. Закройте 
таблицу «Padstacks» и откройте «Footprints». 
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рис.  2-78 

Из таблицы видно, что текущий Footprint имеет только один Pad типа T1. Необходимо 
изменить его тип и координаты. Щёлкните дважды по ячейке с названием Pad-а. 

 
рис.  2-79 

В открывшемся окне измените значение координаты Y на -3.3, а в поле «Padstack 
Name» из раскрывающегося списка выберите только что созданный Padstack TSSOP. 

Закройте все таблицы и посмотрите, что получилось: 

 
рис.  2-80 

Нажмите клавиши <Shift+Home>, если изображение не помещается в рабочей области 
экрана. 
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Обратите внимание, что Pad сместился и изменил форму. 
Прекрасно! Теперь займёмся остальными. Войдите опять в «Footprints», щёлкните 

правой кнопкой мыши и выберите «New…». 

 
рис.  2-81 

Задайте правильные значения координат для вывода #2, проверьте поле «Padstack 
Name» и нажмите «OK». 

Повторите эту процедуру до 12 Pad-а включительно. Обратите внимание, что Layout 
уже сам подставляет правильные значения во все поля для очередного Pad-а. 

Начиная с 13-го Pad-а, не забудьте исправить координату Y на 3.3, а координату X – на 
7.15. Координаты 14-го Pad-а также придётся указать вручную, однако, уже со следующего, 
15-го Pad-а Layout поймёт, что Вы от него хотите, и до последнего, 24-го Pad-а будет про-
ставлять координаты правильно без Вашей помощи. 

Проверьте, что у Вас получилось (рис.  2-82): 

 
рис.  2-82 

Я предлагаю на этом этапе нашу работу сохранить. Нажмите кнопку <Save As…> в по-
ле «Footprints», а в открывшемся окне – <Create New Library…>. 
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рис.  2-83 

Укажите место расположения новой библиотеки Footprint-ов и её имя и нажмите 
<OK>. Ваша библиотека появится в списке подключённых библиотек в окне Library 
Manager. Выбрав её, в поле «Footprints» Вы увидите содержимое данной библиотеки. 

 
рис.  2-84 

Выберите свой компонент – мы с ним ещё не закончили. 

Теперь надо нарисовать в слое Silkscreen корпус микросхемы. Обратимся к Datasheet 
(рис.  2-68). Размеры корпуса: D x E, или: 7.9 х 4.5. Но нас больше интересуют координаты 
каждого из четырёх углов корпуса. Как их вычислить проще всего? 

Выберите «Tool → Dimension → Move Datum». Далее, в окне дизайна Library Manager 
установите курсор на Datum и щёлкните правой кнопкой мыши в этом месте. В открывшемся 
меню выберите «Center Insertion Origin» (рис.  2-85). 
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рис.  2-85 

Datum – начало координат – останется на месте, а Insertion Origin сместится точно в 
центр компонента. 

 
рис.  2-86 

Поскольку наша микросхема имеет прямоугольную – симметричную – форму, нам это 
очень удобно. Зная координаты Insertion Origin – центра симметрии, мы легко вычислим ко-
ординаты угловых точек корпуса. 

Как посмотреть координаты Insertion Origin? Я напомню. Откройте таблицу «Foot-
prints» и дважды щёлкните мышкой по надписи «Insertion Origin». 

Datum Insertion Origin
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рис.  2-87 

Итак, координаты центра микросхемы известны, размер корпуса известен, тогда коор-
динаты углов корпуса посчитаем по формуле: 

[X, Y] = [
2IO
DX ± ,

2IO
EY ± ] 

Где XIO и YIO – координаты центра, D и E – размеры корпуса. 

В итоге: 

[X, Y]1 = [-0.375, -2.25]; 

[X, Y]2 = [-0.375, 2.25]; 

[X, Y]3 = [7.525, 2.25]; 

[X, Y]4 = [7.525, -2.25]. 

Вернитесь в окно дизайна Library Manager и выберите инструмент Obstacle Tool. 

 
рис.  2-88 

В окне дизайна щёлкните правой кнопкой мыши и выберите «New…». Мы начинаем 
рисовать. 

Зададим свойства новой Obstacle. Ещё раз щёлкните правой кнопкой мыши. Вы увиди-
те, что контекстное меню изменилось. Выберите «Properties…» (рис.  2-89). В открывшемся 
окне свойств Obstacle укажите имя (любое), тип (Detail), толщину линии (для линии контура 
компонента – 0.254, т.е. 10 миль), слой (SSTOP). 
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рис.  2-89 

Задав все необходимые свойства, нажимаем <OK>. 

Как рисуют в Layout? Можно мышкой, указывая курсором необходимые точки. Следу-
ет, однако, помнить, что курсор двигается строго по сетке привязки. 

Более точный метод заключается, в указании координат непосредственно в окне ввода. 
Вызвать это окно можно, нажав клавишу <Tab>. 

Проделайте это, и в открывшемся окне введите координаты первой точки, как это по-
казано на рис.  2-90. 

 
рис.  2-90 

Значения вводятся именно так, как показано. Запятая является разделителем парамет-
ров. После запятой пробел можно ставить, а можно – нет. Точка выполняет роль десятичной 
запятой. 

Нажмите <OK>, затем повторите то же самое для следующей точки, следуя часовой 
стрелке. И так далее. 

Чтобы замкнуть Obstacle нажмите клавишу <F>. 
Вот что должно получиться (рис.  2-91). 

Однако, непонятно, где у микросхемы начало. Где первый вывод? Поэтому повторяем 
вышеописанные действия и рисуем ещё одну Obstacle с координатами [0.375; -2.25] и [0.375; 
2.25]. 
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Результат представлен на рис.  2-92. 

 
рис.  2-91 

 
рис.  2-92 

Продолжаем работать с инструментом «Obstacle tool». Всё, что нарисовано в слое Silk-
screen надо перенести в слой для монтажа – ASYTOP. Для этого, используя мышь, выделите 
рамочкой корпус компонента и нажмите правую кнопку мыши. Из меню выберите «Copy». 
Тотчас же рядом с курсором появится ещё один корпус нашей микросхемы (рис.  2-93). 

 
рис.  2-93 

  
рис.  2-94 

Переместите скопированные Obstacles в слой ASYTOP, изменив их свойства. Для этого 
щёлкните правой кнопкой мыши и выберите «Properties…». 

В поле «Obstacle Layer» выберите «ASYTOP». Скопированные Obstacles примут цвет 
указанного слоя (рис.  2-94). 

Точно совместите их с Obstacles слоя SSTOP и щёлкните левой кнопкой мыши. Всё! 
Операция завершена. 

Осталось совсем немного – определить границы компонента. Если помните, нам нужна 
Obstacle типа Place Outline. 

Ну, здесь вычислять ничего не нужно. Начните новую Obstacle, описав её свойства, как 
показано на рис.  2-95. А именно: 

• «Obstacle Type» – Place Outline; 
• «Obstacle Layer» – TOP. 

В поле «Height» (высота компонента) укажите высоту, если необходимо. Значение 
0.0254 соответствует 1 милю, т.е. высота компонента не задана. 

Далее, обведите компонент, как показано на рис.  2-96, пользуясь мышкой. 

Если не получается обвести компонент так, как хотелось бы, значит шаг сетки привяз-
ки слишком велик. Войдите «Options → System Settings…» и уменьшите значение «Detail 
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grid». После этого щёлкните на той стороне Obstacle, которую хотите подвинуть. Нажмите 
клавишу <S> или щёлкните правой кнопкой мыши и из меню выберите «Segment». Пере-
двиньте границу Obstacle так, как нужно. 

 
рис.  2-95 

 
рис.  2-96 

Следующий шаг, который необходимо сделать, это расставить надписи. Можно сде-
лать это как угодно. Я имею в виду, что располагаться они могут в любом месте. Главное, 

Place Outline
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чтобы они были. 
Дело в том, что в будущем, когда мы будем работать над печатной платой, эти надписи 

придётся двигать, поворачивать, изменять размер, поэтому неважно, в каком месте они сей-
час находятся. Сдвиньте их просто в сторонку, чтобы они не мешали изображению компо-
нента. Используйте для этого инструмент «Text Tool». 

 
рис.  2-97 

И, наконец, надо обозначить вывод #1. Напишите рядом с ним единичку. 

Выберите «Text Tool», затем «New…», затем «Properties…». 

 
рис.  2-98 

Укажите параметры: «Type of Text» - Free, и в поле «Text String» впишите единицу. 

 
рис.  2-99 
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В поле «Layer» выберите SSTOP. 
В поле «Line Width» (Толщина линии) и «Text Height» (Высота текста) оставьте те зна-

чения, которые Layout предлагает по умолчанию. 
Нажмите кнопку <OK> и поместите единицу около первого вывода микросхемы. 

Зачем это было нужно? Зачем нужна эта единица, если мы и так уже обозначили пе-
редний край микросхемы? Дело в том, что после монтажа, компонент закроет собой нарисо-
ванный прямоугольник, и определить правильно он установлен или нет будет весьма непро-
сто. 

Скопируйте единицу в монтажный слой и можете записать свою работу. 

Сейчас мы проверим, что всё получилось правильно. Для этого будем выводить на эк-
ран каждый слой по отдельности. Для этого нажмите клавишу <Backspace>, чтобы очистить 
экран. Затем, с помощью селектора слоёв (рис.  1-12) выберите слой, который хотите видеть. 

Итак, слой TOP (рис.  2-100): 

 
рис.  2-100 

Видны контактные площадки – Pad-ы. Также видна линия Place Outline. 

Слой SolderMask (рис.  2-101). Контактные площадки открыты от маски. 

Слой Solder Paste (рис.  2-102). 

Слой Silkscreen (рис.  2-103). 

Монтажный слой (рис.  2-104). 

 
рис.  2-101 

 
рис.  2-102 
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рис.  2-103 

 
рис.  2-104 

Все остальные слои пусты. 

И напоследок ещё пару слов об Insertion Origin. Мы оставили его точно посередине 
микросхемы. Где он должен находиться на самом деле? 

На самом деле, это не так уж и важно. Когда печатная плата первый раз поступает в 
сборочный цех, оператор, который управляет машиной, расставляющей компоненты, выпол-
няет пробную «пристрелку». Это значит, что он смотрит, куда машина помещает компонент 
и затем вручную задаёт необходимое смещение, чтобы компонент точно попал на своё ме-
сто. Эта процедура проводится последовательно со всеми компонентами. 

После того, как первая плата «пристреляна», со всеми остальными платами машина ра-
ботает самостоятельно. 

Таким образом, не играет большой важности, где Вы разместите Insertion Origin – в 
центре компонента, на месте его Datum-а или где-то ещё. Постарайтесь, однако, чтобы он 
хотя бы не выступал за пределы компонента. 

2.7. Крепёжное отверстие. 
Крепёжное отверстие – это всего лишь via большого диаметра. Обычно предусматри-

ваются металлические площадки для шляпки винта с одной стороны платы (рис.  2-105, рис. 
 2-106) и для стойки крепления – с другой. 

 
рис.  2-105 

 
рис.  2-106 

Поэтому диаметр отверстия выбираем немного больше, чем диаметр винта, а размер 
площадок – pad-ов – немного больше диаметра шляпки. 

Ну, например, для винта диаметром 2.75 мм со шляпкой 5.4 мм можно приготовить 
footprint с отверстием 3.2 мм и площадкой 5.5 мм. 

Почему именно так? 
Запомните правило. Для всех thruhole-элементов (винты, выводы компонентов и пр.) 
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отверстия делаем на 15% ~ 20% больше. То есть, для винта диаметром 2.75 – примерно 
3.2мм. 

Площадку можно сделать и больше. Скажем, 6 мм. Это уже зависит от Вашего жела-
ния. 

Откройте Library Manager, создайте footprint с именем BOLT 2.75 и сохраните его в 
библиотеке «PROBA». В результате у Вас должен получиться экран, аналогичный рис.  2-72, 
а именно, такой, как на рис.  2-107. 

 
рис.  2-107 

Установите систему измерения «миллиметры». 
Теперь войдите в «Padstacks» и создайте новый pad с именем BOLT 2.75. 
Следующий этап – описание свойств pad-а в каждом слое. Выделите два слоя: DRILL 

и DRLDWG. После этого вызовите окно «Edit Padstack» и определите следующие поля 
(рис.  2-108): 
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рис.  2-108 
Pad Shape – Round; Pad Width и Pad Height = 3.2. Напомню, что в слое Drill задаётся 

диаметр отверстия, а слой DRLDWG служит для построения таблицы сверлений. 
Аналогичным образом описываются остальные слои. А именно: 

• маршрутизируемые слои TOP, BOTTOM и INNER (все внутренние) – размер и 
форма pad-а: 5.5, Round; 

• слои PLANE: 6, Round (площадка увеличена); 
• слои маски SMTOP, SMBOT: 5.5, Round; 
• монтажные слои ASYTOP и ASYBOT: 5.5, Round. 

В результате имеем Padstack (рис.  2-109): 

 
рис.  2-109 

Теперь необходимо зайти в «Footprints» и изменить тип единственного pad-а, установ-
ленного по умолчанию с T1 на BOLT 2.75. 

Сохраните созданный Footprint, и на этом работу можно считать законченной. 

Подведём итог. На рис.  2-110 показан участок платы с нашим крепёжным отверстием. 

 
рис.  2-110 

 
рис.  2-111 

Цифрами на рисунке обозначены: 
1) – площадка в слое TOP. Она открыта от маски, что описывается в слое SMTOP. 
2) – площадка в слое BOTTOM. Также открыта от маски, что описано в слое SMBOT. 
3) – PLANE layer GND. 
4) – PLANE layer PWR. Эти два слоя служат для разводки «земли» и питания. 

1

2

4

3

5
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5) – столбик металлизации внутри отверстия. Если помните, раньше говорилось, что 
отверстия сверлятся немного большим диаметром. Таким образом, после металлизации пло-
щадки 1) и 2) оказываются соединёнными друг с другом (рис.  2-111), а отверстие будет точ-
но соответствовать требуемому размеру. 

Как вариант, столбик металлизации можно не делать. Для этого в свойствах Padstack 
поставьте флажок «Non-Plated» (рис.  2-112). 

 
рис.  2-112 

Вот что получится (рис.  2-113): 

 
рис.  2-113 

 
рис.  2-114 

Отверстие в этом случае сверлится без запаса, сверлом диаметра, указанного в слоях 
DRLDWG и DRILL!21 

Ещё один вариант показан на рис.  2-114. Возможно, Вам понадобится сделать просто 
отверстие на плате, вообще без каких-либо площадок. В таком случае, размер pad-а в слоях 
TOP, BOTTOM и INNER должен быть равен диаметру отверстия, указанному в слое DRILL и 
DRLDWG (рис.  2-115). PLANE layer описывается как обычно, площадкой увеличенного 
                                                 

21 Данные Padstack, для слоёв DRLDWG и DRILL всегда должны совпадать. В одной из последующих глав мы 
рассмотрим этот вопрос подробнее и разберёмся, что будет, если нарушить это правило. 
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диаметра. 

 
рис.  2-115 

Площадки крепёжных отверстий могут участвовать в электрической разводке и соеди-
няться посредством винтов с корпусом прибора (шасси, массой). Однако для чего определять 
маршрутизируемые слои, если мы не планируем никаких соединений? 

Допустим, что мы не определили pad в PLANE layer. Посмотрите на рис.  2-116. Отвер-
стие, указанное в слое DRILL не является препятствием для медной заливки слоёв PLANE. 
Поэтому эти слои выходят наружу внутрь отверстия, что может стать причиной замыкания. 

 
рис.  2-116 

На рис.  2-116 показано Non-Plated отверстие, т. е. без металлизации, а на рис.  2-117 – с 
металлизацией. В этом случае неизбежно замыкание всех слоёв (рис.  2-118). 
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рис.  2-117 рис.  2-118 
Отверстие, указанное в слое DRILL, но не определённое в слое INNER, TOP и 

BOTTOM также не является препятствием для дорожек и зон медной заливки, расположен-
ных в этих слоях. Поэтому трассировщик может провести дорожку прямо под отверстием. 
Естественно, эта дорожка будет разорвана во время сверления. 

 
рис.  2-119 

На рис.  2-119 изображён один из таких случаев. Два via соединяются дорожкой, на пу-
ти у которой находится отверстие. Padstack такого отверстия показан на рис.  2-120. 

 
рис.  2-120 

Дорожка проложена автотрассировщиком, и даже при повторной проверке командой 
«Design Rule Check» никаких ошибок найдено не будет. 

Даже не спрашивайте меня, откуда я это знаю! 

И ещё один маленький нюанс в этой главе. Рассмотрим более внимательно случай, 
изображённый на рис.  2-114. Если мы создаём footprint отверстия без контактных площадок, 
предназначенного именно для винта, то стоит не забывать о шляпке. Дорожка может быть 
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проложена слишком близко к отверстию, и оказаться под шляпкой. Чтобы не допустить это-
го, необходимо очертить footprint obstacle Route keepout. 

Делается это так. Выберите инструмент «Obstacle Tool» (рис.  2-129). Далее щёлкните 
правой кнопкой мыши в рабочей области экрана и из появившегося меню выберите «New…» 
(рис.  2-130). Можно сразу же определить свойства новой obstacle, как мы уже делали это 
раньше, но можно сделать это и потом. 

Теперь щёлкните левой кнопкой мыши в центре отверстия. Нажмите клавишу <A>, и 
obstacle из отрезка превратится в окружность. Чтобы нарисовать окружность требуемого ра-
диуса, поступим следующим образом: нажмите <TAB> и в открывшемся окне введите 
«0, 2.8». Курсор установится в указанную точку, а следом за ним наша obstacle превратится 
в окружность диаметром 5.6 мм. 

Теперь зададим свойства нашей окружности. Зайдите в «Obstacles». Дважды щёлкните 
по имени единственной существующей в таблице obstacle и в открывшемся окне определите 
её свойства: 

• Obstacle Type – Route keepout; 
• Width – 1 mil (или 0.0254 мм); 
• Obstacle Layer – TOP, если вы хотите ограничить маршрутизацию только под 

шляпкой винта или GLOBAL. В последнем случае ограничение коснётся всех слоёв. 

 
рис.  2-121 

На рис.  2-121 показана Spreadsheet (таблица) Obstacles после произведённых действий. 

Последний штрих. Поскольку мы создаём крепёжное отверстие без контактных площа-
док, нелишне будет нарисовать вокруг него окружность в слое Silkscreen, показывающую 
расположение шляпки винта. 

Скопируйте уже существующую obstacle Route keepout в слой SSTOP, задав ей свойст-
ва: 

• Obstacle Type – Detail; 
• Width – 10 mil (или 0.254 мм); 
• Obstacle Layer – SSTOP. 
То же самое можно проделать для слоя ASYTOP. 

Вот что должно получиться в итоге. 
Spreadsheet Obstacles (рис.  2-122): 

 
рис.  2-122 

Общий вид – рис.  2-123. 
Слой TOP – рис.  2-124. Контактная площадка по размеру совпадает с отверстием. 
Слой ASYTOP – рис.  2-125. 
Два слоя: SSTOP и DRILL – рис.  2-126. 
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рис.  2-123 

 
рис.  2-124 

 
рис.  2-125 

 
рис.  2-126 

2.8. Большой thruhole конденсатор. 
Сейчас мы построим footprint конденсатора, изображённого на рис.  1-16. Это – элек-

тролитический (полярный) конденсатор в цилиндрическом алюминиевом корпусе. На рис. 
 2-127 представлен его чертёж. 

1
2

+ C
180uF x 63V

 

 
рис.  2-127 

Размеры конденсатора находятся в зависимости от его электрических параметров. 
Предположим, что нас интересует конденсатор 180μF x 63V. Тогда, согласно datasheet, его 
размеры (рис.  2-128): 

Pad in PLANE 
layer.

Obstacle Route keepout.

Pad in TOP layer. 

DRILL

Detail layer 
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рис.  2-128 

D (диаметр корпуса) = 5
8

 inch = 625 mil = 15.875 мм; 

L (длина) = 11
8

 inch = 1125 mil = 28.575 мм. 

На рис.  2-127 указано, что диаметр выводов d для D < 0.75" (т.е., для конденсатора в 
корпусе диаметром меньше 0.75 дюймов) составляет 20 AWG. 

Что такое «AWG»? AWG22 – американский сортамент проводов, принятая в США сис-
тема оценки провода на основе диаметра проводника. Чем больше число AWG, тем тоньше 
провод. 

В таблице ниже приведено соответствие числа AWG диаметру провода d, его 
сечению S и максимальному току Imax, который способен выдержать провод. 

AWG d мм S мм2 Imax A 
12 2 3.12 12 
13 1.8 2.53 9.72 
14 1.6 2 7.68 
16 1.3 1.32 5.07 
18 1 0.78 3 
19 0.9 0.63 2.43 
20 0.8 0.5 1.92 
22 0.65 0.33 1.27 
24 0.5 0.2 0.75 
25 0.45 0.16 0.61 
26 0.4 0.12 0.48 
27 0.35 0.1 0.37 
28 0.32 0.08 0.31 
29 0.3 0.07 0.27 
30 0.25 0.05 0.19 
32 0.2 0.03 0.12 
33 0.18 0.03 0.1 
34 0.16 0.02 0.08 
35 0.14 0.02 0.06 
36 0.13 0.01 0.05 
37 0.11 0.01 0.04 
38 0.1 0.01 0.03 

                                                 
22 AWG – American Wire Gauge System. Американская система оценки проводов (стандарты на диаметр про-

водов). 
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Таким образом, для конденсатора в корпусе диаметром D = 0.625" принимаем диаметр 
выводов 20 AWG, что соответствует d = 0.8 мм. 

Теперь у нас есть вся необходимая информация, и можно приступать к составлению 
footprint-а. 

Запустите OrCAD Layout Plus, откройте Library Manager и создайте новый footprint с 
именем «C 180x63». Сохраните его в библиотеке «Proba». Войдите в эту библиотеку и 
щёлкните мышкой по только что появившемуся новому названию. OK! Перед нами старто-
вый экран, похожий на рис.  2-107, с единственным на нём pad-ом типа T1, все параметры – 
по умолчанию, система измерения – мили. 

В этот раз мы начнём не с создания нужного нам нового padstack, а сразу с изображе-
ния компонента в слое Silkscreen и ASYTOP. Я опишу подробно. 

Выберите на панели инструментов Obstacle Tool, как показано на рис.  2-129. 

 
рис.  2-129 

Далее щёлкните правой кнопкой мыши в рабочей области экрана и из появившегося 
меню выберите «New…» (рис.  2-130). Сразу же проделайте эту процедуру вторично и из 
следующего меню выберите «Properties…» (рис.  2-131). Мы начинаем рисовать, и собира-
емся прежде задать свойства новой obstacle. 

 

 
рис.  2-130 

 
рис.  2-131 

Опишите obstacle, как показано на рис.  2-132, а именно: 

 
рис.  2-132 

OrCAD Layout Plus 

 Стр. 75 

• Obstacle Name – Outline (можно указать произвольное имя); 
• Obstacle Type – Detail; 
• Width – 10 mil (для рисования оптимальная ширина линии – 8 или 10 милей); 
• Obstacle Layer – ASYTOP. (Я рекомендую начать рисовать в ASYTOP, потому что 

все элементы, расположенные в этом слое, изображаются зелёным цветом, а в слое SSTOP – 
белым. Однако, белым цветом также изображаются выделенные (подсвеченные, highlight) 
элементы. Поэтому, чтобы не запутаться, удобно всё, что необходимо создать в слое 
ASYTOP, а в слой SSTOP потом просто скопировать.) 

Нажмите <OK>, чтобы закрыть окно свойств, и теперь на клавиатуре – клавишу 
<TAB> для того, чтобы задать координаты первой точки. Мы рисуем прямоугольник. Коор-
динаты вершин прямоугольника (в милях): 

[X, Y]1 = [-562.5, -312.5]; 

[X, Y]2 = [-562.5, 312.5]; 

[X, Y]3 = [562.5, 312.5]; 

[X, Y]4 = [562.5, -312.5]. 

После того, как Вы укажете координаты последней, четвёртой, точки, нажмите клави-
шу <F>, и Layout замкнёт линию. 

Нажмите клавиши <Shift>+<Home>, чтобы изменить масштаб изображения, и посмот-
рите, что получилось (рис.  2-133): 

 
рис.  2-133 

Дорисуем выводы. Две obstacle-линии с координатами: 

[X, Y]1 = [-630, 0]; 
[X, Y]2 = [-562.5, 0]. 

И: 

[X, Y]1 = [562.5, 0]; 
[X, Y]2 = [562.5, 0]. 
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рис.  2-134 

И, наконец, скопируем всё, что получилось в слой SSTOP. О том, как это сделать рас-
сказывалось в главе «SMD footprint.» 

Переходим к созданию pad-ов. 
Ранее мы выяснили, что диаметр выводов равен 0.8 мм. Чтобы не утруждать себя вы-

числениями, связанными с переводом величин из миллиметров в дюймы, предлагаю пере-
ключить систему измерений в миллиметры: 

Options → System Settings… → Display Units → Millimeters 
После этого создаём новый padstack с именем, допустим, 20AWG и параметрами, как 

указано на рис.  2-135. 

 
рис.  2-135 

Меняем систему измерений из «миллиметры» опять в «мили», входим в «Footprints» и 
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определяем количество, тип и координаты pad-ов (рис.  2-136): 

 
рис.  2-136 

В результате имеем картину, аналогичную рис.  2-137. Выводы отступают от корпуса 
примерно на 3.5 мм. 

 
рис.  2-137 

Работа почти закончена. Осталось только обвести наш footprint по контуру obstacle 
Place Outline. Я рекомендую расположить её в слое TOP, чтобы с обратной стороны платы 
можно было размещать SMT-компоненты. Можно также в свойствах obstacle указать высоту 
компонента – 625 милей. 

Не забудьте пометить первый вывод символом «+». 

И ещё. Добавьте два pad-а по бокам. Конденсатор достаточно велик, и, возможно, по-
требуется дополнительно закрепить его на плате при помощи хомутика. 

 
рис.  2-138 

Назовём эти pad-ы M1 и M2. Их координаты: [0, 335] и [0, -335] (рис.  2-138). 
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Свойства obstacle Place Outline показаны на рис.  2-139. 

 
рис.  2-139 

На рис.  2-140 приведён финальный экран законченного footprint-а. 

 
рис.  2-140 

И ещё: 

 
рис.  2-141 

Place Outline 
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2.9. Компоненты с некруглыми выводами. 
LED23 – светодиод. Его рисунок и обозначение на схеме приведено на рис.  2-142. 

 
1 2

D1

LED  

 
рис.  2-142 

Это очень простая деталь. Почему я решил посвятить целую главу описанию footprint-а 
обычного светодиода? 

На самом деле, эта маленькая деталь кроет в себе коварный подвох, который по не-
опытности легко не заметить. 

Итак, как всегда, начинаем с определения pad-ов. Размер вывода на чертеже указан 
0.5 мм. Какой диаметр отверстия нужно задать в таблице padstack? 

Я говорил, что для thruhol-ов необходимо делать увеличение на 20%, иначе вывод не 
втиснется в приготовленное для него отверстие. Значит, 0.5 * 1.2 = 0.6 мм. Правильно? 

Нет. Вот Вы, возможно, и попались! Светодиод не войдёт в приготовленное отверстие. 
Если Вы ещё не поняли почему, обратите внимание на надпись рядом с цифрами «0.5». 
«sq»24 означает, что выводы имеют квадратное сечение. 

 
рис.  2-143 

 
рис.  2-144 

 
рис.  2-145 

На рис.  2-143 изображено то, что получится. Квадрат – это вывод. Окружность обозна-
чает отверстие. Теперь очень хорошо видно, что вывод имеет максимальный размер в своей 
диагонали. А именно: 

2 20.5 0.5 0.71+ ≈  

А мы отверстие сделали только 0.6 мм (рис.  2-144)! 

Правильно будет указать диаметр отверстия равным 0.71*1.2 0.85≈ мм, как показано 
на рис.  2-145. 

На следующем рисунке дано одно из возможных изображений светодиода (рис.  2-146), 
на рис.  2-147 приведена таблица padstack для первого вывода, а на рис.  2-148 – таблица рас-
положения выводов. 

                                                 
23 LED – light-emitting diode. 
24 Sq – square, квадрат. 
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рис.  2-146 

На рисунке цифрами обозначены: 

1) Площадка, слой TOP; 
2) Площадка увеличенного размера в слое PLANE; 
3) Отверстие; 
4) Контур компонента в слое SilkScreen и obstacle Place 

outline. 

 
рис.  2-147 

Для второго вывода создайте padstack LED_2 с такими же параметрами. Единственное 
отличие – Pad Shape во всех слоях укажите «Round». 

 
рис.  2-148 

Ещё один пример. Семисегментный светодиодный индикатор (рис.  2-149). Выводы 
имеют прямоугольную форму. Размер вывода: 0.5 х 0.25 мм. Отверстие какого диаметра мы 
должны предусмотреть? 

Посчитаем: 2 21.2* 0.5 0.25 0.67 0.7мм+ = ≈  

Полученный результат округляем до десятых. С одной стороны, абсолютная точность 
нам не нужна, а с другой – мы должны стремиться к тому, чтобы при производстве платы 
использовалось как можно меньше разных инструментов. Это – более технологично. Плата, 
на которой присутствуют отверстия диаметром 0.67мм, а также 0.71, 0.65мм выглядит менее 
профессионально и требует большее количество разного инструмента, чем плата, со всеми 
отверстиями 0.7мм. 

1 2 

4 

3 
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рис.  2-149 

2.10. PAD-ы с некруглыми отверстиями. 
В этой главе мы разберём очень непростой пример, а именно – создадим footprint пре-

образователя тока фирмы LEM (рис.  2-150). 
Основные отличия этого компонента: 

− сложная форма корпуса; 
− некруглые выводы; 
− высокий протекаемый ток через контакты. 

 
рис.  2-150 

Полное название преобразователя: Current Transducer LAS 100-TP. Применяется он в 
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схемах измерения тока: «Ток → Напряжение», причём значение измеряемой величины на 
выводах IN, OUT может достигать 300А. 

Компонент имеет две группы выводов: 
Primary и Secondary. Группа Primary состоит 
из пары строенных контактов IN и OUT, кото-
рые подключаются в измеряемую цепь. Форма 
контактов – прямоугольная, размер: 1.4 х 1 мм. 

В группе Secondary 4 вывода: Ref, 0, +5 и 
Vout. Измерительное напряжение на выводе 
Vout не превышает 5V (рис.  2-151). Контакты 
также имеют прямоугольную форму. Размеры: 
0.7 x 0.6 мм. 

 
рис.  2-151 

Итак, создаём новый footprint с именем LAS 100-TP и приступаем к описанию pad-ов и 
составлению таблиц Padstack. Начнём, как с более простого, выводов Secondary. 

 
рис.  2-152 

Диаметр отверстия (DRILL, DRLDWG): 2 20.7 0.6 *1.2 1.1мм+ ≈  
Остальные слои – как указано в таблице. 

Через выводы Secondary не протекают большие токи, нет и высоких напряжений, по-
этому, несмотря на прямоугольную форму вывода, отверстие мы делаем круглое. 

По чертежу на рис.  2-150 невозможно определить направление расположения выводов. 
Непонятно, ориентированы они длинной стороной вдоль или поперёк. Зададим поэтому 
форму площадок Square, квадратную. Можно бы и круглую, но у квадратного pad-а площадь 
больше, а значит, и качество пайки будет лучше. 

Если с контактами Secondary всё относительно просто, то с Primary будет гораздо ин-
тереснее. Через Primary течёт очень большой ток, поэтому если мы хотим обеспечить качест-
во монтажа, необходимо сделать для этих выводов pad-ы с прямоугольными отверстиями. 

Как делаются прямоугольные отверстия?25 
Любые некруглые отверстия вырезаются с помощью фрез. Фреза похожа на сверло. 

Отличие состоит в том, что у фрезы основная рабочая поверхность расположена сбоку, а не 
на торце, как у сверла. Если нужно сделать отверстие сложной формы, фреза движется внут-
                                                 

25 Странный вопрос. Прямоугольными свёрлами, разумеется! 
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ри платы по заданному контуру, вырезая необходимую фигуру. 
Поскольку диаметр фрезы не может быть бесконечно малым, нельзя вы́резать идеаль-

ный прямоугольник. Внутренние углы его будут скруглёнными, как на рис.  2-154. 

 
рис.  2-153 

 
рис.  2-154 

 
рис.  2-155 

Здесь: 
1) фреза; 
2) траектория движения фрезы; 
3) отверстие. 

 

Если фреза движется не по замкнутому контуру, а по линии, не важно – прямой или 
изогнутой, прорезая за собой канавку, то такой вырез называется «слот»26. На рис.  2-153 и на 
рис.  2-155 показаны примеры слотов. 

Именно таким способом, с помощью слотов, опишем pad-ы Primary. 

 
рис.  2-156 

Размер вывода 1.4 х 1 мм. Приняв во 
внимание 20-процентный запас, получим, что 
ширина слота равна 1.2 мм. В длину запас 
можно не делать, и тогда слот будет длиннее 
вывода на диаметр фрезы. То есть, слева 
плюс радиус и справа плюс радиус: 
0.6 1.4 0.6 2.6+ + =  (рис.  2-156). 

Здесь: 
1) Вывод; 
2) Отверстие. 

 У нас проблема. Посмотрите на чертёж (рис.  2-150). Расстояние между выводами рав-
но 2.54 мм, а отверстие получилось 2.6 мм! Что делать? 

Давайте создадим новый – экспериментальный – pad с такими параметрами: в слое 
INNER нарисуем прямоугольник, который будет символизировать вывод. В слое BOTTOM 
нарисуем слот (Pad Shape – Oblong), который будет обозначать отверстие. Затем расположим 
                                                 

26 Slot – канавка, вырез, щель. 
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в ряд три pad-а и посмотрим, что получится. 
Таблица Padstack (рис.  2-157): 

 
рис.  2-157 

Таблица Footprints (рис.  2-158): 

 
рис.  2-158 

А вот и результат (рис.  2-159): 

 
рис.  2-159 

На рисунке: 1) – вывод; 2) – отверстие. 

Отверстия накладываются друг на друга.27 
В этой ситуации можно придумать вот что: немного увеличим диаметр фрезы, и тогда 

станет возможным значительно укоротить слот. 

Новые параметры: 

 
рис.  2-160 

В слое INNER будто бы нарисован вывод. В слое BOTTOM – отверстие. В слоях TOP 
и PLANE нарисованы контактные площадки для слоёв TOP и PLANE. 

                                                 
27 Семь раз отмерь – один отрежь. Знаменитая русская поговорка! Интересно, что у роботов тоже бывают по-

говорки, и одна из них звучит примерно так: «Семь раз отмерь – 132 раза отрежь». 

1 2
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И тогда: 

 
рис.  2-161 

Цифрами на рисунке обозначены: 
1) вывод; 
2) отверстие; 
3) контактная площадка слоёв TOP, BOTTOM и INNER; 
4) контактная площадка слоёв PLANE. 

Расстояние между площадками PLANE равно: (2.54-2.35)*39.4≈7.5  mil, что вполне 
приемлемо. 

Зоны надёжного контакта вывода с платой для двух случаев: отверстие в виде слота 
(рис.  2-162) и круглое отверстие (рис.  2-163): 

 
рис.  2-162 

 
рис.  2-163 

Конечная таблица Padstack (рис.  2-164): 

 
рис.  2-164 

В маршрутизируемых слоях (TOP, BOTTOM, PLANE, INNER) и в слоях маски 
(SMTOP, SMBOT) описываем контактные площадки как обычно. В слоях DRLDWG и 

1

2
3

4
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DRILL указываем диаметр фрезы. В слоях ASYTOP и ASYBOT указываем размер слота. 
И последнее. В будущем, в самом дизайне необходимо будет в таблице «Drills», найти 

наше отверстие и в поле «Note» добавить: «Slot = 2.2x1.3 mm» (рис.  2-165): 

 
рис.  2-165 

В таблице DRILL CHART появится такая же надпись (рис.  2-166). 

Если в дизайне имеются круглые отверстия такого же диаметра, чуть-чуть измените их 
размер. Не 1.30, а, скажем, 1.31 мм. Тогда в таблице Drill Chart они будут обозначены другим 
символом, и их нельзя будет спутать со слотом. 

 

 
рис.  2-166 

Тут требуется пояснение. Не надо думать, что чертёж, который мы создаём, будут об-
рабатывать машины. Будто бы наши файлы будут заложены в какие-то компьютеры или ав-
томаты, заработает технологическая линия, и в её конце появится плата. 

К счастью или разочарованию, это не так. Наши файлы, прежде всего, попадут к лю-
дям – инженерам, которые на компьютерах откроют наш дизайн, проверят его на ошибки и, 
уже действительно, подготовят данные для автоматов каждого процесса. 

Поэтому, мы должны позаботиться о том, чтобы наш чертёж был понятен людям. Это и 
хорошо и плохо. Хорошо, потому что мы всегда можем сбоку дизайна просто написать ка-
кое-либо пояснение, и тот, кто будет работать с ним после нас, просто прочитает наши запи-
си. 

Плохо же потому, что если мы напишем недостаточно ясно, то нас могут не понять 
или, что намного хуже, понять неправильно. В первом случае нам, скорее всего, позвонят по 
телефону и попросят уточнений. Во втором – плата будет изготовлена неправильно. 

По этой причине, всегда старайтесь видеть свою работу как бы со стороны, чужими 
глазами. Есть ли в дизайне места, понятные только Вам? Есть ли в дизайне места, которые 
могут вызвать дополнительные вопросы? Есть ли места, которые можно понять двояко? 
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Представьте, что Вам принесли чужую плату и спрашивают, что Вы о ней думаете. 
Быть может, Вам это сейчас не очень ясно, но взгляните на рис.  2-150 и попытайтесь 

догадаться, как расположены выводы Secondary – вдоль или поперёк? Попробуйте также оп-
ределить размеры выступающей части. 

Возвращаясь к описанию pad-ов Primary. Как Вы уже, очевидно, поняли, в Layout нет 
специальных инструментов для фрезерования. Любое некруглое отверстие или вырез оформ-
ляются в виде отдельного чертежа в слое DRLDWG. Это не недостаток Layout, а общеприня-
тая практика. Однако такой метод ведёт к усложнению дизайна, ухудшению его читаемости. 
Вы должны стремиться к тому, чтобы рядом с печатной платой было как можно меньше раз-
личных пояснений, какого-то текста. Таблица Drill Chart – это уже много! 

То, что мы сейчас делаем – приём не вполне стандартный, но он понятно описан, не 
допускает двоякого толкования, не загромождает чертёж, и поэтому я вполне могу рекомен-
довать его к использованию. Как правило, никаких дополнительных вопросов он не вызыва-
ет. 

Опишем таблицу footprints. Обратите внимание, что нам дан вид снизу (Bottom view), 
поэтому рисовать мы должны в зеркальном отражении (рис.  2-167): 

 
рис.  2-167 

Выберем положение начала координат (Datum) в левом верхнем углу. В таком случае 
получаем (значения немного округлены) (рис.  2-168): 

 
рис.  2-168 

Обведём компонент obstacle Place outline. Для этого можно на листке бумаги нарисо-
вать несложный чертёж и проставить координаты вершин (рис.  2-169). После этого останет-
ся только последовательно ввести эти координаты, нажимая клавишу <Tab>. 

Параметры Place outline: Layer – TOP; Height = 21 mm. 

Копируем созданную obstacle в слои ASYTOP и SSTOP с параметрами: 

• Obstacle Type – Detail; 
• Width = 0.254 mm (10 mil). 

При желании, можно нарисовать компонент со скруглёнными углами. Для этого при-
дется вручную редактировать созданные obstacles. Попробуйте сами справиться с этой зада-

Datum
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чей. Большую помощь в этом Вам окажет таблица «горячих клавиш», приведённая ниже. 

 
рис.  2-169 28 

«Горячие клавиши» при работе с obstacles29: 

Клавиша Описание 
Левая кнопка мыши 
(LMB) или Пробел 

Начинает рисование, проводит линию или выбирает сегмент для 
редактирования.  

Колёсико мыши или 
ESC 

Отмена текущего действия 

Правая кнопка мыши 
(RMB) или + на циф-
ровой клавиатуре 

Вызывает контекстное меню 

Ctrl+E Окно свойств obstacle. 
F Замыкает obstacle под прямым углом. 
S В режиме редактирования сдвигает сегмент целиком. Например, 

если Вы хотите отодвинуть одну из сторон прямоугольника. 
A Создаёт дугу из двух смежных сегментов. 
X «Смена углов». В режиме редактирования один из концов сегмента 

закреплён, а второй привязан к указателю мыши. После нажатия на 
клавишу <X>, мышь цепляется к другому концу сегмента. 

Y По умолчанию, obstacles можно рисовать только под углом, крат-
ным 45˚. Клавиша <Y> отменяет этот режим. Восстановить его 
можно, выбрав в меню пункт «135’s and 90’s Only». 

Ctrl+X Удаляет сегмент 
U Отменяет (только одно) предыдущее действие. 
Ctrl+LMB, RMB Указанная комбинация действий вызывает дополнительное контек-

стное меню: 
• Ctrl+C – копирует obstacle целиком; 
• Ctrl+X – удаляет obstacle целиком; 
• R – поворот obstacle. Поворот осуществляется на угол, задан-

ный в меню: System Settings → Rotation → Increment; 
• Ctrl+M, Mirror – отражение obstacle слева-направо; 
• Opposite – перенос obstacle на зеркальный слой. 
• Move On/Off – позволяет перетащить obstacle в другое место. 

 

                                                 
28 Координаты, помеченные символом «*», взяты примерно. Все остальные – с точностью до 0.1 мм. 
29 Многие из указанных комбинаций действительны и в других режимах работы. 

0; 0 33.3; 0 

33.3; -11.9 
25.8*; -11.9 

3*; -11.9 

25.8*; -14.9 3*; -14.9 

0; -11.9 
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Цифры 30 Выбор слоя. 

Если Вы находитесь в режиме редактирования, то выбранная obsta-
cle целиком перейдёт в указанный слой. 
Клавиша Название NickName Цвет 

0 Global Global  
1 TOP TOP  
2 BOTTOM BOT  
3 PLANE PLANE  
4 INNER INNER  
5 SMT  
6 

Solder Mask 
SMB  

7 SPT  
8 

Solder Paste 
SPB  

9 SST  
Ctrl+0 

Silk Screen 
SSB  

Ctrl+1 AST  
Ctrl+2 

Assembly 
ASB  

Ctrl+3 Drills Drawing DRD  
Ctrl+4 Drill DRL  
Ctrl+5 Comment Comment  
Ctrl+6 Spare 2 SP2  
Ctrl+7 Spare 3 SP3   

Обратите внимание, что приведённые в таблице цвета не совпадают с теми, которые 
Вы видите в Layout Library Manager по умолчанию. О таблице цветов разговор будет в сле-
дующей главе. 

Дополнительные клавиши. 

Клавиша Описание 
I Увеличение масштаба. 
O Уменьшение масштаба. 
Shift+Home Показать footprint целиком. 
Z Масштабирование по выделению. 
C Переместить изображение. 
. (десятичная точка на 
цифровой клавиатуре) 

Режим высокой контрастности. Цветом выделяется только актив-
ный элемент. 

– (минус на цифровой 
клавиатуре) 

Активный слой виден/не виден. 

Backspace Очистить экран. 
Home Обновить экран. 
+ на основной клавиа-
туре 

Полноэкранный курсор. 

                                                 
30 Приведённая нумерация слоёв справедлива только для Library Manager. В режиме дизайна и количество 

слоев, и их состав (LayerStack), и, соответственно, нумерация отличаются. 
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В итоге мы должны получить следующее:  

 
рис.  2-170 

– общий вид (3D-view). 

 
рис.  2-171 

– слой TOP. Видна obsta-
cle Place outline. 

 
рис.  2-172 

– SST. 

 
рис.  2-173 

– ASYTOP. 
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рис.  2-174 

– слои SST, ASYTOP, 
DRL. 

И в завершение главы, уточним ещё раз правила описания слотов способом создания 
особого pad-а. Таблицы Padstack для случаев Plated и Non-plated: 

Pad Shape Pad Size Layer 
Plated Non-Plated Plated Non-Plated 

TOP, 
BOTTOM, 

INNER 
Любой Oblong Размер контакт-

ной площадки. Размер слота 

PLANE Любой Oblong 
Увеличенный 
размер контакт-
ной площадки. 

Увеличенный 
размер слота 

SMTOP, 
SMBOT 

Такой же, как 
в TOP и в 
BOTTOM 

— Такой же, как в 
TOP и в BOTTOM — 

ASYTOP, 
ASYBOT Oblong Размер слота 

DRLDWG, 
DRILL Round Диаметр фрезы, равный ширине 

слота 

Остальные слои не описываются. 

2.11. Цветовая таблица. 
До сих пор мы обходились стандартным набором цветов, которые Layout присваивает 

слоям по умолчанию. Однако в предыдущей главе мы научились использовать слои и табли-
цу Padstack не по назначению. Не совсем по назначению. А именно – для проверки наших 
расчётов и для правильного подбора размеров pad-а. Теперь, когда мы уже вполне свободно 
оперируем такими понятиями как layer и obstacle, самое время разобраться с таблицей цве-
тов. 

Каждый слой имеет свой цвет. Это значит, что по умолчанию любые элементы дизай-
на, которые расположены в одном слое, будут одинакового цвета. Например, слой ASYTOP – 
зелёного цвета. Obstacles, размещённые в этом слое будут нарисованы зелёным. Надписи 
слоя ASYTOP также будут зелёные. 

Слой SSTOP – белый, а значит, что и надписи и obstacles, созданные или перенесённые 
в этот слой тоже станут белыми. 

На стр. 75 я уже говорил, что контур детали лучше всего рисовать сначала в слое 
ASYTOP, а потом копировать в SSTOP. Дело в том, что белый – цвет выделения. Когда Вы 
указываете курсором на какой-либо элемент, он становится белым. По ошибке можно поду-
мать, что этот элемент расположен в слое SSTOP. 

Из сказанного становится ясно, что помимо слоёв, цвет может быть определён и дру-
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гим объектам или даже действиям. Например, выделению. 

Войдите в Library Manager, откройте footprint какого-либо компонента и вызовите на 
экран таблицу цветов. Для этого можно воспользоваться кнопкой на панели инструментов 
(рис.  2-175) или основным меню: «Options → Colors…» 

 
рис.  2-175 

На рис.  2-176 показан возможный вариант цветовой таблицы. Рассмотрим её. 
Первой строкой стоит цвет фона (Background) – чёрный. Затем перечисляются слои от 

Global до DRLDWG. Слово «Default», стоящее перед названием каждого слоя означает, что, 
если не определено иначе, то любой элемент, расположенный в этом слое, примет указанный 
цвет. 

 
рис.  2-176 

 
рис.  2-177 

Например (1), контактные площадки, расположенные в слое TOP, будут нарисованы 
голубым. Obstacle Free track, расположенная в TOP также будет нарисована голубым. Одна-
ко, obstacle Place outline будет тёмно-голубого цвета, потому что для её отображения опреде-
лено особое правило (2). 

Напротив, все названия выводов в любом слое будут отображаться белым, как указано 
в строке «Pin name» (3). 

Выделение (Highlight) также показывается белым (4). 

Создадим собственное правило. Пусть контактные площадки в любом слое отобража-
ются синим цветом. Вызовите цветовую таблицу, щёлкните на ней правой кнопкой мыши и 
из появившегося меню выберите «New…» (рис.  2-178). 

 
рис.  2-178 

В открывшемся окне установите флажок около «Padstack» (рис.  2-179). 

1 

2 

3 

4 
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рис.  2-179 

В поле «Layer» стоит прочерк. Это значит, что правило будет справедливо в любом 
слое. Если нужно определить, конкретный слой, выберите его название из раскрывающегося 
списка. 

Нажав <OK>, мы увидим, что таблица «Color» изменилась – в ней появилась новая 
строка: «Padstack (Any layer)» (рис.  2-180). 

 
рис.  2-180 

Чтобы изменить цвет, выделите её, а затем щёлкните по выделенному правой кнопкой 
мыши. Появится новое меню с дополнительными командами и набором цветов. Выберите 
нужный цвет (рис.  2-181). 

Впрочем, выбор не ограничен только шестнадцатью предлагаемыми цветами. Если вы-
брать «Properties…», то откроется дополнительная палитра (рис.  2-182). 
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рис.  2-181 

 
рис.  2-182 

Проверьте, что получилось, и после этого удалите правило. Для этого выделите строку 
«Padstack (Any layer)», щёлкните по ней правой кнопкой мыши и выберите пункт «Delete». 

В таблице цветов, предлагаемой по умолчанию, не всё удобно. Например, не очень 
удачно обозначен зелёным слой INNER. Зелёного и так уже много: SMTOP и ASYTOP также 
зелёного цвета. 

Не нужны правила для DRC box и Matrix. Зато отсутствует слой DRILL, и из-за этого 
нет возможности видеть реальный размер отверстий.31 

Создайте правило для слоя DRILL. Вызовите окно «Add Color Rule» как описывалось 
выше или через меню «Options → Colors Rules…». 

 
рис.  2-183 

В списке «Layer» выберите «Drill», а в поле «Rule» – «Default» (рис.  2-183). После 
этого войдите в таблицу «Color» и определите для нового правила цвет. 

Попытайтесь самостоятельно привести таблицу цветов, предлагаемую по умолчанию 
(рис.  2-176) к виду, показанному на рис.  2-177. 

И последнее действие: сохраните полученную настройку цветовых правил. Для этого, 
                                                 

31 Не исключено, что в той версии OrCAD Layout Plus, которой пользуетесь Вы, раскладка цветов иная. 
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находясь в таблице цветов, щёлкните правой кнопкой мыши и выберите из меню «Save color 
setup…». Создайте у себя на диске директорию с именем «Libraries», а в ней – «Colors». На-
зовите файл «Library.col» и сохраните его в только что созданной папке. Впоследствии мы 
будем её постепенно пополнять. 

2.12. Площадки нестандартной формы. 

 
рис.  2-184 

Немного отдохнём от thruhol-ов чтобы узнать, что не-
обычного может быть в создании footprint-ов SMD-
компонентов. 

В этой главе у нас в гостях – Silicon N-Channel MOSFET 
2SK1764 – полевой транзистор фирмы Hitachi32. Его изобра-
жение слева, на рис.  2-184. 

Типичное применение этого транзистора – быстродей-
ствующий коммутатор33 (≈1MHz). 

На рис.  2-185 представлен его чертёж. Обратите внимание на вывод 2. Это – сток.34 
Протекающий через открытый транзистор ток может достигать 2А. Пиковое значение – 4А. 

 
рис.  2-185 

Для того, чтобы улучшить теплоотвод, вывод сделали особой формы. 
Компонент очень маленький и не требует специального радиатора, поскольку радиато-

ром служит сама плата. Наша задача – обеспечить наилучший контакт транзистора с платой. 
Мы должны сделать pad такой же необычной формы, как и вывод. 

Корпус, в котором выполнен компонент, называется UPAK. 

Следует сказать, что стандартные footprint-ы, как правило, имеют название. Например, 
TO220 или SOT23. Для простых SMD-компонентов (резисторов, конденсаторов) распростра-
нены названия, отражающие размер footprint-а: 0603, 0805, 1210, 1808 и т.д. К примеру, мар-
                                                 

32 MOS – metal-oxide-semiconductor. Структура металл-оксид-полупроводник (МОП). FET – field-effect tran-
sistor. Канальный (полевой) транзистор. 

33 Application: Low frequency amplifier, High speed switcher. 
34 Drain – сток, Gate – затвор, Source – исток. 
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кировка 0805 означает 80 mil – расстояние между центрами pad-ов, 50 mil – ширина площад-
ки.35 

Некоторые footprint-ы могут называться по-разному: MiniMELF и SOD-80, например. 
В то же время, легко ошибиться в выборе footprint-а, когда речь идёт о конденсаторах. 
CASE-B для танталового конденсатора очень отличается от CASE-B для алюминиевого. 

Другие названия корпуса UPAK: SOT89, SC62, MPT3, TO243AA. 

Создание footprint-а начнём с того, что рассмотрим чертёж компонента и приведём его 
к виду, нам более понятному. 

 
рис.  2-186 

1 – Datum. Установим начало координат. Пусть это будет центр среднего вывода. 

2 – выводы. Размер среднего вывода согласно чертежу – 0.53 х 1.75. Определим для не-
го pad немного больше, а именно – 0.6 х 2.00. Размер боковых выводов равен 0.48 х 1.55. Я 
предлагаю для них использовать тот же padstack, что и для центрального вывода. 

Таблица Padstack: 

 
рис.  2-187 

Подровняем pad-ы по верхнему краю. Длина центрального вывода (а мы опираемся 
именно на него) равна 1.75 мм, длина pad-а – 2 мм. Таким образом, если сдвинуть pad на 

                                                 
35 Примерные величины. Многие фирмы устанавливают внутренние рекомендации, исходя из требований к 

своей продукции. 

Datum 

0.75; 3.375

2.25; 2.975

2.25; 0.475

-0.125; 1.5

Y=0.875 

Y=0.475 
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0.125 мм вниз, то запас для пайки составит 0.25 мм. 
Таблица Footprints: 

 
рис.  2-188 

3 – медная зона. Сейчас у нас готовы три прямоугольных pad-а. Но средний вывод 
имеет вовсе не прямоугольную форму! 

Чтобы создать площадку особой формы, просто нарисуем её. Установите параметр De-
tail grid равным 0.1 мм. После этого начните рисовать новую obstacle с параметрами: 

• Obstacle Type – Copper area; 
• Width – 0.0254 mm (1 mil); 
• Obstacle Layer – TOP; 
• Do Not Fill Beyond Obstacle Edge36 – Unchecked (флажок НЕ установлен) (рис. 

 2-189). 

Последний параметр нам встречается впервые и требует пояснения. 

 
рис.  2-189 

Флажок «Do Not Fill Beyond Obstacle Edge» доступен только для obstacles, которые 
допускают заливку – Copper Area и Copper Pour. Очерченная фигура в этом случае складыва-
ется из двух составляющих: собственно obstacle, которая образует границу (Edge) фигуры и 
заливки. 

Так как obstacle имеет толщину, то очерченная фигура получается несколько больше. 
Например, если мы рисуем прямоугольник, то его ширина и высота будут больше задуман-
                                                 

36 Не обводить периметр. 
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ной ровно на толщину obstacle. 
На рис.  2-191 показана прямоугольная зона Copper Area. Для наглядности граница зо-

ны и область заливки нарисованы разными цветами. 
Если непременно нужно, чтобы очерченная фигура имела заданные размеры, то можно 

установить флажок «Do Not Fill Beyond Obstacle Edge», и тогда граница исчезнет. 

 
рис.  2-190 

 
рис.  2-191 

 
рис.  2-192 

Не стоит, однако, этого делать в том случае, когда мы создаём pad-ы для footprint-ов. В 
дизайн из библиотеки такие obstacles не передаются.37 Вместо этого указывайте ширину ob-
stacle равной 1 mil. 

Итак, рисуем площадку. Начните у правого верхнего края центрального вывода и по-
тяните курсор вправо-вверх. Продолжайте, пока координата курсора X не станет равна 0.8. 
Напомню, что координаты курсора можно увидеть в окне, расположенном под панелью ин-
струментов (рис.  2-3) или в строке состояния в нижней части экрана. 

 
рис.  2-193 

Щёлкните левой кнопкой мыши и продолжайте рисовать 
вверх до координат [0.8; 3.4], затем влево [-0.8, 3.4] и так да-
лее. 

Можете нарисовать с запасом. Например, использовать 
координаты [0.9, 3.6]. Однако, чересчур увлекаться не стоит, 
иначе footprint получится слишком большой, а это может в бу-
дущем помешать расстановке компонентов. 

На рис.  2-193 показано, что у Вас должно получиться. 

Теперь войдите в свойства только что созданной obstacle и нажмите кнопку «Pin At-
tachment» (рис.  2-194). В поле «Pin name» поставьте двойку. Теперь obstacle является ча-
стью pad-а, в чём можно легко убедиться. 

 
рис.  2-194 

Закройте окно свойств, выберите инструмент «Pin Tool», щёлкните и потяните в сто-
рону второй pad. Вы увидите, что obstacle перемещается вместе с pad-ом. Прекрасно! Если 
так всё и происходит, значит, Вы всё делаете правильно. 

                                                 
37 О причинах такого явления можно лишь гадать, тем более, что проблема описана на сайте 

www.orcadpcb.com 

ЗаливкаГраница 
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Однако, это ещё не конец. Вспомните, что SMT-pad располагается в четырёх слоях. 
Значит, созданная нами obstacle тоже должна располагаться в этих же слоях. Выделим её и 
скопируем: 

− в слой SMTOP, чтобы она не оказалась закрашена маской; 
− в слой SPTOP, чтобы при монтаже на неё нанесли паяльную пасту; 
− в слой ASYTOP, чтобы было красиво. 

4 – контур компонента. С электрической частью закончено. Теперь нарисуем контур 
компонента для слоёв ASYTOP и SSTOP. 

 
рис.  2-195 

 
рис.  2-196 

Это очень просто! Смотрите на рис.  2-186 и рисуйте по ко-
ординатам: 

[±2.30; 3.00] и [±2.30; 0.50]. 

Мы округляем до одного знака после запятой. 

Параметры для obstacle: 
• Obstacle Type – Detail; 
• Width – 0.254 mm (10 mil); 
• Obstacle Layer – ASYTOP. 

На рис.  2-195 показан слой ASYTOP. 

В слое SSTOP рисуем не прямоугольник, а два уголка, как 
на рис.  2-196. Почему так? 

Дело в том, что если нарисовать прямоугольник, как в слое 
ASYTOP, то краска будет нанесена поверх pad-ов. По крайней ме-
ре, так следует из нашего чертежа. Конечно, инженер, который по-
лучит на доработку Ваш чертёж, исправит это, и всё будет как на-
до. Я скажу даже больше. Программа Gerber Tool38, предназначен-
ная для окончательной доводки дизайна и подготовки его к произ-
водству, имеет специальную утилиту, убирающую краску с pad-
ов39. 

Таким образом, если нарисовать прямоугольник в слое Silkscreen, это даже не будет 
считаться ошибкой. Однако нехорошо заставлять кого-то работать за себя. То, что прощают 
любителям, не к лицу профессионалам. 

Хотя, повторяю, ошибкой это не является, исправляется очень легко, и поэтому, если 
форма детали слишком сложна или Вы не имеете много времени, такими мелочами можно 
пренебречь, как мы это уже делали на рис.  2-146. 

5 – граница. Теперь определим границу footprint-а. Начните новую obstacle с парамет-
рами: 

• Obstacle Type – Place outline; 
• Width – 0.0254 mm (1 mil); 
• Obstacle Layer – TOP. 

Никакой точности на данном этапе не требуется, и расчётов производить не нужно. 
Просто обведите footprint, как показано на рис.  2-197. 

6 – надписи. Последнее, что необходимо сделать, это расставить текст вокруг готового 
footprint-а. 

Как уже говорилось ранее, надписи расставляются в произвольном порядке. Назначе-
ние надписей понятно из их названия, однако, эту тему мы пока не рассматриваем. 

                                                 
38 Входит в пакет OrCAD. 
39 См. стр. 363. 
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Общий вид footprint-а UPAK показан на рис.  2-197. 

 
рис.  2-197 

Ниже, как обычно, показаны все слои по отдельности: 
• рис.  2-198 – ASYTOP; 
• рис.  2-199 – SSTOP; 
• рис.  2-200 – TOP; 
• рис.  2-201 – SMTOP; 
• рис.  2-202 – SPTOP. 

 
 рис.  2-198 

 
рис.  2-199 

 
рис.  2-200 

 
рис.  2-201 

 
рис.  2-202 

Footprint готов. Вы можете сравнить его с тем, что имеется в библиотеке OrCAD 

Place Outline 

Place Outline 
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Layout. Имя библиотеки – TO, имя footprint-а – TO243AA/SOT89. 

 
рис.  2-203 

2.13. Компонент с замкнутыми выводами. 
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рис.  2-204 

Ещё один пример, похожий на рассмот-
ренный только что. Dual N-Channel 60V (D-S) 
MOSFET Si7948DP от фирмы Vishay Siliconix. 
Два мощных полевых транзистора в одном кор-
пусе (рис.  2-204). 

Сразу бросается в глаза, что выводы 
DRAIN сдвоены. 

Компонент производится в корпусе PowerPAK SO-8. 

Слева, на рис.  2-205 показаны два вида кор-
пусов PowerPAK: Dual Pad и Single Pad. 

 
рис.  2-206 

 

 
рис.  2-207 

 
рис.  2-205 

Вверху приведены для сравнения корпуса 
PowerPAK SO-8 (рис.  2-207) и обычный SO-8 
(SOIC-8) с планарными выводами (рис.  2-206). 

Так же, как и 2SK1764, Si7948DP предназначен для коммутации значительного тока 
(≈3А). Долговременная рассеиваемая мощность на каждом транзисторе – 1.4W. Поэтому для 
отвода тепла используют pad-ы особой формы. 

На рис.  2-208 даны размеры компонента и нумерация выводов40. 

                                                 
40 Со времён ламповой электроники сохранился термин «цоколёвка». 
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рис.  2-208 

 
рис.  2-209 

На рис.  2-209 указаны размеры pad-ов. 

 
рис.  2-210 

А на рис.  2-209 приведён уже готовый footprint. 

Obstacles электрически подключены к выводам 6 и 7. Поскольку каждую obstacle мож-
но связать только с одним выводом, то между pad-ами 5-6 и 7-8 получается короткое замы-
кание. Очевидно, Layout Plus должен сообщить об ошибке. 

Так и происходит, если попытаться разместить footprint на плате (рис.  2-212). 

 
рис.  2-211 

После проверки DRC41 над выводами 5 и 8 будут нарисованы маркеры ошибок. Описа-
ние маркеров содержится в таблице «Error Markers» (рис.  2-211). 
                                                 

41 Design Rule Check – утилита проверки дизайна. О её работе мы поговорим немного позже. 
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рис.  2-212 

Совсем по-другому выглядит картина, если выводы DRAIN соединены на схеме (рис. 
 2-213): 
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рис.  2-213 

Ошибок нет. 

 
рис.  2-214 

В завершение главы – пару слов о созданном footprint-е. Почему бы pad-ы 5 и 8 не соз-
давать вовсе, а нарисовать их с помощью тех же obstacles Copper Area, немного их услож-
нив? В этом случае не было бы никаких ошибок! 

Верно. Но во-первых, такой footprint не пропустит утилита AutoECO, которая передаёт 
информацию из OrCAD Capture в Layout Plus, а во-вторых, к «ненастоящим» выводам невоз-

Verify Board Design: 
2 errors found. 

Verify Board Design: 
No errors found. 

Соединение 

Соединение 

Маркер 
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можно подвести дорожки. 

И ещё одно замечание. Я рекомендую созданные obstacles Copper Area скопировать в 
слой TOP и изменить на Via Keepout. В этом случае Вы избежите возможной ситуации, изо-
бражённой на рис.  2-215. 

 
рис.  2-215 

Дорожка начинается от вывода 5 и переходит на противоположную сторону платы че-
рез via, расположенного точно в Copper Area. 

2.14. Компонент со свободными выводами. 
В этой главе мы забежим немного вперёд и разберём интересный случай, когда выво-

ды компонента находятся за пределами его footprint-а. 

 
рис.  2-216 
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TRANSFORMER FLAT COMPACT 
рис.  2-217 

Примером такого компонента может служить, например, трансформатор, у которого 
вывод одной из обмоток выходит сверху корпуса (рис.  2-216). Вполне вероятно, что этот вы-
вод удобно завести в плату на некотором отдалении, и между ним и трансформатором будут 
размещены другие компоненты. 

Отверстие 

Via 

Track TOP 

Track BOTTOM 
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рис.  2-218 

Принципиальная схема показана на рис.  2-217. Вы-
воды 1 6÷  находятся под корпусом трансформатора, а 
вывод #7 выходит отдельным проводом. 

Нарисуем footprint, причём все выводы располагаем 
в пределах footprint-а (рис.  2-218), в том числе и вы-
вод #7, который можно поместить в любое свободное ме-
сто. 

Ничего необычного на этом этапе нет. Сохраняем 
footprint и закрываем Library Manager. 

Разместим компонент на плате (рис.  2-221), после чего зайдём: «Options → User Pref-
erences…» и установим флаг в поле «Allow Editing of Footprint», как показано на рис.  2-219. 

 
рис.  2-219 

После этого используем инструмент «Pin Tool» (рис.  2-220). 

 
рис.  2-220 

Щёлкаем мышкой на выводе #7 и перемещаем его в то место на плате, которое требу-
ется (рис.  2-222). 

 
рис.  2-221 

 
рис.  2-222 



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 106 

2.15. Использование Pad-генератора. 
Для построения footprint-ов с большим количеством выводов удобно пользоваться спе-

циальной утилитой, которая называется Pad Array Generator. 

В этой главе мы построим footprint TQFP4442. Чертёж корпуса показан на рис.  2-223. В 
таблице ниже приведены размеры в миллиметрах. 

 
рис.  2-223 

 
рис.  2-224 

     
 A B C D E  
 10 12 0.45 0.8 0.75  

Начнём с подготовки pad-ов. И поступим очень хитро! Войдите в Library Manager и от-
кройте любой footprint из любой библиотеки. Теперь создайте новый pad прямоугольной 
формы с размерами 0.5 х 1.6 мм. Назовите его, к примеру, TQFP-44. 

Теперь, не выходя из таблицы Padstack, выделите свой pad и щёлкните на его имени 
правой кнопкой мыши. В открывшемся меню выберите «Save to Library…» (рис.  2-225): 

 
рис.  2-225 

Создайте библиотеку «PADs.LLB» в желаемом месте и сохраните в ней только что 
созданный pad (рис.  2-226). 

 
рис.  2-226 

                                                 
42 TQFP – Thin Quad Flat Pack. Тонкий плоский SMT-корпус с квадратным расположением выводов. Цифра 

44 означает количество выводов компонента. 
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Только теперь, подготовив в библиотеке контактную площадку нужного размера, на-
чинаем создание footprint-а. И начинаем с нажатия кнопки «Create New Footprint…». 

 
рис.  2-227 

В открывшемся окне укажите имя footprint-а, выберите систему измерений (поскольку 
у нас все размеры даны в миллиметрах, то – метрическую), установите флажок «Use Pad Ar-
ray Generator» и нажмите <OK>. 

Вот, примерно, то, что Вы должны увидеть: 

 
рис.  2-228 

 
рис.  2-230 

 
рис.  2-229 

На рис.  2-229 показано основное окно Pad Generator-а. Нажмите кнопку <Style 
Sample> и разместите рабочие окна на экране в том же порядке, как они расположены на 
этой странице (рис.  2-228, рис.  2-229, рис.  2-230). 

По названиям окон нетрудно догадаться об их назначении. В окне «Style Sample» вы-
водится образец создаваемого footprint-а, а также имена подставляемых переменных, таких 
как расстояние между выводами и пр.. В главном окне мы выбираем тип (style) footprint-а и 
задаём необходимые параметры построения. В окне «Preview» тут же отображается резуль-
тат. 

Pad Generator спасает от рутинной работы по расстановке множества контактных пло-
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щадок для компонентов, имеющих десятки выводов – большие интегральные микросхемы, 
коннекторы, ламели (ножевые разъёмы непосредственно на плате). Если же площадки созда-
ваемого footprint-а располагаются по окружности, то Pad Generator просто незаменим, пото-
му что иначе бы пришлось высчитывать координаты каждого pad-а вручную. Такая работа 
очень утомляет. К тому же она требует значительного времени, а из-за высокой вероятности 
совершить ошибку, обязательно потом приходится проверять всё заново. 

У нас, однако, задача относительно простая – 44 прямоугольных pad-а, расположенных 
по квадрату. Выбираем вверху окна стиль «QFP/Chip Carrier» (рис.  2-229). 

Теперь подставим вместо контактной площадки, предлагаемой по умолчанию, недавно 
созданный нами pad. Нажмите кнопку <Select…> около стоки «Default Padstack». 

 
рис.  2-231 

В открывшемся окне (рис.  2-231) найдите и выберите недавно созданный нами padstack 
TQFP-44. Обратите также внимание, что в списке библиотек «Padstack Libraries» присутст-
вует новая библиотека PADs. 

Именно здесь можно подключать и отключать библиотеки padstacks. Подключённые 
библиотеки будут появляться также и в окне «Edit Pad» (см. рис.  2-79 на стр. 55). 

 
рис.  2-232 

Нажимаем <OK> и видим, что окно «Preview» странно 
изменилось (рис.  2-232): 

Дело в том, что количество контактных площадок рас-
считывается по формуле, которая видна в правом верхнем уг-
лу окна «Style Sample» (рис.  2-228), и, так как p=q=1, то со-
ставляет 4. 

Параметры x и y определяют расстояние между пло-
щадками. В данный момент x=y=0, так что в окне «Preview» 
мы видим четыре pad-а, один на другом. 

Введём требуемые данные. 
Переменные p и q соответствуют количеству выводов по горизонтали и вертикали. Для 

корпуса TQFP44 они будут равны 11. 
Расстояние между выводами x и y (см. рис.  2-223) равно 0.8 мм. 

После того, как нужные значения будут введены, переменная n в окне «Style Sample» 
покажет число 44, соответственно общему количеству выводов (рис.  2-233). 

Окно «Array Preview» также изменится (рис.  2-234): 
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рис.  2-233 

 
рис.  2-234 

Необходимо знать значение переменных z и w, которые определяют расстояние между 
рядами. На рис.  2-224 им соответствует расстояние f, которое необходимо рассчитать, исхо-
дя из тех данных, что присутствуют на рис.  2-223. 

Не желая загромождать страницу вычислениями, скажу, что f = 1.625 мм. Примем его 
равным 1.7 мм, исходя из того, что длина вывода E, которая будет припаяна, составляет 
0.75 мм, а длина pad-а – 1.6 мм. Таким образом, pad будет немного сдвинут вперёд, выступая 
большей частью из-под микросхемы. Со внешней стороны площадка будет выступать на 
0.5 мм, а со внутренней – на 0.35 мм. 

Должно получиться так, как нарисова-
но на рис.  2-236. При этом окно «Preview» 
будет выглядеть, как на рис.  2-235. 

Начало координат – Datum – совпадает 
с координатами первого вывода. Insertion 
Origin расположен в центре компонента. 

 

рис.  2-235  

рис.  2-236 

Остальные параметры описывать нет нужды. Они очевидны, и Вы легко с ними разбе-
рётесь самостоятельно. 

А нам осталось только сохранить готовый… Нет, ещё не готовый footprint, а только за-
готовку для него! 

Поскольку мы работали, используя метрическую систему мер, а библиотека 
Proba.LLB – дюймовая, то Layout Plus перед сохранением преобразует все данные из милли-
метров в мили (рис.  2-237). 

Datum

Insertion 
Origin 
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рис.  2-237 

Вот как на данном этапе выглядит наш footprint (рис.  2-238): 

 
рис.  2-238 

 
рис.  2-239 

На рис.  2-239 показано, как он должен выглядеть после окончания работы. Необходи-
мо нарисовать контур компонента, указать первый вывод а, желательно, и все угловые. Кро-
ме того, нужно не забыть про obstacle Place Outline и расставить надписи. 

Я советую потрудиться ещё немного и заменить все pad-ы, кроме тех, чьи номера крат-
ны пяти с прямоугольных на продолговатые (Oblong). Теперь, если понадобится найти, ска-
жем, 17-й вывод, сделать это будет намного проще и удобнее! 

Ну вот! Поздравляю! Вполне профессиональная работа! Я и сам не сделал бы лучше! 

2.16. Зоны отвода тепла: создание footprint-а. 
В главах  2.12 и  2.13 мы встретились с компонентами, которые выделяют значительное 

количество тепла во время своей работы. Радиатором для таких компонентов служат кон-
тактные площадки особой формы и увеличенной площади. 

В ряде случаев, однако, таких мер может оказаться недостаточно. Установка дополни-
тельного радиатора может, конечно, решить проблему охлаждения, но не стоит торопиться. 
Оказывается, иногда хороший радиатор можно сделать из самой платы. 

Делается это следующим образом. В том месте, где в будущем понадобится охлажде-
ние, создаются зоны медной заливки расположенные одна под другой во всех слоях. После 
этого указанное место прошивается дырочками, или, проще говоря, vias с металлизацией 
внутри. Получается прекрасный радиатор! Причём, в зависимости от требований к конструк-
ции, он может быть открыт от маски (слои Solder Mask) или находиться под маской. 
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рис.  2-240 

На рис.  2-240 показан пример платы с компонентом, окружённым сеткой vias. 

 
рис.  2-241 

 
рис.  2-242 

На рис.  2-241 тот же компонент с другой стороны, а на рис.  2-242 показана зона рас-
сеивания тепла со стороны слоя BOTTOM. 

В этой главе мы рассмотрим, как создаётся такой «радиатор», а заодно увидим, как 
можно использовать Pad Generator для этой цели. 

 
рис.  2-243 

Итак, имеем участок платы, с выделенным местом 
5х15 мм, которое надо превратить в зону-радиатор. 

Очертим его obstacle Detail, расположив её в слое 
ASYTOP. Рядом с зоной находится via, имеющее соеди-
нение с «землёй», и весь наш радиатор, согласно усло-
виям разработки, должен «сидеть на земле». Согласно 
тем же условиям, для прошивки используются vias диа-
метром 12 mil. Зона должна быть открыта от маски. 

Каким образом можно прошить определённое ме-
сто группой vias, расположенных на равном расстоянии 
друг от друга? Можно, конечно, сделать это вручную. 
Но что, если количество vias достигает сотни или даже 
больше? 

Вы, конечно же, поняли, куда я клоню. Нужно применить Pad Array Generator43. 

                                                 
43 В дальнейшем Вы увидите, что существует ещё один способ. 

 

Heat sink 
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Board outline 
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Сначала приготовим padstack нужного нам via. В предыдущей главе рассказывалось, 
как это сделать и как сохранить созданный padstack в библиотеке. Назовите его 
«VIA_12_FLOODPLANE», указав параметры, как на рис.  2-244. 

 
рис.  2-244 

Для того, чтобы выделить все слои щёлкните по имени padstack-а, затем войдите в 
«Properties…» и установите флажок «Flood Planes/Pours» (рис.  2-245). 

 
рис.  2-245 

Установка этого флажка приведёт к запрету соединения via с зонами медной заливки и 
со слоями типа Plane по типу Thermal Relief. Иными словами, пространство между перемыч-
ки Thermal Relief будет заполнено (затоплено44) медью. 

Теперь немного посчитаем. 1 мм – это, примерно 40 mil.45 Таким образом, на площади 
5х15 мм поместится 5*15 vias, размещённых друг от друга через 40 mil. Создадим footprint, 

                                                 
44 Flood – затоплять, заливать. 
45 39.37 mil, если быть точным. 
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используя Pad Array Generator, который так и назовём – MATRIX 5X15. 
В открывшемся окне Pad Generator-а выбираем Style – GridArray. Параметры p и q, 

соответственно, – 5 и 15. Расстояния x и y – 40 mil. В поле Padstack выбираем наш 
VIA_12_FLOODPLANE (рис.  2-247). 

 
рис.  2-246 

 
рис.  2-248 

 
рис.  2-247 

В окне «Preview» видим то, что получилось, а в окне «Style Sample» – количество vias 
на указанной площади. 

Выходим из Pad Generator-а и сохраняем созданный footprint в библиотеке элементов. 

2.17. Зоны отвода тепла: размещение на плате. 
Чтобы закончить пример, нам снова нужно заглянуть вперёд, в будущее. Во второй по-

ловине главы мы выйдем из Library Manager и будем работать в режиме дизайна. Experienced 
users, то есть те читатели, которые знакомы с OrCAD Layout Plus могут последовать за мной, 
повторяя все действия на компьютере. 

Целью этой главы является показать, как можно использовать на плате заготовленный 
нами footprint и только. Я не буду описывать всё с самого начала, всему своё время. Поэтому 
те, кто только начинает осваивать систему, могут пропустить эту главу с тем, чтобы вернуть-
ся и разобраться во всём позже. 

Впрочем, ничего сложного нас не ждёт. 

Итак, предполагается, что у нас есть начатая плата, на которой имеется участок 
5х15 мм. Рядом расположена via, соединённая с землёй (рис.  2-243). Дополнительные усло-
вия задачи описаны на стр. 111. 
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На панели инструментов выберите Component Tool.46 Потом щёлкните правой кноп-
кой мыши в произвольном месте дизайна и выберите «New…» (рис.  2-249). 

 
рис.  2-249 

В открывшемся окне нажмите кнопку <Footprint…>, найдите свою библиотеку и вы-
берите MATRIX 5X15 (рис.  2-250). 

 
рис.  2-250 

В поле «Component flags» установите флаг Not in Netlist. Это признак того, что ком-
понент был добавлен в дизайн вручную и на принципиальной схеме его нет. 

Нажмите <OK> и поместите footprint в очерченную зону (рис.  2-251). 

 
рис.  2-251 

 
рис.  2-252 

 
рис.  2-253 

                                                 
46 Напоминаю, что мы находимся в режиме Design View. 
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В предыдущей главе мы заранее вычислили количество vias footprint-а, и поэтому он 
точно подошёл по размерам. Однако есть и другой способ. 

Можно нарисовать footprint заведомо бо́льших размеров. Поместив его в зону, очер-
ченную obstacle (рис.  2-252), сразу станет видно, сколько лишних рядов и столбцов vias не-
обходимо убрать (рис.  2-253). 

Итак, зона прошита отверстиями, которые нужно соединить с землёй. Делается это так. 
На панели инструментов выберите Connection Tool (рис.  2-254). 

 
рис.  2-254 

Щёлкните мышкой по одному из отверстий и протяните ниточку от него до via GND. 

 
рис.  2-255 

Если Layout выдаст предупреждение, о соединении с существующей цепью, ответьте 
«Да» (рис.  2-256). 

 
рис.  2-256 

Соедините между собой все отверстия (рис.  2-257). Не правда ли, это похоже на какую-
то детскую игру? 
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рис.  2-257 
К сожалению, назначить какую-либо цепь сразу группе выводов нельзя. 

Теперь в указанном месте нужно создать поле медной заливки. Выберите Obstacle 
Tool, щёлкните по obstacle, очерчивающей зону и измените её свойства на: 

• Obstacle Type – Copper Pour; 
• Obstacle Layer – BOTTOM; 
• Net Attachment – GND. 

Вот что должно получиться (рис.  2-258): 

 
рис.  2-258 

Если Вы случайно пропустили одно из отверстий и оставили его неподключённым, это 
сразу будет видно (рис.  2-259): 

 
рис.  2-259 

Допущенную ошибку легко исправить. 

Скопируйте obstacle во все слои, предназначенные для маршрутизации (TOP и INNER), 
а также в слои SMTOP и SMBOT, чтобы открыть зону от маски. PLANE layers будут под-
ключены автоматически. 

А теперь такой вопрос: почему мы использовали Copper Pour, а не Copper Area? 
Вспомните (рис.  2-41 и рис.  2-42 на стр. 43), что obstacle Copper Area окружает любое 

отверстие вплотную, а Copper Pour использует соединение Thermal Relief. Для чего было 
нужно ставить атрибут «Flood Planes/Pours» всем vias в footprint-е, если можно использовать 
Copper Area? 
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Существуют три причины поступить именно так, как сделали мы. 
Во-1, установив атрибут «Flood Planes/Pours», мы сделали наш footprint универсаль-

ным. Его можно использовать как с Copper Pour, так и с Copper Area. 
Во-2, если зона, предназначенная для рассеивания тепла прямоугольная, то можно ис-

пользовать и Copper Area. Но если зона имеет сложную форму и граничит с другими obsta-
cles, то без Copper Pour не обойтись. Дело в том, что параметр Z order, указывающий при-
оритет перекрывающихся obstacles, для Copper Area недоступен. 

В-3, если дизайн содержит PLANE layers, то все соединения с ним будут осуществлены 
способом Thermal Relief. 

2.18. Импорт из дизайна. 
Иногда бывает так, что приходится продолжать кем-то начатую работу. У Вас есть lay-

out готовой печатной платы в которой что-то требуется изменить, но нет библиотеки foot-
print-ов, которой пользовался предыдущий разводчик. 

Как поступить в этом случае? Создавать библиотеку самому с самого начала? Или, 
быть может, искать того человека, который работал с платой до Вас, в надежде, что он со-
хранил данные о проекте? 

К счастью, не требуется ни то ни другое. Можно получить библиотеку footprint-ов 
прямо из дизайна. 

В самом начале книги мы рассматривали печатную плату (рис.  1-1). Найти её можно в 
папке примеров, устанавливаемых вместе с OrCAD: 

“…layout_plus\samples\demo\finished.max” 

Откройте Library Manager, и просто добавьте в качестве новой библиотеки файл «fin-
ished.max». После того, как библиотека FINISHED появится в списке, щёлкните по её на-
званию и рассмотрите содержимое. 

Вот, например, интересный footprint (рис.  2-260): 

 
рис.  2-260 

Некоторые footprint-ы выглядят странно. К примеру, во многих из них почему-то про-
дублированы надписи. 
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Найдите и откройте footprint SOG.050/44/WG.642/L1.150 (рис.  2-261): 

 
рис.  2-261 

Мы видим две надписи Reference Designator: «&Comp». Почему? 

Закройте Library Manager и откройте плату «finished.max» в Layout Plus. Найдём, кому 
принадлежит такой footprint. Войдите в «Components», а затем щёлкните в любом месте таб-
лицы правой кнопкой мыши и из появившегося меню выберите «Select Any…» (рис.  2-262). 

 
рис.  2-262 

В окне «Component Selection Criteria» в поле «Footprint Name» введите начало на-
звания footprint-а, заменив оставшуюся часть звёздочкой (рис.  2-263). Нажмите <OK>. 

 
рис.  2-263 

1

2

OrCAD Layout Plus 

 Стр. 119 

Такой footprint – у компонента U33 (рис.  2-264). 

 
рис.  2-264 

Найдём его на плате. Для этого нажмите: 

<Shift>+<Home> – чтобы увидеть дизайн целиком, 
3 раза <I> –  увеличиваем изображение, 

<TAB> –  вызываем окно поиска, 

и вводим в него «U33» (рис.  2-265): 

 
рис.  2-265 

Результатом наших действий является следующий экран (рис.  2-266): 

 
рис.  2-266 
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Если Вы ничего здесь не понимаете, нажмите последовательно: 

<Backspace> – чтобы полностью очистить изображение, 
<Shift>+<3> –  показать слой ASYTOP, 
<Shift>+<1> –  показать слой SSTOP. 

 
рис.  2-267 

Хочу напомнить, что сочетания клавиш для слоёв можно найти в таблице «Layers» 
(рис.  1-19). 

Как видно, надпись «U33» расположена слева от микросхемы. Та же надпись, только в 
слое ASYTOP, находится в центре компонента. Очевидно, что в библиотеке footprint-ов обе 
эти надписи совпадали и располагались в центре. Когда компонент поместили на плату, раз-
водчик вынес silk «U33» за пределы микросхемы. В импортированной из платы библиотеке 
видны обе надписи. 

На рис.  2-261 мы видим историю размещения компонента. Не всю, к счастью, а лишь 
первый и последний шаги. 

На стр. 115 я говорил, что соединение vias похоже на игру. Теперь это похоже на де-
тектив! 

«История» сохраняется для надписей и obstacles. Вот как будет выглядеть созданный 
нами footprint PCA9555, если его поместить на обратную сторону печатной платы, а потом 
импортировать обратно в библиотеку (рис.  2-268): 

 
рис.  2-268 

Легко восстановить первоначальный вид footprint-а. Для этого достаточно удалить все 
надписи и obstacles из обратных – зеркальных – слоёв. А именно: BOTTOM, SSBOT и 
ASYBOT (рис.  2-269): 
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рис.  2-269 

В то же время – кто знает! – дополнительная информация тоже может пригодиться 
(рис.  2-270): 

 
рис.  2-270 

Восстановите исходный вид нужного Вам footprint-а и сохраните в своей собственной 
библиотеке. Теперь Вы можете его использовать по своему усмотрению. 

2.19. Каталог библиотеки footprint-ов. 
Ещё одна полезная возможность, которая существует в OrCAD Layout Plus, но про ко-

торую не все знают: создание каталога footprint-ов. Это – функция, обратная описанной вы-
ше. Библиотеку можно либо целиком распечатать на принтере, либо создать из неё файл ди-
зайна. 

Вот как это делается. Откройте OrCAD Layout Plus и выберите: «Tools → Catalog → 
Create…» (рис.  2-271): 

 
рис.  2-271 

В качестве примера возьмём библиотеку SM.LLB, расположенную в общем каталоге 
библиотек. Укажите путь к ней в поле ввода «Input» (рис.  2-272). 

Назначение всех остальных полей понятно из их названия. Чтобы у нас получилось 
одинаково, заполните их, как показано на рис.  2-272. 
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рис.  2-272 

Нажмите кнопку <Additional Options…> (рис.  2-273). 

 
рис.  2-273 

В этом окне тоже нет никаких специальных терминов, поэтому, надеюсь, объяснять 
ничего не нужно. Заполните поля, как на рисунке. 

После того, как мастер через короткое время закончит работу, откроется окно OrCAD 
Layout Plus – Design View, в котором можно увидеть всю библиотеку SM.LLB. Содержимое 
библиотеки размещается на трёх листах формата A4 (рис.  2-274). 

Чтобы лучше было видно, я изменил цвет слоя COMMENT на оранжевый. 
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рис.  2-274 

Элементы библиотеки располагаются в отсортированном порядке в соответствии с те-
ми требованиями, которые были указаны в окне «Additional Options» (рис.  2-275). 

 
рис.  2-275 

В некоторых footprint-ах разработчики из Cadence оставили пояснения (рис.  2-276): 

 
рис.  2-276 

Распечатать библиотеку можно, воспользовавшись командой меню: «Tools → Catalog 
→ Print…» 

рис. 2-275

рис. 2-276
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3. Работа со схемой. 

В этой главе мы начнём создавать нашу первую печатную плату. Я проведу Вас через 
все основные этапы работы над дизайном: получение задания; передача данных из OrCAD 
Capture в Layout Plus; определение правил дизайна; размещение компонентов; разводка элек-
трических цепей; оптимизация и доводка печатной платы; расстановка надписей; подготовка 
необходимых файлов для производства и общее оформление архива проекта. 

Следует понимать, что требования к оформлению заказа на производство, требования к 
оформлению проекта могут меняться в зависимости от правил, действующих в Вашей ком-
пании. Поэтому я постараюсь в начале описать общие принципы, а потом остановлюсь на 
некоторых конкретных вариантах. 

Небольшое отступление. Эта книга – о Layout Plus – программе проектирования печат-
ных плат. Однако Layout, являясь мощным самостоятельным инструментом, входит как один 
из составляющих компонентов в общую среду разработки и проектирования электронных 
устройств OrCAD. Это значит, что в процессе работы над проектом мы неоднократно будем 
прибегать к помощи и использовать возможности других компонентов системы. В первую 
очередь, это OrCAD Capture – редактор принципиальных схем. 

Возможно, нам понадобятся также «помощники» для разводки, такие как OrCAD 
SmartRoute или Specctra Autorouter. 

У Layout есть и другие «друзья», и описание в деталях каждого из них способно занять 
отдельную книгу. Поэтому, когда возникнет необходимость в использовании какого-либо 
дополнительного инструмента, я буду давать лишь ту информацию, которая нужна для ре-
шения только текущей задачи, непосредственно связанной с работой над нашей печатной 
платой. 

Пожалуй, небольшое исключение можно сделать лишь для Capture. Удивительно, но 
очень многие весьма грамотные инженеры рассматривают Capture всего лишь как специали-
зированный графический редактор, не подозревая о его подлинных возможностях. Будьте 
внимательны! Принципиальная схема, которая выглядит идеально на бумаге, для Вас, как 
для разводчика, может таить множество коварных подвохов. Готовое устройство, собранное 
на Вашей печатной плате окажется неработоспособным, и будет бесполезно кому-либо по-
том доказывать, что Вы изготовили плату в абсолютной точности с полученной схемой. 

По этой причине, ниже по тексту Вы найдёте множество отступлений в сторону Or-
CAD Capture. Я надеюсь, что в будущем эта информация сослужит Вам хорошую службу. 

3.1. Принципиальная схема. 
Итак, Вы получаете задание на разработку печатной платы для очередного проекта 

(рис.  3-1). Создайте в Windows Explorer новую папку, присвойте ей имя проекта и перепи-
шите в неё все полученные файлы. 

А именно: 
9 Файл с расширением .dsn. Это – принципиальная схема устройства. 
9 Текстовый файл с расширением .bom. Это – Bill of Materials, список используе-

мых компонентов с указанием их footprint-ов. Я говорил ранее, что один и тот же ком-
понент может выпускаться в различных корпусах, поэтому, если только не Вы сами 
разрабатывали схему, Вы должны попросить такой список. 
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рис.  3-1 
 
9 Datasheet47 на каждый компонент. 
9 Чертёж печатной платы. Я имею в виду – механический чертёж, на котором по-

казана форма платы, расположение крепёжных отверстий, разъёмов и других элемен-
тов, чьё расположение определено конструкцией проектируемого устройства. Вы мо-
жете получить такой чертёж на бумаге или в файле с расширением .dxf. Его составляет 
инженер-механик в Вашей фирме. 
9 Список технологических требований. Как то: минимальная толщина дорожек, 

количество слоёв в плате и т.д.. 
9 Список электрических особенностей. Например, если Вы разрабатываете какое-

то мощное устройство, Вы должны знать ширину дорожек, по которым проходит 
большой ток. Если в Вашем устройстве присутствует высокое напряжение, необходимо 
знать расстояние между высоковольтными цепями и прочими элементами. 
9 Конструктивные особенности. Например, должны ли крепёжные отверстия со-

единяться с землёй или все отверстия должны быть выполнены без металлизации (non-
plated)? Какими винтами будет прикручиваться плата к корпусу устройства, и, соответ-
ственно, какое расстояние стоит предусмотреть для шляпки винта? 

Следует отметить, что многие детали, перечисленные выше, могут выясняться уже по 
ходу проектирования. Идеальных случаев не бывает и, возможно, какие-то требования будут 
меняться, заставляя иной раз переделывать почти готовую плату заново. Однако, Ваша зада-
ча – узнать как можно больше сведений у того, кто передаёт Вам проект, будь то Ваш на-
чальник, инженер-электронщик из соседнего отдела или заказчик со стороны. Всё, что Вы 
пропустите, чревато впоследствии лишней работой. 

Не бойтесь быть нудным в начале, иначе придётся расплачиваться в конце. Напротив, 
грамотно поставленные вопросы, повысят Ваш авторитет и внушат к Вам доверие. 

Вам совершенно не обязательно досконально разбираться с принципом работы устрой-
ства, в разработке которого Вы принимаете участие. Однако попросите объяснить, его назна-
чение, назначение основных блоков. Мысленно или на схеме определите основные функцио-
нальные модули. Отделите блок питания от схемы передачи данных, процессор – от каких-то 
аналоговых фильтров и т.д.. Полученная информация позволит применить Вам Ваши собст-
венные знания и Ваш опыт для грамотного размещения компонентов на плате. 

В процессе работы над проектом, как Вы увидите дальше, нам, возможно, придётся 
вносить изменения в схему устройства. Поэтому следующим шагом будет создание подпап-
ки с именем «Original». Обязательно заархивируйте или скопируйте в неё все полученные 
файлы в их первоначальном виде. 

Важное примечание! Не используйте в названиях файлов и папок имена с нестандарт-
ными символами, такими как, например, пробел. Дело в том, что некоторые программы, на-
пример, Specctra, получают информацию из Layout через командную строку, и наличие про-
бела в имени файла ошибочно будет расценено как разделитель параметров. Specctra отка-
жется работать, а Вы долго будете ломать голову, пытаясь выяснить причину такого явления. 

В свете вышесказанного обратимся к полученной схеме (рис.  3-1) и проанализируем её. 
Схема очень несложная. Это – просто часы.48 Основные функциональные блоки: 

1) Логическая часть. Схема управления реализована на процессоре49 фирмы Texas In-
struments MSP430F1121A. «Обвязка» процессора – компоненты R8, R10, Y150. Это значит, 

                                                 
47 Datasheet – это полное описание компонента от производителя. В datasheet включается словесное описание 

компонента, обозначение его на принципиальной схеме, электрические характеристики, способы типичного 
применения, названия корпусов (footprints) в которых выпускается компонент и их чертежи. В некоторых слу-
чаях, что для нас несомненно удобно, приводится чертёж посадочного места на печатную плату. 

48 Схема не заимствована из каких-либо сторонних источников и является разработкой автора. 
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что имеет смысл расположить указанные компоненты в непосредственной близости от 
процессора. 

Программирование процессора осуществляется непосредственно на плате, для чего 
предусмотрен разъём для программатора J1. Разъём должен быть легко доступен. В то же 
время, он должен находиться недалеко от процессора. Или процессор от разъёма. Таким 
образом, подразумеваем пока, что разъём J1 будет находиться у края платы, а процессор – 
поблизости от него. 

2) Блок индикации. Четыре 7-сегментных светодиодных индикатора красного цвета с 
общим катодом LD1-LD4 управляются микросхемой U1. U1 – это специализированный чип, 
предназначенный для поддержания развёртки и управления одновременно до пяти 7-
сегментных индикаторов. Программирование микросхемы осуществляется через последова-
тельный порт. 

Светодиоды D1 и D2 выполняют роль двоеточия – разделителя между часами и мину-
тами. Очевидно, они должны находиться между LD2 и LD3. 

Светодиод D3 – индикация включения будильника. Точное положение всех индикато-
ров должно быть указано инженером-механиком, который разрабатывал чертёж передней 
панели часов. Впрочем, для упрощения задачи, будем считать, что дизайн передней панели 
пока не определён, поэтому ситуация прямо противоположная: механик ждёт от нас го-
товой печатной платы, чтобы потом опираясь на наш чертёж, сделать переднюю панель. 

Резистор R7 – задаёт ток и, следовательно, яркость свечения индикаторов. Располагаем 
поблизости от U1. 

Ёмкости C1 и C2 – ёмкости по питанию. C2 должна находиться рядом с U1. 

3) Питание устройства в целом осуществляется от источника постоянного тока напря-
жением 6V. Однако процессор питается от 3.6V. Микросхема U3 и компоненты вокруг неё 
образуют преобразователь 6V → 3.6V. Располагаться может в удобном для нас месте, кро-
ме C6, которая должна находиться рядом с процессором. 

4) LS1 и компоненты рядом – звонок. LS1 – пьезоэлектрический зуммер, который кре-
пится прямо на плате. Располагаем в любом удобном месте. 

5) Датчик. R2 – фоторезистор. Микросхема U1 – MC14489DW позволяет менять яр-
кость свечения индикаторов. Эту возможность можно использовать. Пусть наши часы днём 
светятся ярко, а в тёмной комнате – только в половину яркости. Выходы резистивных дели-
телей R2-R12 (ADC1) и R1-R11 (ADC2) подаются на вход встроенного в процессор компара-
тора. При этом резистор R1 определяет порог срабатывания. R2 будет крепиться на перед-
ней панели и соединяться с платой с помощью коротких проводников. Предусмотрим для 
этой цели место для двухконтактного разъёма. Остальные компоненты можно располо-
жить в любом удобном месте. 

6) Управление. Для установки времени, будильника и т.д. предусмотрены 4 кнопки 
SW1-SW4. Очевидно, они должны быть расположены в нижней части платы в один ряд. 
SW5 служит для выключения будильника. Она будет расположена отдельно, поэтому для 
неё тоже предусмотрим разъём, который можно поместить в любом удобном месте. 

Теперь проанализируем цепи. 
В данной схеме нет ни силовых, ни высоковольтных цепей. Нет и высокоскоростных 

линий, чувствительных ко внешним помехам. Раз так, то можно принять ширину дорожек по 
умолчанию – 8 милей. 

8 милей – стандартная ширина дорожек для маломощных устройств. Если Вы проекти-
руете цифровую плату с высокой плотностью монтажа, можно принять ширину равной 6 ми-

                                                                                                                                                                  
49 Правильнее – микроконтроллере. 
50 Для MSP430 внешний кварц не нужен, но ничего страшного не будет, если мы предусмотрим для него ме-

сто. 
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лей. Многие предприятия-изготовители печатных плат допускают минимальную ширину 
треков до 4 милей, однако стоимость такой платы значительно выше, а надёжность может 
быть хуже. Если у Вас возникнет необходимость проектирования платы столь высокой плот-
ности – обязательно поговорите с технологом предприятия-изготовителя, прежде чем начи-
нать проект. 

Давайте усложним задачу. Увеличим толщину цепей питания GND, +6V и Vcc. Кроме 
того, цепи B1_1-B1_5 к которым подключены выводы индикаторов «Общий катод» тоже ис-
пытывают повышенную нагрузку. Для всех перечисленных выше цепей определим ширину 
дорожек в 12 милей. 

Расстояние между цепями определим в 8 милей. 

3.2. Подготовка библиотеки footprint-ов. 
Разобравшись с принципиальной схемой, переходим к вещам, более нам уже знако-

мым. Подготовим библиотеку footprint-ов на все типы компонентов. Запускаем OrCAD Lay-
out Plus, входим в Library Manager, создаём в рабочей директории новый файл библиотеки с 
именем проекта, – например, «Clock.LLB», – и начинаем его заполнять. 

Первый компонент – U1. Микросхема 
MC14489DW. Открываем datasheet компонента и 
видим (рис.  3-2), что микросхема выпускается в 
корпусах двух типов: CASE 738 – DIP корпус, и в 
планарном (SMD) исполнении – CASE 751D. 

Теперь нужно посмотреть Bill of Materials, 
чтобы выяснить, какой корпус предпочёл заказчик. 
Допустим, это CASE 751D, планарный вариант. 

Обычно чертежи корпусов находятся в самом 
конце datasheet. Находим чертёж нужного нам кор-
пуса (рис.  3-3) и создаём в библиотеке Layout новый 
footprint с именем, например, «MC14489DW CASE-
751D». 

 
рис.  3-2 

 
рис.  3-3 

Аналогично поступаем с остальными компонентами. 
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На этом этапе имеет смысл воспользоваться библиотеками, которые поставляются вме-
сте с Layout. К примеру, footprint для процессора можно найти в библиотеке SOG.LLB под 
именем SOG.050/20/WG.420/L.500. 

Все применяемые резисторы – SMD-типа в корпусе 0805. Такой footprint можно найти 
в библиотеке SM под именем SM/R_0805. 

То же самое относится ко всем неполярным конденсаторам. Footprint SM/C_0805. 

Полярные конденсаторы C1 и C4. Тоже 0805, однако, один из выводов необходимо 
обозначить знаком «плюс». Какой? Помнится, я говорил, чтобы Вы сохранили в отдельной 
папке все полученные файлы в нетронутом виде, потому что, возможно, придётся вносить 
изменения в схему. Этот момент как раз наступил. 

На схеме (рис.  3-1) номера выводов у всех конденсаторов скрыты. Разработчику прин-
ципиальной схемы они не нужны, потому что лишь загромождают чертёж, но нам – другое 
дело. Нам эта информация просто необходима. 

В OrCAD Capture выделите элемент C1 и щёлкните на нём правой кнопкой мыши. Из 
контекстного меню выберите: «Edit Part» (рис.  3-4). 

 
рис.  3-4 

В открывшемся окне редактора выберите: «Options → Part Properties…» и измените 
свойство «Pin Numbers Visible» на «True» (рис.  3-5). 

 
рис.  3-5 

Закройте окно редактора. На вопрос «Желаете ли обновить свойства всех компонентов 
или только выбранного?» ответьте: «Всех» («Update All») (рис.  3-6). 

Вернувшись в окно Schematic Editor, убедитесь, что и у C1 и у C4 появились номера 
выводов (рис.  3-7). 
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Поправьте надписи около элементов, если они сместились. 

 
рис.  3-6 

Вернёмся к библиотеке footprint-ов. Возьмите footprint SM/C_0805, дорисуйте рядом с 
первым выводом «+» и сохраните новый footprint под именем «SM/C_0805 PLUS» (рис.  3-8). 
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рис.  3-7 

 
рис.  3-8 

Подобную процедуру необходимо повторить со всеми компонентами, для которых ну-
мерация выводов имеет значение. А именно: все полярные элементы, диоды, транзисторы и 
т.д.. 

Диод D4. Корпус 0805. В библиотеке SM имеется три типа footprint-ов: SM/D_0805, 
SM/D_0805_12 и SM/D_0805_21. Сверяясь со схемой, выбираем footprint SM/D_0805_21. 

Все отобранные footprint-ы копируйте в библиотеку Clock.LLB. 

Транзистор Q1. Смотрим datasheet. Сразу бросается в глаза, что нумерация выводов 
для thruhole-варианта (рис.  3-9) не совпадает с указанной на схеме. Ошибка? 
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рис.  3-9 

 
рис.  3-10 

Нет, в данном случае, это не ошибка. Такие транзисторы выпускаются и в планарном 
исполнении в корпусе SOT-23. Для SMD-варианта расположение выводов другое (рис.  3-10). 

Ищем в библиотеке SM footprint-ы SOT23, выбираем подходящий и копируем в свою 
библиотеку. Назовём его «2N2222 - SM/SOT23_123». 

Разъём для программирования процессора J1. 8 выводов в один ряд. Подходящий foot-
print найдётся в библиотеке BCON100T. Это – BLKCON.100/VH/TM1SQ/W.100/8. 

Разъём J2 для подключения источника питания. Можно воспользоваться footprint-ом 
BLKCON.100/VH/TM1SQ/W.100/2. Сохраните его под именем «CONN 2». 

 
рис.  3-11 

 
рис.  3-12 

Проделайте ещё одну процедуру. А именно: рядом со вторым выводом поставьте плюс. 
Сохраните этот footprint под именем «CONN 2 PLUS». Именно его мы будем использовать 
для J1. 

Footprint CONN 2 можно сопоставить фоторезистору R2 и клавише выключения звонка 
SW5. 

SW1-SW4 – миниатюрные кнопки SKHJ Series. 
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рис.  3-14 

 
рис.  3-13 

 
рис.  3-15 

Проверим соответствие нумерации выводов на схеме (рис.  3-16) и на самой кнопке 
(рис.  3-15) и с горечью убедимся, что на схеме нарисовано неправильно. 

Исправим, как показано на рис.  3-17. 
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рис.  3-16 
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рис.  3-17 

Для светодиодов D1-D3 подойдёт footprint, созданный нами в главе «Компоненты с не-
круглыми выводами.» 

Опять-таки, проверяем соответствие нумерации выводов! 
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рис.  3-18 

Для кнопок, как и для остальных компонентов создаём footprint-ы самостоятельно. На 
рис.  3-18 даны размеры для U3. Footprint можно так и назвать: «LP2980». 

 
рис.  3-19 

На рис.  3-19 приведён чертёж 7-сегментного индикатора. Footprint назовём «7LED 
336T». 

Footprint «CRYSTAL» для кварцевого резонатора нарисуйте примерно так, как показа-
но на рис.  3-20.  
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рис.  3-20 

 
рис.  3-21 

Footprint «SPEAKER» выглядит примерно, как на рис.  3-21. 

 Подготовка библиотеки Clock.LLB для проекта закончена. На рис.  3-22 показано её 
содержание: изображения всех footprint-ов и их имена. 

 
рис.  3-22 

3.3. Подготовка данных для Layout Plus. 
У нас есть схема, мы создали footprint-ы для всех компонентов. Очевидно, теперь нуж-

но установить соответствие каждого элемента принципиальной схемы его footprint-у из биб-
лиотеки. 

Сделать это можно разными способами. 

Способ #1. Определим footprint для элемента U2. Найдите его на схеме и дважды 
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щёлкните левой кнопкой мыши. Откроется окно свойств объекта (рис.  3-23). 

 
рис.  3-23 

В поле PCB Footprint введите название footprint-а в точности так, как Вы его опреде-
лили в библиотеке (стр. 129). 

Этот способ удобен тем, что мы видим элемент, прежде чем задаём его свойства. Одна-
ко, если нужно описать свойства группы элементов, то лучше воспользоваться другим мето-
дом. 

Находясь в OrCAD Capture, перейдите в окно Project Manager. 

 
рис.  3-24 

Укажите мышкой на файл дизайна, как показано на рис.  3-24, а затем войдите: «Edit → 
Object Properties…». Откроется Property Editor – общая таблица свойств всех элементов 
схемы (рис.  3-26). 

Убедитесь, что в нижней части экрана выбрана вкладка Parts (рис.  3-26 – c). 

 
рис.  3-25 

Сдвиньте столбцы так, как Вам более удобно. Для этого выделите нужный столбец и 
перетащите его мышкой в новую позицию (рис.  3-25). Например так, чтобы столбцы 
Graphic и PCB Footprint были рядом. 
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рис.  3-26 

Для того чтобы изменить какое-либо свойство группы элементов, выделите необходи-
мые ячейки мышкой, используя клавиши <Ctrl> или <Shift>. Проделайте это для элементов 
C2, C3, C5, C6, а затем нажмите <Ctrl>+<E>. 

1

2 
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рис.  3-27 

Укажите название footprint-а для этих конденсаторов, как показано на рис.  3-27. 

Проделайте аналогичную работу для всех остальных компонентов, исключая LD1-LD4, 
как показано на рисунке. Я это сделал специально. Для чего – скажу позже. 

Надо сказать, что Property Editor показывает Вам не всё. Чтобы не загромождать экран 
лишними данными, для вывода информации используются фильтры (рис.  3-26 – d). 

Попробуйте самостоятельно подобрать такой фильтр, чтобы стал виден столбец 
«Color» (рис.  3-28), после чего измените цвет R1 и R2 на оранжевый, а SW5 – на темно-
зелёный. 

 
рис.  3-28 

Для того чтобы создать свой собственный фильтр щёлкните правой кнопкой мыши по 
заголовку одного из столбцов, выберите «Filters → Add Filter…» (рис.  3-29) и укажите имя 
нового фильтра. Новый фильтр будет создан, и на экран будут выведены абсолютно все 
свойства. 

 
рис.  3-29 

С помощью этого же меню выберите столбцы, которые Вы хотите скрыть. 

Информация об используемых фильтрах хранится в файле: 
C:\Cadence\PSD_15.1\tools\capture\PREFPROP.txt 

Файл имеет текстовый формат. Откройте его и поинтересуйтесь содержимым. 
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3.4. Forward Annotating. 
Мы ещё совсем не закончили работать ни со схемой, ни с Capture. Однако подготов-

ленных данных вполне хватает, чтобы начать работать в Layout Plus. Сейчас мы попробуем 
стартовать Layout-сессию, а затем увидим, как можно вносить новые данные в уже сущест-
вующий дизайн. 

Процесс передачи данных из OrCAD Capture в Layout называется «Forward 
Annotating». Он состоит из двух этапов: подготовка Netlist-а в OrCAD Capture и последую-
щая трансляция его в Layout. 

Netlist – это словесное описание принципиальной схемы. Capture создаёт файл особого 
формата, понятный Layout, в котором записана вся информация о: 

– компонентах, используемых в схеме; 
– соединениях; 
– общие сведения, такие, например, как размерность системы измерений. 

Для того чтобы создать netlist в OrCAD 
Capture перейдите в окно Project Manager и 
нажмите кнопку на панели инструментов 
Create Netlist (рис.  3-30, рис.  3-31). 

 
рис.  3-30 

 
рис.  3-31 

В открывшемся окне выберите вкладку Layout, а в поле Options – обязательно укажите 
«User Properties are in inches» (рис.  3-32)! 

 
рис.  3-32 

Ох, и намучился я в своё время, из-за того, что пытался начать плату в дюймовой сис-
теме измерений, а netlist создавал в метрической! Снова и снова пытался я понять, почему 
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после трансляции Layout открывает мне совершенно пустое окно… 

 
рис.  3-33 

Нажмите <OK>, и увидите, что в окне 
проекта появился новый файл clock.mnl. Это 
и есть файл netlist-а. 

Netlist не будет создан, если на схеме 
имеются элементы с одинаковыми Reference 
Designator. Ошибка произойдёт и в том слу-
чае, если у одного из элементов имеются вы-
воды с одинаковыми номерами. 

 

Созданный файл имеет двоичный формат. Посмотреть его содержимое можно, вос-
пользовавшись возможностями экспорта Layout. 

В окне Layout Session выберите команду «File → Export → MAX ASCII Netlist». Ука-
жите путь ко входному файлу, задайте имя выходного, и получите файл clock.asc, который 
можно открыть любым текстовым редактором51. 

Трансляция netlist-а в Layout Plus осуществляется утилитой AutoECO. Запустите Layout 
Session и выберите «File → New». Мы начинаем новую плату! 

В открывшемся окне (рис.  3-34) в поле Options выбрано «AutoECO» (f). Обратите 
внимание на пояснения, следующие ниже. Именно этот вариант используется, если Вы толь-
ко начинаете работать. 

 

 
рис.  3-34 

                                                 
51 Формат файла описан в документе «C:\Cadence\PSD_15.1\doc\lay_ug\lay_ug.pdf» OrCAD 

Layout® User’s Guide в разделе «Layout files and file translation → MAX ASCII files → MAX ASCII file general 
format». 

1

2

3

4
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Как мы увидим дальше, утилита AutoECO используется не только во время создания 
новой платы, но и для всех случаев, когда нужно обновить данные из Capture в Layout, ка-
сающиеся изменения схематики. 

Вариант «AutoECO» выбирается всегда, если в схеме произошли какие-то принципи-
альные изменения. Например, были добавлены или удалены компоненты или изменились 
соединения между элементами. Соответствующие компоненты будут добавлены на печатной 
плате, ненужные более – удалены, а цепи переподключены заново. При этом свойства уже 
существующих в Layout элементов не изменятся. 

Об этом мы ещё поговорим, а сейчас в поле d укажите путь к файлу clock.mnl, а в по-
ле c укажите путь к файлу _default.tch. 

Файлы с расширением .tch это, так называемые «Technology Templates» – технологи-
ческие шаблоны. Они используются, если Вы начинаете работу над новой печатной платой и 
содержат информацию об основных правилах построения дизайна. Как то: 

– количество слоёв в будущей плате; 
– установки для сеток привязки; 
– правила размещения компонентов; 
– правила маршрутизации и ширина треков; 
– заготовки padstacks; 
– color rules, т.е. цветовую таблицу и т.д.. 

В некоторых случаях вместо Technology Templates в поле c подставляется файл с рас-
ширением .tpl. Это – файл «Board Templates» – заготовки плат. Board Templates использу-
ются для разработки серии схожих PCB52 и помимо перечисленной выше информации могут 
содержать в себе данные о физических размерах печатной платы, предустановленные компо-
ненты (такие как крепёжные отверстия, коннекторы и пр.), текст и уже готовые элементы 
оформления. 

В поле c подставляется уже существующая плата, если требуется произвести обновле-
ние данных. 

В поле e задается имя результирующего файла. Layout Plus работает с файлами PCB, 
имеющими расширение .max. Самый первый файл я обычно называю «00.max», а после-
дующие – «01.max», «02.max» и так далее. Это позволяет не запутаться в версиях, и спасает 
от возможных сбоев компьютера, потому что всегда даёт возможность вернуться на произ-
вольное количество шагов назад, если вдруг выяснится, что произошла какая-либо ошибка. 

Нажимаем кнопку <Apply ECO> и с волнением ждём результат. 

 
рис.  3-35 

В предыдущей главе на стр. 137 я просил не указывать footprint names для LD1-LD4, 
обещая потом что-то рассказать. Я просто хотел показать ещё один способ сопоставления 
                                                 

52 Printed Circuit Board – печатная плата. 
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элементов принципиальной схемы их footprint-ам – интерактивный способ. Сейчас утилита 
AutoECO споткнётся на одном из этих 7-сегментных индикаторов и выведет на экран окно 
(рис.  3-35). 

Нажмите кнопку <Link existing footprint to component…>. 

 
рис.  3-36 

Откроется другое окно (рис.  3-36). Укажите в поле Libraries свою библиотеку «Clock», 
а в списке Footprints выберите «7LED 336T». 

После этого AutoECO спокойно продолжит работу, поскольку для всех остальных ком-
понентов соответствия заданы. 

В конце нам будет выдан отчёт, после чего Layout – наконец то! – откроет окно дизай-
на, в котором будет присутствовать таблица Drill Chart, а рядом – все наши компоненты, ак-
куратно отсортированные по footprint-ам и соединённые жёлтыми ниточками ratsnest – це-
пей. 

 
рис.  3-37 

Если Вы стараетесь повторять за мной все мои действия, и у Вас это получилось, то 
позвольте поздравить Вас с успехом! Мы на самом деле продвинулись уже очень далеко, хо-
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тя и предстоит ещё много. Layout – это сложная программа, требующая внимательности, 
аккуратности и немало вспомогательных знаний. Если Вы сейчас видите перед собой на эк-
ране компьютера то, что изображено на рис.  3-37, Вы по праву можете гордиться собой. 
А я – собой, потому что мне удалось провести Вас до этой, хотя и промежуточной, но, не-
сомненно, – вершины. 

Отчёт AutoECO можно просмотреть повторно. Он находится в рабочей директории в 
файлах с расширением .lis. 

Ошибки во время трансляции записываются в файлы .err. Названия файлов совпадают 
с названием главного файла – файла .max. 

Интересное явление! Если Вы повторно запустите утилиту AutoECO и попытаетесь 
ещё раз оттранслировать netlist в Layout, то с удивлением можете заметить, что окно Link 
Footprint to Component (рис.  3-35) больше не появляется! Layout где-то запомнил новые 
данные. Это с одной стороны хорошо, но иногда, может и мешать. Поэтому полезно знать, 
где хранится эта информация. 

Есть два текстовых файла, в которых Layout Plus хранит  информацию о соответствии 
элементов OrCAD Capture их footprint-ам. Оба они находятся в директории: 

…\layout_plus\data 

Первый называется system.prt. Он устанавливается вместе с программой, и изменять 
его не стоит. 

Второй называется USER.PRT. Если в netlist-е отсутствуют данные о footprint-е како-
го-либо компонента, то утилита AutoECO проверяет свои записи в USER.PRT, потом в sys-
tem.prt и лишь затем выдает запрос на установление соответствия вручную. 

В нашем случае файл USER.PRT выглядит так: 

! ********************************************************* 
! AutoECO edits: Jul 6, 2005  --  11:16 am 
! Source file: C:\MY\BOOK\CLOCK\6_7_2005\CLOCK.MNL 
! ========================================================= 
! Source FP             -   Layout FP 
! ========================================================= 
  "TLR336T"             -  "7LED 336T" 

3.5. Technology templates. 
Описание всех файлов, используемых Layout Plus можно найти в описании OrCAD 

Layout® User’s Guide, поставляемом вместе с общим пакетом on-line документации. Часть 
этих файлов находится в системной директории Layout, часть – в директории проекта. Неко-
торые мы уже знаем, на других, если будет необходимость, остановимся позже. Я не соби-
раюсь пересказывать то, что Вы можете прочитать самостоятельно. Однако для полноты 
книги требуется, чтобы я рассказал о существующих в системе шаблонах. Соображать тут, 
как говорится, нечего – знать надо53. Поэтому со ссылкой на вышеупомянутый документ, я 
предоставлю слово разработчикам этих шаблонов54. 

Используя technology template, Вы, тем самым, определяете класс (уровень) требова-
ний, касающийся сложности производства Вашей платы. Существует три уровня технологи-
ческой сложности (согласно IPC-В-275). Они определяют общие параметры PCB, правила 
размещения компонентов и правила маршрутизации, что, в свою очередь, находит отраже-
ние в выборе материалов и инструментов для производства, задаёт повышенные требова-
ния к каждому технологическому процессу. 
                                                 

53 Фраза из фильма «Москва – Кассиопея». 
54 OrCAD Layout User’s Guide, page 121. 

OrCAD Layout Plus 

 Стр. 143 

� Уровень А (дизайн обычной сложности; предпочтительный). Согласно тех-
нологии, возможно провести один трек между двумя выводами стандартной 
DIP-микросхемы55 (рис.  3-38). Минимальное расстояние между треками – 12 
милей. 

� Уровень B (дизайн средней сложности; стандартный). Разрешается провес-
ти два трека между двумя выводами стандартной DIP-микросхемы (рис.  3-39). 
Расстояние между треками – 8 милей. 

� Уровень С (дизайн повышенной сложности). Разрешается провести три тре-
ка между двумя выводами стандартной DIP-микросхемы (рис.  3-40). Расстояние 
между треками – 6 милей. 

 
рис.  3-38 

 
рис.  3-39 

 
рис.  3-40 

Следует отметить, что уровни технологической сложности определяют требования не 
только для PCB, но и для footprint-ов. К примеру, на приведённых выше рисунках использо-
ван один и тот же footprint DIP.100/14/W.300/L.750 из библиотеки DIP100T. Диаметр pad-а в 
слоях TOP, BOTTOM и INNER равен 58 милей. Это вполне удовлетворяет требованиям 
уровня A. Однако вы ни за что не сможете провести между выводами этого footprint-а две и, 
тем более, три дорожки, как это определяется уровнями B и C. 

 
рис.  3-41 

 
рис.  3-42 

 
рис.  3-43 

На рис.  3-41 - рис.  3-43 хорошо видно, что диаметр pad-а приходится уменьшать, для 
чего необходимо редактировать footprint. 

Приведённая ниже таблица позволит Вам лучше разобраться во всей этой математике. 

 DIP Pad size Net width Route spacing 
Уровень A 62 12 12 
Уровень B 54 10 8 
Уровень C 50 6 6 

Обратите внимание, что в слоях PLANE диаметр pad-а не меняется. Это и понятно. 
Ведь в слоях типа PLAIN никаких дорожек не бывает. Весь слой – это одна зона сплошной 

                                                 
55 Расстояние между соседними выводами – 100 mil. 
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заливки медью, предназначенная для распределения цепей земли или питания. 
Диаметр DIP-pad-а в слоях PLAIN независимо от установленного уровня технологиче-

ской сложности составляет 78 милей. 

Далее с минимальными пояснениями: описание Technology Templates, входящих в па-
кет OrCAD Layout Plus. 

1BET_ANY.TCH 
Шаблон, соответствующий уровню A. Выводы стандартных DIP-корпусов имеют сле-

дующие параметры: PAD = 62 mil, отверстия = 38 mil. Сетки привязки (см. стр. 25): маршру-
тизации = 25 mil; размещения vias = 25 mil; размещения компонентов = 100 mil; расстояние 
между треками = 12 mil. 

2BET_SMT.TCH 
Шаблон, соответствующий уровню B. Используется для плат, проектируемых на осно-

ве SMT или thruhole-технологии (смешанной). Выводы стандартных DIP-корпусов имеют 
следующие параметры: PAD = 54 mil, отверстия = 34 mil. Сетки привязки: маршрутизации = 
8⅓ mil; размещения vias = 8⅓ mil; размещения компонентов = 50 mil; расстояние между тре-
ками = 8 mil. 

2BET_THR.TCH 
Шаблон, соответствующий уровню B. Используется для плат, проектируемых на осно-

ве thruhole-технологии. Выводы стандартных DIP-корпусов имеют следующие параметры: 
PAD = 54 mil, отверстия = 34 mil. Сетки привязки: маршрутизации = 20 mil; размещения vias = 
20 mil; размещения компонентов = 100 mil; расстояние между треками = 8 mil. 

386LIB.TCH 
Используется для работы с файлами OrCAD PCB386+. 

3BET_ANY.TCH 
Шаблон, соответствующий уровню C. Выводы стандартных DIP-корпусов имеют сле-

дующие параметры: PAD = 50 mil, отверстия = 34 mil. Сетки привязки: маршрутизации = 12½ 
mil; размещения vias = 12½ mil; размещения компонентов = 50 mil; расстояние между трека-
ми = 6 mil. 

METRIC.TCH, CERAMIC.TCH, HYBRID.TCH, MCM.TCH56 
Метрические шаблоны со следующими параметрами: сетка привязки маршрутизации и 

размещения vias = 10 mil; размещения компонентов = 50 mil; расстояние между треками = 10 
mil. 

Если Вы собираетесь использовать метрические шаблоны, то и netlist тоже должны 
создать в метрической системе измерений. Для этого в окне «Create Netlist» (рис.  3-32) в по-
ле Options выберите «User Properties are in millimeters». 

_DEFAULT.TCH, DEFAULT.TCH57 
Шаблон, соответствующий уровню A и используемый по умолчанию. Выводы стан-

дартных DIP-корпусов имеют следующие параметры: PAD = 62 mil, отверстия = 38 mil. Сетки 
привязки: маршрутизации = 25 mil; размещения vias = 25 mil; размещения компонентов = 100 
mil; расстояние между треками = 12 mil. 

JUMP5535.TCH, JUMP6035.TCH, JUMP6238.TCH 
Шаблоны идентичны другим шаблонам уровня A. Позиционируются как шаблоны для 

разработки плат с перемычками. Слой TOP описывается как JUMPER Layer, слой BOTTOM – 
Routing. Для перемычек предусматриваются vias с размером pad-а 55, 60, 62 mil и отверсти-
ем 35, 35 или 38 mil соответственно. 

                                                 
56 Шаблоны, похоже, полностью идентичны. 
57 Идентичны 1BET_ANY. 

OrCAD Layout Plus 

 Стр. 145 

P99SE.TCH, PROTEL.TCH 
Очень интересные шаблоны! Интересны они тем, что позволяют создать 20-слойную 

плату58. Оба шаблона – дюймовые. Предназначены для трансляции файлов из Protel. Соот-
ветствуют технологической сложности уровня A. 

CADSTAR.TCH, PADS.TCH, TANGO.TCH 
Шаблоны предназначены для трансляции файлов из соответствующих программ. 

TUTOR.TCH 
Учебный шаблон. 

Возвращаясь к нашему проекту… Все параметры платы мы установим самостоятельно, 
поэтому нам сейчас неважно, какой шаблон применить. Пусть это будет шаблон, предлагае-
мый по умолчанию – _default.tch. 

3.6. Граница платы. 
После Forward annotating необходимо определить размеры и форму будущей печатной 

платы. Сделать это можно тремя способами. 

Первый – загрузить заготовку платы из шаблона. Если бы у нас была такая заготовка, 
её следовало бы указать в поле «Шаблоны» (рис.  3-34 c). Заготовки у нас нет, поэтому пе-
рейдём ко второму способу. 

Второй способ заключается в том, чтобы, используя инструмент Obstacle Tool, нари-
совать контур платы вручную. Как Вы помните, мы должны использовать obstacle Board 
Outline, расположенную в слое Global. Рисовать можно мышкой, используя сетку привязки 
или последовательно вводя координаты вершин фигуры, которая образует нашу плату. 

Рисовать различные фигуры Вы уже умеете, поэтому рассмотрим третий способ. 

Третий способ заключается в импорте чертежа PCB, который подготовил для Вас ин-
женер-механик в программе AutoCAD или SolidWorks. Вы должны получить файл, который 
имеет расширение .dxf (рис.  3-44). 

60
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рис.  3-44 

В окне Layout Session выберите команду «File → Import → DXF to Layout» (рис. 
 3-45). 

                                                 
58 В самом начале книги говорилось, что OrCAD Layout Plus может работать одновременно с 30-ю слоями, из 

которых 16 могут быть маршрутизируемыми. Далее мы увидим, как можно «обмануть» программу, и довести 
количество маршрутизируемых слоёв до 20. 
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рис.  3-45 

В следующем окне укажите необходимые данные (рис.  3-46). Файл конфигурации в 
поле DXF ini File появится автоматически. 

 
рис.  3-46 

Нажмите кнопку <Interact>. Откроется один из «помощников» Layout – чертёжный 
редактор OrCAD Visual CADD. 

Раньше Visual CADD был основным инструментом доработки механических чертежей 
в среде OrCAD. Начиная с пакета версии 10, в состав системы входит более мощный редак-
тор IntelliCAD 2001. Visual CADD сохранился, и используется, главным образом, именно 
для импорта .dxf-файлов в Layout. 

Вы должны увидеть следующее окно (рис.  3-47): 
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рис.  3-47 

Вам необходимо выделить границу платы, чтобы перенести её в Layout. 
Board Outline должна отвечать следующим требованиям: 

¾ Такая obstacle может быть одна – и только одна – во всём чертеже (дизайне) пе-
чатной платы; 

¾ Obstacle Board Outline должна быть замкнутой и непрерывной; 

Это значит, что мы не можем импортировать в Layout чертёж целиком, в том виде, как 
он показан на рис.  3-47 – вместе с нарисованными отверстиями, текстом и размерами. Нам 
нужна только линия, очерчивающая плату, а всё остальное придётся добавлять позже. 

Если это непонятно, я объясню. 
Почему, например, нельзя импортировать Board Outline уже вместе с заготовленным 

отверстием, как это видно на рис.  3-47 c? 
Нельзя потому что тогда у нас получится две obstacles Board Outline. 
Ну и что? Пусть будет две. Откуда такое ограничение? 
Не всё так просто. Для нас, разводчиков PCB, отверстие в плате – это компонент. Такой 

же равноправный, как и все другие компоненты, присутствующие в netlist-е. Вспомните, в 
своё время мы посвятили целую главу описанию крепёжного отверстия. Внутри него может 
быть металлизация или нет (non-plated). В слоях TOP и BOTTOM могут быть предусмотрены 
колечки pad-ов для шляпки винта. Наконец, крепёжное отверстие может принимать участие в 
маршрутизации. Например, иметь соединение с землёй. 

Поэтому для каждого такого отверстия придётся изготавливать footprint, а потом, све-
ряясь с механическим чертежом, точно помещать его на своё место. 

То же самое относится и к различным вырезам на плате. Если внутри PCB нужно выре-
зать слот, можно воспользоваться способом, описанным в главе «PAD-ы с некруглыми от-
верстиями.» Если же вырез имеет сложную форму, то в дизайне он описывается особым спо-
собом. Как – мы рассмотрим позже. 

1
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Однако, если Вам очень хочется, (а зачастую так и приходится делать), то чертёж мож-
но импортировать целиком, поместив его в один из документальных слоёв. Он будет «про-
свечивать» сквозь плату, и это можно использовать просто для самопроверки. 

Как в редакторе Visual CADD выделить нужную фигуру? 

Первый способ. Войдите в меню и выберите: «Edit → Select → Object», после чего 
укажите мышкой на желаемый объект. 

В зависимости от методов, которые привык использовать в своей работе Ваш инженер-
механик, этот способ может не сработать. Например, выберется не вся фигура, а только одна 
из линий, образующих её. 

Поэтому существует другой способ, заключающийся в удалении всего лишнего с чер-
тежа, как показано на рис.  3-48. 

 
рис.  3-48 

После этого выбираем команду: «Edit → Select → All» и нажимаем на кнопку <Con-
vert to MAX [MX2]>. 

 
рис.  3-49 

В новом окне (рис.  3-49) указываем, что выбранная фигура превратится в obstacle 
Board Outline, расположенную в слое Global. 

Нажимаем кнопку <Options>, и в очередном окне (рис.  3-50) выбираем единицы изме-
рения. Обратите внимание, что речь идёт о единицах измерения DXF-файла, а не дизайна 
Layout. 

Последовательно нажимаем кнопки <OK> в одном окне, потом в другом, закрываем 
Visual CADD и наблюдаем завершение работы утилиты импорта DXF to MAX. 

1
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рис.  3-50 

К достоинствам второго способа преобразования относится тот факт, что если фигура, 
образующая плату в DXF-файле имеет невидимые на чертеже разрывы, такие, как на рис. 
 3-48 c, то утилита DXF to MAX автоматически соединит их. 

Мы получили файл Board.max. Откройте его (рис.  3-51). 

 
рис.  3-51 

 Необходимо проверить, что нет никаких ошибок. Для этого, во-первых, убедитесь, что 
видимая фигура действительно образована obstacle Board Outline. Для этого необходимо вы-
брать инструмент Obstacle Tool, щёлкнуть по нашей obstacle и проверить её свойства. 

Во-вторых, нужно измерить полученную PCB. 

Выберите инструмент для проставления размеров: 
«Tool → Dimension → New». Вы увидите, что курсор пре-
вратился из большого крестика в маленький. В Layout Plus 
это – признак активности какого-то инструмента. 

Теперь щёлкните правой кнопкой мыши и в контекст-
ном меню (рис.  3-52) укажите «Snap To Board Outline». Это 
значит, что курсор будет «цепляться» к границе платы. 

Щёлкните правой кнопкой мыши ещё раз и войдите в 
«Properties…». 

рис.  3-52 
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Укажите необходимые параметры, как пока-

зано на рис.  3-53. 

Dimension Type: Relative – значит, что изме-
рение будет произведено между двумя точками; 
Absolute – между указанной точкой и началом ко-
ординат (Datum). 

Arrow Style: задаёт внешний вид стрелок. 

Include units in text: в зависимости от теку-
щей системы измерений, рядом с цифровым зна-
чением измеренной величины будет указано 
«mm» – миллиметры или «m» – мили. 

Layer: слой, в котором будет расположены 
замеры. 

Располагайте все измерения в монтажном 
слое, т.е. в слое ASYTOP. 

 
рис.  3-53 

Нажмите <OK> и проведите мышкой вокруг платы. Вы увидите особый маркер, кото-
рый двигается синхронно с указателем мыши, цепляясь к границе платы (рис.  3-54 c). 

 
рис.  3-54 

Расположите указатель мыши немного выше Board Outline, чтобы маркер оказался в 
левом верхнем углу платы, и щёлкните мышкой. Потяните мышку влево, как показано на 
рис.  3-54 и щёлкните ещё раз. 

Если нужно удалить измерительные стрелки с чертежа, выберите: «Tool → Dimension 
→ Select Tool», потом щёлкните по стрелке и нажмите клавишу <Del>. 

Сравните измеренную длину платы с указанной на рис.  3-44. Если она составляет 60 
мм, значит, Вы всё сделали правильно. Если же измеренная величина отличается от задан-
ной, значит, придётся подбирать коэффициент масштабирования. Вот как это делается. 

Посчитайте отношение измеренной величины к заданной, после чего повторите проце-
дуру импорта заново. В Visual CADD, находясь в окне Setup, в поле DXF File Units укажите 
«Use Custom Scale Factor», а в поле Custom Scale Factor – коэффициент соответствия. По-
сле этого всё должно быть в порядке. 

Закройте дизайн, сохранив его под именем «Board1.max». 
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3.7. Логотип фирмы. 
Давайте ещё немного потренируемся и научимся делать собственный логотип – произ-

вольный рисунок, который можно будет потом нанести на готовую PCB. 

Для этой цели Вам понадобится какой-нибудь редактор векторной графики, способный 
экспортировать изображение в DXF-формат. Например, Macromedia Flash. 

 
рис.  3-55 

Приготовьте рисунок (рис.  3-55), и экспортируйте его в DXF. После чего запустите 
утилиту импорта DXF to MAX. 

В редакторе Visual CADD выберите: «Edit → Select → All». 
В окне Translate Selections to MAX (рис.  3-56) укажите параметры obstacles «Free 

Track» и слой «SSTOP». 

 
рис.  3-56 

В следующем окне: «Use Custom Scale Factor» и прочие величины (здесь придётся 
экспериментировать) (рис.  3-57). 

 
рис.  3-57 
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Завершите импорт, откройте получившийся файл (назовём его «Crab.max») и посмот-
рите, что получилось (рис.  3-58): 

 
рис.  3-58 

3.8. Слияние файлов. 
Теперь у нас есть три файла: 00.max – PCB с компонентами; Board.max – PCB с Board 

Outline; Crab.max – с логотипом. Из трёх файлов необходимо получить один. 

Откройте 00.max. Теперь выберите: «File → Load…». 

 
рис.  3-59 

В окне диалога выберите тип файла: «Merge board (*.max)» и укажите файл 
Board.max. Вот что примерно должно получиться (рис.  3-60). 

 
рис.  3-60 

Повторите процедуру с файлом «Crab.max» (рис.  3-61). 
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рис.  3-61 

Если у Вас получилось не так компактно, сдвиньте элементы дизайна плотнее. 

Чтобы подвинуть Obstacle, выберите Obstacle Tool, потом обведите её мышкой и, 
удерживая левую кнопку мыши, передвиньте в нужное место. 

Чтобы сдвинуть Drill Chart, выберите: «Tool → Drill Chart → Move Drill Chart». По-
сле чего укажите мышкой, где должен находиться верхний левый угол таблицы. 

Чтобы переместить компоненты, расположенные слева, выключите инструмент Online 
DRC (рис.  3-62) и выберите Component Tool (рис.  3-63). После этого, выбранные компонен-
ты можно двигать произвольно. 

 
рис.  3-62 

 
рис.  3-63 

Теперь необходимо совместить Datum с левым нижним углом платы. 

 
рис.  3-64 

1 – Board Outline; 
2 – Маркер; 
3 – Datum; 
4 – Drill Chart. 

Просто мышкой это сделать не получится, потому что указатель мыши всегда цепляет-
ся к сетке привязки, а нам нужно совместить абсолютно точно. Значит, нужно узнать коор-
динаты угла. 

2
3

1
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Единицу измерения устанавливаем – мили, выбираем Dimension Tool с параметрами: 
Snap to Board Outline и Absolute Dimensions. После чего определяем искомые координаты 
(рис.  3-64). 

Меняем параметры на Gridless Dimensioning и далее: «Tool → Dimension → Move Da-
tum». Чтобы указать точные координаты, как Вы помните, нажимаем клавишу <Tab> (рис. 
 3-65): 

 
рис.  3-65  

рис.  3-66 
Проверяем (рис.  3-66), после чего координатные метки можно стереть. 

Следует сказать, что именно с точной установкой Datum имеются некоторые пробле-
мы. Возможно, это наблюдается не во всех версиях OrCAD Layout Plus, но зачастую выше-
указанная процедура не работает. Datum не перемещается. Если Вы делаете всё, как надо, 
однако, ничего не получается, поступите следующим образом. Установите шаг сеток привяз-
ки равным 1 mil. Определите координаты угла платы как показано на рис.  3-64, выберите 
команду Move Datum и, сверяясь по координатам курсора мыши в строке состояния в ниж-
ней части экрана (рис.  3-67), аккуратно переместите Datum в нужное место. Проверьте ре-
зультат (рис.  3-66). 

 
рис.  3-67 

Теперь проверьте свойства obstacle Board Outline (рис.  3-68): 

 
рис.  3-68 

Board Outline

Global Layer
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Особо обратите внимание на параметр Width. Если Вы применяете в своей плате 
PLAIN-layers, то половинное значение Width определяет зазор между краем платы и медным 
полем слоя Plain. По умолчанию этот параметр равен 50 mil. Однако если имеются компо-
ненты слишком близко расположенные к краю платы, чрезмерная толщина Board Outline 
может мешать. 

Следующий шаг – скопируйте obstacle Board Outline в слои монтажа ASYTOP и 
ASYBOT. Согласитесь, что это разумно – видеть контур платы в монтажном слое? 

Расставьте размеры, какие считаете нужными. Поместите их в слое ASYTOP. 

Выделите логотип целиком (краба), и определите тип obstacles как Detail, слой SSTOP. 

Теперь, после наведения порядка (рис.  3-69) сохраните файл под очередным номером 
(у меня это – 02.max). 

 
рис.  3-69 

3.9. Ошибки подключения питания. 
Если Вы думаете, что пришло время размещения компонентов, то Вы, мягко говоря, 

торопитесь. Мы опять возвращаемся к принципиальной схеме. В главе  3.2 мы проверили все 
элементы схемы, чтобы убедиться, что номера выводов соответствуют действительности. 
Если этого не делать, то с вероятностью 50% все диоды и конденсаторы окажутся подклю-
чёнными задом наперёд. Это, бесспорно, будет ошибка разводчика платы. 

Там же мы увидели, что некоторые элементы в зависимости от исполнения могут 
иметь разную нумерацию выводов (речь идёт о транзисторе 2N2222). Если Вы упустите из 
вида этот факт, то впоследствии, несмотря на все свои предыдущие заслуги, услышите о себе 
немало тёплых слов. 

Сейчас мы рассмотрим некоторые ошибки – действительно ошибки, которые принесут 
Вам вместе с принципиальной схемой. Несмотря на то, что это ошибки не Ваши, в конечном 
счёте, касаются они только Вас. Вы должны знать их, в противном случае, плата может ока-
заться неработоспособной. 

В этой главе мы рассмотрим только два вида таких ошибок, и оба они связаны с пи-
тающими цепями. 
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Первая – самая простая. Вы, очевидно, знаете, что у большинства цифровых микросхем 
выводы питания не показывают, чтобы не загромождать общую схему. В главе  3.2 мы от-
крывали номера выводов всех полярных элементов, теперь нужно то же самое проделать с 
микросхемами. 

Быть может, Вы спросите, почему мы не сделали это сразу? Не сделали, потому что на 
принципиальной схеме мы ничего бы и не заметили. Я хотел, чтобы Вы увидели получив-
шиеся соединения в Layout, живьём, так сказать. 

Найдите на схеме микросхему U1 и откройте её выводы питания, сменив, заодно их 
тип с «Zero Length» на «Short». На схеме это будет выглядеть так (рис.  3-70): 
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рис.  3-70 

Вывод #3 м/с называется Vcc. К какой цепи он подключён? 

 
рис.  3-71 
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2 
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Щёлкните дважды по U1, чтобы войти в Property Editor (рис.  3-71), выберите фильтр 
OrCAD-Capture (c), а внизу – вкладку Pins (d). Теперь посмотрим… 

Вывод #14 (поле Number) имеет имя GND (Name) и подключён к цепи GND (Net 
Name). Правильно. 

Вывод #3 имеет имя Vcc и подключён к цепи Vcc. Вот и ошибка! На схеме имеются 
две цепи питания: Vcc и +6V. U1 должна быть подключена к цепи +6V. 

Теперь перейдите в Layout Plus и найдите компонент U1. Для этого нажмите клавишу 
<Tab> и введите в поле Item Name значение U1.3 (рис.  3-72): 

 
рис.  3-72 

 
рис.  3-73 

Курсор переместится в требуемое место. Выберите инструмент Pin Tool (рис.  3-73) и 
щёлкните по выводу #3 (рис.  3-74). 

 
рис.  3-74 

В строке состояния, как и следует ожидать, написано, что вывод соединён с цепью Vcc. 

Как это можно исправить? 
Первый способ, в данном случае неправильный, – переподключить вывод прямо в Lay-

out Plus. Вызовите окно свойств (делается это, как всегда, комбинацией клавиш <Ctrl>+<E>) 
и из выпадающего списка Net name выберите правильное подключение (рис.  3-75): 

 
рис.  3-75 
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Второй способ заключается в том, чтобы внести исправления на схеме59. Так, как пока-
зано на рис.  3-76. 
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рис.  3-76 

Сделайте Forward Annotating, причём на этапе создания netlist-а в окне Create Netlist 
(рис.  3-32) установите флажок Run ECO to Layout. Если у Вас открыт Layout Plus с теку-
щим файлом 02.max, это вызовет процедуру автоматического обновления данных. 

Сохраните файл как 03.max и проверьте отчёт утилиты AutoECO: 

AutoECO Report 
FILE-A: C:\CLOCK\02.MAX 
FILE-B: C:\CLOCK\CLOCK.MNL 
If "*EOF*" immediately follows, no changes were made 
Adding package MC14489DW_2 c 
Adding U1.3 to net +6V d 
Deleting U1.3 from net VCC e 
*EOF* 
No errors found 

Поскольку микросхема U1 редактировалась, новые данные передаются в Layout, о чём 
сообщается в строке c. 

В строке e говорится о том, что вывод 3 микросхемы U1 был отключён от цепи Vcc. 
В строке d сообщается, что тот же вывод подключён к цепи +6V. 

Итак, первый тип ошибок подключения питания связан с тем, что на принципиальной 
схеме забывают указывать Power pins для микросхем. Для проверки вызываем Property Editor 
и во вкладке Pins смотрим правильность подключения выводов питания соответствующим 
цепям. 

Второй тип ошибок несравненно коварнее. В OrCAD Capture откройте окно Property 
Editor, как мы это делали ранее (рис.  3-26), перейдите на вкладку Schematic Nets и окиньте 
взглядом существующие цепи. Понятно, что если схема очень велика, то никакого взгляда не 
хватит. Но нас все цепи и не интересуют. Нас интересуют только цепи питания и земли, а 
посему, ищем строчки, которые начинаются с цифры (например, 3.3V), со знака (например, 
+5V или -Vcc), а также характерные сокращения (VDD, VSS, GND). 

И сразу же находим то, что искали! В строке #22 (рис.  3-77) присутствует цепь 
GND_POWER, а в строке #23 – цепь GND. Это интересно! Обнаружились две цепи земли! 

 
                                                 

59 Разумеется, прежде чем вносить какие-либо изменения в схему, даже если они для Вас очевидны, прокон-
сультируйтесь с её разработчиком. Быть может, что Вы-то как раз и ошибаетесь. 
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рис.  3-77 

Перейдём на вкладку Globals. Это – то, что нам нужно. Globals – это таблица не цепей, 
а символов земли и питания, присутствующих на схеме. 

 
рис.  3-78 

Измените цвет символов GND_POWER (рис.  3-78) и найдите их на схеме (рис.  3-79). 
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рис.  3-79 

Теперь подсветите цепь у синих символов. Для этого щёлкните по одному из проводов 



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 160 

правой кнопкой мыши и выберите «Select Entire Net» (рис.  3-80): 

 
рис.  3-80 

Сомнений быть не может, на схеме имеется две независимые земли! Осталось только 
понять, как это произошло. 

Вновь посмотрите на рис.  3-78. Для обозначения земли в библиотеке OrCAD Capture 
CAPSYM имеются два символа, которые выглядят совершенно одинаково. Один – это GND, 
а другой – GND_POWER (рис.  3-81). 

 
рис.  3-81 

Для построения схемы в некоторых случаях использовали первый, а в некоторых – 
второй. Соответственно и цепи приняли разные названия. 

Исправить это можно разными способами. Во-первых, объединить две цепи в Layout. 
Выберите инструмент Connection Tool (рис.  3-82). 

 
рис.  3-82 

Затем щёлкните мышкой по второму выводу U3 и протяните ниточку к первому выво-
ду разъёма J2. 

Layout выдаст запрос на подтверждение слияния двух цепей (рис.  3-83). В следующем 
окне будет предложено выбрать название цепи (рис.  3-84). 
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рис.  3-83 

 
рис.  3-84 

В Capture разные земли можно соединить проводником (рис.  3-85)… 
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рис.  3-85 

…или, что то же самое, присвоить цепи имя (рис.  3-86): 
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рис.  3-86 

В последних двух случаях, цепь будет иметь двойное имя (рис.  3-87), что ошибкой не 
является. 

 
рис.  3-87 

 
рис.  3-88 

Кстати, на схеме есть ещё одна цепь с двойным именем. Это – цепь Vcc, она же 3.6V. 
Рассмотрите схему внимательно и постарайтесь самостоятельно понять, как это получилось. 

Самый правильный способ заключается в переименовании символов земли 
GND_POWER в GND с помощью Property Editor-а. Заодно, это поможет лучше понять, чем 
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отличаются экраны на рис.  3-77 и рис.  3-78. 

 
рис.  3-89 

Измените имя одного из символов на GND (рис.  3-89) и подсветите цепь GND_POWER 
(рис.  3-90). Как видите, после изменения имени символа земли, цепь также поменяла своё 
имя, подключившись к цепи GND. 

 
рис.  3-90 

Поменяйте имена для остальных «неправильных» символов, а заодно верните им цвет 
по умолчанию и сделайте Forward Annotating. 

AutoECO Report 
FILE-A: C:\CLOCK\03.MAX 
FILE-B: C:\CLOCK\CLOCK.MNL 
If "*EOF*" immediately follows, no changes were made 
Adding U3.2 to net GND 
Adding R16.2 to net GND 
Adding C6.2 to net GND 
Adding C4.2 to net GND 
Deleting net GND_POWER 
*EOF* 
No errors found 

Надеюсь, в отчёте AutoECO всё понятно. 

Сохраните файл под именем 04.max. 

Обратите внимание, что мы ни разу не воспользовались встроенным в Capture средст-
вом Design Rule Check (рис.  3-91). Этот инструмент предназначен немного для других це-
лей, и разводчику PCB от него пользы мало. 
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рис.  3-91 

Больше в данной схеме ошибок нет, однако, это не значит, что мы рассмотрели все ва-
рианты. Позже мы специально вернёмся к этой теме ещё раз. 

3.10. Группировка компонентов. 
Для дальнейшей работы очень удобно объединить компоненты в группы. На рис.  3-94 

показан один из вариантов. К примеру, компоненты, образующие преобразователь питания, 
входят в группу #2. 

Выделите мышкой на схеме компоненты группы #4, после чего откройте окно Property 
Editor (рис.  3-92). 

 
рис.  3-92 

Установите фильтр OrCAD-Layout, после чего выделите целиком столбец 
COMPGROUP, нажмите <Ctrl>+<E> и впишите значение «4». 

Больше ничего интересного в этой таблице нет. 
Повторите эту операцию, чтобы установить остальные группы. Компоненты можно 

выбирать мышкой, охватывая их в рамочку или щёлкая по ним, удерживая клавишу <Ctrl>. 

 
рис.  3-93 
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рис.  3-94 
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Перейдите в Project Manager и откройте Property Editor, чтобы видны были свойства 
всех компонентов (рис.  3-93). 

Отсортируйте таблицу по значениям столбца COMPGROUP, для чего щёлкните дваж-
ды по его заголовку. Если Вы ничего не пропустили, то в группе «0» окажутся четыре ком-
понента, не вошедшие ни в одну из шести групп. 

Отправим новую информацию в Layout. Процедура обычная – создаём обновлённый 
netlist, утилита AutoECO запустится автоматически. 

 
рис.  3-95 

Чтобы обновить свойства компонентов, в поле Options выбираем «AutoECO Override 
Attrs». Напомню, что обычная процедура AutoECO служит для передачи информации толь-
ко об изменившихся связях в схеме, о новых или удалённых компонентах. Атрибуты и свой-
ства уже имеющихся компонентов и цепей не обновляются. 

 
рис.  3-96 

После окончания Forward Annotating проверьте в Layout свойства какого-либо компо-
нента (рис.  3-96). Убедитесь, то поле Group # соответствует присвоенной группе.  
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3.11. Back Annotating. 
Для упрощения следующей задачи познакомимся с одной очень полезной процедурой, 

которая называется «Back Annotating». 
Если Forward Annotating служит для передачи данных из Capture в Layout, то Back An-

notating, как следует из названия, выполняет прямо противоположную функцию – передача 
данных из Layout в Capture. 

Делается это по команде в Layout: «Auto → Back Annotate». В рабочей директории 
появится текстовый файл с расширением .SWP. После этого в Capture выбирается инстру-
мент Back annotate (рис.  3-97). 

 
рис.  3-97 

В новом окне укажите путь к этому файлу и, не изменяя других опций, нажмите <OK>. 

 
рис.  3-98 

Процедура Back Annotating передаёт в Capture сведения о свойствах компонентов и 
цепей. Не передаются данные, касающиеся каких-либо изменений схематики. А именно: 

– иное подключение цепей; 
– добавление новых или удаление существующих цепей; 
– добавление или удаление компонентов в Layout. 

Согласитесь, что если бы мы внесли изменения на PCB, а Capture сам перерисовал бы 
принципиальную схему, это было бы просто чудо! 

3.12. Net Properties. 
В этой главе я собираюсь показать, как установить для цепей необходимые атрибуты, 

которые будут использованы для построения PCB. 
Открыв Property Editor на вкладке Schematic Nets, мы увидим доступные для измене-

ний свойства цепи (рис.  3-99). 
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рис.  3-99 

Как узнать, что означают эти поля? Впрочем, даже если названия некоторых столбцов 
кажутся интуитивно понятными, как правильно задать параметры? Каков синтаксис каждого 
поля? 

Можно было бы написать, что, дескать, «в это поле впишите такое-то значение, а в 
другое – такое». Но я хочу, чтобы Вы не просто знали, а поняли, откуда эти значения берут-
ся. Как научиться добывать информацию? Искать ответы в Интернете, на форумах, звонить в 
службу поддержки или перерыть все файлы в директории \Doc, которая находится в папке 
Cadence? 

Почитать документацию, спору нет, всегда полезно. Однако же, сколько это займёт 
времени? Да и найдёте ли Вы там то, что ищете? Если бы книги об OrCAD были настолько 
просты, понятны и исчерпывающи, то я бы и не писал ничего сейчас. 

Сейчас мы сделаем так, что OrCAD нам сам всё расскажет, но прежде я предлагаю пе-
рейти в Layout и разобраться с тем, какие вообще бывают свойства у цепей? 

Откройте «Nets» spreadsheet (рис.  3-100): 

 
рис.  3-100 

Найдите цепь Vcc и, дважды щёлкнув по ней, откройте её свойства (рис.  3-101). 
Не вдаваясь досконально во все параметры, рассмотрим только те, которые нас интере-

суют. А именно: принадлежность цепи слоям. 

Мы можем определить слои платы, в которых разрешена маршрутизация конкретной 
цепи. Нажмите кнопку f (рис.  3-101), которая называется Net Layers… Откроется окно 
(рис.  3-102), в котором будут перечислены слои нашей PCB. 

Если Вы при создании платы использовали шаблон _default.tch, то у Вас сейчас долж-
но присутствовать шесть маршрутизируемых слоёв: TOP, BOTTOM, два внутренних и два – 
типа Plane. 

Установите флажки, как показано на рис.  3-102, разрешив, таким образом, прокладку 
дорожек цепи Vcc в слоях TOP и BOTTOM, и определив этой цепи Plane Layer POWER це-
ликом. 
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рис.  3-101 

Как Вы уже знаете, в слоях разводки земли и питания (Plane Layers) дорожек не бывает. 
Весь слой представляет собой сплошное поле, залитое медью. Возникает вполне естествен-
ное желание назначить этому слою ещё какую-нибудь цепь и посмотреть, что получится. 

 
рис.  3-102 

 
рис.  3-103 

Ничего не получится. Layout, как и следует ожидать, выдаст сообщение об ошибке 
(рис.  3-103), смысл которого сводится к следующему: нельзя назначить одновременно две 
цепи слою Plain. Однако можно использовать зоны Copper Pour в этом слое для разводки 
других цепей! 

Если мы хотим использовать эту возможность, то флажок в поле Plane Layers для той 
цепи, которая будет подсоединена к Copper Pour, нужно снять. 

Следующий параметр, который нас интересует – ширина дорожки. 

 
рис.  3-104 

Во-первых, указываем глобальные параметры – минимальное допустимое значение 
(рис.  3-101 c), значение по умолчанию (d) и максимальное значение (e). 

Во-вторых, нажимаем кнопку Width By Layer… (рис.  3-101 g) и задаём номинальное 
значение в каждом конкретном слое (рис.  3-104). 

Укажите так, как показано на рисунках. Это значения произвольные, просто для того, 
чтобы посмотреть, что получится потом. 

1 2 3

5 

4 

6
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Ещё одна настройка – расстояние между дорожкой указанной цепи и дорожками ос-
тальных цепей (рис.  3-101 h) на каждом слое. 

 
рис.  3-105 

Проставьте значения, как показано на рис.  3-105. 

В результате наших действий строчка VCC в таблице Nets (рис.  3-100) изменится сле-
дующим образом (рис.  3-106): 

 
рис.  3-106 

Звёздочки в поле Routing Enabled означают, что цепь имеет ограничения для разме-
щения по слоям. Надпись в этом поле «Yes*» означает, что цепь не имеет ограничений для 
размещения в слоях TOP, BOTTON и INNER, плюс к этому разрешён один из слоёв Plane. 

Надпись «No» сообщает, что цепь временно исключена из доступных к маршрутиза-
ции. 

А теперь пришёл момент увидеть, ради чего мы всё это делали. Отправим данные в 
OrCAD Capture с помощью операции Back Annotating. 

 
 

 

 
 
 
 
 
 
 

рис.  3-107 
Откройте в Capture Property Editor и найдите цепь Vcc (рис.  3-107)60. Ну, разве я не го-

                                                 
60 Загляните заодно и во вкладку Parts. 
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ворил, что OrCAD сам всё расскажет? Теперь осталось только заполнить поля для всех ос-
тальных цепей по готовому образцу (рис.  3-108). 

 
рис.  3-108 

Указываем ширину дорожек для цепей, как это оговаривалось на стр. 127. Для цепей 
Vcc и GND указываем дополнительно принадлежность к одному из Plain-слоёв. Все осталь-
ные параметры, которые не заданы в этой таблице, будут приняты Layout Plus исходя из су-
ществующих настроек по умолчанию. Например, если не указан параметр ROUTELAYERS, 
это значит, что возможна прокладка дорожки в любом из маршрутизируемых слоёв. 

Маленький вопрос. Зачем разрешать маршрутизацию в слоях TOP или BOTTOM для 
цепи, допустим, Vcc, если в её распоряжении целый Plane-layer? 

Если плата состоит целиком из thruhole-компонентов, то, может, и не нужно. Но как Вы 
сделаете соединения с SMD? Ведь они устанавливаются на поверхности. Если запретить раз-
водку цепи Vcc в слое TOP, то все SMD, расположенные на верхнем слое платы, останутся 
без питания. 

Завершая эту главу, передаём данные в Layout Plus утилитой AutoECO с параметром 
«AutoECO Override Attrs» или «AutoECO Net Attrs». 

3.13. Components Property Table. 
Ниже представлена таблица возможных свойств компонентов. 

Part property name Example value Description 
COMPFIXED YES Если YES, компонент (например, коннектор) 

будет неподвижно закреплён на плате. 
COMPGROUP 2 Целое число от 0 до 100, выражающее при-

надлежность компонента к определённой 
группе для последующего размещения на 
плате. 

COMPKEY YES Используется для указания «ключевого» ком-
понента в группе. Ключевой компонент по-
мещается на плату первым, в то время как ос-
тальные компоненты в группе размещаются в 
непосредственной близости. 

COMPLOC [1000, 1000] Координаты компонента на плате. В зависи-
мости от установленной системы измерений, 
выражаются в милях или в микронах. 

COMPLOCKED YES Если YES, компонент будет временно зафик-
сирован на текущей позиции. 
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COMPROT 270.00 Поворот компонента на плате, выраженный в 
углах и минутах против часовой стрелки. 
Точка (.) используется как разделитель углов 
и минут. Если компонент находится на обрат-
ной стороне PCB, мы всё равно смотрим на 
него со стороны слоя TOP, как бы сквозь пла-
ту. 

COMPSIDE BOT Определяет сторону PCB на которой установ-
лен компонент – TOP или BOTTOM. 

PCB FOOTPRINT DIP24 Footprint компонента. 
FPLIST DIP24\400 Список подходящих footprint-ов для данного 

компонента. Имена footprint-ов разделяются 
запятыми без пробела. В Layout доступны че-
рез контекстное меню Alternate Footprint. 

GATEGROUP 1 Назначает группу для вентиля (gate) в преде-
лах одного компонента (package)61, устанав-
ливая, таким образом, ограничения на пере-
становку gate-ми. Для совершения переста-
новки, два gate-а должны принадлежать одной 
группе. 

PARTNUM 489746 Part Number компонента – буквенно-
цифровой код, однозначно идентифицирую-
щий компонент, включая его производителя и 
тип корпуса. 

PARTSHAPE 74LS04 Основное обозначение компонента, такое как, 
например, 74LS04 или 2N2222, которое одно-
значно указывает на тип компонента, но не 
содержит в себе информации ни о типе кор-
пуса, ни о производителе. Если footprint для 
такого компонента не определён или не най-
ден, то поиск подходящего footprint-а будет 
осуществлён в файле SYSTEM.PRT. 

POWERPIN YES Режим отображения выводов питания компо-
нента. Обычно устанавливается, если нужно 
изменить стандартное подключение этих вы-
водов к цепям Vcc или Gnd. 

Удалить property можно, используя комбинацию клавиш <Ctrl>+<L>. 

3.14. Nets Property Table. 
Таблица возможных свойств цепей, транслируемых из Capture в Layout. 

Net property name Example value Description 
CONNWIDTH 10 Устанавливает номинальную ширину до-

рожки. 
HIGHLIGHT YES «Подсветка» цепи. 
MAXWIDTH 12 Устанавливает максимальную ширину до-

рожки. 
                                                 

61 См. гл.  1.4.12 «Составные компоненты.» на стр. 195. 
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4. Ручное размещение компонентов на плате. 

Продолжим работу в Layout Plus. 
В настоящий момент состояние проекта таково: принципиальная схема показана на 

рис.  3-94. Для всех компонентов подготовлены footprint-ы, а сами компоненты объединены в 
группы. Описаны основные свойства всех цепей схемы: минимальная, максимальная и пред-
почтительная ширина дорожек, а также принадлежность цепей слоям платы. В Capture соз-
дан netlist, который был передан в Layout Plus. Кроме того, мы уже подготовили контур пла-
ты, и даже логотип фирмы. 

В результате дизайн PCB выглядит как на рис.  3-69. 

Файлы в рабочей директории: 

*.opj – файл проекта OrCAD Capture. Содержит информацию о всех связанных фай-
лах, используемых Capture или созданных им. 

*.dsn  – файл дизайна Capture, или, попросту, схема. 
*.mnl – netlist. 
*.max – файлы PCB OrCAD Layout. Если Вы следуете моим советам, то сохраняете 

каждый новый файл под новым именем. У меня последний файл PCB имеет имя/версию 
“07.max”. 

*.olb – библиотека элементов OrCAD Capture. Если Вы рисовали некоторые элемен-
ты самостоятельно (например, такие как U1 и LD1~LD4), то, возможно, сохранили их изо-
бражения в собственной библиотеке. 

*.llb – библиотека footprint-ов. 
*.log – файл отчётов Layout. Отчёты о рутинных операциях. 
Backup.max – несколько файлов резервного сохранения, которые создаёт Layout. 
*.lis – отчёт утилиты AutoECO. 
*.err – отчёт утилиты AutoECO об ошибках. 
*.swp – файлы, сгенерированные Layout по команде Back Annotate. 

4.1. Параметры дизайна OrCAD Layout. 
Следующий шаг – определение параметров PCB. 

1. Количество и тип используемых слоёв. 
С целью обучения я предлагаю изготовить четырёхслойную плату, причём внутренние 

слои будут типа PLAIN. 

Здесь следует сказать, что в своей последующей практике Вы без особого ущерба для 
здоровья можете использовать вместо PLAIN слои типа INNER. INNER-слои дают бо́льшую 
свободу, а если такой слой целиком залить медью, используя зону Copper Pour, то, фактиче-
ски, он превратится в PLAIN63. Многие разработчики так и поступают. Различия в этом слу-
чае между PLAIN и INNER минимальные, и выражаются лишь в размере контактных площа-
док и в некоторых правилах проверки дизайна. 

Однако мы ведь учимся, правда? Поэтому определим два внутренних PLAIN-слоя, из 
которых один будет служить для разводки земли, а второй – для разводки питания. Причём, 
рассмотрим, как на одном PLANE-слое возможно развести одновременно две питающих це-
пи. 

Откройте «Layers». Сейчас должно быть определено 6 маршрутизируемых слоёв, как 
показано на рис.  4-1. 

                                                 
63 См. пояснение на стр. 338. 
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MINWIDTH 8 Устанавливает минимальную ширину до-
рожки. 

NETGROUP 2 Назначает цепь определённой группе. 
NETWEIGHT 60 Целое число от 1 до 100, указывающее на 

относительный приоритет (степень «важно-
сти») цепи. Имеет значение при автомати-
ческой разводке. По умолчанию, все цепи 
имеют приоритет 50. 

PLAINLAYERS GND Сопоставляет Plane layer цепи. 
RECONNTYPE ECL Определяет параметр Reconnect Rules.62 

Возможные значения: STD, HORZ, VERT, 
NONE, or ECL. 

ROUTELAYERS TOP,BOT Определяет слои, разрешённые для раз-
водки данной цепи. 

SPACINGBYLAYERS TOP=13,BOT=8 Минимальное расстояние Net-to-Net на ка-
ждом слое. 

TESTPOINT YES В случае YES, цепи автоматически назна-
чается Test Point. 

VIAPERNET VIA1 Типы vias, разрешённых для данной цепи. 
WIDTH 12 Параметр определяет ширину дорожки, ес-

ли параметры CONNWIDTH, MAXWIDTH и 
MINWIDTH не определены. 

WIDTHBYLAYER TOP=6,BOT=12 Ширина дорожки на каждом слое. 

Как и в предыдущем случае, <Ctrl>+<L> удаляет property. 

                                                 
62 См. @@@ 
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А именно: два наружных слоя TOP и BOTTOM, два внутренних – INNER1 и INNER2, и 
два слоя типа Plane – GND и POWER. 

 
рис.  4-1 

Уберите слои INNER, присвоив им тип «Unused» (рис.  4-2). 

 
рис.  4-2 

Остальные слои должны быть определены так, как это показано на рис.  4-3. 

 
рис.  4-3 

Два слоя маски – SM; два слоя паяльной пасты для монтажа SMD-компонентов – SP; 
два слоя Silkscreen – SS; монтажные слои – ASY; слои сверления DRLDWG и DRILL. 

Таков минимальный набор слоёв, который нам может понадобиться. 

2. Правила размещения. 
Следующим шаг – определение таких параметров как минимально допустимое рас-

стояние между дорожками и другими объектами на плате. 

Войдите: «Options → Global Spacing…». Откроется таблица, как на рис.  4-4. 
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рис.  4-4 

Несмотря на то, что команда называется «Global Spacing», имя таблицы – «Route Spac-
ing», т.е. речь идёт только о правилах, касающихся маршрутизации. 

В OrCAD Layout не определяются общие правила для расстояния между компонента-
ми. Считается, что это не нужно, так как физические границы каждого компонента описыва-
ются obstacle Place Outline. Единственное правило, которого Вы должны придерживаться, и 
придерживается его программа – это то, что obstacles Place Outline не должны перекрываться. 

В таблице указываются расстояния между маршрутизируемыми объектами в каждом 
слое: дорожками, vias, и контактными площадками (pads). Зоны заливки медью эквивалент-
ны дорожкам (tracks). 

Ничего пока не изменяйте в этой таблице. Расстояния в 12 милей вполне нам подходят. 

4.2. Color settings. 
Прежде, чем продолжить, создадим несколько цветовых правил – Color settings или 

Color rules. Это обеспечит гарантию, что Вы будете видеть дизайн таким, как вижу его я, и 
так как он показан на иллюстрациях этой книги. 

В главе «Цветовая таблица.» на стр. 91 мы уже создали одно правило для работы с 
Library Manager. Опишем ещё несколько. Созданные правила будем сохранять в директории 
Libraries\Colors как файлы с расширением .COL. 

ALL.COL – общая таблица. Видны все слои четырёхслойной платы. Слой TOP 
имеет голубой цвет, BOTTOM – красный. Зоны Copper Pour, чтобы не сливаться 
с дорожками, имеют более тёмный оттенок. Нити неразведённых цепей – rats-
nests – имеющие цвет слоя GLOBAL (или Conn64) по умолчанию показаны жёл-
тым. 

DRILL.COL – быстрое выключение всех слоёв. Остаются видны только граница пла-
ты, ratsnests и отверстия. При необходимости, нужный слой (например, 
ASYTOP) легко включить нажатием горячих клавиш. 

ASYTOP.COL и ASYBOT.COL – видны слои ASY и SS. Очень удобно на завершаю-
щем этапе работы над платой для расстановки надписей. 

                                                 
64 От слова «Connection» – соединение. 
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All.COL 

 
DRILL.COL 

 
ASYTOP.COL 

 
ASYBOT.COL 

PLACEMENT.COL – цветовая таблица, которую удобно использовать при размеще-
нии компонентов. Слой GLOBAL выключен, из-за чего ratsnests не видны. В то 
же время, правило «Board outline (Any layer)» позволяет видеть границу платы. 
При необходимости, ratsnests легко включаются/выключаются нажатием на кла-
виши <0> или <0>,<-> цифровой клавиатуры. Компоненты обозначены конту-
рами Place Outline. 
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ROUTING.COL – используется для ручной разводки. Видны все маршрутизируе-
мые слои, ratsnests, контуры компонентов. Правила для слоёв SS и ASY не уда-
лены, а скрыты. 

 
PLACEMENT.COL 

 
ROUTING.COL 

Созданные цветовые таблицы сохраните. Их можно использовать для работы над по-
следующими проектами. Если же Вам понадобится развести плату с количеством слоёв бо-
лее четырёх, просто добавьте в них правила для слоёв INNER. 

Хочу напомнить, что список горячих клавиш для быстрого перехода в нужный слой 
можно увидеть в таблице «Layers» (рис.  1-19). Чтобы скрыть или показать активный слой 
воспользуйтесь клавишей <-> на цифровой клавиатуре. 

4.3. User Preferences. 
Для собственного удобства Вам может быть понадобится изменить некоторые на-

стройки пользователя. 

Войдите: «Options → User Preferences…», 
чтобы увидеть экран настроек (рис.  4-6). Некото-
рые из них Вам уже знакомы. 

Первая группа – настройки отображения ди-
зайна, Display Preferences. 

Enable Full Screen Cursor. Также активиру-
ется нажатием клавиши <+> на основной клавиа-
туре. Как Вам известно, курсор в Layout Plus имеет 
вид крестика. Если активирован какой-либо инст-
румент, курсор-крестик становится маленьким. В 
некоторых случаях бывает полезно изменить его 
вид, как показано на рис.  4-5. 
  

рис.  4-5 
 

Курсор 
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рис.  4-6 

Enable AutoPan. Включение режима автоматического панорамирования. Панорамиро-
вание – это смещение рабочей области вместе с курсором в центр экрана. Если эта опция вы-
ключена, панорамирование осуществляется нажатием клавиши <C>. 

Чтобы испробовать функцию AutoPan, установите флажок, затем активируйте инстру-
мент Component Tool. После этого выберите какой-либо компонент мышкой и поднесите 
его к краю экрана. Рабочая область немедленно сдвинется так, что компонент вместе с кур-
сором окажутся в самом центре. 

Use Opaque Graphics. Использование «непрозрачной графики» (рис.  4-8). Если фла-
жок снят, слои просвечивают друг сквозь друга (рис.  4-7). 

 
рис.  4-7 

 
рис.  4-8 

Use Hollow Pads. Выводы всех компонентов, а также vias выводятся на экран в виде 
контуров (рис.  4-9). Это даёт возможность видеть дорожки непосредственно в точке подсое-
динения к pad-у. 
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рис.  4-9 

Show 3D Effects. Установка этого флажка позволяет визуально выделить те компонен-
ты, для которых определена высота. Кроме того, выводится значение высоты в текущей сис-
теме измерений. 

 
рис.  4-10 

Вторая группа настроек – Global Preferences. 

Activate Online DRC. Установка этого флажка эквивалентна включению кнопки 
Online DRC на панели инструментов. Если Online DRC включена, Layout будет «на лету» 
проверять все Ваши действия. Например, Вы не сможете ошибочно поставить один компо-
нент на другой. В режиме ручной разводки Online DRC не позволит провести две дорожки 
ближе, чем это определено в таблице Route Spacing и т.д.. 

Обычно Online DRC включен. Выключать его имеет смысл в том случае, если нужно, к 
примеру, временно переместить какой-либо компонент за пределы платы, чтобы произвести 
перестановку компонентов. 

Другая причина, по которой Вы можете захотеть выключить Online DRC – значитель-
ное замедление работы компьютера. Особенно это заметно на многослойных платах с высо-
кой плотностью монтажа и большими зонами Copper Pour. Любое Ваше действие будет при-
водить к тому, что компьютер начнёт впадать в длительное «задумчивое» состояние, которое 
способно продолжаться десятки секунд. 

Ускорить работу компьютера в этом случае можно, не выключая Online DRC, а сузив 
зону его работы. Вы, очевидно, обратили внимание, что в центре экрана обычно присутству-
ет белый пунктирный прямоугольник (рис.  4-11). Это – область, в которой Online DRC дей-

Высота
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ствует, и только в которой Вы, фактически, можете работать. Размер этой зоны можно ме-
нять, и, понятно, что чем больше зона, тем мощнее должен быть Ваш компьютер. 

Для изменения размера DRC-прямоугольника нажмите клавишу <B> и мышкой укажи-
те область другого размера. Масштаб экрана изменится, изменится также и зона Online DRC. 

К сожалению, с маленькой DRC-зоной ручную разводку выполнять очень неудобно, а с 
очень маленькой – практически невозможно. 

 
рис.  4-11 

Дополнительно к опции Online DRC можно установить Allow DRC Errors. В этом слу-
чае, Вы будете видеть возникающие маркеры ошибок непосредственно во время работы. 

Выберите инструмент Component Tool, после чего подцепите мышкой какой-нибудь 
компонент и попробуйте перемещать его туда-сюда через границу платы. Вы увидите, что в 
центре платы и в центре самого компонента появляются (рис.  4-12) и исчезают (рис.  4-13) 
маркеры ошибок. 

 
рис.  4-12 

 
рис.  4-13 

Instantaneous Reconnection Mode. Эквивалентна кнопке на панели инструментов «Re-
connect Mode». 

Если этот режим выключен, в слое GLOBAL отображаются нити ratsnests – все нераз-
ведённые ещё цепи. В процессе ручной расстановки компонентов на PCB, ratsnests видеть 

Online 
DRC zone 

Маркер

Маркер 
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очень важно. Однако, иногда эти линии располагаются так плотно, что просто мешают рабо-
те над проектом. 

Режим Reconnect Mode позволяет скрыть все посторонние ratsnests, оставив только те, 
которые подсоединены к выделенному компоненту (компонентам). На рис.  4-14 Reconnect 
Mode выключен, а на рис.  4-15 – включён. Видно, что выбран компонент С4. Цепи, не 
имеющие отношения к выделенному компоненту, скрыты. 

Если теперь потянуть С4 в сторону (рис.  4-16), то мы увидим, что ratsnests во время 
движения переподключаются к ближайшим компонентам, минимизируя таким образом дли-
ну цепей. Именно по этой причине режим и называется «Reconnection». 

 
рис.  4-14 

 
рис.  4-15 

 
рис.  4-16 

Reconnection Mode отменяет Online DRC. Это сто́ит помнить. Если Вы не хотите от-
ключать Online DRC, но обилие ratsnests Вам мешает, загрузите только что нами созданную 
цветовую таблицу PLACEMENT.COL. Эффект будет тот же самый, за исключением автома-
тической минимизации соединений. 

Минимизировать соединения вручную можно в любой момент, нажав клавишу <M>.  

Allow Editing of Footprints. Эта опция меняет режим работы инструмента Pin Tool. 
Выберите этот инструмент и дважды щёлкните по выводу одного из компонентов. Если 

опция отключена, появится окно, как на рис.  4-17. Здесь Вы можете переподключить вывод к 
другой цепи или отключить от всех цепей. 

Если опция включена, откроется окно редактирования pad-а. Можно изменить его 
форму, выбрав из списка другую площадку или даже переместить pad в произвольное место 
на PCB, как мы это уже однажды делали в главе «Компонент со свободными выводами.» 

Окно «Edit Pad» было рассмотрено на стр. 31. 

Третья группа настроек в окне User Preferences – Copper Pour Preferences. 

Enable Copper Pour. Если этот флажок убрать, все Copper Pour будут запрещены. Ин-
тересная деталь! На уже готовой плате все соединения, осуществлённые через Copper Pour 

Новая 
ratsnest 
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будут разорваны, хотя в окне статистики утверждается, что плата разведена на 100%. 

 
рис.  4-17 

 
рис.  4-18 

Use Pours for Connectivity. Несмотря на то, что выводы компонентов имеют соедине-
ние через Copper Pour, они будут указаны как неподключённые. Вы увидите ratsnests на эк-
ране (рис.  4-19). 

 
рис.  4-19 

Skeleton Display. Упрощённое изображение зон медной заливки (рис.  4-20). 

 
рис.  4-20 
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Не стоит путать эту опцию со способом штриховки Pours – Hatch Pattern (см. рис. 
 2-45). Не забудьте также отключить эту опцию в конце работы над проектом, если Вы её ис-
пользовали, иначе плата в таком виде и будет изготовлена. 

Use Fast Fill Mode. Ещё более упрощённый способ отображения Pours (рис.  4-21). 

 
рис.  4-21 

Этот режим предназначен для ускорения вывода на экран, однако Layout всё равно 
производит полный обсчёт каждой зоны, поэтому, думаю, использование этого режима на 
современных компьютерах лишено всякого смысла. 

Опять-таки, не забудьте отключить этот режим в финале работы, иначе плата будет ис-
порчена. 

Нормальное положение флагов в поле Copper Pour Preferences показано на рис.  4-22. 

 
рис.  4-22 

О четвёртой группе – Miscellaneous Preferences я, пожалуй, расскажу позже, исключая 
опцию 

Show Tooltips. Если эта опция включена, то при наведении мышки на какую-либо 
кнопку панели задач, Вы увидите краткую всплывающую подсказку. 

Установив все желаемые опции, нажмите кнопку Save User Preferences, иначе после 
перезагрузки Layout, все настройки вернутся в прежнее состояние. 

4.4. Компоненты, отсутствующие на схеме. 
Обратимся к чертежу платы (рис.  3-44 на стр. 145). На PCB имеются два крепёжных 

отверстия. Я уже говорил, что все крепёжные отверстия, несмотря на своё «механическое» 
происхождение, являются полноправными компонентами дизайна и даже могут принимать 
участие в маршрутизации. 
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Поскольку в принципиальной схеме устройства и, следовательно, в netlist-е о них ника-
кой информации нет, нам придётся вручную добавить их в дизайн. 

Для начала, конечно же, нужно приготовить соответствующий footprint. Сверяясь с 
чертежом, выясняем, что диаметр отверстия равен 3.2 мм. Диаметр шляпки винта, для кото-
рого это отверстие предназначено, примем примерно 5.5 мм. 

Откройте библиотеку CLOCK.LLB и добавьте в неё новый footprint с именем 
HOLE 3.2x5.5. На рис.  4-23 показан его padstack. 

 
рис.  4-23 

Закройте Library Manager, чтобы вернуться к работе над платой. На панели инструмен-
тов выберите Component Tool, после чего щёлкните в свободном месте правой кнопкой мы-
ши. 

  
рис.  4-24 

 Из раскрывшегося меню выберите «New…» (рис.  4-24), чтобы появился диалог «Add 
Component» (рис.  4-25). 

 
рис.  4-25 
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Нажмите кнопку Footprint, найдите свою библиотеку и укажите на только что создан-
ный footprint крепёжного отверстия. 

Из прочих параметров зададим: 
Reference Designator: H_1; 
Location (расположение): -5, 10; 

Обратите внимание на поле Component flags. Установлен флаг «Not in Netlist». Воз-
можно, нам понадобится вносить изменения в принципиальную схему и, как следствие, об-
новлять netlist. Если этот флаг не будет установлен, утилита AutoECO удалит крепёжное от-
верстие с платы, не найдя его в списке компонентов. 

Если мы планируем соединить крепёжное отверстие с землёй или с какой-либо иной 
цепью, флаг «Route Enabled» также должен быть установлен. 

Одно отверстие уже на своём месте! Удерживая клавишу <Shift>, щёлкните по нему 
левой кнопкой мыши и из контекстного меню выберите «Copy». Появится ещё одно отвер-
стие. Отредактируйте его свойства аналогичным образом, указав координаты: 65, 30 (в мил-
лиметрах, разумеется). 

 
рис.  4-26 

Чтобы случайно не сдвинуть одно из отверстий, зафиксируйте их. Для этого нужно ус-
тановить флаг «Fixed». 

Чем отличается «Fixed» («зафиксирован») от «Lock» («заблокирован»)? Строго говоря, 
ничем. Фиксация – более жёсткое закрепление компонента на плате. Для того чтобы снять 
фиксацию, необходимо войти в свойства компонента и сбросить флаг Fixed. Lock – более 
мягкое, временное закрепление и может быть снято простым нажатием горячей клавиши <L> 
или даже – в некоторых ситуациях – самим Layout Plus. 

Таким образом, зафиксировав компонент, Вы как бы страхуете сами себя от ошибоч-
ных действий. 

А теперь подключим оба отверстия к земле. 

 
рис.  4-27 

На панели инструментов выберите Connection Tool. Щёлкните левой кнопкой мыши 
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по первому отверстию и протяните нить-ratsnest ко второму. Появится окно (рис.  4-27) в ко-
тором из раскрывающегося списка нужно выбрать название цепи, с которой нужно осущест-
вить соединение. 

Если указать произвольное название, то Layout создаст новую цепь с таким именем, и 
отверстия будут соединены исключительно друг с другом. 

Проверьте себя. Увеличьте правый верхний угол платы и нажмите последовательно 
клавиши: 

<Backspace> – очистить экран; 
<0> – показать слой GLOBAL (ratsnest и Board Outline); 
<Shift>+<6> – показать слой DRILL; 
<3> – показать слой GND. 

 
рис.  4-28 

На рис.  4-28 показано то, что Вы должны уви-
деть: 

1) – Board Outline; 
2) – отверстие; 
3) – ratsnest GND; 
4) – колечко Thermal Relief в слое GND. 

Убедитесь, что в слое PWR колечко Thermal Relief отсутствует, и, следовательно, со-
единения с этим слоем нет. 

Если Вы немного запутались и не понимаете, каким образом слой GND стал «земля-
ным», вернитесь назад и найдите рис.  3-108 на стр. 170. 

Не слой присваивается цепи, а цепь назначается PLAIN-слою! Для цепи GND мы ука-
зали необходимость её расположения в слое GND, используя property PLANELAYERS. Та-
ким образом, любое отверстие или via, имеющее соединение с цепью GND, автоматически 
будет иметь соединение со всем PLAIN-слоем GND. 

На рис.  3-108 показано, каким образом назначить цепь PLAIN-слою в OrCAD Capture, а 
на рис.  3-102 то же самое действие показано в среде Layout Plus. 

4.5. Общая идеология расстановки компонентов. 
Расстановка компонентов производится в следующем порядке: 
- сначала устанавливаются на плату те компоненты, чьё положение определено за-
ранее. В первую очередь – элементы крепежа. Понятно, что если плата не сможет 
войти в корпус устройства, или неправильно определены крепёжные вырезы и отвер-
стия, то дальнейшая разводка теряет смысл. Всё равно, придётся всё переделывать. 

- во вторую очередь устанавливаются органы управления, если они есть, а также 
разъёмы, индикаторы и т.д. Т.е. все те элементы, которые выступают наружу из кор-
пуса будущего устройства. Положение на PCB всех этих компонентов, как правило, 
уже оговорено заранее. 

- потом, исходя из расположения установленных компонентов, расставляются ос-

1 

2
3 

4
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тальные. Начинаем со внешних разъёмов. Самые критичные – разъёмы, к которым 
подключаются какие-либо датчики для измерений. Во избежание искажений и наво-
док на измеряемый сигнал, компоненты, подключённые к таким разъёмам, должны 
располагаться в самой непосредственной от них близости. 

- далее, условно в порядке убывания важности, можно назвать высокочастотные 
разъёмы, разъёмы высокоскоростой связи, силовые коннекторы и т.д. 

- постепенно плата заполняется. Оставшееся место согласно принципиальной схеме 
нужно рационально распределить между функциональными блоками устройства, оп-
ределить для каждого блока приблизительно его место. На этом этапе, возможно, Вы 
увидите, что кое-какие из внешних коннекторов было бы хорошо переставить или 
поменять местами. Возможно, сто́ит настоять на своём мнении. 

- после того, как Вы определились с компоновкой PCB, начинайте расстановку ком-
понентов по очереди для каждого модуля. Начните с самых крупных компонентов, 
хотя тут нельзя посоветовать однозначно. Установив, к примеру, большую инте-
гральную микросхему, расположите вокруг неё «сопровождающие» её детали. Затем 
принимайтесь за следующую. 

Расставляя компоненты, смотрите, как располагаются ratsnests. Располагайте компо-
ненты так, чтобы цепи как можно меньше запутывались. Располагая компоненты слишком 
близко, думайте, сможете ли Вы потом вывести от них дорожки, хватает ли места, чтобы 
можно было поставить via? Кстати, если у Вас многослойная плата, не думайте, что развести 
её будет намного легче! Vias требуют гораздо больше пространства вокруг себя, поэтому по-
ставить лишнюю via подчас труднее, чем провести пару дорожек. 

Иногда следует, если плата большая, провести пробную разводку только что скомпо-
нованного участка. 

Располагайте компоненты как можно плотнее, даже если места достаточно. Лучше по-
том, если понадобится, раздвинуть их. 

Расположив на плате самые критичные компоненты и компоненты, положение которых 
было указано заранее, можно заблокировать их командой «Lock» и попробовать использо-
вать функцию Layout Plus Autoplacement, т.е. «Автоматическое размещение». 

Мы ещё вернёмся к этой теме. 

Расстановка компонентов на плате – самый ответственный и самый трудный этап в 
проектировании PCB. В зависимости от того, насколько удачно у Вас это получится, развод-
ка проводников может быть простой или превратиться в мучение. В последнем случае, воз-
можно, самое правильное решение, это выполнить команду «Unplace Board» (освободить 
плату от незакреплённых компонентов) и начать всё с начала. 

Я не шучу. Сложную плату практически невозможно оптимально скомпоновать с пер-
вого раза. Придётся делать ещё и ещё попытку. И каждый раз Вам будет ужасно жаль ломать 
свою работу, когда кажется, что уже пора приступать к разводке. 

Первоначальная расстановка, кажется очень трудной и занимает много времени. Когда 
ту же плату Вы компонуете повторно, оказывается, что дело движется намного быстрее, так 
как Вы уже знаете на что нужно обратить внимание и каких ошибок избежать. Вторая по-
пытка оказывается, как правило, намного более удачной, чем первая. 

Приступив к компоновке той же самой платы в третий раз, Вы с удивлением можете 
заметить, что закончили работу за полдня, хотя с первым вариантом просидели около неде-
ли. Да и плата, правду сказать, не идёт ни в какое сравнение с первым вариантом! 
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4.6. Cross Probing. 
Несомненное достоинство Layout – его постоянная связь с Capture, т.е. Intertool Com-

munication. Сто́ит Вам только выбрать какой-либо компонент на печатной плате, как Вы не-
медленно увидите участок схемы, на котором он находится. Справедливо и обратное: вы-
бранный элемент на принципиальной схеме тут же подсвечивается в Layout. Называется это 
– «Cross Probing». 

Чтобы включить возможность Cross Probing, в OrCAD Capture войдите в меню: «Op-
tions → Preferences… → Miscellaneous» и установите флажок «Enable Intertool Communi-
cation». 

Связь Capture с Layout осуществляется посредством netlist-а. Поэтому если Вы перене-
сли свой проект, скажем, на другой компьютер и не обновили netlist, Intertool Communication 
работать не будет. 

Откройте в Capture схему, показанную на рис.  3-94. Теперь войдите в Layout и открой-
те нашу плату. Выберите в Layout компонент LD1, а затем «отпустите» его, нажав клавишу 
<ESC>. Перейдите в Capture. Обратите внимание, что на принципиальной схеме LD1 выде-
лен. 

Теперь опять вернитесь в Layout и выполните команду меню: «Window → Half Screen». 
Capture и Layout разделят экран пополам, расположившись рядом (рис.  4-29). Попробуйте 
выбирать различные компоненты в Layout и смотрите, как реагирует на ваши действия Cap-
ture. То же самое проделайте в Capture и понаблюдайте за действиями Layout Plus. 

 
рис.  4-29 

Попробуйте выбрать не компонент, а цепь. 

Наиболее комфортной представляется работа, если Ваш компьютер позволяет подклю-
чить одновременно два монитора. В этом случае, на втором дисплее удобно расположить ок-
но OrCAD Capture, и у Вас всегда перед глазами будет именно тот участок схемы, с которым 
Вы работаете в данный момент. 

 

OrCAD Layout Plus 

 Стр. 189 

4.7. Выборка компонентов. 
Размещение компонентов осуществляется согласно Place Grid – сетке привязки. По 

умолчанию устанавливается шаг сетки 100 милей. Меньшие значения рекомендуется выби-
рать так, чтобы они были кратны 100, т.е.: 25, 20, 1

212 , 10, 1
38 , 1

46  mils. 
Для метрических плат шаг сетки обычно выбирают равным 2 мм, 1 мм или 0.5 мм. 

Слишком большое значение этого параметра будет мешать расстановке. Если шаг сет-
ки установить слишком мелким, компоненты будет трудно выравнивать. 

Конечно же, никто Вам не запрещает в процессе работы переходить от одной сетки к 
другой. 

Определите Place Grid равным 25 mils, а Visible Grid – 50 mils, и давайте расставим 
компоненты, положение которых более-менее известно. Я говорю об индикаторах и кнопках. 
Мы должны расположить их примерно так, как показано на рис.  4-30. 

 
рис.  4-30 

Загрузите цветовую таблицу PLACEMENT.COL, чтобы скрыть несущественные на 
данном этапе элементы дизайна. 

Какие существуют способы выбора компонентов? 

9 Первый, самый очевидный. Щёлкнуть по компоненту мышкой. 
Выберите инструмент Component Tool. Теперь найдите кнопку SW1 и щёлкните по 

ней левой кнопкой мыши. Перекрестье курсора станет маленьким, и кнопка «прилипнет» к 
нему. Перенесите её на плату и щёлкните ещё раз. Кнопка встанет на то место, которое Вы 
укажете, а курсор вновь станет большим, показывая, что инструмент освободился. 

Во время перемещения компонента, в контекстном меню, которое вызывается правой 
кнопкой мыши, доступны команды: 

Rotate (клавиша <R>) – повернуть компонент; 
Lock (клавиша <L>) – заблокировать компонент в указанном месте; 
Opposite (клавиша <T>) – переставить компонент на другую сторону платы. 

Команда «Rotate» действует в соответствии со значением, указанном в поле Rotation → 
Increment, которое находится в окне System Settings (рис.  2-2). 

9 Второй способ – выбор компонента согласно его Reference Designator. 
Щёлкните правой кнопкой в любом месте экрана и выберите команду «Select Any…» 

(рис.  4-31). Или воспользуйтесь комбинацией клавиш <ALT>+<S>. 
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рис.  4-31 

В открывшемся окне (рис.  4-32) в поле Ref Des впишите имя искомого компонента. 

 
рис.  4-32 

Поставьте вторую кнопку рядом с первой. 

9 Третий способ – выбор из очереди. 
Щёлкните правой кнопкой мыши и из контекстного меню выберите команду «Queue 

For Placement…». В открывшемся окне (рис.  4-33) укажите критерии отбора компонентов 
для постановки в очередь. 

 
рис.  4-33 

 
рис.  4-34 

Поскольку нам необходимы только кнопки, напишите в поле Ref Des: «SW*». Знак «*» 
в данном случае, как это принято, означает любое сочетание символов. Дополнительно мож-
но использовать знак «?», что будет означать любой один символ. 

Из дополнительных критериев отбора можно указать footprint компонентов, номер 
группы, тип и т.д.. 

Флаги внизу окна определяют правила исключения. Поставьте флажок «Exclude 
Placed», чтобы в очередь не попали уже установленные на плату компоненты. 

После того, как очередь создана, щёлкните правой кнопкой мыши ещё раз и выберите 
команду «Place…». Откроется окно со списком компонентов, ожидающих в очереди (рис. 
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 4-34). 
Имя компонента в очереди состоит из его Reference Designator. После точки указывает-

ся количество выводов. После пробела – footprint компонента. 

Выбирая из очереди, поставьте кнопки SW3 и SW4 рядом с первыми двумя. 

Теперь создайте очередь из группы #4. Это – светодиодные индикаторы. Расположите 
их на плате, как это показано на рис.  4-30. 

Сохраните файл. У меня это – 11.max. 

4.8. Работа с группами компонентов. Кластеры. 
Вы уже знаете, что компоненты можно объединять в группы. Мы это делали на уровне 

принципиальной схемы, используя OrCAD Capture. 
Как можно определить группу компонентов в Layout? 

9 Индивидуальным выбором. 
Удерживая клавишу <Shift>, щёлкните по одному из компонентов. Затем аналогичным 

образом укажите остальные компоненты (рис.  4-35). 

 
рис.  4-35 

Закончив выбор, войдите в «Properties…» и установите номер для новой группы, как 
это показано на рис.  4-36. 

 
рис.  4-36 

9 Выделением рамкой. 
Название говорит само за себя. Нужно с помощью мыши обвести группу компонентов 

прямоугольной рамкой. 
Используя инструмент Component Tool, обведите плату, полученную в прошлой главе, 
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рамкой и нажмите клавишу <L>. Это равносильно команде «Lock», т.е. блокирование уста-
новленных компонентов на плате. 

9 С помощью команды Block. 
Способ похож на предыдущий, с той разницей, что позволяет очерчивать рамку произ-

вольной формы. 
Выберите команду: «Tool → Block → Select Tool», после чего начинайте рисовать рам-

ку так, будто рисуете обыкновенную obstacle. 

 
рис.  4-37 

После завершения, очерченные компоненты окажутся выбранными. 

9 С помощью таблицы (Spreadsheet) компонентов. 
Войдите в «Components». Удерживая клавишу <Shift>, можно выбирать компоненты в 

произвольном порядке, после чего, войдя в «Properties…», объединить их в группу. 

Расставлять компоненты на плате удобно именно по группам, особенно, при включён-
ной опции Intertool Communication. Для этого из группы формируется очередь, как это опи-
сано в предыдущей главе. Размещаемый компонент будет виден в окне OrCAD Capture на 
принципиальной схеме. 

Если приходится разрабатывать плату большого размера, удобно преобразовать группу 
в кластер (Cluster). 

В режиме Reconnect Mode, кластеры изображаются на экране в виде окружностей раз-
личного диаметра. Чем больше компонентов входит в кластер, тем больше окружность. По 
умолчанию компонент, имеющий самое большое количество соединений, даёт кластеру своё 
имя. 

Кластеры активно используются алгоритмами автоматической расстановки. В ручном 
режиме их можно использовать для предварительной прикидки будущего расположения 
функциональных блоков. 

На маленьких платах использование кластеров в ручном режиме не имеет смысла, но 
для обучения мы посмотрим, как это делается. 

Сохраните свой дизайн из файла 11.max в 12_cluster.max. Загрузите цветовую таблицу 
ALL.COL. Теперь выберите инструмент Component Tool и включите Reconnect Mode. На-
жмите <ALT >+<S> и укажите в поле Group Number группу #6. 

Все компоненты группы окажутся притянутыми к курсору. 
Щёлкнув правой кнопкой мыши, выберите команду Make или нажмите клавишу <K>. 

Группа преобразуется в кластер, который можно перемещать как единое целое. Расположите 
кластер на плате в любом свободном месте (рис.  4-38). 
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рис.  4-38 

Кластер получил имя Q1, поскольку транзистор Q1 имеет наибольшее количество со-
единений. 

Войдите в «Components», а затем – в свойства компонента LS1. 

 
рис.  4-39 

Установите флажок Key, после чего вернитесь в дизайн и обновите экран, нажав на па-
нели инструментов кнопку Refresh All. 

Название кластера поменяется на LS1. Теперь именно этот компонент является глав-
ным – ключевым – в группе. При автоматическом размещении именно он будет помещён на 
плату первым, а остальные компоненты кластера будут расположены вокруг него. 

Отменить группировку компонентов в кластер можно командой Break, или клавишами 
<Ctrl>+<K>. 

4.9. Использование матрицы. 
Инструмент Matrix используется для полуавтоматического размещения однотипных 

компонентов – например, элементов памяти – по прямоугольной сетке. К сожалению, пра-
вильно нарисовать сетку оказывается, подчас, труднее, чем расположить компоненты вруч-



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 194 

ную. После нескольких попыток, в результате которых сетка у Вас получается то слишком 
большая, то слишком маленькая, Вы, наконец, добиваетесь желаемого результата. Однако 
тут же обнаруживаете, что компоненты  расположились, хотя и ровно, но в произвольном 
порядке. 

Однако же, рассмотрим и этот способ. 

Выберите: «Tool → Matrix → Select Tool». Установите курсор в левый верхний угол 
предполагаемой сетки. Щёлкните левой кнопкой мыши и потяните курсор в правый нижний 
угол. Щёлкните ещё раз. Перемещая курсор внутри очерченной зоны, разбейте прямоуголь-
ник на желаемое количество ячеек. Третий щелчок завершит создание матрицы (рис.  4-40). 

 
рис.  4-40 

Выберите теперь Component Tool и выделите С1-С6. Из контекстного меню выберите 
команду Matrix Place. 

 
рис.  4-41 

Выделенные элементы расположатся в узлах сетки (рис.  4-41). 

Чтобы переместить матрицу, выделите её мышкой. Нажатие при этом клавиши 
<Insert> приведёт к созданию её копии, а клавиша <Delete> уничтожит сетку. 

Те же самые действия можно производить и с линиями, образующими матрицу. 

4.10. Shove – толкание компонентов. 
Иногда, чтобы добавить новый компонент, нужно немного раздвинуть уже установ-

ленные. Возьмите, к примеру, С3 и перенесите немного вверх (рис.  4-42). Не отпуская его, 
щёлкните правой кнопкой мыши и выберите команду Shove или нажмите клавишу <J>. 
Компоненты С4 и С6 отодвинутся в сторону. 

Командой Shove нужно пользоваться очень осторожно, особенно на платах с высокой 
плотностью монтажа. Освобождая место, выталкиваемые  компоненты будут толкать своих 
соседей, а те, в свою очередь – своих. В одно мгновение можно всё испортить, «растолкав» 
половину платы. 

Чтобы избежать подобной ситуации, используйте команду Lock для временного закре-
пления компонентов. 

Команда Undo (клавиша <U>) позволяет отменить одно последнее действие. Повтор-
ное нажатие <U> возвращает отменённое действие обратно. 
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рис.  4-42 

 
рис.  4-43 

4.11. Swap – обмен компонентов. 
Быстро поменять компоненты местами можно при помощи команды Swap (клавиши 

<Ctrl>+<W>). 
Выделите первый компонент и нажмите <Ctrl>+<W>. Укажите на второй компонент. 

Компоненты поменяются местами. 

4.12. Составные компоненты. Swap Gates – обмен секций. 
Как Вы, без сомнения, знаете, многие радиокомпоненты могут объединять в одном 

корпусе несколько элементов – секций. Если секции одинакового типа, то такой компонент 
называется гомогенным (Homogeneous), если же разного – гетерогенным (Heterogeneous). 
Примером составного компонента может служить, например, микросхема 7400, которая объ-
единяет в одном корпусе четыре секции 2И-НЕ (рис.  4-44). 

1

2
3

U1A 7400

4

5
6

U1B 7400

9

10
8

U1C 7400

12

13
11

U1D 7400

 
рис.  4-44 

Чего Вы, возможно, ещё не знаете, что Layout Plus способен менять прямо на плате не 
только компоненты между собой, но и секции65 (Gates) внутри компонентов. Кроме того, 
возможен обмен секциями между соседними компонентами. 

Давайте, во избежание путаницы в голове, уточним ещё раз терминологию, используе-
мую в системе OrCAD Capture и OrCAD Layout. 

Радиодетали, из которых построена принципиальная схема устройства и которые потом 
нужно будет смонтировать на печатной плате в OrCAD Capture называются Component Parts 
или просто Parts. В OrCAD Layout мы называем их Components. 

В библиотеках OrCAD Capture хранятся описания всех Parts в виде Electric Packages. 
Electric Package – включает в себя графическое изображение детали (Part) на принципиаль-
ной схеме, её возможные свойства, информацию о секциях (Gates), и выводах (Pins). 

OrCAD Layout каждому компоненту из своих библиотек ставит в соответствие его foot-
print. Footprint, как уже известно, включает в себя информацию о физических размерах ком-
понента, его изображении на PCB, информацию о количестве и расположении выводов 
(Pins). В каждом из слоёв печатной платы выводы представляются pad-ами – контактными 
площадками. Описание вывода в виде набора pad-ов по слоям называется Padstack-ом. 

Количество выводов, указанное в footprint-е может отличаться от указанного на схеме. 
                                                 

65 К элементам логики применимо также понятие «вентиль». 
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Как правило, в бо́льшую сторону. 

Найдите на принципиальной схеме кнопку SW1 (рис.  3-17) и обратите внимание, что 
указывается только два вывода – #1 и #3. Теперь посмотрите на рис.  3-14. Реальная кнопка 
имеет не два, а четыре вывода. Именно так – с четырьмя выводами – мы и должны создавать 
её footprint, иначе же кнопку просто нельзя будет вставить в плату! 

Если Вы обратили внимание, то я нарисовал footprint не с 4, а с 6-ю выводами. Внутри 
таких кнопок может находиться ещё и светодиод, поэтому я просто использую универсаль-
ный footprint, вот и всё. 

Выводы 1-2 и 3-4 (см. рис.  3-15) для надёжности можно будет соединить прямо в Lay-
out Plus, используя инструмент Connection Tool. 

Понятно, что footprint компонента не может иметь количество выводов меньше, чем 
указано на схеме. Это – ошибка. 

Возвращаясь к теме составных компонентов. Нарисуйте вот такую ничего не означаю-
щую схему (рис.  4-45): 
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рис.  4-45 

Передайте netlist в Layout и, очертив очень простую плату, расставьте на ней компо-
ненты, как показано на рис.  4-46: 

 
рис.  4-46 

Воспользуйтесь готовыми footprint-ами из библиотек Layout: для микросхем – 
DIP.100/14/W.300/L.750, для коннектора – BLKCON.100/VH/TM1SQ/W.100/3. 

Проектируя схему, Вы не задумываетесь, какие секции микросхем использовать. На 
печатной же плате видно, что ratsnest перекрещены. Это вызовет ненужные трудности в раз-
водке. Кроме того, и в U1 и в U3 имеются свободные секции, расположенные значительно 
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ближе к U2. 
Теперь-то видно, что, составляя схему, хорошо было бы использовать другие секции. 

Но сидеть и перерисовывать схему, особенно, если она очень большая (больше, чем наша) – 
нереальная задача! 

К счастью, разработчики Layout предусмотрели подобную ситуацию. Мы можем про-
извести обмен секций прямо на PCB, а потом с помощью операции Back Annotating внести 
изменения в принципиальную схему. 

 
рис.  4-47 

Зайдите в Packages. Вы увидите таблицу, примерно как на рис.  4-47. В этой таблице 
содержится информация об Electric Packages используемых компонентов. Это – данные ис-
ключительно об электрических характеристиках компонента. Вы можете в своей практике 
развести десятки плат, ни разу не заглянув сюда. Однако сейчас как раз такой случай, когда 
эти данные могут быть нам очень полезны. 

В первом столбце – «Package Name or Pin Number» – мы видим, что в проекте ис-
пользуются два типа packages. Package 7400 – очевидно, это микросхемы. Package CON3 – 
это электрическое описание разъёма. 

Package 7400 включает 14 выводов. Они перечислены в том же, первом столбце: Pad 1 – 
Pad 14. 

В столбце «Gate Name» указывается принадлежность выводов секциям. Здесь мы мо-
жем узнать о наличии в компоненте секций вообще и их названия. Electric Package 7400 со-
держит четыре секции, которые называются: A, B, C, D. Секции A принадлежат выводы 1, 2, 
3, секции B – 4, 5, 6 и т.д.. 

В следующем столбце, о чём говорит его название – «Pin Name», – указываются имена 
выводов. Поскольку все секции одинаковы, имена выводов разных секций совпадают. На-
пример, выводы 3, 6, 8, 11 имеют имя «Y». 

Столбец «Gate group» служит для объединения секций в группы. Обмен секций раз-
решается только в том случае, если они принадлежат одной группе. Группа 0 запрещает об-
мен. 

Приведите таблицу Packages к виду, как показано на рис.  4-47. 

Теперь закройте её и выберите инструмент Gate: «Tool → Gate → Select Tool». Щёлк-
ните по первому выводу микросхемы U1 (рис.  4-48). 
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рис.  4-48 

Видите? Выделились выводы 1, 2 и 3, т.е. сейчас подсвечена целиком вся секция A. 

Нажмите <Ctrl>+<W> или выберите команду Swap из контекстного меню. 

 
рис.  4-49 

Будут подсвечены все секции, доступные для обмена (рис.  4-49). 
Щёлкните по секции C той же микросхемы, чтобы произвести обмен (рис.  4-50). 

 
рис.  4-50 

Теперь самое главное – не забыть сделать операцию Back Annotating, чтобы произве-
дённые изменения отразились на принципиальной схеме. 

В результате, должна получиться схема, показанная на рис.  4-51: 

OrCAD Layout Plus 

 Стр. 199 

12

13
11

U2D 7400

9

10
8

U1C 7400

1

2
3

U3A 7400
1
2
3

J1

CON3

4

5
6

U2B 7400

1

2
3

U2A 7400

9

10
8

U2C 7400

 
рис.  4-51 

В процессе Back Annotating OrCAD Capture, возможно, сообщит об ошибке. Посмотри-
те, что записано в журнале сессии: «Window → Session Log». 

**************************************************************************** 
* 
*  Performing back annotation. 
* 
**************************************************************************** 
ERROR [GAT0016]   Unable to change U1C to U1A because U1C was not found 
Back annotation complete. 

Всё верно. Это просто предупреждение. Ведь на схеме (рис.  4-45) действительно U1C 
не было! 

4.13. Swap Pins – обмен выводов. 
Взгляните на рис.  4-50. Ratsnest, подключённые к выводам 12 и 13 микросхемы U2, пе-

рекрещены. В то же время, оба этих вывода совершенно одинаковы по своему функциональ-
ному назначению. Очевидно, если их поменять друг с другом, работа схемы не нарушится. 

 
рис.  4-52 

Снова зайдите в Packages. В столбце Pin Group нужно определить выводы, доступные 
для обмена. Выводы можно менять только в пределах своей секции, поэтому, например, вы-
вод #1 можно будет поменять с #2, а с #4 – нельзя. 
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5. Автоматическое размещение компонентов. 

В этой главе рассмотрим возможности автоматической и полуавтоматической расста-
новки, предоставляемые Layout Plus. 

5.1. Алгоритмы расстановки. 
Автоматический расстановщик компонентов Layout Plus действует в соответствии с 

набором правил, которые устанавливает пользователь. Правила эти сведены в таблице «Place 
Pass». 

Войдите в: «Options → Placement Strategy…» (рис.  5-1). 

 
рис.  5-1 

Столбец «Pass» определяет номер шага, этапа расстановки. Всего таких шагов может 
быть 12. Выполнить или пропустить шаг – указано в столбце «Enabled». 

В столбце «Operation» указывается, какой алгоритм расстановки будет использован на 
данном этапе. Возможен выбор из шести вариантов66: 

Assign Clusters – Layout Plus пытается автоматически сгруппировать компоненты пе-
ред началом расстановки, что даёт возможность более грамотного размещения. 
Группировка осуществляется, главным образом, по критерию максимизации 
соединений внутри каждого кластера и минимизации соединений между кла-
стерами. 

Place Clusters – размещение кластеров на печатной плате друг относительно друга и 
относительно зафиксированных компонентов, таких, например, как разъёмы. 

Proximity Place – расположение кластеров на PCB рассматривается как ориентировоч-
ная позиция для начального размещения компонентов, входящих в кластер. 
После этого Layout Plus пытается путём многократного перебора различных 
вариантов оптимально расположить компоненты. Компоненты лишь приблизи-
тельно расставляются на свои места перед началом следующего этапа. 

Adjust Components – расталкивание компонентов, расположенных неоправданно куч-
но. Окончательная расстановка и выравнивание. 

Swap Comps – попытка улучшить расстановку за счёт обмена соседних компонентов. 

Swap Pins – попытка минимизировать соединения с помощью операции Swap Pins, 
рассмотренной в главе  4.13. 

                                                 
66 Описание алгоритмов работы см. «OrCAD Layout User’s Guide». 
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Выводы #3, 6, 8 и 11 должны быть запрещены к обмену, поскольку имеют другое 
функциональное назначение. 

Не смотрите на столбец Pin Type. Информация, содержащаяся в этом столбце, не ис-
пользуется при операциях Swap Gate и Swap Pin. 

Закройте таблицу Packages и выберите инструмент Pin. Щёлкните по выводу #13 U2. 
Он выделится. Теперь нажмите <Ctrl>+<W>. Подсветится рядом вывод #12, указывая на го-
товность к обмену (рис.  4-53). 

 
рис.  4-53 

Щёлкните по нему, и выводы поменяются местами (рис.  4-54). 

 
рис.  4-54 

После Back Annotating схема будет выглядеть как на рис.  4-55. 
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рис.  4-55 
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Чтобы рассмотреть дополнительные параметры, настраиваемые для каждого этапа, 
дважды щёлкните мышкой по одной из строк таблицы. Например, по Pass 7 (рис.  5-2). 

 
рис.  5-2 

Флажок Swap Gates разрешает обмен секций. 

Установка флажка Fast Reconnect позволяет уменьшить время расстановки. Сброс 
флага, напротив, позволяет достичь несколько лучших результатов размещения. 

Iterations – определяет количество попыток использовать данный алгоритм во время 
работы команды автоматического размещения. 

Attempts – определяет количество переборов различных комбинаций во время работы 
данного алгоритма. 

Max Clusters – определяет количество кластеров, которые Layout Plus попытается соз-
дать во время автоматической группировки компонентов. По совету разработчиков OrCAD 
Layout, 10 обычно является оптимальной величиной. Или же 5 кластеров из расчёта на каж-
дые 100 микросхем. 

Последний флаг – Done. Устанавливается автоматически по завершении работы рас-
становщика. Если флаг Done установлен, считается, что этап завершил свою работу, и будет 
пропущен. Поэтому, прежде чем начать автоматическую расстановку, убедитесь, что флаг 
Done сброшен. 

5.2. Файлы стратегий. 
Стратегии определяют работу инструментов автоматической расстановки и автомати-

ческой маршрутизации. Выбор той или иной стратегии осуществляется загрузкой соответст-
вующего файла. Файлы стратегий имеют расширение .SF и располагаются в директории: 

“…tools\layout_plus\data” 

В режиме ручной расстановки загрузка файла стратегии скажется лишь на таблице цве-
товых правил. Элементы дизайна, такие как линии компонентов Place Outline, ratsnests, Board 
Outline и др. будут выделены. Напротив, элементы, не имеющие отношения к процессу раз-
мещения, например, слои SP, SS, ASY, DRILL, будут скрыты. 

Файлы стратегий размещения начинаются с букв «PL». Всего имеется пять таких фай-
лов. Ниже представлено их описание от разработчиков OrCAD Layout Plus. Показаны также 
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соответствующие таблицы Place Pass. 

PLSTD.SF – стратегия для высококачественного размещения (рис.  5-3). В большинст-
ве случаев является оптимальной. Качество размещения сказывается на про-
должительности работы. Стратегия требует значительно большего времени по 
сравнению с остальными. Стратегия не включает операции Swap Gates и Swap 
Pins. 

 
рис.  5-3 

PLFAST.SF – используется для быстрого размещения компонентов на относительно 
простых платах (рис.  5-4). Не рекомендуется использовать для сложных плат 
или плат, с шинами передачи данных. Можно использовать для оценочного 
размещения компонентов с целью выявления потенциальных проблем расста-
новки. Позволяет оценить, какие компоненты лучше переместить на вторую 
сторону платы или какую из сторон использовать для размещения SMT-
компонентов. 

 
рис.  5-4 

PLBEST.SF – используется для достижения самого лучшего качества размещения 
(рис.  5-5). Все опции Fast Reconnect выключены. 

 
рис.  5-5 
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PLCLUST.SF – используется для автоматической группировки компонентов в класте-
ры (рис.  5-6). Может служить в качестве помощи для интерактивной (ручной) 
расстановки, особенно если отсутствует принципиальная схема. 

 
рис.  5-6 

PLFINISH.SF – эта стратегия начинает свою работу там, где заканчивает PLCLUST.SF 
и завершает размещение, используя настройки PLBEST.SF (рис.  5-7). 

 
рис.  5-7 

После загрузки любой из стратегий, выделите столбец «Clusters» и определите количе-
ство создаваемых кластеров. Обычно – 10. Если в этом столбце оставить «ноль», то кластеры 
создаваться не будут, что очень значительно ухудшит качество и увеличит время расстанов-
ки. 

5.3. Дополнительные средства автоматического размеще-
ния. 

Мы можем конкретизировать работу мастера авторасстановки. Иными словами, ука-
зать дополнительные условия расположения компонентов. Для этого существуют две катего-
рии obstacles, ранее нами не рассмотренных. 

Категория первая: группировка компонентов по высоте. 
Посмотрите на рис.  5-8. Имеем прямоугольную плату и три группы компонентов. Для 

компонентов группы c высота не задана. Компоненты группы d имеют высоту 275.58 ми-
лей. Компоненты группы e имеют высоту 240 милей. 

Граница платы обозначена obstacle Board Outline f. 
g – это obstacle Comp height keepin, расположенная в слое TOP. На рис.  5-9 видно, 

что obstacle имеет параметр Height67 равный 250 миль. Таким образом, все компоненты вы-
сотой 250 милей и выше обязаны располагаться внутри очерченной зоны. 

                                                 
67 Высота. 
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рис.  5-8 

Обратите внимание, как выглядит граница obstacle Comp height keepin при включённом 
параметре «Show 3D Effects». 

 
рис.  5-9 

Если теперь выполнить команду «Auto → Place → Board», мы увидим примерно то, 
что показано на рис.  5-10. Как и следовало ожидать, компоненты d находятся внутри зоны 
Height Keepin. Все остальные компоненты имеют высоту меньшую указанных 250 милей, 
поэтому действие obstacle на них не распространяется. Они могут располагаться в произ-
вольном месте. 

На рис.  5-11 показано действие obstacle Comp height keepout. Данная obstacle запре-
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щает размещение компонентов указанной высоты и выше в очерченной области. 
Компоненты d находятся снаружи зоны. Все остальные компоненты – в произвольном 

месте. 

 
рис.  5-10 

 
рис.  5-11 

Аналогично работают obstacles другой категории – Comp group keepin и Comp group 
keepout. Как ясно из названия, obstacle Group keepin объединяет компоненты указанной 
группы, а obstacle Group keepout наоборот, запрещает размещение компонентов определён-
ной группы в очерченной области. 

 
рис.  5-12 

 
рис.  5-13 

На рис.  5-12 показано действие obstacle Group 3 keepin, на рис.  5-13 – Group 3 kee-
pout. 
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5.4. Круговое размещение. 
Бывают случаи, когда нужно расположить компоненты по окружности. Как правило, 

ситуации по необычному размещению компонентов возникают при проектировании различ-
ного типа датчиков и сенсоров. 

 
рис.  5-14 

Взгляните на рис.  5-14. Требуется расположить пять микросхем c вокруг центра e. 
Цифрами на рисунке обозначены: d - Datum; f – окружность радиусом 700 милей; 

g – окружность радиусом 1000 милей. 

 
рис.  5-15 

Войдите: «Auto → Place → Array…». Откроется окно «Circular Placement» (рис.  5-15). 
В работе мастера кругового размещения есть одна особенность. Он не может расста-

вить компоненты, присутствующие в дизайне. Вместо этого, в дизайн будут добавлены пять 
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новых микросхем, отсутствующих в netlist-е. 
Вот что это значит. Нажмите кнопку <Footprint> и в появившемся окне диалога ука-

жите footprint, соответствующий микросхемам c (рис.  5-16). 

 
рис.  5-16 

В поле Reference Des появится число, с которого начнётся нумерация созданных ком-
понентов. 

В поле Group Number можно указать номер группы, которой будут принадлежать но-
вые компоненты. 

В поле Circle Center указываются координаты центра e. У нас они равны [1650; 1550]. 
Далее задаются либо радиус окружности и начальный угол, либо координаты первого 

компонента. 
Из выпадающего списка Place Comp By выбираем, каким образом будут размещаться 

компоненты: относительно datum их footprint-а, относительно первого вывода, относительно 
их Insertion Origin или относительно геометрического центра. 

В поле Comp Count указывается количество компонентов. 

 
рис.  5-17 

Вот что получится в результате (рис.  5-17). 

Измените параметр Comp Angle с нуля на 90, и полу́чите другую картину (рис.  5-18): 
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рис.  5-18 

Чтобы расположить компоненты не по окружности, а по дуге, измените параметр Angle 
To Fill с 360˚ на, скажем, 180˚. 

 
рис.  5-19 

Вот что получится (рис.  5-19). 

Что? Разве Вы хотели не так? Вы хотели, чтобы первая и последняя микросхема оказа-
лись на одной линии, как это показано на рис.  5-20? 

Действительно, ведь мы просили расположить пять компонентов на дуге от 0˚ до 180˚! 
Почему же последняя микросхема оказалась так далеко? 

Посмотрите на рис.  5-17. Микросхемы расположены на окружности. Иными словами, 
на дуге от 0˚ до 360˚. Но ведь последняя – пятая – микросхема повёрнута не на 360˚! Если бы 
это было так, то она совпала бы с первой. 

Давайте представим следующее: микросхем у нас не пять, а шесть, причём шестая – 
невидимая. Чтобы получить такую же картину, как на рис.  5-17, нужно шесть микросхем 
расположить на окружности от 0˚ до 360˚+72˚ (значение 72˚ смотрим в поле Comp Angle In-
crement). 
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рис.  5-20 

Анализируя вышесказанное, вновь вызовем окно мастера Circular Placement и устано-
вим параметры, как показано на рис.  5-21. 

 
рис.  5-21 

 
рис.  5-22 

А именно: количество размещаемых компонентов – 4 на дуге 180˚. В поле Comp Angle 
Increment смотрим угол приращения. 

После этого меняем значение Comp Count на 5, а в поле Angle To Fill пишем 180˚+45˚, 
т.е. – 225˚ (рис.  5-22). 

Нажимаем кнопку <OK>, и получаем результат как на рис.  5-20. 

Однако это не всё. Появились пять лишних компонентов, которых нет на схеме. В то 
же время, компоненты, которые действительно нужно было разместить, находятся за преде-
лами платы. 

На помощь придёт инструмент Swap Components (гл.  4.11). Укажите на микросхему #1 
(рис.  5-20), нажмите <Ctrl>+<W>, а потом – на микросхему #7. Компоненты поменяются 
местами. 

Аналогично поступи́те с микросхемами #2–#5, после чего можете ненужные более 

#1

#7
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компоненты #7–#11 удалить. 

 
рис.  5-23 

На рис.  5-23 показан конечный результат. 

5.5. A fly in the ointment68. 
К сожалению, система автоматической расстановки OrCAD Layout Plus имеет довольно 

много существенных недостатков. Первый недостаток, который сразу же бросается в глаза – 
невозможность автоматического переноса компонентов на противоположную сторону платы. 
Странно, но такая возможность в OrCAD Layout нигде даже не упоминается. 

Второй недостаток, возможно, наблюдается не во всех версиях OrCAD, хотя мне и уда-
лось проверить несколько. Речь идёт об операции Swap Gates. Я пробовал десятка полтора 
различных вариантов схем и плат, и мне ни разу не удалось добиться работы этой функции в 
автоматическом режиме, т.е. в режиме AutoPlacement. Если у кого-то получилось, пожалуй-
ста, вышлите мне файл примера на электронную почту. Спасибо! 

Третий недостаток опять-таки связан с составными компонентами. На стр. 171 в табли-
це Components Property было указано, что секции составных компонентов можно группиро-
вать в OrCAD Capture. И это действительно так. Более того, в netlist-е эта информация при-
сутствует. Неприятность состоит в том, что OrCAD Layout Plus этой информацией не пользу-
ется, поэтому данные в столбцах Gate Group (а также и Pin Group) в таблице Packages (рис. 
 4-47) всякий раз придётся править вручную непосредственно в Layout. 

Справедливо и обратное: данные из этой таблицы не передаются из Layout в Capture 
операцией Back Annotating. 

5.6. Пробное авторазмещение. 
В свете вышесказанного, давайте произведём пробное размещение компонентов в ав-

томатическом режиме. 

Мы остановились на стр. 191. Наша плата имеет вид как на рис.  4-30. На ней расстав-
лены индикаторы, кнопки и крепёжные отверстия. 
                                                 

68 Ложка дёгтя в бочке мёда. 



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 212 

Последний файл дизайна OrCAD Layout Plus называется 11.max. 

Добавим на плату вручную ещё несколько компонентов: 
c – разъём питания J2. Расположим его слева. 
d – длинный разъём J1 для программирования процессора удобно расположить в пра-

вом нижнем углу. 
e – коннектор SW5. Кнопка выключения будильника. Логично предположить, что она 

должна находиться вверху. 
f – звонок. Поместим его пока в центре платы. Позже, если понадобится, можно будет 

сместить его в сторону. 

 
рис.  5-24 

Для того, чтобы авторасстановщик не сместил новые компоненты, нужно их закрепить. 
Выберите инструмент Component Tool, а затем выделите мышкой всю плату, чтобы 

выбрать все компоненты, уже на ней расположенные. На вопрос: 

 «One or more components locked. Override?69»  

следует ответить <OK>, а потом нажать клавишу <L> . 
Вновь установленные компоненты будут также блокированы от перемещения. 

Сохраните дизайн под именем 12.max. 

Теперь попробуем запустить мастер авторасстановки, и для начала загрузим стратегию: 
«File → Load…». Файл PLSTD.SF – стандартная стратегия. 

Цветовая таблица, возможно, изменится. 

Запустите авторасстановщик командой: «Auto → Place → Board». На рис.  5-25 показа-
но, что получилось после окончания работы мастера. 

Увы, первые результаты разочаровывают. Взгляните на рисунок. Для наглядности, я 
выключил все ratsnests, оставив только цепи XIN, XOUT. 

c – это процессор. Как и планировалось, он расположен вблизи разъёма J1. Но по-
смотрите, где находится кварцевый резонатор d! К тому же, ratsnests перекрещены. 

Преобразователь +6V→3.6V U3 (e) находится от разъёма питания J2 на противопо-
ложной стороне платы. 

Зуммер LS1, расположенный в центре платы выглядит одиноким. Где находятся его 
компоненты, компоненты группы 6? f – это транзистор Q1, а g – диод D4. 

                                                 
69 Предупреждение, что один или более выбранных компонентов являются заблокированными. 
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рис.  5-25 

Увы! Первый блин вышел комом! Загрузите свой дизайн из файла 12.max и попробуй-
те конкретизировать задачу. 

В правом нижнем углу очень удобно помещается кварц Y1 (c), а над ним – процессор 
U2 (d). 

Микросхему U3 (e) расположим поближе к разъёму J2. 

 
рис.  5-26 

Сохраним работу под именем 13.max и вновь запустим мастер авторазмещения, не за-
быв закрепить новые компоненты. 

Результат показан на рис.  5-27. Вряд ли эта плата выглядит лучше, чем на рис.  5-25. 
Обратите внимание на транзистор Q1 (d) и диод D4 (c). 

Новая попытка. Укажем, используя obstacles Comp Group Keepin, приблизительные 
границы групп d,h и c (рис.  5-28). Сохранитесь под именем 14.max. 

Напомню, что названия obstacles Group Keepin видны при включённом режиме Show 
3D Effects. 

На рис.  5-29 показано то, что получится. Ну что же, плата, хотя и далека ещё от совер-
шенства, но выглядит уже намного лучше. 

Взгляните, однако, на выделенный участок. Пытаясь выполнить наши требования, Or-
CAD не смог найти достаточно места для двух резисторов. В результате границы R8 и R12 
перекрываются. 
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рис.  5-27 

 
рис.  5-28 

 
рис.  5-29 

Последняя попытка. Выделите все компоненты, которые находятся пока ещё за преде-
лами платы, исключая U1 и R2. Затем клавишей <T> или с помощью команды Opposite, дос-
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тупной из контекстного меню, перенесите их на другую сторону платы. 
Запускаем AutoPlace Board (рис.  5-30). 

 
рис.  5-30 

На первый взгляд, не так уж и плохо. Давайте проверим расстановку компонентов со-
гласно требованиям, описанным на стр. 126. 

Ёмкости C6 и C2 должны находиться как можно ближе к выводам GND микросхем U2 
и U1. C6 расположена очень удачно, а вот С2 находится не на своём месте. 

Можно переместить ещё несколько компонентов, но в целом, получилось действитель-
но очень неплохо! 

Поэкспериментируйте самостоятельно, загружая различные стратегии и изменяя пра-
вила. Я же хочу сказать вот что. Конечно же, ни один авторасстановщик не скомпонует пла-
ту правильно на 100%. Разные программы делают это по-разному, используя сложные алго-
ритмы и предоставляя разработчику широкий набор правил, позволяющих «объяснить» сис-
теме, что именно он от неё хочет. Проблема состоит в том, что порой описание этих правил 
по сложности может превысить сложность самой платы. В этой главе мы на примере рас-
смотрели, как можно достичь наилучших – приемлемых – результатов за минимальное вре-
мя. 

Конечно, наша плата совсем несложная, и, возможно, расставляя компоненты вручную, 
мы затратили бы времени ещё меньше. Но, я думаю, если Вам предлагают помощь, никогда 
не сто́ит пренебрегать ею. Нужно только уметь ей воспользоваться! 

Если Вы работаете над большой и сложной платой, мастера авторасстановки можно 
использовать на начальном этапе проектирования. Определитесь, какие компоненты играют 
наиболее важную роль, а какие – второстепенную. После этого заблокируйте второстепен-
ные компоненты (мелкие резисторы, ёмкости и пр.) за пределами платы, а к остальным при-
мените команду автоматического размещения. Не исключено, что решение, которое предло-
жит Вам программа, окажется лучше того, которое поначалу было у Вас. 

Авторасстановщик может быть полезен и на конечном этапе. Если наиболее важные 
компоненты уже находятся на своих местах, имеет смысл разместить оставшиеся детали в 
автоматическом режиме. 

5.7. Завершение компоновки. 
Закончим расстановку компонентов. Как бы ни хотелось нам отдать всю работу маши-

не, поработать руками всё же придётся. 

C6

C2

R2
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Загрузите цветовую таблицу PLACEMENT.COL и нажмите цифру 0 на дополнительной 
клавиатуре, чтобы появились ratsnests. Сейчас все они одинакового – жёлтого цвета. Чтобы 
легче было ориентироваться, измените цвет цепей GND, +6V и VCC. Для этого войдите в 
Nets, щёлкните правой кнопкой мыши по нужной цепи и из контекстного меню выберите 
Change Color (рис.  5-31). 

 
рис.  5-31 

Определите +6V синим цветом, VCC – сиреневым, а GND – зелёным. 

Проверьте значение Place Grid. Оно должно быть 25 милей. Если у Вас не будет полу-
чаться размещать компоненты на плате ровно, можете уменьшить его вдвое – 12.5 mil. Мо-
жете даже поставить 6.25 mil, но всегда старайтесь придерживаться кратности исходной сет-
ки привязки. 

Напомню основные действия. 

Для ручной расстановки компонентов мы используем Component Tool – кнопка на па-
нели инструментов (рис.  5-32). 

 
рис.  5-32 

Щёлкнув по нужному компоненту, мы можем его переместить в необходимое место на 
плате. 

Основные команды клавиатуры: 
R – повернуть компонент (Rotate); 
T – перенести на противоположную сторону (Opposite); 
L – заблокировать (Lock); 
J – раздвинуть соседние компоненты (Shove); 
Ctrl+F – поиск (Find); 
Alt+S – выбрать компонент или группу компонентов (Select Any…); 
N – выбрать следующий (Next); 
U – отменить последнее действие (Undo); 
M – минимизировать соединения (Minimize Connections). 

Дополнительные команды доступны из контекстного меню, вызываемого щелчком 
правой кнопки мыши. 

Ручное размещение можно производить при включённом режиме Online DRC (рис. 
 5-33). В этом режиме Layout не позволит Вам поставить компонент, если нарушаются прави-
ла расстановки. Например, перекрываются obstacles Place outline соседних компонентов. 

 
рис.  5-33  

рис.  5-34 
При включённом Online DRC невозможно и переместить компонент за пределы печат-

ной платы, поскольку это тоже является нарушением. Если какой-либо компонент Вам в 
данный момент мешает, убрать его можно несколькими способами: 

OrCAD Layout Plus 
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1) выключить проверку Online DRC. 
2) удерживая клавишу Shift, выбрать один или несколько компонентов и отдать коман-

ду: «Auto → Unplace → Component(s)». 
3) перейти в режим Reconnect Mode (рис.  5-34). 
Как дополнительный вариант, можно работать, не выключая Online DRC с установлен-

ной опцией Allow DRC Errors (см. главу «User Preferences.» на стр. 177). 

Режим Reconnect Mode является альтернативным режимом ручной расстановки. В этом 
режиме видны ratsnests только выбранного в текущий момент компонента. Однако если есть 
необходимость, существует возможность временно включить все ratsnests. Для этого нажми-
те цифру 0 – номер слоя Global – на дополнительной клавиатуре. 

Интересен контрастный режим отображения платы, который включается командой: 
«View → High Contrast» или клавишей <.> (точка) на дополнительной клавиатуре. 

 
рис.  5-35 

На рис.  5-35 показана плата при включённых режимах High Contrast и Reconnect Mode. 
Выбран резистор R16. Он отображается реальным цветом. Все остальные компоненты обес-
цвечены. Видны также цепи, подключённые к R16. 

Итак, закончим расстановку компонентов. Мы остановились на варианте платы, пока-
занном на рис.  5-30. У меня она сохранена под именем 15.max. 

 
рис.  5-36 

Переместите разъём R2 в правый верхний участок платы, как показано на рис.  5-36. 
Между R2 и SW5 удобно становится R9. Рядом с R2 поставьте и R12. 

R16

R2

R12

U1

SW5

R9



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 218 

Закончив с разъёмами, наведём порядок около микросхемы U3. Расположим R15, R16 
и C5 так, как показано на рис.  5-37. Обратите внимание, что все компоненты находятся в 
слое TOP. 

 
рис.  5-37 

 
рис.  5-38 

На рис.  5-38 показано размещение деталей около зуммера. Диод D4 расположен с об-
ратной стороны платы между выводами LS1. Транзистор Q1 находится рядом. 

Процессор U2 вместе с сопутствующими компонентами показан на рис.  5-39. Для об-
легчения рисунка большинство ratsnests скрыто. 

 
рис.  5-39 

Ёмкости C6 и C4 находятся с обратной стороны как можно ближе к ножкам питания 2 
и 4 U2. Все остальные компоненты расположены так, чтобы соединяющие их ratsnests были 
наименьшей длины и не перепутывались. 

Расставьте остальные компоненты по своему усмотрению. На рис.  5-40 показан один 
из возможных вариантов. 

Пусть Вас пока не беспокоит, что названия компонентов – Reference Designators – рас-
положены беспорядочно и накладываются друг на друга. В нужный момент мы займёмся и 
этим, а пока я хочу показать ещё одну команду, которая может быть полезна. 

Режим «View → Density Graph → Fine/ Medium/ Coarse» выводит на экран гистограм-
мы плотности монтажа/соединений. Синий цвет соответствует разрежённым участкам, крас-
ный – переполненным. 

Density Graph нашей платы показан на рис.  5-41. 
Вернуться в обычный режим можно командой: «View → Design». 

U1

C6

C4
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рис.  5-40 
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рис.  5-41 

И напоследок – один маленький приём. Внимательно посмотрите на рис.  5-40 и найди-
те ёмкости C1 и С2. Несмотря на то, что оба компонента имеют одинаковый footprint, ровно 
расположить их никак не удаётся (рис.  5-42). Не помогает даже команда Adjust. 

 
рис.  5-42 

Такое может случиться из-за того, что компоненты повёрнуты друг относительно друга 
на 180˚. 

В этом случае разверните один из компонентов, выровняйте его и разверните обратно. 

5.8. Проверка ошибок. 
Проверьте свою работу на наличие ошибок. Для этого выполните команду: «Auto → 

Design Rule Check…». В открывшемся окне установите флажок Placement Spacing Viola-
tions (нарушения правил расстановки), как показано на рис.  5-44 и нажмите <OK>. 

К сожалению, всё не так гладко, как хотелось бы. 
Обнаружились две ошибки (рис.  5-43). 

Список найденных ошибок приводится в таблице 
Error Markers, а сами ошибки помечаются на печатной 
плате особыми маркерами в виде перечёркнутых окруж-
ностей. Цвет маркера совпадает с цветом слоя, в котором 
расположена ошибка. 

 
рис.  5-43 

Войдите в таблицу Error Markers (рис.  5-45). 
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рис.  5-44 

В столбце Location указываются координаты маркера ошибки. В столбце Type поясня-
ется, какое правило было нарушено. В столбце Comment даётся краткое описание. 

 
рис.  5-45 

Дважды щёлкните по первой строчке. Layout Plus перерисует окно дизайна так, чтобы 
маркер ошибки оказался в центре экрана. 

 
рис.  5-46 

Выберите на панели инструментов Error Tool (рис.  5-47) и щёлкните указателем мыши 
по маркеру. В строке состояния Вы увидите описание ошибки (рис.  5-48). 

 
рис.  5-47 

 
рис.  5-48 

Маркер 
ошибки 
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6. Разводка платы. 

Разводка платы или маршрутизация – следующий этап работы над проектом. Пожалуй, 
это самый интересный этап. В Layout Plus предусмотрены три режима маршрутизации: руч-
ной, автоматический и полуавтоматический. Кроме того, если Вам недостаточно тех воз-
можностей, которые предоставляет Layout Plus, можно воспользоваться дополнительными 
инструментами: программой SmartRoute или же Specctra – мощнейшим средством автомати-
ческой разводки. 

В этом разделе мы подробно рассмотрим все методы работы с Layout Plus и коротко 
разберём примеры использования указанных программ. Кроме того, программе Specctra бу-
дет посвящён один из последующих разделов. 

6.1. Настройка параметров. 
На каждом новом этапе работы, прежде всего, мы проверяем соответствующие на-

стройки. 

Первое: проверим ещё раз свойства obstacle Board Outline – границы платы. Мы обсуж-
дали уже эту тему на стр. 154. В данном случае нас интересует толщина obstacle. Как видно 
на рис.  3-68, мы установили этот параметр 25 милей. 

Половина толщины obstacle Board Outline определяет минимальное расстояние от края 
платы до установленных компонентов, дорожек, слоёв Plane и зон заливки медью. 

Второе: определим сетки маршрутизации и vias. Для этого вызовите окно System Set-
tings и установите значения Routing grid и Via grid равными 6.25 милей (рис.  6-1). 

 
рис.  6-1 

Пусть Вас не беспокоит такая малая величина. Современные технологии позволяют де-
лать печатные платы с очень высокой плотностью разводки. Во многих случаях разрешается 
даже совсем не определять сетку для vias. 

Впрочем, возможно стоит проконсультироваться на эту тему с технологом предпри-
ятия, где Вы собираетесь заказывать свои платы. 

Третье. Необходимо задать набор vias, которые мы будем использовать. 
Откройте таблицу Padstacks. В данный момент определён только один тип vias (рис. 

 6-2). 
VIA1 – это via, используемая по умолчанию. Для нас она слишком велика: посмотрите 
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Теперь выберите инструмент Query (рис.  5-49) и, не выключая Error Tool, снова щёлк-
ните мышкой по тому же маркеру. 

 
рис.  5-49 

 
рис.  5-51  

рис.  5-50 
В окне Query будет представлено детальное описание ошибки (рис.  5-51). Резистор 

R16 перекрывает obstacle 284. Это – obstacle типа Place Outline, принадлежащая, очевидно, 
компоненту U3, что хорошо видно на рис.  5-46. 

Устраните ошибку, передвинув R16 чуть ниже, и ещё раз проверьте дизайн на наличие 
ошибок. 

Окно запроса подробной информации может быть использовано не только для анали-
зирования типа ошибок. Попробуйте щёлкнуть по R16, используя Component Tool (рис. 
 5-50). Вы получите подробный отчёт о месторасположении компонента, используемом foot-
print-е, подключённых к нему цепях и пр. 

Недоумение могут вызвать последние две строчки, однако, если посмотреть таблицу 
Text, всё прояснится (рис.  5-52). 

 
рис.  5-52 

Окно Query имеет своё контекстное меню. Например, чтобы сохранить полученную 
информацию в файле, щёлкните внутри окна правой кнопкой мыши и выберите команду 
Output Listing. 

Команда Print… позволяет распечатать содержимое окна на принтере. 
Команда Inactivate запрещает обновление информации в окне, а команда Activate, со-

ответственно, возобновляет. 

Теперь, когда размещение компонентов завершено, и дизайн не содержит ошибок, со-
храните работу. У меня это – файл 16.max. 
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на диаметр отверстия. Он равен 28 милей. Это же около 0.7 мм! 
Ещё обратите внимание на строки SMTOP и SMBOT. Via открыта от маски.  

 
рис.  6-2 

Такие переходные отверстия можно использовать как контрольные точки. К ним мож-
но прикоснуться щупом осциллографа, а большое отверстие позволяет даже припаять тонкий 
проводок. Однако если мы не собираемся впоследствии исследовать работу будущего уст-
ройства, via такого типа нам не нужны. 

 
рис.  6-3 

Переопределите VIA1 в соответствии с рис.  6-3. 

Четвёртое: нужно определить правила относительных расстояний. Для этого выполни-
те команду: «Options → Global Spacing…». 
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Откроется таблица Route Spacing (рис.  6-4). 

 
рис.  6-4 

С этой таблицей мы уже не раз встречались. Изменяя значения в столбцах, можно ука-
зать минимально возможное расстояние для соседних дорожек, минимальное расстояние от 
дорожки до via, от дорожки до вывода компонента и т.д.. 

Следует помнить, что для каждой цепи мы можем установить индивидуальные пара-
метры, используя Net Properties. 

Изменяя значения в строках, можно указать правила для каждого слоя индивидуально. 

Я думаю, что смысл этой таблицы интуитивно понятен. Установите значения, как пока-
зано на рисунке. 

Сохраните файл под очередным именем: 17.max. 

6.2. Разводка цепей питания. 
Загрузите, пожалуйста, цветовую схему ROUTING.COL. Если Вы всё делали синхрон-

но со мной, то плата должна иметь вид, как на рис.  6-5. Надеюсь, что это так. 

 
рис.  6-5 

Зелёные нити – это цепи GND, синие – цепь +6V, сиреневые – VCC, а жёлтые – все ос-
тальные цепи. 
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Я не буду подробно останавливаться на проверке свойств цепей. Nets Properties мы оп-
ределили ещё на этапе подготовки Netlist-а. Если есть желание, можете проконтролировать 
себя, войдя в таблицу Nets и убедиться в следующем: 

– цепи питания, земли и B1_1 ~ B1_5 имеют ширину: 8, 12, 20. 
– остальные цепи имеют ширину: 8, 8, 20. 
– цепь GND разрешена для маршрутизации в слоях TOP, BOTTOM и GND. 
– цепь VCC разрешена для маршрутизации в слоях TOP, BOTTOM и POWER. 
– остальные цепи разрешены только в слоях TOP и BOTTOM. 

Нажмите последовательно клавиши <3> и <4>. Вы должны увидеть следующую карти-
ну (рис.  6-6): 

 
рис.  6-6 

Обратите внимание на зелёные и сиреневые колечки вокруг некоторых выводов. Это – 
соединения thruhole-компонентов с Plain-layers GND и POWER по типу Thermal Relief. Ко-
лечки имеют тот же цвет, что и соответствующие цепи. То есть, зелёные – это соединения со 
слоем GND, а сиреневые – со слоем POWER. 

Теперь посмотрите на четыре кнопки, расположенные внизу платы. Как видите, у каж-
дой кнопки подключены только два вывода – #1 и #3. Это вполне логично, потому что на 
принципиальной схеме они тоже показаны лишь с двумя выводами (рис.  6-7).  

31

SW?

SW PUSHBUTTON  
рис.  6-7 

31

42

SW?

SW PUSHBUTTON  
рис.  6-8 

На схеме так показано, чтобы не загромождать чертёж. В реальности же у кнопки не 
два, а четыре вывода, как показано на рис.  6-8. 

Не будет ошибкой, если всё останется, как есть. Но будет лучше, если, используя Con-
nection Tool, соединить между собой выводы (#1 - #2) и (#3 - #4) у каждой кнопки. 

Вот что должно получиться (рис.  6-9): 

Сохраним дизайн под именем 18.max. 

Поскольку цепи земли и питания расходятся по всей плате, имеет смысл заняться ими в 
первую очередь. Наша задача сильно облегчается наличием дополнительных Plain-слоёв 
POWER и GND. Однако, если со слоем GND всё ясно, то как быть с питанием? Мы имеем 
только один слой POWER при наличии двух цепей: VCC и +6V. 

GND 

VCC
#3 

#1 
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рис.  6-9 

Для начала давайте исключим из маршрутизации все цепи, кроме питающих. Откройте 
таблицу Nets, затем щёлкните мышкой по столбцу Routing Enabled. 

 
рис.  6-10 

Столбец выделится целиком. Щёлкните ещё раз правой кнопкой мыши и из контекст-
ного меню выберите команду Enable ↔ Disable. Все цепи будут исключены из разрешённых 
к разводке. 

Теперь, щёлкая по названиям цепей +6V, GND и VCC, примените к ним ту же команду 
(рис.  6-10). В результате мы увидим плату как на рис.  6-11. 

 
рис.  6-11 

Обратите внимание, что сиреневые ratsnests VCC расходятся неравномерно. В центре 
PCB их практически нет. Зато в центре платы проходит цепь +6V. Если разделить слой 

#1 #2

#3 #4
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POWER на две части, то мы сможем использовать его намного более эффективно. 

Такая возможность есть. Начните новую obstacle с параметрами, как указано на рис. 
 6-12, а именно: 

– тип: Copper Pour; 
– расположение: POWER Layer; 
– Net Attachment: +6V. 

 
рис.  6-12 

Обведите ею замкнутую зону так, чтобы охватить область вокруг цепи +6V. 

Обновите окно дизайна и опять нажмите клавиши <4> и <3>, чтобы увидеть Plane Lay-
ers. На рис.  6-13 видно, что должно получиться. 

 
рис.  6-13 

Obstacle имеет тёмно-зелёный цвет. Это – цвет слоя POWER. Параметр obstacle Width 
определяет зазор между зоной +6V и областью VCC. 

Около разъёма J2 и зуммера LS1 появились синие колечки – признак подключения к 

Copper Pour 

+6V 

GND

VCC 
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слою. 
Сохраните дизайн под очередным именем 18.max. 

6.3. Auto Fanout. 
Откройте окно Check Design Rules, включите все типы проверок с помощью кнопки 

Select All и нажмите <OK>. Layout Plus выдаст сообщение, что обнаружено 32 ошибки. 
Теперь откройте таблицу Error Markers. Все ошибки относятся к SMD-компонентам и 

имеют одинаковый тип – «No Connection to Plane». 
Выделите всю таблицу, щёлкнув по заголовку первого столбца, и удалите ошибки, что-

бы маркеры исчезли с PCB. 

Соединить вывод SMD-компонента с Plane-слоем можно двумя способами. Во-первых, 
соединить вывод короткой дорожкой с via, установленной рядом. Этот процесс носит назва-
ние Fanout70. Во-вторых, можно поставить via прямо под выводом. 

Второй метод применяется в исключительных случаях и требует, чтобы это правило 
было описано в свойствах footprint-а. Мы уже рассматривали такой случай в начале книги на 
стр. 32 (см. рис. (4) Allow via under pad). 

Как правило, пользуются первым методом71. 

Операцию Fanout можно осуществить как вручную, так и с помощью Layout Plus – ав-
томатически. Для автоматического режима укажем необходимые настройки. Для этого зай-
дём в меню: «Options → Fanout Settings…» (рис.  6-14). 

 
рис.  6-14 

Как видно, окно Fanout Settings разделено на две части: 
отдельно для цепей Power и Ground, и отдельно для всех 
остальных цепей – Signals. Цепи Power и Ground имеют со-
единение со слоями Plain, или, вернее, определены в слоях 
Plain. В этом их отличие от прочих цепей. 

Таким образом, если установлен флажок Fanout 
power/gnd, то будет выполнена операция Fanout для цепей, 
определённых в Plain-слое. Если установлен флажок Fan-
out signals, то Fanout будет выполнен для всех остальных 
цепей, разрешённых к маршрутизации. 

Lock after fanout – после завершения рассеивания, до-
рожки будут заблокированы. Это значит, что автотрасси-
ровщик не сможет их переместить. 

Disable after fanout – если по завершении операции 
цепь окажется полностью разведённой, она исключается из 
доступных к маршрутизации. 

Share close vias – разрешает использовать нескольким 
стрингерам одну via, если она находится достаточно близ-
ко. Здесь следует экспериментировать. С одной стороны, 
установка этого флажка позволяет уменьшить количество 
vias на плате, а с другой – может привести к удлинению 
стрингеров. 

Use free vias. О free vias мы поговорим немного позже. Скажу только, что via, опреде-
лённая как «свободная» имеет те же «права», что и компонент. Автотрассировщик не имеет 
возможности перемещать или удалять free vias. 

                                                 
70 В русском языке применяется термин «рассеяние vias». Дорожки, соединяющие такие via с выводами, на-

зываются «стрингерами». 
71 Вместо термина «Fanout» иногда можно встретить выражение «Via Dispersion». 
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IC fanout direction. Если установлен флажок Inside, то разрешается генерация стрин-
геров под компонентом. Соответственно, установка флага Outside разрешает генерацию во-
круг компонента. 

Параметр Maximum fanout distance определяет максимально допустимое расстояние 
от центра площадки до via. 

Layout Plus позволяет определить каждой цепи список используемых для неё vias. Де-
лается это с помощью команды Assign via per net, доступной из таблицы Nets. Если такое 
соответствие не задано или установлен флаг Override via per net, Fanout будет выполнен, 
используя тип via, указанный в окне Default via. 

Теперь установите параметры так, как показано на рис.  6-14 и сохраните плату под 
очередным именем. 

 
рис.  6-15 

Выполните команду: «Auto → Fanout → Board». После завершения операции нажмите 
кнопку Refresh All. Вот что должно получиться (рис.  6-15). 

Проанализируем результат. Проверьте DRC и сделайте, чтобы видны были слои PWR и 
GND. 

 
рис.  6-16 

Сравните рис.  6-16 и рис.  6-13. Бросается в глаза, что исчезли зелёные ratsnests – GND. 
Однако остались ratsnests VCC и +6V. Почему так? 
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Ratsnests земли исчезли потому, что цепь GND полностью разведена. 
Что это значит? Если ratsnests не видны, значит ли это, что цепь больше недоступна? 

Но ведь мы не устанавливали флаг Disable after fanout? 
Нет, цепь по-прежнему доступна для маршрутизации, в чём можно убедиться, заглянув 

в таблицу Nets. В столбце Routing Enabled напротив цепи GND вы увидите Yes. Просто rats-
nests уже разведённых цепей больше не отображаются, что вполне логично. 

Если удалить один из стрингеров или via, принадлежащих GND, зелёные ниточки поя-
вятся вновь. 

Почему же не исчезли ratsnests +6V и VCC? 
Обратите внимание на vias c и d (рис.  6-16). Я увеличу фрагмент (рис.  6-17). Вокруг 

них нет колец, показывающих соединение со слоем PWR. Маркеры ошибок на соответст-
вующих выводах также указывают на отсутствие соединения: «No Connection to Plane». 

 
рис.  6-17 

Причина в том, что указанные vias находятся как раз на границе obstacle, разделяющей 
зоны VCC и +6V. При изготовлении платы это вызовет замыкание. Вот почему питание ока-
залось разведено не полностью. 

Рассмотрим участок e на рис.  6-16 (e, рис.  6-18). Маркер ошибки сообщает, что via 
нарушает правило размещения по сетке привязки (Off-grid via). 

 
рис.  6-18 

Пусть пока так и будет, лучше обратите внимание, что, подчиняясь настройкам (за-
прещены Shared vias), Layout создал для всех выводов, отдельные vias со своими стрингера-
ми. 

Иная ситуация на участке f (рис.  6-16). Цепь +6V не определена ни в одном из слоёв 

1 
2 

3 
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Plain, и, следовательно, с точки зрения Layout Plus, является цепью «Signal». 

 
рис.  6-19 

Для цепей такого типа опция Share close vias разрешена (f, рис.  6-19). 

Возможно, у Вас есть вопрос, почему нет ошибок в местах, подобных g на рис.  6-16 и 
рис.  6-19, ведь via явно находится на границе obstacle. 

Ошибки нет и быть не может, потому что эта via соединяет вывод компонента со слоем 
GND, а obstacle находится в другом слое – слое PWR. Таким образом, в этом месте нет ни 
конфликтов, ни замыканий. 

6.4. Manual Fanout. 
Исправим найденные ошибки вручную, а заодно изучим простейшие приёмы ручной 

разводки. Для этого будем использовать инструмент Add/Edit Route Mode (рис.  6-20). 

 
рис.  6-20 

Щёлкните мышкой по дорожке c (рис.  6-17) и нажмите клавишу <D>, чтобы убрать 
стрингер. Дорожка исчезнет. Теперь щёлкните мышкой по синей ниточке-ratsnest и соедини-
те выводы, как показано на рис.  6-21. 

 
рис.  6-21 

 Обновите экран, и Вы увидите, что синие ratsnests исчезли. Это означает, что цепь +6V 
разведена полностью. 

Внесите исправления там, где нужно и проверьте дизайн. Ошибок быть не должно, а 
сама плата должна выглядеть примерно так (рис.  6-22): 

4 

5 
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рис.  6-22 

Список горячих клавиш, используемых при ручной разводке: 

Клавиша Описание 
Левая кнопка мыши 
(LMB) или Пробел 

Начинает дорожку (щелчок по ratsnest) или выбирает сегмент для 
редактирования.  

Колёсико мыши или 
ESC 

Отмена текущего действия 

Правая кнопка мыши 
(RMB) или + на циф-
ровой клавиатуре 

Вызывает контекстное меню 

F Finish. Автоматически заканчивает дорожку. 
Ctrl+X, G Unroute Segment. Удаляет сегмент. 
D Unroute. Удаляет дорожку. 
Alt+D Unroute Net. Удаляет все дорожки выбранной цепи. 
S Segment. В режиме редактирования позволяет передвинуть сег-

мент трека. 
X Exchange Ends. В режиме редактирования один из концов сегмен-

та закреплён, а второй привязан к указателю мыши. После нажатия 
на клавишу <X>, мышь цепляется к другому концу сегмента. 

Y Any Angle Corners. По умолчанию, проводить дорожки можно 
только под углом, кратным 45˚. Клавиша <Y> отменяет этот ре-
жим. Восстановить его можно, выбрав в меню пункт «135 Cor-
ners» или «90 Corners». 

V Add Via. Ставит via в указанном месте. 
E Add Free Via. Ставит в указанном месте Free via. 
L Lock. Блокирует дорожку. 
Ctrl+L Unlock. Разблокирует дорожку. 
Ctrl+T Tack. Позволяет закрепить ratsnest на PCB. Щелчок левой клави-

шей мыши позволяет создать излом ratsnest. 
M Minimize Connections. Минимизирует ratsnests. Отменяет действие 

Tack. 
N Next. Выбирает следующую неразведённую цепь. Цепи выбирают-
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ся бессистемно. Клавиша полезна, когда на разведённой плате не 
удаётся отыскать обрыв. Нажатие на клавишу <N> устанавливает 
курсор на потерянный (неразведённый) сегмент. 

W Change Width. Позволяет изменить ширину сегмента. 
Shift+W Вызывает окно Track Width, в котором предоставляется выбор из-

менения ширины текущего сегмента, дорожки или всех дорожек 
текущей цепи на плате. 

 
U Отменяет одно последнее действие. 
I, O, Z, Shift+Home Клавиши изменения масштаба. 
C Позиционирование изображения. 
B Масштабирование DRC-зоны. 
H Highlight. Подсветка цепи. Установите курсор мыши над дорожкой 

(без щелчка мышкой) и нажмите клавишу <H>. Цепь подсветится. 
Отменить подсветку можно повторным нажатием на <H>. 

1, 2 и т.д. Перемещает дорожку или сегмент в указанный слой (клавиша со-
ответствует номеру слоя, доступному для маршрутизации). При 
необходимости добавляются vias. 

Некоторые дополнительные команды доступны по нажатию правой кнопки мыши из 
контекстного меню. 

Не забудьте сохранить дизайн. Пусть это будет 21.max. 

6.5. Statistics. 
Окно статистики позволяет осуществить дополнительную проверку дизайна. 

На панели инструментов нажмите кнопку View Spreadsheet и выберите пункт 
Statistics. На рис.  6-23 показан фрагмент таблицы для нашего проекта. 

Обратите внимание на строку %Routed. В столбце Enabled стоит 100%, а в столбце 
Total – 34.09%. Это значит, что все цепи, разрешённые к маршрутизации, разведены полно-
стью. В то же время, это составляет лишь 34.09% от общего количества. Всего же неразве-
дённых цепей на плате осталось 87, о чём сообщается в ячейке Unrouted\Total. 

В таблице статистики приведены сведения о площади платы, количестве компонентов, 
количестве vias, времени, потраченном на разработку и т.д.. 

В конце работы над дизайном обязательно проверьте, что ячейка %Routed\Total (и, 
конечно же, %Placed\Total) равна 100%. 
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рис.  6-23 

6.6. Drill Chart. 
Как Вы думаете, почему я вдруг решил вспомнить про таблицу сверлений? 

Закройте свой дизайн и откройте снова. К Вашему изумлению, совершенно неожидан-
но Layout Plus выдаст сообщение об ошибке (рис.  6-24): 

 
рис.  6-24 

Вот так удар в спину! Вот так несправедливость! Ведь мы же делали всё правильно. 
Мы много раз проверяли дизайн, и никаких ошибок не было. Что же случилось? 

 
рис.  6-25 

В сообщении говорится, что для разных отверстий используется один и тот же символ 
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в таблице Drill Chart. Ну что ж, нажмите клавиши <Shift>+<5>, чтобы увидеть слой DRD, и 
рассмотрите таблицу сверлений (рис.  6-25): 

Действительно, разные отверстия обозначены одинаковым символом. Попытаемся по-
нять, как такое могло случиться. 

Новые отверстия на плате появились после операции Fanout. Так что 22 отверстия диа-
метром 12 mil – это, не что иное, как 22 vias (c, рис.  6-26). 

Что такое два отверстия диаметром 126 mil? 

 
рис.  6-26 

Таким символом обозначены крепёжные отверстия (d, рис.  6-26). 

Layout Plus, добавляя в дизайн новый тип отверстий, почему-то присвоил им символ, 
который уже используется. Это, конечно, очень некрасиво с его стороны, хотя, справедливо-
сти ради, надо отметить, что он же нам про это и сообщил. 

Так или иначе, ошибку нужно исправить. Для этого откройте таблицу Drills (рис.  6-27) 
и исправьте один из одинаковых символов (рис.  6-28). 

рис.  6-27 рис.  6-28 
Теперь снова всё в порядке (рис.  6-29). 

 
рис.  6-29 

Сохраним дизайн под именем 22.max. 

1 

1

2

1 
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6.7. Thermal Relief. 
Соединение с Plain-слоем, как Вы знаете, всегда осуществляется по типу Thermal relief. 

Via соединяется со слоем посредством перемычек. Во время пайки вывода, перемычки не 
позволяют теплу распространиться по всему слою, который в данном случае является боль-
шим радиатором. Благодаря Thermal relief, возможно повысить температуру пайки, и в то же 
время значительно сократить время нагрева вывода без опасения испортить компонент или 
плату. 

В этой главе мы подробнее остановимся на вопросах, касающихся этой темы. 

Прежде всего, повнимательнее рассмотрим нашу плату и на примере слоя PWR хорошо 
разберёмся с тем, что у нас получилось. 

Покажите плату так, чтобы была видна граница PCB, слой PWR и отверстия. Для этого 
последовательно нажмите клавиши: 

<Backspace> – чтобы очистить экран; 
<0> – чтобы увидеть слой GLOBAL; 
<3> – показать слой PWR; 
<Shift>+<6> – показать слой DRILL. 

 
рис.  6-30 

Вы должны увидеть картину, как показано на рис.  6-30. Всё ли Вам понятно на этом 
рисунке? 

c – это просто фон. 
d – граница платы, obstacle Board Outline. Расположена в слое GLOBAL. Поскольку 

цвет слоя жёлтый, obstacle также нарисована жёлтым цветом. 
e – отверстия показаны цветом слоя DRILL, т.е. коричневым. 
f – pad, расположенный в слое PWR, имеет цвет слоя и показан тёмно-зелёным. Это 

место будет вытравлено в процессе изготовления. 
g – этот вывод имеет соединение со слоем. 
h – граница obstacle Copper Pour. Obstacle разделяет слой на две зоны различного пи-

тания, и тоже показана тёмно-зелёным цветом, цветом слоя PWR. 
i и j – колечки Thermal Relief. Колечки имеют цвет соответствующей цепи. 
k – собственно слой PWR. Поскольку слои Plain отображаются инверсно, то всё чёр-

ное внутри obstacle Board Outline – это медь. 

Вот так будет выглядеть сейчас слой PWR на самом деле (рис.  6-31). 

Как можно изменить параметры соединения Thermal Relief? На стр. 46 мы лишь 
вскользь коснулись этой темы, а сейчас рассмотрим подробно. 

1 

2 
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Layout Plus позволяет описывать два вида подключения по типу Thermal Relief: Large 
Thermal Relief и Small Thermal Relief. Названия чисто условные, т.е. никаких функцио-
нальных различий у этих двух видов нет, и Вы можете использовать как Large, так и Small 
совершенно в произвольных целях. 

 
рис.  6-31 

Какой из этих двух видов будет использован при подключении via или вывода к Plane-
слою или obstacle Copper Pour определяется свойствами Padstack-а. 

Откройте таблицу Padstack, и войдите в окно свойств VIA1 (рис.  6-32). 

 
рис.  6-32 

Установите флажок Large Thermal Relief и посмотрите, что изменилось на плате (рис. 
 6-33). Все vias, созданные во время Fanout, изменили способ подключения (рис.  6-34). 

Верните плату в исходное состояние. 

Размеры колец-перемычек задаются в окне Thermal Relief Settings, которое вызывает-
ся командой: «Options → Thermal Relief Settings…» (рис.  6-35). 
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рис.  6-33 

 

 
рис.  6-34 

На рис.  6-36 нарисована via, имеющая соединение с Plain вместе с необходимыми по-
яснениями. Обратите внимание, что параметр Annular Over Drill подразумевает расстояние 
не от центра отверстия, а от его края. 

 
рис.  6-35 

 
рис.  6-36 

 
Попробуйте изменить ширину перемычек (Spokes), увеличив её до 25 милей.  

 
рис.  6-37 

 

 
рис.  6-38 

Результат приведён на рис.  6-38. Изменилась ширина перемычек вокруг всех vias и вы-
водов, использующих подключение Small Thermal Relief. 
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Для thruhole-выводов (не для vias) существует возможность изменить ориентацию пе-
ремычек. Попробуйте проделать такой опыт. Для этого нужно отредактировать свойства pad-
stack соответствующего вывода. 

 
рис.  6-39 

Включите инструмент Pin Tool и щёлкните мышкой по выводу #2 разъёма J2. Теперь, 
чтобы снять выделение, нажмите клавишу <ESC> и откройте таблицу Padstacks. Нужный 
нам Padstack уже выбран. Войдите в его свойства и измените параметр Pad Rotation на 45˚ 
(рис.  6-39). 

 
рис.  6-40 

 
рис.  6-41 

Нажмите <OK> и обновите дизайн. 
Результат нашей работы представлен на рис.  6-41. 

6.8. Алгоритмы автоматической трассировки. 
Автотрассировщик Layout Plus совершает 7 циклов (Sweeps) для разводки PCB. Во 

время каждого цикла меняется алгоритм разводки. 
Чтобы открыть таблицу Route Sweep, войдите: «Options → Route Strategies → Route 

sweeps…» (рис.  6-42). 
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рис.  6-42 

На рис.  6-43 показано окно Sweep-настроек. 

 
рис.  6-43 

Layout Plus «мысленно» делит всю PCB на равные участки, размер которых указан в 
поле Route Box. Размеры эти выбираются в зависимости от плотности платы, количества ис-
пользуемых слоёв и, ограничиваются размером оперативной памяти компьютера. Разводка 
платы осуществляется от участка к участку, в направлении, указанном в поле Sweep Direc-
tion, причём границы участков «размыты», они перекрываются. Процент перекрытия указан 
в поле Overlap %. 

Поле Diagonal Routing разрешает или запрещает проводить дорожки под углом 45˚. 
При включённой опции On разводка под углом 45˚ допускается лишь при необходимости, 
при опции Maximize – везде, где возможно. 

Из таблицы Route Pass, которая вызывается командой: «Options → Route Strategies → 
Route Passes…» (рис.  6-44), видно, что каждый Sweep-цикл состоит из трёх этапов (Passes). 

В окне Edit Route Pass (рис.  6-45) осуществляется выбор алгоритма автоматической 
разводки и ряд других параметров. 

Для управления работой автотрассировщика в Layout Plus применяется система стои-
мости тех или иных действий. Например, высокая цена vias, указанная в поле Via Cost, будет 
вынуждать автотрассировщик по возможности уменьшать их использование на плате. 

Обратной стороной медали высокой стоимости vias может быть увеличение длины до-
рожек. Вместо того, чтобы перейти на другой слой, трассировщик будет пытаться обогнуть 
препятствие. 
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рис.  6-44 

Via Cost равная 100 совсем запрещает использование vias на данном шаге разводки. 

 
рис.  6-45 

Retry Cost – стоимость повторения. Определяет 
поведение автотрассировщика при попытке провес-
ти трек в обход уже существующей дорожки. 

• При величине Retry Cost равной 30 трассировщик 
предпримет одну попытку обогнуть существую-
щую на плате дорожку, а потом попытается пере-
развести её. 

• Если Retry Cost = 50, будет предпринято три по-
пытки обойти существующую дорожку, после че-
го она будет разведена заново. 

• 60 – будет предпринято 9 попыток. 
• Retry Cost = 100 запрещает переразводить уже 
проложенные дорожки. 
Имеет смысл устанавливать низкое значение Re-

try Cost на начальном этапе разводки платы с тем, 
чтобы дать автотрассировщику больше свободы и 
более высокое на конечном этапе, чтобы ограничить 
многочисленные и малоэффективные попытки пере-
разводки уже разведённых дорожек.  

Если установлена низкая стоимость vias, то параметр Retry Cost должен быть высоким, 
иначе чрезмерная степень ремаршрутизации уже разведённых дорожек приведёт к наводне-
нию платы переходными отверстиями. 

Напротив, высокая стоимость vias при низком значении Retry Cost позволит избавиться 
от «неудобных» дорожек, которые мешают остальным. 

Параметр Route Limit определяет настойчивость трассировщика в прокладке трасс. 
Если этот параметр слишком высок, трассировщик будет пытаться во что бы то ни стало за-
вершить разводку в ущерб качеству. 

• Значение этого параметра, равное 20 приведёт к разводке только тех дорожек, на 
пути которых нет никаких значительных препятствий. 
• Значение 50 приведёт к разводке примерно 90% платы. 
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• Значение 80 является стандартным. 
• Значение 100 использовать не рекомендуется. Если при значении 80 развести пла-
ту не удалось, сто́ит, возможно, изменить размещение компонентов. 

Attempts указывает количество попыток для разводки соединения. Для разводки 90 со-
единений из 100 достаточно 2 attempts. Значение, равное 12, обычно достаточно для боль-
шинства случаев. 

В поле Type выбирается алгоритм разводки. 

Heuristics – игнорирует значения всех параметров Costs, исключая параметр Attempts. 
Разводятся только самые очевидные дорожки, по горизонтали или вертикали. 

Maze – алгоритм «поиск выхода из лабиринта». Учитываются все параметры стоимо-
сти. Во время работы «Лабиринта» дорожки могут сдвигаться и переразводиться. 

Auto DFM – (Design for Manufacturability) эквивалентна команде Cleanup Design. Оп-
тимизирует разводку платы, устраняя некоторые проблемы. А именно: 

– скашивает острые углы (Miter 90˚ Corners); 
– исправляет ошибки соединения дорожек с контактными площадками; 
– исправляет ошибки, связанные с соприкосновением vias и др. 

Fanout – используется алгоритм Heuristics для осуществления операции Fanout. Пред-
почтение отдаётся расположению vias под компонентом. 

Via Reduce – попытка уменьшить количество переходных отверстий на плате. 

Auto CDE – (Clear Design Error). Удаляет (Unrouting) замкнутые дорожки, которые 
могли появиться после того, как Вы передвигали компоненты на уже разведённой плате. 
Auto CDE рекомендуется также выполнять после операции ECO – обновления дизайна через 
netlist. 

 
рис.  6-46 

Дополнительные опции: 
Partial – если Вы выполняете, к примеру, команду Route DRC/Route box, то снимите 

этот флаг, чтобы дорожки, которые выходят за пределы DRC-зоны не разводились совсем. 
Если этот флаг установить, выходящие наружу соединения будут разведены, но лишь час-
тично, до границы зоны. 

Fast – быстрый (черновой) режим. Позволяет оценить возможность разводки платы и 
сделать вывод о качестве расстановки компонентов. 



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 244 

 
рис.  6-47 

Флаг Enabled разрешает выполнение соответст-
вующего этапа. 

Флаг Done устанавливается автоматически после 
завершения этапа. Если Вы хотите повторить развод-
ку, убедитесь, что этот флаг сброшен. 

Ещё одна таблица вызывается командой: 
«Options → Route Strategies → Route Layers…» (рис. 
 6-46). 

Двойной щелчок ведёт в окно настроек, описы-
вающих поведение автотрассировщика в каждом слое 
во время Sweep-циклов (рис.  6-47). 

Routing Enabled – разрешает слой для маршрути-
зации. 

Layer Cost – устанавливает стоимость слоя. Чем выше цена слоя, тем меньше дорожек 
на нём будет. 

Primary Direction – устанавливает предпочтительное направление дорожек. 

Between Pins – определяет, что автотрассировщик будет стараться провести дорожки 
между выводами микросхем или обогнуть их. Значение 100 запрещает разводку дорожек 
между выводами. 

6.9. Стратегии. 
Как уже говорилось ранее, стратегии являются шаблонами, набором правил, опреде-

ляющих работу инструментов автоматической расстановки и автоматической маршрутиза-
ции. Выбор той или иной стратегии осуществляется загрузкой соответствующего файла. 
Файлы стратегий имеют расширение .SF и располагаются в директории: 

“…tools\layout_plus\data” 

Имеется пять стратегий размещения, имена которых начинаются с букв «PL». Все ос-
тальные файлы с расширением .SF – стратегии маршрутизации. Имя файла стратегии скла-
дывается из следующих составляющих72: 

2, 4, 6 или 8 – указывает количество маршрутизируемых слоёв. 

H – указывает, что слой TOP используется преимущественно для горизонтальной раз-
водки. 

V – указывает, что слой TOP используется преимущественно для вертикальной раз-
водки. 

THR – стратегия предназначена для работы с thruhole-платами. 

SMD – для двухслойных плат, выполненных по SMT или смешанной технологии. 

SM1 – для плат, выполненных по SMT или смешанной технологии, у которых компо-
ненты расположены только со стороны слоя TOP (Component side). 

SM2 – для плат, выполненных по SMT или смешанной технологии, с расположением 
компонентов на двух сторонах (Component side и Solder side). 

Эти стратегии предназначены для работы над платами с количеством слоёв до восьми. 
Если Вы разрабатываете более сложную плату, то можете модифицировать любую из суще-

                                                 
72 См. on-line документацию «OrCAD Layout User’s Guide». 
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ствующих стратегий. 

Файлы: 

STD.SF – стандартная стратегия, которая загружается по умолчанию. 

2__SMD_H.SF – применяется для двухслойных плат, выполненных по SMT или сме-
шанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – горизонтальное. 

2__SMD_V.SF – применяется для двухслойных плат, выполненных по SMT или сме-
шанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – вертикальное. 

2__THR_H.SF – применяется для двухслойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – горизонтальное. 

2__THR_V.SF – применяется для двухслойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – вертикальное. 

386LIB.SF – для библиотек, транслированных из OrCAD PCB386+. 

4__SM1_H.SF – применяется для четырёхслойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены на одной сторо-
не. Направление разводки для верхнего слоя – горизонтальное. 

4__SM1_V.SF – применяется для четырёхслойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены на одной сторо-
не. Направление разводки для верхнего слоя – вертикальное. 

4__SM2_H.SF – применяется для четырёхслойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – горизонтальное. 

4__SM2_V.SF – применяется для четырёхслойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – вертикальное. 

4__THR_H.SF – применяется для четырёхслойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – горизонтальное. 

4__THR_V.SF – применяется для четырёхслойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – вертикальное. 

6__SM1_H.SF – применяется для шестислойных плат, выполненных по SMT или сме-
шанной технологии, у которых компоненты расположены на одной стороне. 
Направление разводки для верхнего слоя – горизонтальное. 

6__SM1_V.SF – применяется для шестислойных плат, выполненных по SMT или сме-
шанной технологии, у которых компоненты расположены на одной стороне. 
Направление разводки для верхнего слоя – вертикальное. 

6__SM2_H.SF – применяется для шестислойных плат, выполненных по SMT или сме-
шанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – горизонтальное. 

6__SM2_V.SF – применяется для шестислойных плат, выполненных по SMT или сме-
шанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – вертикальное. 

6__THR_H.SF – применяется для шестислойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – горизонтальное. 
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6__THR_V.SF – применяется для шестислойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – вертикальное. 

8__SM1_H.SF – применяется для восьмислойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены на одной сторо-
не. Направление разводки для верхнего слоя – горизонтальное. 

8__SM1_V.SF – применяется для восьмислойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены на одной сторо-
не. Направление разводки для верхнего слоя – вертикальное. 

8__SM2_H.SF – применяется для восьмислойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – горизонтальное. 

8__SM2_V.SF – применяется для восьмислойных плат, выполненных по SMT или 
смешанной технологии, у которых компоненты расположены с одной или двух 
сторон. Направление разводки для верхнего слоя – вертикальное. 

8__THR_H.SF – применяется для восьмислойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – горизонтальное. 

8__THR_V.SF – применяется для восьмислойных плат, выполненных по thruhole-
технологии. Направление разводки для верхнего слоя – вертикальное. 

FAST_H.SF – черновая разводка со включённой опцией Fast. Позволяет оценить каче-
ство расстановки компонентов. Направление разводки для верхнего слоя – го-
ризонтальное. 

FAST_V.SF – черновая разводка со включённой опцией Fast. Позволяет оценить каче-
ство расстановки компонентов. Направление разводки для верхнего слоя – вер-
тикальное. 

JUMPER_H.SF – применяется для разводки плат с перемычками. Направление раз-
водки для верхнего слоя – горизонтальное. 

JUMPER_V.SF – применяется для разводки плат с перемычками. Направление раз-
водки для верхнего слоя – вертикальное. 

REROUT_H.SF – ремаршрутизация уже разведённой платы с горизонтальным на-
правлением разводки верхнего слоя. 

REROUT_V.SF – ремаршрутизация уже разведённой платы с вертикальным направле-
нием разводки верхнего слоя. 

VIARED_H.SF – попытка уменьшить количество vias на уже разведённой плате с го-
ризонтальным направлением разводки верхнего слоя. 

VIARED_V.SF – попытка уменьшить количество vias на уже разведённой плате с вер-
тикальным направлением разводки верхнего слоя. 

6.10. Автоматическая разводка. 
В свете новых полученных знаний попробуем развести нашу плату в автоматическом 

режиме, пользуясь различными методами. 
Поскольку цепи питания уже разведены, имеет смысл исключить их из списка доступ-

ных к маршрутизации. Для этого откройте таблицу Nets, щёлкните по столбцу Routing En-
abled и из контекстного меню выберите команду Enable ↔ Disable. 

Чтобы автотрассировщик во время работы не сместил стрингеры и vias, созданные во 
время операции Fanout, заблокируем цепи VCC, +6V и GND. Чтобы заблокировать цепь, 
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щёлкните по её названию и выберите команду Lock. 
Закройте таблицу. 

 
рис.  6-48 

Вы увидите (рис.  6-48), что появились ratsnests цепей, ожидающих разводки. 

Если на плате имеются цепи, которые нужно развести в первую очередь или для кото-
рых установлены особые требования, то они должны быть разведены на данном этапе вруч-
ную. После этого они также исключаются из доступных к маршрутизации и блокируются. 

На нашей плате таких цепей нет, поэтому этот шаг мы пропускаем. 

Как Вы уже знаете, автотрассировщик Layout Plus мысленно разбивает печатную плату 
на зоны одинакового размера и старается произвести разводку участка за участком, двигаясь 
в направлении, указанном в настройках Sweep Direction. 

Пытаясь провести трассу, трассировщик раздвигает уже проложенные дорожки. Если 
таким методом освободить путь не удаётся, трассировщик пытается обогнуть препятствие 
или перейти на другой слой. Если после нескольких попыток и это не удаётся, трассировщик 
попытается ремаршрутизировать мешающую дорожку. 

В Layout Plus доступны команды для автоматической маршрутизации всей платы, зоны 
в пределах DRC-рамки или только одного компонента. 

Теперь обязательно сохраните свой дизайн! У меня это – 23.max. 

Сейчас мы проверим нашу плату на предмет возможных конфликтов во время развод-
ки, а заодно выясним предпочтительное направление треков по слоям. 

Загрузите стратегию FAST__H.SF командой: «File → Load…» и выполните: «Auto → 
Autoroute → Board». Это стратегия быстрой трассировки с преимуществом горизонтальной 
маршрутизации в верхнем слое. 

Layout Plus очень быстро завершит работу. Нажмите кнопку Design Rule Check, и да-
вайте проанализируем результат (рис.  6-49). 

Как минимум, два конфликтных участка существует на плате. В зоне c – узкое место, 
дорожки идут очень плотно. В зоне d из-за плотности монтажа не удалось произвести раз-
водку. Возможно, было бы неплохо разместить компоненты немного иначе. 

Закройте дизайн и откройте файл 23.max заново. Загрузите стратегию FAST__V.SF. 
Попробуем вариант вертикальной разводки (рис.  6-50). 

Трудности в участке c пропали, а участок d остался. Компоненты, расположенные 
под микропроцессором создают проблемы в работе автотрассировщика. 
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рис.  6-49 

Поскольку это – учебная плата, мы не будем ничего перемещать. Оставим всё, как есть. 
Кроме того, Вы, наверное, согласитесь, что по результатам пробной разводки мы должны 
предпочесть стратегию с вертикальной ориентацией треков в верхнем слое. Однако чтобы 
убедиться в правильности нашего выбора, я предлагаю сделать несколько вариантов. 

 
рис.  6-50 

На рис.  6-51 показан результат работы стратегии STD.SF. 

 
рис.  6-51 

На рис.  6-52 – 2__SMD_H.SF. 

1 2
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рис.  6-52 

На рис.  6-53 – 2__SMD_V.SF. 

 
рис.  6-53 

Как и следовало ожидать, в последнем случае разводка получилась наиболее удачная. 
Особенно обратите внимание на верхний ряд выводов процессора. 

Убедитесь, что дизайн не содержит ошибок и сохраните плату под именем 24.max. 

6.11. Cleanup Design. 
Теоретически, наша плата почти готова. Во всяком случае, её можно изготовить, и уст-

ройство будет работать. 
Практически же, останавливаться ещё рано. Посмотрите, пожалуйста, на рис.  6-54. На 

плате, очевидно после ремаршрутизации во время работы трассировщика, остались ненуж-
ные переходы c. Дорожки соединяются под немыслимыми углами d или изгибаются со-
вершенно бессмысленным образом e. 

Всё это не придаёт плате красоты. И уж конечно, такой работой нельзя похвастаться. 
Кроме того, если Вы создаёте устройство, чувствительное к помехам или с высокоскорост-
ными связями, то такие «недочёты» могут оказаться просто губительными. 

Оставив пока в стороне вопрос о проектировании скоростных систем, разберёмся, как 
можно средствами Layout Plus и с минимальными затратами времени исправить ситуацию. 

Инструмент, который нам нужен, называется Cleanup Design. Выполните команду: 
«Auto → Cleanup Design…». Откроется окно настроек (рис.  6-55). 
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рис.  6-54 

 
рис.  6-55 

Окно имеет два поля: Cleanup Routing (подчистка 
трассировки) и Cleanup Database (очистка базы данных). 

Доступные опции: 
• Скос прямых углов. Если возможно, прямой угол будет 
заменён диагональю. 
• Устранение острых углов. 
• Устранение ненужных изгибов. 
• Устранение ситуаций, когда перекрываются две дорож-
ки одной и той же цепи. 
• Устранение ситуаций, когда перекрываются две via од-
ной и той же цепи или же существует возможность исполь-
зовать одну via вместо двух. 
• Оптимизация подключения дорожки к контактной пло-
щадке. 

Включение опции Override locked tracks позволяет 
трассировщику двигать в случае необходимости заблоки-
рованные дорожки. 

OrCAD Layout Database подобна кэшу, который существует в OrCAD Capture. Когда 
Вы добавляете в дизайн новый компонент, Layout сохраняет копию его footprint-а73 из биб-
лиотеки в локальной базе данных. Таким образом, в файле .max содержится вся информация 
о разрабатываемой PCB, включая  используемые footprint-ы, padstacks и настройки. Это 
удобно, если нужно перенести работу на другой компьютер. С другой стороны, в локальной 
базе данных может содержаться избыточная информация. Например, о неиспользуемых объ-
ектах, уже удалённых из дизайна. Операция Cleanup Database позволяет удалить ненужные 
данные и, как следствие, уменьшить размер файла .max. 

Мастер очистки дизайна может быть запущен вручную или автоматически во время ра-
боты одной из стратегий. 

Откройте окно статистики (рис.  6-56) платы, изображённой на рис.  6-53. Обратите 
внимание на количество vias. 

Теперь загрузите стратегию VIARED_V.SF и запустите Autorouter. Работа стратегии 
завершится утилитой Cleanup. 

Новая разводка показана на рис.  6-58. 

Проверьте плату утилитой DRC и сохраните под именем 25.max. 

                                                 
73 Instance. 

1 

2 3
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рис.  6-56 
 

рис.  6-57 
Вновь откройте окно статистики и сравните результаты (рис.  6-57). 

 
рис.  6-58 

Обратите внимание, что уменьшилось не только количество vias, но и общая длина до-
рожек (Routed Dist). 

6.12. Растровая  и векторная графика. Типы автотрасси-
ровщиков. 

Если Вы знаете, в чём отличие растровой графики от векторной, то можете пропустить 
бо́льшую часть этой главы. Если же не очень, то давайте немного отвлечёмся и поговорим на 
эту, казалось бы, не имеющую к разводке печатных плат никакого отношения, тему. 

Как создаётся изображение на экране компьютера? 
Существует два способа: растровый и векторный. Рассмотрим простейший пример. На 

чёрно-белом, монохромном74 дисплее нужно нарисовать отрезок определённой толщины. 
Растровый метод хранения изображения заключается в том, что всё рабочее поле разби-

                                                 
74 Без градаций яркости. 
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вается сеткой на равные и очень мелкие участки – пи́ксели. Чтобы нарисовать на таком поле 
фигуру, изображённую на рис.  6-59, каждому пикселю, находящемуся под фигурой, при-
сваивается значение «закрашен» (рис.  6-60). Все остальные пиксели, находящиеся рядом, 
имеют значение «не закрашен». 

 
рис.  6-59 

 
рис.  6-60 

 
рис.  6-61 

На рис.  6-61 хорошо видно, что такой метод хранения изображения приводит к иска-
жениям. Очевидно, что чем чаще шаг сетки, чем мельче размер пикселей, тем меньше будут 
и искажения. 

 
рис.  6-62 

 
рис.  6-63 

Откройте на компьютере любую кар-
тинку формата .BMP, .GIF, .PNG или 
.JPG в своём любимом графическом 
просмотрщике (рис.  6-62) и попробуйте 
увеличить изображение. Вы увидите, что 
изображение портится, «распадается на 
квадратики» (рис.  6-63). 

Все современные мониторы являются растровыми. Если разрешающая способность 
Вашего монитора75 установлена как 1024х768, это значит, что всё изображение, которое Вы 
видите, формируется из 1024х768 пикселей. 

Сколько нужно памяти для хранения растрового изображения? 
Чтобы нарисовать чёрно-белую картину на экране монитора размером 1024х768 пик-

селей необходимо иметь видеопамять объёмом 786΄432 бит. Вне зависимости от того, что́ 
будет нарисовано на экране, количество памяти остаётся неизменным, меняется лишь ин-
формация в ячейках-пикселях: закрашен / не закрашен76. 

Это – очень удобный метод хранения графической информации. Кроме того, растро-
вые изображения очень просто обрабатывать, потому что растр – это, фактически, двумер-
ный массив, копия экрана в памяти компьютера. 

Чтобы нарисовать отрезок, подобный тому, что показан на рис.  6-59 в векторном фор-
мате, мы должны создать три переменные: координаты начала отрезка, координаты его кон-
ца и толщину. Этого вполне достаточно. 

В более сложном случае, необходимо указать дополнительную информацию. Напри-
мер, чтобы нарисовать круг, нужно создать объект «круг» с атрибутами: координаты центра, 
радиус, толщина окружности, закрашен / не закрашен. 

Для описания произвольной фигуры нужны следующие данные: объект «фигура», ко-
ординаты вершин, толщина огибающей, атрибут закрашена / не закрашена. 

                                                 
75 Screen resolution. 
76 Возможно, Вы возразите: «У меня хранится коллекция фотографий в формате .JPG. Я сам их снимал 

цифровым фотоаппаратом. Они все одинакового размера, но занимают на диске разное количество места». 
Дело в том, растровые изображения хранятся в компьютере в упакованном, сжатом виде. Преобразуйте 

свои фотографии в формат .BMP, и Вы сразу увидите, что они не только станут занимать одинаковое количест-
во места на диске, но и многократно вырастут в объёме. 

 

OrCAD Layout Plus 

 Стр. 253 

Примером электронного устройства, выводящего на экран изображение в векторной 
форме, может служить электронно-лучевой осциллограф. Наверняка, Вы видели магические 
фигуры Лиссажу. Луч осциллографа воспроизводит фигуру на экране абсолютно точно, та-
кой, какая она есть на самом деле, без промежуточного преобразования в растр. 

Ещё примеры. Принтер является растровым устройством, а чертёжный перьевой гра-
фопостроитель – векторным. Сканер – устройство для ввода изображения в растровом фор-
мате, а ручной планшет – в векторном. 

 
рис.  6-64 

 
рис.  6-65 

Как видно, векторный способ хране-
ния изображений более сложен, но у не-
го есть ряд преимуществ. Во-первых, 
векторная фигура не искажается. От-
кройте изображение из векторного фай-
ла с расширением .WMF (рис.  6-64) и 
попробуйте увеличить его. Вы увидите, 
что картинка не портится, как бы Вы ни 
старались (рис.  6-65). 

Второе преимущество векторной графики – значительно меньший, как правило, размер 
файла. Впрочем, в данном случае, размер файла зависит от количества объектов, из которых 
состоит изображение. Поэтому, если изображение слишком сложное, оно может превысить 
по размеру свой растровый эквивалент. 

Третье преимущество является наиболее существенным. На рис.  6-66 нарисованы два 
отрезка в векторном формате. Они расположены очень близко друг к другу, но всё же хоро-
шо различимы. 

На рис.  6-67 показано преобразование их в растровую форму, а на рис.  6-68 – резуль-
тат. Из-за недостаточного количества выделенной памяти, два отрезка слились в одну фигу-
ру. Изображение не просто исказилось, оно приобрело другой смысл! 

 
рис.  6-66  

рис.  6-67 

 
рис.  6-68 

Если векторный формат имеет столько преимуществ, почему же до сих пор существует 
растровый? 

Преобразуйте каким-либо графическим редактором большой файл .WMF в формат 
.BMP. Теперь попробуйте открыть оба файла. Вы не можете не заметить, что картинка .BMP 
открывается практически мгновенно, а .WMF – с задержкой. Изображение появляется посте-
пенно, компьютер как бы быстро-быстро рисует его. 

Вот Вам и первое преимущество растровых изображений. Простой способ записи даёт 
значительный выигрыш в производительности. Изображение в векторном формате, это, если 
хотите, программа, которая описывает процесс создания этого самого изображения. 

Другая причина мирного сосуществования двух принципиально разных форматов – 
цели, которые ими решаются. Попробуйте, например, описать морской пейзаж в векторной 
форме! 

С другой стороны, технические чертежи сто́ит хранить именно в векторном формате, 
поскольку они состоят из отрезков, окружностей и других геометрических фигур. 



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 254 

Так и поступают. Фотографии и картины хранят в растровом формате, а чертежи, схе-
мы и печатные платы – в векторном. 

Да, печатные платы, как только что сказано, хранятся в векторном формате. Это не со-
всем тот формат, который используется для записи обычных изображений, но основные 
принципы такие же. Все объекты, «нарисованные» на плате – контактные площадки, copper 
zones, vias – представляются в виде примитивов, простейших геометрических фигур. Напри-
мер, дорожка является совокупностью отрезков (сегментов) определённой ширины. 

Несмотря на это, существует два вида трассировщиков печатных плат. 
Grid-mapped routers используют так называемую «сеточную» технологию. Сеточный 

трассировщик мысленно разбивает плату на «пиксели» после чего начинает разводку. 
ShapeBased или Gridless маршрутизаторы являются бессеточными. Это значит, что 

они не осуществляют промежуточного преобразования PCB в «пиксельную» форму, а опе-
рируют объектами в их истинном виде. 

Обоим типам трассировщиков присущи достоинства и недостатки, полностью отра-
жающие достоинства и недостатки используемой технологии. 

Grid-mapped трассировщики имеют значительные преимущества в скорости разводки. 
ShapeBased трассировщики обеспечивают высокое качество и способны работать с платами 
более высокой плотности (см. рис.  6-66). Бессеточные трассировщики менее требовательны 
к размеру оперативной памяти компьютера, но требуют более мощного процессора. 

OrCAD Layout Plus располагает трассировщиками как первого так и второго типа. 
Встроенный autorouter использует технологию Grid-mapped. Вы можете воспользоваться им 
в большинстве случаев, когда важна скорость выполнения проекта. 

В том случае, если плотность PCB слишком высока, и плату не удаётся развести обыч-
ным методом, существует возможность использовать бессеточный маршрутизатор, который 
выполнен в виде внешнего модуля. Называется он – SmartRoute. 

6.13. SmartRoute. 
SmartRoute – программа автоматической трассировки, входящая в пакет OrCAD. Главное 

отличие SmartRoute от встроенного трассировщика Layout Plus – использование ShapeBased 
технологии. 

 
рис.  6-69 

Запускается SmartRoute из окна Layout Session коман-
дой: «Tools → SmartRoute». 

Запустите программу и откройте файл 23.max. Это – 
плата, у которой уже разведены цепи питания (рис.  6-48). 

Программа имеет простой и интуитивно понятный ин-
терфейс (рис.  6-70). Она очень проста в самостоятельном 
изучении, поэтому мы не будем останавливаться на ней 
слишком подробно, а лишь рассмотрим основные команды 
и произведём пробную разводку нашей платы. 

Как обычно, все команды доступны через систему меню, расположенного в верхней 
части экрана (c). Внизу (d) находится панель индикаторов текущего состояния маршрути-
затора, которая может меняться в зависимости от выбранного инструмента. Сюда же выво-
дятся подсказки. 

SmartRoute принимает из Layout Plus плату со всеми текущими настройками, как то: 
количество и конфигурация слоёв, параметры цепей и расстояния между объектами (Clear-
ances). Если необходимо изменить какой-либо параметр, то, в большинстве случаев, это де-
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лается в Layout Plus. 

 
рис.  6-70 

Конфигурация основных горячих клавиш – масштабирование изображения, переклю-
чение слоёв – такая же, как в Layout. 

Чтобы подготовить плату к автоматической разводке выполните команду: «Options → 
Parameters» (рис.  6-71). 

 
рис.  6-71 

В этом окне вы можете указать предпочтительное направление разводки для каждого 
слоя (слои Plane не показываются), изменить некоторые настройки и проанализировать уста-
новленные параметры. 

Все значения переменных в поле Parameters рассчитываются SmartRoute заранее, и из-

1 

2
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менять их не рекомендуется. Они отражают усреднённое (типичное) значение таких величин 
как ширина дорожек и расстояние между ними, размер типичного переходного отверстия и 
т.д.. Точные и более подробные значения этих параметров устанавливаются в Layout Plus. 

 
рис.  6-72 

Командой: «Options → Net Properties…» выводится окно, в котором указываются свой-
ства каждой цепи (рис.  6-72). Это окно также наследуется из Layout Plus, однако, при необ-
ходимости Вы можете внести сюда кое-какие изменения. 

Командой: «Options → Routing Passes…» выводится окно, в котором активизируются 
стратегии проходов трассировщика (рис.  6-73). Рассмотрим его более подробно. 

 
рис.  6-73 

Memory77 – разводка цепей, характерных при использовании микросхем памяти или 
иных однотипных компонентов, соединяющихся параллельно. 

Если Вы посмотрите на рис.  6-74, то поймёте, что́ я имел в виду. На рисунке показана 
разводка индикаторов на нашей плате методом Memory. 

                                                 
77 Другое название стратегии – Bus, разводка шин данных. 
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рис.  6-74 

Разводка использует алгоритм Heuristic, во время которого соединяются выводы, нахо-
дящиеся «в прямой видимости» друг от друга или выводы, для которых поиск маршрута дос-
таточно очевиден. 

Fan Out Used SMD Pins – выполняется операция Fanout. 

Pattern – во время этого шага, SmartRoute перебирает несколько встроенных шаблонов 
разводки, «примеряя» их на Вашу плату. 

Push’N Shove – основной этап. SmartRoute может сдвигать и переносить разведённые 
дорожки, чтобы освободить место новой трассе. 

Rip Up – устранение конфликтов. Место конфликта помечается на плате жёлтым 
кружком. На этом этапе SmartRoute разрывает дорожки в зоне конфликта и ремаршрутизиру-
ет их. 

Evenly Space Tracks – центрирование дорожек между выводами компонентов. Раздви-
гание трасс, где это возможно, для равномерного заполнения платы. 

Track Corners – сглаживание прямых углов. 

После того, как все параметры заданы, можно проанализировать настройки командой: 
«Auto → Pre-Route Synopsis…». В отчёте указывается примерное время, необходимое для 
разводки. SmartRoute вычисляет его, исходя из времени, затраченного на трассировку тесто-
вой платы. 

Чтобы выполнить тестовую разводку, найдите в группе программ OrCAD ярлык Lay-
out Plus SmartRoute Calibrate и запустите его. 

 
рис.  6-75 

Попробуйте развести нашу плату, меняя различные параметры. Один из вариантов раз-
водки со всеми включёнными Route Passes показан на рис.  6-75. 

Направление разводки в каждом слое выбрано: Best Choice. 
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Совместимость Layout Plus и SmartRoute! 

• SmartRoute не поддерживает скругление соединений. 
• Не поддерживаются прямоугольные vias. 
• Не поддерживаются ситуации, когда Plain-layer разделён на зоны, как это сделано в 

нашем случае. 
• Применение зон Copper Pour может вызвать проблемы. Рекомендуется сначала вы-

полнить трассировку платы, и лишь затем создавать области заливки медью. 

Несколько слов о ручной разводке в SmartRoute. 
В SmartRoute имеется лишь два инструмента ручной разводки, и оба очень примитив-

ны. Первый включается командой: «Tools → Manual Route» или той же командой из контек-
стного меню и позволяет выполнять лишь самые простейшие действия. 

 
рис.  6-76 

 
рис.  6-77 

 
рис.  6-78 

Второй режим включается командой: «Tools → SketchATrack78». Для того чтобы со-
единить два вывода, Вы должны лишь указать примерное направление. Вот как это делается. 

 
рис.  6-79 

 
рис.  6-80 

Активизируйте SketchATrack 
и щёлкните мышкой по выводу 
(рис.  6-76). Цепь подсветится. 
Укажите мышкой на один из 
pad-ов и, зажав левую кнопку 
мыши, проведите линию до дру-
гого вывода (рис.  6-77). Отпус-
тите кнопку мыши, и SmartRoute 
проложит, если это возможно, 
дорожку по указанному Вами 
пути (рис.  6-78). 

На рис.  6-79 и рис.  6-80 по-
казан другой вариант соедине-
ния. 

6.14. SPECCTRA autorouter. 
Прошу знакомиться: SPECCTRA, мощнейший ShapeBased автотрассировщик. 

SPECCTRA – это Photoshop79 в мире PCB. Количество настроек в SPECCTRA потрясает. 
SPECCTRA позволяет качественно разводить чрезвычайно сложные платы с учётом множе-
                                                 

78 Sketch – эскиз, набросок. 
79 Adobe Photoshop – самый известный редактор растровой графики. За свои безграничные возможности дав-

но считается эталоном у профессионалов. 
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ства требований. Будьте уверены, если SPECCTRA не может развести Вашу плату, значит 
это невозможно. 

Ну а теперь, когда фанфары смолкли, попробуем использовать её для наших скромных 
целей. 

Откройте в Layout Plus плату 23.max (рис.  6-48). Эту плату мы разводили самыми раз-
нообразными способами. Посмотрим, как справится с ней SPECCTRA. 

Выберите команду: «Auto → Autoroute → SPECCTRA». Откроется окно транслятора 
SPECCTRA Interface (рис.  6-81): 

 
рис.  6-81 

В поле c указывается путь к программе. В поле d – путь к командному файлу, кото-
рый выполняется после запуска трассировщика. Сотрите это поле, если оно не пустое, и на-
жмите кнопку <Create>. Layout Plus создаст новый файл, исходя из текущих настроек. 

 
рис.  6-82 

На вопрос: «Желаете ли Вы внести изме-
нения в созданный файл?» (рис.  6-82) следу-
ет ответить: <Нет>. 

Нажмите кнопку <Route>. 

Вам будет предложено указать тип используемой лицензии. Выберите, если это воз-
можно, «SPECCTRA expert system» (рис.  6-83), так как остальные типы лицензий имеют те 
или иные ограничения. 

 
рис.  6-83 

SPECCTRA, как и SmartRoute, принимает данные из Layout, производит все необходи-
мые операции и возвращает плату обратно. После выбора лицензии открывается окно 
SPECCTRA User Interface (рис.  6-84) и начинается выполнение командного файла. 

Вы можете наблюдать за ходом разводки платы. В поле c выводится информация о те-
кущем состоянии платы: степень завершённости, количество неразведённых цепей, количе-
ство конфликтов и т.д. 

2 
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Прервать или приостановить работу программы можно с помощью кнопки-индикатора, 
расположенной в левой нижней части экрана d. 

 
рис.  6-84 

 
рис.  6-85 

Дождитесь завершения работы и за-
кройте программу обычным образом, как 
любое приложение Windows (рис.  6-84, 
e). 

На вопрос Save And Quit можете вы-
брать любой вариант ответа, кроме <Can-
cel>, разумеется. 

Мы возвращаемся в Layout Plus и, хотим посмотреть, что у нас получилось (рис.  6-86). 

 
рис.  6-86 

Бросается в глаза, что практически нет диагональных соединений. Могу успокоить, что 

2 

1 
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это – явление временное. SPECCTRA полностью подчиняется нам, и, если будет нужно, то 
разведёт и по диагонали. 

Отсутствие диагональных соединений на данном этапе объясняется простотой нашей 
платы. Места для разводки более чем достаточно. SPECCTRA использовала соединения под 
прямым углом для всех дорожек только потому, что так нам будет проще впоследствии ре-
дактировать плату вручную. 

Откроем окно статистики (рис.  6-88). На рис.  6-87 для сравнения показана статистика 
после разводки платы встроенным трассировщиком Layout Plus после работы стратегии 
VIARED_V.SF. 

 
рис.  6-87 

 
рис.  6-88 

После разводки платы в SPECCTRA количество vias оказалось даже меньше. 
Я предлагаю остановиться на этом варианте разводки. Сохраните плату (пусть это бу-

дет файл 29.max), сделайте Cleanup Design (рис.  6-89) и сохраните её ещё раз под именем 
30.max. 

 
рис.  6-89 

На этом наше знакомство со SPECCTRA временно заканчивается. Мы вернёмся к ней в 
одном из последующих разделов. 

Впрочем, можете поэкспериментировать самостоятельно. Попробуйте использовать 
SPECCTRA, предварительно загружая в Layout Plus различные стратегии. 

 

1 

2 
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6.15. Manual Routing. 
Некоторые разводчики утверждают, что никогда не пользуются средствами автомати-

ческой трассировки. Якобы, ни один автотрассировщик не выполнит работу также хорошо, 
как человек. 

Не знаю, не знаю… Если Вам встретится такой специалист, спросите его, способен ли 
он за минуту перебрать несколько сотен различных комбинаций и соединений. Когда речь 
идёт о разводке цифровых устройств, то полностью ручная разводка, на мой взгляд, – это ча-
сы бесполезно потраченного времени. Когда-то давно я разводил одну из своих первых плат. 
Плата была меньше коробка от спичек, и я потратил полдня, пытаясь распутать переплетение 
ratsnests. Окончательно выбившись из сил, я почему-то не сразу вспомнил о существовании 
autorouter-а. Каково же было моё изумление, и как было уязвлено моё самолюбие, когда 
встроенный autorouter развёл плату буквально за пару минут! 

Да и насчёт качества тоже позвольте усомниться. Разводя плату целиком вручную, Вы 
ставите свою интуицию в противовес опыту и усилиям целого коллектива разработчиков. 
Разумно ли это? 

Впрочем, есть совершенно определённые области, в которых автоматическая разводка 
неприменима. К примеру, проектирование источников питания. Платы устройств подобного 
типа изобилуют зонами медной заливки, дорожки имеют разную ширину и т.д.. 

В то же время, при проектировании высокоскоростных устройств передачи данных, 
может потребоваться группировка цепей и выравнивание дорожек по длине. Разводка таких 
трасс вручную чрезвычайно затруднительна. 

Правильным решением, на мой взгляд, является комбинирование различных стратегий 
и инструментов. Наиболее важные цепи разводятся вручную с последующей блокировкой. 
Затем выделяются, к примеру, цепи, требующие выравнивания. Все остальные соединения 
запрещаются к трассировке, и запускается autorouter. Затем разводится то, что осталось. И в 
завершение, вносятся необходимые исправления вручную. 

Мы уже почти заканчиваем разводку нашей платы. Сейчас, после того как были испро-
бованы различные варианты трассировки, стало видно, что некоторые компоненты располо-
жены не очень удачно. Посмотрите на рис.  6-89. Резистор R12 (c) совершенно очевидно, 
нужно сдвинуть к верхнему краю платы. Резисторы R1 и R8 для соединения с Plain-слоем 
имеют отдельные via (d). Их можно соединить, оставив только одно переходное отверстие. 

Вы сможете заняться этим самостоятельно, а сейчас мы рассмотрим инструменты руч-
ной трассировки и нанесём кое-какие последние штрихи. 

В Layout Plus имеется четыре инструмента ручной разводки. Активируются они соот-
ветствующими кнопками на панели инструментов: 

Auto Path Route tool. Самый активный и «непослушный» инст-
румент. Используется для полуавтоматической трассировки. Во 
время движения указателя мыши, Вы видите предполагаемый мар-

шрут. По щелчку мыши, прокладывается очередной участок трассы, используя алгоритм ав-
томатической трассировки. Инструмент может раздвигать и ремаршрутизировать другие до-
рожки. По этой причине, использовать его следует осторожно, так как легко можно испор-
тить предыдущую работу. Сохраняйтесь как можно чаще. 

Shove Track tool. Также используется для полуавтоматической 
разводки, но менее агрессивен. Вы должны щёлкнуть левой кноп-
кой мыши, чтобы проложить очередной сегмент, при этом сосед-

ние дорожки раздвигаются. 
Инструменты Auto Path Route и Shove Track действуют 

только при включённой опции Online DRC. 

Edit Segment tool. Наиболее безопасный и удобный инстру-
мент. Позволяет прокладывать или редактировать трассу, не затрагивая при этом соседние 
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дорожки. Предоставляет Вам полный контроль над совершаемыми действиями. При пересе-
чении другой трассы автоматически устанавливает via и переносит дорожку на свободный 
слой. Очень удобно работать при включённой опции Online DRC. 

Add/Edit Route tool. Инструмент практически иденти-
чен предыдущему. Разница проявляется, во время редакти-
рования уже существующей дорожки. Щелчок указателем 

мыши по сегменту трассы разрывает трассу с возможностью прокладки нового маршрута. 
Щелчок мышкой по сегменту в режиме Edit Segment трассу не разрывает, а позволяет дви-
гать сегмент. 

На рисунках ниже наглядно показано отличие этих двух инструментов. 

Edit Segment tool  Add/Edit Route tool 

 

c

 

 

d

 

 
рис.  6-90 

e

 
рис.  6-91 

Edit Segment mode (рис.  6-90): допустим, нужно обогнуть thruhole-вывод с другой сто-
роны (c). Щёлкнув мышкой по наклонному сегменту, входим в режим редактирования (d). 
Двигая сегмент влево, мы упрёмся в pad (e). Перескочить через вывод нам не позволит кон-
троль Online DRC. 

Add/Edit Route mode (рис.  6-91): щёлкнув по диагональному сегменту, мы разрываем 
трек (c). Вручную прокладываем путь (d). Щёлкнув по pad-у, завершаем дорожку (e). 
Лишние участки трассы удаляются автоматически. 

Между этими двумя режимами очень легко переключаться «на лету». Стоит нажать 
клавишу <S>, и Add/Edit mode переходит в режим редактирования сегмента. Обратная про-
цедура достигается нажатием клавиши <G>. 

Командой: «Options → Route Settings…» (рис.  6-92) открывается окно дополнительных 
настроек инструментов. 

Переключатели в поле Route Mode аналогичны соответствующим кнопкам на панели 
инструментов. Имеется возможность выбирать степень агрессивности Shove Track Mode. 
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Low Power – аккуратный режим. Соседние дорожки раздвигаются, пропуская новую 
трассу. 

Medium Power – разрешает инструменту раздвигать дорожки, перенося их через vias 
или выводы компонентов. 

High Power – агрессивный режим. В процессе прокладки новой трассы, соседние до-
рожки могут быть ремаршрутизированы. 

 
рис.  6-92 

Опции для режима Auto Path: 
Suggest Vias – позволяет инструменту использовать все слои для поиска маршрута. 

При этом указывается предполагаемое место расположения via. Если флаг сброшен, попыток 
перехода на другой слой не предпринимается. 

Allow Off-Grid Routing – если флаг установлен, отход от сетки маршрутизации позво-
ляется только для соединения с выводами компонентов. Снятие флага в ряде случаев позво-
ляет проложить трассу между выводами. 

Shove Components – позволяет автоматически сдвигать не только мешающие дорожки, 
но и незаблокированные компоненты. 

Maximize 135 Corners – установка этого флага разрешает инструменту AutoPath про-
кладывать диагональные сегменты. 

Use All Via Types (для всех режимов) – если флаг установлен, разрешается использо-
вание любых типов vias, определённых в таблице Padstacks. Игнорируются установленные 
соответствия Via Per Net (см. главу « 6.17 Vias.»). Если флаг сброшен, используются только 
vias, разрешённые для конкретной цепи либо VIA1 из таблицы Padstacks. 

VIA1 в Layout Plus является via, используемой по умолчанию. 

Snap To Grid Routing – снятие флага позволяет не использовать сетку маршрутизации 
при работе с инструментами Shove Track, Edit Segment и Add/Edit Route, что, как уже было 
сказано, позволяет иногда проложить трассу между pad-ами. 

В поле Drawing Method устанавливается разрешённое направление прокладки трасс в 
ручном режиме: под любым углом, диагональное, ортогональное, скруглённые углы. 

Во всех режимах ручной маршрутизации Вы можете пользоваться горячими клавиша-
ми, список которых приведён в таблице на стр. 233. 

Попробуйте, используя инструменты ручной трассировки, привести плату к виду, ана-
логичному на рис.  6-94 (имя файла: 32.max). 
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рис.  6-93 

На рис.  6-93 я для сравнения показал ещё раз то, что получилось после SPECCTRA. 

 
рис.  6-94 

Чтобы не закрывать рисунок, я не буду расставлять на нём указатели, а постараюсь 
объяснить словами. 

Для начала, я постарался размотать петли, образованные некоторыми дорожками в 
районе процессора. Для этого несколько трасс пришлось перемаршрутизировать. Далее, ана-
логичная работа была проделана вокруг микросхемы U1 – драйвер дисплея. Все дорожки 
были максимально спрямлены. Старайтесь, чтобы трассы состояли из как можно меньшего 
количества сегментов. Пришлось немного сдвинуть некоторые fanout-vias, а некоторые – 
объединить. Дорожки, которые слишком близко подходят к краю лучше отодвинуть, если 
это возможно. Постарайтесь избегать ситуаций, когда трассы проходят между выводами 
SMT-компонентов. Плохого в этом ничего нет, но и хорошего тоже нет ничего. 

В результате плата приобрела гораздо более благородный – я бы сказал – человеческий, 
а не машинный вид. Надеюсь, Вы со мной согласитесь, что чисто эстетически, она стала вы-
глядеть красивее. Красивые вещи всегда работают лучше, потому что красота – это признак 
количества труда, вложенного в изделие. Не все это осознают, но – будьте уверены – чувст-
вуют. Фирма, заказавшая у Вас разводку однажды, несомненно, обратится к Вам ещё раз. 

Давайте посмотрим окно статистики. Оно приведено на рис.  6-96. На рис.  6-95 для 
сравнения показано окно после авторазводки в SPECCTRA. 
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рис.  6-95 

 
рис.  6-96 

Как видите, теоретические рассуждения подтверждаются документально. Удалось не 
только уменьшить количество vias, но и сократить общую длину трасс. 

Пусть Вас не вводит в заблуждение строчка Unrouted Dist. В этом поле отражено зна-
чение для цепей, соединяющихся не посредством дорожек, а через Plane-слои или зоны Cop-
per Pours. Плата разведена полностью, о чём свидетельствует значение 100% в поле 
%Routed. 

Дополнительно убедиться в этом можно, нажав клавишу <N>. Должно появиться со-
общение (рис.  6-97): 

 
рис.  6-97 

Используйте эту клавишу, когда в окне статистики сообщается, что степень разводки 
меньше 100%, но визуально найти разорванную трассу не удаётся. Обычно, это указывает на 
проблему около одного из pad-ов или via. Курсор установится на место разрыва, а в строке 
состояния будет сообщено название цепи. 

В этом случае зачастую оказывается достаточным нажать клавишу <F> (завершить со-
единение), чтобы ошибка исчезла. 

6.16. Некоторые приёмы и советы. 
9 В процессе разводки используйте клавишу <M>. Ratsnests натягиваются между вы-

водами компонентов. Если Вы подвели трассу к уже существующей via и хотите к ней под-
ключиться, нажмите <M>, и ratsnest переключится на неё, как на ближайший доступный объ-
ект. 

9 Для завершения трассы пользуйтесь клавишей <F>. Клавиша особенно полезна, если 
нужно соединиться с выводом, который расположен вне сетки маршрутизации. 

9 Пример соединения двух off-grid pad-ов (рис.  6-98). Начните дорожку, щёлкнув по 
одному из выводов и создайте короткий стрингер. Нажмите клавишу <X> чтобы изменить 
направление редактирования. Выведите стрингер от другого вывода (рис.  6-99). Нажмите 
<F>, и дорожка соединится автоматически (рис.  6-100). 
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рис.  6-98 

 
рис.  6-99 

 
рис.  6-100 

9 Если ratsnests перекрываются (рис.  6-101), используйте команду Tack. 

 
рис.  6-101 

 
рис.  6-102 

Выделите цепь и нажмите <Ctrl>+<T>. Курсор подхватит ratsnest. Щёлкните мышкой, 
чтобы создать излом (рис.  6-102). 

Команда Minimize Connections отменяет действие Tack. 

 
рис.  6-103 

 
рис.  6-104 

9 Для того чтобы перенести сегмент 
трассы на другой слой (рис.  6-103), выдели-
те его и нажмите номер слоя. Сегмент будет 
перенесён, и будут сгенерированы необхо-
димые vias (рис.  6-104). 

Если места для установки via недоста-
точно, команда выполнена не будет 

9 С помощью команды контекстного меню Curve Corners можно рисовать дорожки со 
скруглёнными углами (рис.  6-105). Не используйте эту возможность без необходимости. Та-
кие платы труднее редактировать. 

 
рис.  6-105 

9 Как скопировать трек? 
Дорожку можно скопировать при условии, что оба её конца окажутся корректно под-

ключенными. Применяется этот метод для ручного разводки большого количества однотип-
ных соединений. 
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рис.  6-106 

 
рис.  6-107 

 
рис.  6-108 

 
рис.  6-109 

Допустим, нужно соединить соседнюю цепь аналогично уже существующей (рис. 
 6-106). Выберите один из инструментов ручной разводки и выделите рамочкой участок ис-
ходной трассы (рис.  6-107). Нажмите <Ctrl>+<C> или клавишу <Ins>. Появится копия до-
рожки (Instance), которая будет следовать за курсором мышки. Переместите её к месту на-
значения (рис.  6-108) и щёлкните левой кнопкой мыши. Ratsnest в месте соединения исчез-
нет, сменившись новой трассой. 

Вы можете продолжить копирование, так как instance дорожки всё ещё следует за ука-
зателем. 

Чтобы выйти из режима копирования, нажмите клавишу <Esc>. 

9 Аналогичным образом можно копировать группу треков. Для этого нужно выделить 
рамкой все треки, предназначенные для копирования. 

9 Как открыть дорожку от маски? 
Убедитесь, что слои Solder Mask доступны для просмотра, определены в цветовой таб-

лице. Создайте instance дорожки, как было описано выше. Нажмите клавиши <Ctrl>+<7>, 
чтобы скопировать трек в слой SMTOP или <Ctrl>+<8> для слоя SMBOT (рис.  6-110). Со-
вместите копию с исходной дорожкой. 

 
рис.  6-110 

 
рис.  6-111 

Нажмите <Esc>, чтобы выйти из режима копирования. Проверьте результат, для чего 
покажите слой маски. На рис.  6-111 слой SMTOP показан зелёным цветом. Как видно, от 
маски открыты все thruhole-выводы и один из треков. Остальные треки и vias находятся под 
маской. 

9 Как продублировать дорожку в другой слой? 
Процедура аналогична вышеописанной с той разницей, что трасса копируется в нуж-

ный слой, а не в слой маски. 
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9 Как между pad-ами проложить две дорожки? 
Прокладка трассы возможна только при наличии ratsnest. Если между pad-ами дорожка 

уже существует, то цепь считается разведённой, и ratsnest автоматически удаляется.  

 
рис.  6-112 

 
рис.  6-113 

Если нужно усилить цепь, прокладкой ещё одной трассы, соедините эти же выводы 
ещё одной ratsnest, используя Connection Tool (рис.  6-112). После этого провести новый трек 
не составит труда (рис.  6-113). 

«Лишняя» ratsnest исчезнет, если воспользоваться командой Minimize Connections. 

9 Как создать T-соединение? 
Проблемы возникают, если трек, к которому Вы пытаетесь подключиться, находится 

вне сетки Routing Grid (рис.  6-114). Это, в свою очередь, может быть вызвано тем, что трасса 
соединяется с выводом компонента. 

 
рис.  6-114 

 
рис.  6-115 

 
рис.  6-116 

Ничего страшного! Продолжите соединение до вывода (рис.  6-115) или до того места, 
где трасса «становится» на сетку. Дорожки соединятся. После этого подровняйте соедине-
ние, используя Edit Segment Tool (рис.  6-116). 

9 Как можно подсветить всю цепь на плате? 

 
рис.  6-117 

 
рис.  6-118 

Установите курсор над дорожкой или pad-ом и нажмите <H>. Цепь подсветится (рис. 
 6-117). Для лучшей наглядности измените правила Highlight в цветовой таблице (рис.  6-118). 

Подсветка отменяется повторным нажатием <H>. 
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рис.  6-119 

Можно определить постоянную подсветку одной или нескольких цепей, установив 
флаг Highlight в их свойствах (рис.  6-119). 

6.17. Vias. 
Откройте последнюю сохранённую плату (файл 32.max) и сохраните под новым име-

нем: 33.max для того, чтобы не испортить предыдущую работу. Сейчас мы будем экспери-
ментировать. 

 
рис.  6-120 

Типы vias, как известно, определяются в таблице Padstacks. В таблице зарезервировано 
место для 16-ти типов vias. OrCAD Layout Plus по умолчанию использует VIA1. 

Создайте новый тип via, для чего войдите в Padstacks и определите VIA2, как показано 
на рис.  6-120. Это – via бо́льшего размера, чем та, которую мы использовали на плате. К то-
му же, она открыта от маски. 

Чтобы изменить текущий тип используемых vias, активируйте инструмент Edit Seg-
ment. Щёлкните по одному из существующих переходных отверстий. Теперь щёлкните пра-
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вой кнопкой мыши и выберите команду Change Via Type. 

 
рис.  6-121  

рис.  6-122 

Откроется окно Via Selection (рис.  6-121). Выберите нужный тип и установите via на 
плату (рис.  6-122). 

Этим самым действием Вы сменили и via по умолчанию. Все новые переходные отвер-
стия будут такими же. 

 
рис.  6-123 

 
рис.  6-124 

Если в таблице Padstacks определе-
но несколько типов vias различного 
размера, но места на плате недоста-
точно, в окне Via Selection будут по-
казаны только те типы переходных 
отверстий, которые возможны в теку-
щей ситуации. 

Каждой цепи можно назначить 
конкретный вид используемых пере-
ходных отверстий. Для этого нужно 
открыть таблицу Nets, щёлкнуть пра-
вой кнопкой по наименованию цепи и 
выбрать команду Assign Via per Net 
(рис.  6-123). 

В открывшемся окне Assign Via (рис.  6-124) укажите те vias, которые разрешается ис-
пользовать. 

Это правило будет проигнорировано, если в настройках Route Settings (рис.  6-92) ус-
тановлен флаг Use All Via Types. 

Помимо обычных vias, Layout Plus позволяет оперировать так называемыми «свобод-
ными» или Free vias. Free vias служат тем же целям, что и обычные, но, в отличие от послед-
них, не могут быть перемещены или удалены трассировщиком. Обычные via устанавливают-
ся в месте перехода трассы с одного слоя на другой и будут удалены, если переход больше не 
существует. Free via может быть установлена на трассе, не имеющей переходов. 

Вот как это можно использовать. На рис.  6-125 показана характерная ситуация. Два 
вывода, расположенные в слое TOP, соединяются дорожкой. Необходимо к существующей 
дорожке подключить ещё одну, которая находится в слое BOTTOM. 

Заранее выйти со слоя BOTTOM на TOP возможности нет, поэтому нужно ставить via 
прямо на дорожке. Однако, это невозможно. Мы не можем выбрать голубую дорожку и до-
бавить via, потому что дорожка целиком располагается в одном слое и переходов не имеет. 

Подвести красную дорожку снизу и попытаться поставить via тоже может не получить-
ся, если шаг сеток Via Grid и Routing Grid не совпадает или же верхняя дорожка проложена 
не по сетке. 

VIA1 VIA2
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рис.  6-125 

 
рис.  6-126 

 
рис.  6-127 

 
рис.  6-128 

В такой ситуации можно поставить Free via, как показано на рис.  6-126. По команде 
Minimize Connections ratsnest переключится на ближайший объект (рис.  6-127). Остальные 
действия не представляют сложности (рис.  6-128). 

Обратите внимание, что Free vias обо-
значаются на плате буквами «FV». 

Не сто́ит забывать об используемых 
Free vias. Допустим, что понадобилось раз-
маршрутизировать созданное соединение 
(рис.  6-129). Дорожки исчезнут, но Free via 
останется. Если Вы забыли о её существова-
нии, то она будет мешать дальнейшей работе 
над платой. 

 
рис.  6-129 

Список всех Free vias, используемых в дизайне, можно найти в таблице Components 
(рис.  6-130). 

 
рис.  6-130 

Free vias во многом похожи на компоненты, но всё же таковыми не являются. Чтобы вы-
брать Free via, нужно активизировать инструмент не Component Tool, а один из инструмен-
тов ручной разводки. 

 
рис.  6-131 

 
рис.  6-132 

Ещё одно важное отличие Free via от компонента: Free via не может не принадлежать ни 
одной из цепей. 

Удаляется Free via нажатием клавиши <Delete>. Изменить Free via можно, войдя через 
контекстное меню в пункт Properties (рис.  6-131). 
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Впрочем, у Free via есть шанс стать настоящим компонентом! Если в окне Edit Free 
Via нажать кнопку <Convert To Component…>, откроется окно менеджера библиотек, и 
Вам будет предложено выбрать подходящий footprint для замены. 

Другие применения Free vias. 
Соединение зон заливки медью (рис.  6-133). 

 
рис.  6-133 

 
рис.  6-134 

Zero-length Fanout, т.е. соединение SMD-
компонента с Plain-слоем без стрингера. 

Такой случай уже был рассмотрен на стр. 
32. В свойствах pad-а должен быть установ-
лен флаг Allow via under pad. 

Очень редкая ошибка: pad компонента выделен треугольником (рис.  6-135). 

 
рис.  6-135 

Это – ошибка типа «Zero-length Connection». Отсутствие соединения pad-а с другим 
слоем. 

6.18. Free Via Matrix. 
В главе  2.16 рассказывалось о применении vias для создание зон отвода тепла. Для это-

го мы создали специальный footprint, используя PadGenerator. Существует, однако, альтерна-
тивный метод решения задачи путём использования Free vias. 

Группа Free vias может быть автоматически размещена в указанной зоне. Сделать это 
можно двумя способами. Начнём с более сложного. 

На рис.  6-136 показана плата на которой имеются два соединения и медная зона. Необ-
ходимо прошить указанную зону vias. 

Free 
via
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рис.  6-136 

Прежде всего, естественно, решаем, via какого размера мы будем использовать. Вхо-
дим в таблицу Padstacks и создаём via нужного типа. 

Теперь укажем параметры заполнения: «Options → Free Via Matrix Settings…» (рис. 
 6-137). 

 
рис.  6-137 

Padstack Name – выбираем тип via. 
Net Name – как Вы помните, Free via обязательно 

должна иметь соединение с какой-либо цепью. Выби-
раем название цепи из списка. 

Group Number – в этом поле можно указать к ка-
кой группе компонентов будут принадлежать сгене-
рированные vias. 

Minimum X Pitch – расстояние между соседними 
vias по горизонтали. 

Minimum Y Pitch – расстояние между соседними 
vias по вертикали. 

Via to Edge Space – минимальное расстояние от 
границы obstacle Copper Area до центра via. 

Spacing Tolerance – допустимое отклонение пре-
дыдущего параметра. Т.е., если Via to Edge Space = 50, 
а Spacing Tolerance = 30, то ближайшая от границы 
obstacle via может находиться в пределах 50 ± 30 = 20 
~ 80 mil. 

Lock Free Vias – возможность блокировки. 
Periphery Only – расположение vias по периметру указанной зоны без заполнения 

внутреннего пространства. 

 
рис.  6-138 

Если всё готово, выберите команду: «Auto → Place → Free Via Matrix» и щёлкните 
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мышкой по зоне Copper Area. При указанных на рис.  6-137 параметрах, vias расположатся, 
как показано на рис.  6-138. 

Измените параметры, как на рис.  6-139, и vias расположатся иначе (рис.  6-140). 

 
рис.  6-139 

рис.  6-140 

Я прошу особо обратить внимание, что указанная в примере obstacle является obstacle 
типа Copper Area, а не Copper Pour! После обновления экрана, Вы увидите, что зона вновь 
залита медью, и vias соединяются с ней без перемычек Thermal Relief (рис.  6-141). 

 
рис.  6-141 

Ну а теперь зато Вы можете делать с медной зоной что угодно – сменить тип или даже 
совсем убрать. Установленные vias останутся на месте. 

Способ номер два совсем простой. Заключается он в том, что Free vias заполняют пря-
моугольную область, выделенную мышкой. При этом игнорируются параметры Via to Edge 
Space и Spacing Tolerance. 

В качестве примера возьмём ту же плату, выполним команду: «Auto → Place → Free 
Via Matrix» и обведём рамочкой левый нижний угол платы (рис.  6-142). 

На рис.  6-143 показано, что получится. Vias заполняют всё указанное пространство, 
включая любые зоны заливки медью и исключая места, занятые компонентами или трассами, 
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принадлежащими другим цепям. 

 
рис.  6-142 

Как видно, vias располагаются по диагонали. Это обеспечивает наиболее высокую 
плотность размещения. 

 
рис.  6-143 

6.19. Test Points. 
Test points – контрольные точки – применяются для возможности проверки будущего 

устройства. Layout Plus может сгенерировать контрольные точки автоматически. Для этого, 
во-первых, нужно определить via, которое будет использоваться в качестве контрольной точ-
ки. Во-вторых, нужно указать цепи, для которых необходимо создание контрольных точек. 

Откройте плату, над которой мы работали и опишите новый тип via, как это показано 
на рис.  6-144. Очевидно, что контрольная точка должна быть открыта от маски, чтобы к ней 
можно было прикоснуться щупом осциллографа.  

Кроме того, опишите padstack контрольной точки в слоях ASYTOP и ASYBOT, чтобы 
они были видны на монтажном чертеже. 

Не забудьте установить флаг Use For Test Point в свойствах via. 

Войдите в «Nets», выделите цепи P1.0 ~ P1.7, откройте Properties и установите флаг 
Test Point (рис.  6-145). 

Теперь выполните команду: «Options → Test Point Settings…» (рис.  6-146). В этом окне 
указываем наши условия. 
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рис.  6-144 

 
рис.  6-145 

Generate test points from vias – если трасса имеет переходные отверстия, то этот флаг 
разрешает убрать существующую via и вместо него поставить via, определённое как Test 
Point. Если флаг не установлен, то установленные vias не будут тронуты. 

 
рис.  6-146 

Allow test points under components – позволяет создавать контрольные точки под ком-
понентами, внутри obstacles Place Outline. Если компоненты располагаются только с одной 
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стороны платы, установите этот флаг. Если же компоненты расположены с обеих сторон, то 
флаг лучше снять, иначе контрольная точка может оказаться недоступной. 

Allow through-hole as test points – позволяет не создавать контрольную точку, если 
цепь соединяется хотя бы с одним выводом thruhole. Предполагается, что можно прикос-
нуться щупом осциллографа не к контрольной точке, а к такому выводу. 

Test Point Pitch – минимальное расстояние между контрольными точками. Представь-
те ситуацию, когда нужно снять показания двух сигналов одновременно. Test Points могут 
оказаться так близко друг от друга, что это вызовет затруднения при подключении измери-
тельных приборов. 

Указав настройки, как на рис.  6-146, выполним команду: «Auto → Place → Test 
Points». 

 
рис.  6-147 

На рис.  6-147 показана плата целиком. Зелёный цвет – цвет слоя SMTOP. Test Points 
открыта от маски, обычные vias – скрыты под маской. 

 
рис.  6-148 

На рис.  6-148 хорошо видны две Test Points, расположенные под кнопками. Надпись 
внутри via «TP» означает контрольную точку. 

На рис.  6-149 показаны точки, которые Layout Plus создал вокруг процессора. Так как в 
этой зоне места немного, то в качестве Test Points были использованы уже существующие 
vias. Поскольку VIA1 и VIA3 (Test Point), используемые на плате, совпадают по размеру, то 
с заменой проблем не возникло. 

2 

1

1 

1
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рис.  6-149 

Контрольные точки могут быть и SMT-исполнения. Для этого надо описать два pad-
stack-а: отдельно для слоя TOP и отдельно – для BOTTOM. 

 
рис.  6-150 

Padstack для точки, которая будет расположена в верхнем слое должен иметь описания 
TOP, SMTOP и ASYTOP layers. Padstack для точки, которая будет расположена в нижнем 
слое должен иметь описания BOTTOM, SMBOT и ASYBOT layers. 

На рис.  6-150 показано применение SMT Test Points. Как видно, они имеют разную 
форму. В нижнем слое квадратную, в верхнем – круглую (слои маски не показаны). 

Если для расстановки thruhole-точек на плате недостаточно места, то вариант с SMT-
точками может решить проблему. Однако в этом случае не забудьте снять флаг Allow test 
points under components, иначе некоторые из точек могут быть закрыты компонентами, как 
это получилось на рис.  6-150. 

Test Points, подобно Free vias, перечисляются в таблице Components. Подобно Free vias, 
они могут быть преобразованы в компоненты. Однако есть и отличие. Test Points включают-
ся в специальный отчёт, который может быть сформирован Layout Plus. 

2

22

TOP

TOP

BOT

BOT
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7. Завершение работы. 

Основная и самая ответственная работа позади. Теперь нужно расставить надписи на 
плате, оформить проект, как положено, подготовить документацию и файлы для отправки на 
завод-изготовитель (Board house). 

7.1. Монтажный чертёж. 
Монтажный чертёж нужен для последующей сборки устройства, для установки и рас-

пайки деталей на плате. Человек, который будет заниматься этой работой должен иметь воз-
можность взять распечатку платы, положить перед собой на стол или повесить на стену и, 
глядя на неё, легко определить местоположение каждого компонента. Поэтому на чертеже 
должны быть показаны все компоненты вместе с Reference designators. 

Если компоненты располагаются с обеих сторон платы, то, очевидно, должно быть два 
монтажных чертежа: вид со стороны Component side и со стороны Solder side. 

Образуется монтажный чертёж из слоёв ASYTOP и ASYBOT. 

На рис.  6-94 показан последний вариант нашей PCB. Сохраните файл под новым име-
нем и загрузите цветовую таблицу ASYTOP.COL (рис.  7-1). 

 
рис.  7-1 

Сейчас все маршрутизируемые слои скрыты. На экран выведены только два слоя: 
ASYTOP – верхний монтажный слой и SSTOP – верхний слой Silkscreen. ASYTOP выводит-
ся зелёным цветом, а слой SSTOP – белым. Жёлтым показана граница платы – Board Outline, 
расположенная в слое GLOBAL. 

Скройте, пожалуйста, все слои, кроме ASYTOP. Именно этот слой нам нужен на дан-
ном этапе (рис.  7-2). 

На чертеже уже присутствуют граница платы и основные размеры. Необходимо при-
вести в порядок только надписи. 

Каждый footprint наследует из библиотеки несколько текстовых полей. Среди них: 
− Reference Designator. Поле располагается в слоях Silkscreen и Assembly. 
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− Component Value. Слой Assembly. 
− Package Name. Слой Assembly. 
− Footprint Name. Слой Assembly. 

 
рис.  7-2 

Нас интересует только Reference Designator компонента, остальные поля нужно уда-
лить. Для этого откройте таблицу Text, щёлкните правой кнопкой мыши в произвольном 
месте и выберите команду Select Any… В открывшемся окне установите переключатель в 
положение Footprint Name (рис.  7-3) и нажмите <OK>. 

 
рис.  7-3 

В таблице выделятся соответствующие строки. Удалите их, нажав клавишу <Delete> 
или выбрав команду Delete из контекстного меню. 

Аналогичным образом поступите с записями Package Name и Component Value. После 
этой процедуры экран станет значительно свободнее (рис.  7-4). 

Критерий, который используется при расстановке надписей только один: абсолютная 
ясность чертежа! Все остальные правила являются лишь следствиями. А именно: 

− Расположение Reference Designator-а должно однозначно указывать на компонент, 
к которому он относится. 

− Reference Designator выносится за пределы корпуса компонента, чтобы установлен-
ный на плату компонент не закрыл его. Это правило обязательно для слоя Silkscreen. 
В слоях Assembly допускается располагать надписи внутри компонентов, но я не ре-
комендую этого делать. Оптимально, если одинаковые надписи, расположенные в 
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слоях Silkscreen и Assembly,  будут совпадать. Это облегчит сверку PCB с чертежом. 

 
рис.  7-4 

− Не сто́ит без необходимости делать слишком мелкие надписи. Хорошо, если наи-
более важные компоненты будут обозначены крупным шрифтом. 

− Не сто́ит располагать надписи поверх vias. Дырочки в плате испортят текст. 

− Ориентируйте все надписи в одну сторону. То есть, например, все вертикальные 
текстовые поля должны быть повёрнуты на 90˚. Надписей, развёрнутых на 270˚ быть 
не должно, иначе, рассматривая плату, придётся поворачивать её то так, то эдак. 

− Если компоненты расположены чересчур плотно, вынесите надпись в свободное 
место, снабдив её стрелочкой-указателем на компонент. 

− Не располагайте надписи на pad-ах. Совершенно очевидно, что это бессмысленно80. 

Вот несколько примеров: 

 
рис.  7-5 

 
рис.  7-6 

На рис.  7-5 резистор R2 обозначен с помощью выноски. На рис.  7-6 расположение 
надписей повторяет расположение компонентов. На рис.  7-7 показан способ обозначения 
группы однотипных компонентов. На рис.  7-8 приведён немного более сложный случай. 
                                                 

80 Когда я проектировал свою первую плату, для меня это было совершенно неочевидно. ☺ 
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рис.  7-7 
 

рис.  7-8 
Вернёмся к нашей плате и приведём оставшиеся надписи к одинаковому размеру. 

 

 

 

 

 

 
 

рис.  7-9  

Находясь в таблице Text, выделите все строки Reference Designator и нажмите 
<Ctrl>+<E>, чтобы открылось окно Text Edit. Смысл полей окна интуитивно понятен. Уста-
новите параметры, как показано на рис.  7-9 и нажмите <OK>81. 

Указанные параметры являются оптимальными для большинства случаев. Образец тек-
стовой строки показан в верхнем ряду рядом с рис.  7-9. Ниже приведены образцы, получен-
ные в результате изменения полей Line Width, Text Height, …, Char Aspect. 

Для плат с низкой плотностью расположения компонентов можно установить Line 
Width = 10, а Text Height = 75. Устанавливать Line Width меньше, чем 6 милей не рекомен-
дуется, потому что линии текста будут слишком тонкими, и могут оказаться неразборчивы-
ми. 

Теперь включите инструмент Text Tool и аккуратно распределите надписи. 

Напоминаю, что перемещается текст в соответствии с сеткой Detail Grid. Поворот тек-
ста осуществляется клавишей <R>. Дополнительные команды доступны по щелчку правой 
кнопки мыши. 

Постарайтесь привести плату к виду, оказанному на рис.  7-10. Не забывайте про vias! 

                                                 
81 Вы, конечно, помните, что пустые поля не изменят своего оригинального значения. 
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Включи́те слой Drill, чтобы видеть отверстия. 

 
рис.  7-10 

Вы никогда не запутаетесь в надписях и не ошибётесь, потому что выбранная надпись 
тут же подсвечивает компонент, которому она принадлежит (С5 на рис.  7-11). 

 
рис.  7-11 

Команда контекстного меню Mirror переворачивает надпись в её зеркальном отраже-
нии. Команда Opposite не только переворачивает надпись, но и переносит её на противопо-
ложный слой. 

 
рис.  7-12 

Завершив работу со слоем ASYTOP, займитесь слоем ASYBOT (рис.  7-12). 
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7.2. Silkscreen. 
Как Вы помните, реально на плату будет нанесены только те надписи, которые присут-

ствуют в слоях Silkscreen. Следующий этап – наведение порядка в этих слоях. Метод работы 
очень прост: совмещение всех надписей слоя Silkscreen с соответствующими надписями слоя 
Assembly. 

Включите слои ASYTOP, SSTOP и проделайте это (рис.  7-13): 

 
рис.  7-13 

В отдельности слой SSTOP выглядит, как показано на рис.  7-14. 

Такую же работу нужно сделать для обратной стороны платы. 

Не забудем и про заготовленный заранее логотип. Расположен он в слое SSTOP, но на 
этой стороне платы места недостаточно, поэтому перенесём его на противоположную сторо-
ну. Выделите фигуру, используя Obstacle Tool. Из контекстного меню выберите команду 
Opposite. Фигура отразится зеркально в слой SSBOT. После этого переместите её в свобод-
ное от компонентов место на PCB. 

На рис.  7-15 показано что́ должно получиться в результате. 

 
рис.  7-14 

На рис.  7-15 включены только слои ASYBOT и SSBOT. 



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 286 

 
рис.  7-15 

7.3. Оформление дизайна. 
Правила оформления дизайна диктуются исключительно двумя вещами: здравым 

смыслом и требованиями фирмы, в которой Вы имеете счастье работать. В самом простей-
шем случае, работу над дизайном можно считать уже завершённой и приступать к выпуску 
Gerber-файлов. 

В ином случае, Вам придётся учитывать стандарты, принятые в Вашей фирме. Могу 
рекомендовать Вам попросить какой-нибудь уже завершённый проект, чтобы использовать 
его в качестве образца. Можете даже сделать себе шаблон на его основе. Для этого удалите 
из дизайна всё, кроме элементов оформления и сохраните файл как Template, присвоив ему 
имя, например, «GetUp.TPL». 

Начиная в будущем новую работу, загрузи́те этот файл, и полу́чите уже сконфигуриро-
ванный и оформленный как положено проект. 

Итак, что помимо PCB может присутствовать в дизайне? 
Во-первых, рамка. В директории: 

…\layout_plus\data 

можно найти несколько шаблонов с рамками. 

Добавим рамку в наш дизайн. В главе  3.8 «Слияние файлов.» мы рассматривали про-
цедуру объединения одного файла с другим. Тем не менее, данная тема часто вызывает за-
труднения, поэтому я опишу подробно. 

Следует усвоить, что когда Вы сливаете вместе два файла в OrCAD Layout Plus (опера-
ция Merge Board), то конечный файл наследует настройки Global Spacing, Grids а также опи-
сания vias из подгружаемого файла! Подгружаемый файл – главный! То же самое относится 
и к загрузке в готовый дизайн файла *.TPL. 

• Закройте текущий дизайн. 
• Из Layout Session откройте файл …\layout_plus\data\titlblok.tpl. Вы 

увидите пустой дизайн с рамкой, размещённой в слое FAB (Fabrication Drawing). 
• Переместите Datum в то место, где предположительно будет находиться начало ко-

ординат подгружаемого файла (левый нижний угол платы). 
• С помощью команды: «File → Load…» загрузите свою работу. На вопрос Layout 

Plus о том, следует ли создавать копии идентичных цепей, ответьте «Yes». 
• С помощью окна статистики проверьте, что плата разведена полностью. 
• С помощью утилиты Design Rule Check проверьте, что плата не содержит ошибок. 
• Переместите Drill Chart под плату. 
• Восстановите цветовую таблицу. Создайте, если нужно, новое правило для слоя 
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FAB (у меня – оранжевый цвет). 

 
рис.  7-16 

На рис.  7-16 показано, что должно получиться. 

Второе, что может потребоваться – описание взаимного расположения слоёв82. Для 
двухслойной платы это необязательно, для четырёхслойной – желательно. Если же плата со-
стоит из многих слоёв, то такое описание непременно должно присутствовать. 

На рис.  7-17 показан один из вариантов оформления стека слоёв для 18-слойной печат-
ной платы. 

Слева (c) указано название слоя. 
Посередине (d) дан схематический разрез платы. Слои, не участвующие в маршрути-

зации нарисованы тонкими линиями. Маршрутизируемые слои показаны сплошной залив-
кой. Внутри слоя указывается его толщина в OZ-ах (унциях). 

Слои изоляции – препрег83 – показаны заштрихованными. Толщина препрега указыва-
ется в милях. 

Справа (e) приводится функциональное название слоя. Обратите внимание: надписи 
поля e расположены в тех слоях, которым они соответствуют. Дело в том, что на заводе 
принимают заказ в формате не OrCAD, а Gerber, и информация о порядке расположения сло-
ёв утрачивается. Такое оформление стека слоёв не допустит путаницы. 

В поле f подводится резюме и может быть указана общая толщина платы. 

                                                 
82 Layers Order или Layers Stack. 
83 Prepreg. 
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рис.  7-17 

Впрочем, рисовать так тщательно сто́ит лишь в исключительных случаях.  

1 2 3 

4 
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рис.  7-18 

На рис.  7-18 показан полностью оформленный дизайн. Стек слоёв помещается в пра-
вой части чертежа (c). Вот как он оформлен (рис.  7-19): 

 
рис.  7-19 

Все надписи и комментарии сделаны в слое FAB, за исключением названий слоёв, ко-

1

2

4
3

5
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торые располагаются в соответствующем им слое. 
Рядом с маршрутизируемыми слоями приведена их толщина. Внизу таблицы указыва-

ется общая толщина платы. Толщина препрега будет вычислена, исходя из этих величин. 

 
рис.  7-20 

В поле d рис.  7-18 находится таблица основных требований к изготовлению PCB: ма-
териал, из которого следует изготовить плату; допустимая величина перекоса; механическая 
погрешность. Если внутренние вырезы предполагается изготавливать фрезерованием, указы-
вается радиус фрезы, используемой по умолчанию (All undefined PCB radiuses). 

Погрешность сверления отверстий обычно приводится в таблице Drill Chart (рис.  7-21). 
В противном случае, принимается значение по умолчанию (All unspecified holes). 

 
рис.  7-21 

Далее указана толщина металлизации отверстий (Plating thruholes), цвет краски для 
слоёв Silk и Mask. 

 
рис.  7-22 

Наверху (рис.  7-18, e) напишите название проекта. В свободном месте (f) можно рас-
положить логотип Вашей фирмы с указанием атрибутов (рис.  7-22). Ну и, конечно же, не за-
будьте заполнить необходимые поля в рамке (g). 
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7.4. Механический чертёж. 
На рис.  7-23 показан механический чертёж нашей платы. Он формируется из слоёв 

Global, Drill Drawing (DRD) и Fabrication Drawing (FAB). 

 
рис.  7-23 

В Global находится контур PCB (Board Outline). В слое DRD размещается Drill Chart и 
символы сверления отверстий, в слое FAB – вся остальная информация. Единственное, что 
нам нужно сейчас сделать, это добавить размеры платы в слой FAB. Проставьте их. 

Итак, на чертеже присутствуют Board Outline и основные размеры. Для того чтобы из-
готовить плату на заводе этого вполне достаточно. Никаких дополнительных размеров мож-
но не указывать. Файл дизайна содержит в себе всю необходимую информацию о форме 
PCB, расположении отверстий и компонентов. Я надеюсь, что Вы не думаете, будто бы плату 
станут выпиливать вручную, сверяясь с распечатанным бумажным чертежом? 

По этой причине, если нет особой необходимости, указываются только размеры PCB 
по вертикали и горизонтали. Делается это лишь для того, чтобы инженер, принявший заказ, 
мог убедиться, что данные импортировались правильно, без искажения масштаба. 

На плате, с которой мы работаем, нет никаких особенностей, требующих дополнитель-
ного описания. В дальнейшем мы разберём несколько случаев, требующих детального пояс-
нения, а пока давайте окинем взглядом дизайн: слой за слоем. 
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7.5. Слой за слоем. 
В этой главе мы не узнаем ничего нового. Рассмотрим каждый слой в отдельности, 

чтобы убедиться, что не осталось никаких неясных моментов. 
Цвет нам не понадобится, поэтому определите такую цветовую таблицу (рис.  7-24): 

 
рис.  7-24 

Цвет фона – белый, цвет слоёв – чёрный. Введено отдельное правило для obstacle Board 
Outline. Сделано это для того, чтобы можно было выключить все элементы слоя Global, ис-
ключая границу платы. 

 
рис.  7-25 

Слой Global (рис.  7-25). Видна obstacle Board Outline и obstacles компонентов Place 
Outline, расположенные в слое Global. 

 
рис.  7-26 

Слой TOP (рис.  7-26). Верхний маршрутизируемый слой. Видны дорожки, pad-ы ком-
понентов, площадки vias и thruhole-отверстий, а также obstacles Place Outline компонентов, 
расположенные в слое TOP. 

Перекрестье в левом нижнем углу – это Datum, начало координат. 
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рис.  7-27 

BOT (рис.  7-27), Bottom. Нижний слой. Видны дорожки, pad-ы компонентов, располо-
женных на обратной стороне платы, площадки vias и thruhole-отверстий, а также obstacles 
компонентов Place Outline. 

 
рис.  7-28 

GND (рис.  7-28). Чёрные площадки – pad-ы thruhole-отверстий, не имеющих соедине-
ния со слоем. В этих местах медь будет вытравлена. Зелёные пунктирные колечки тоже бу-
дут вытравлены. Это – соединения со слоем по типу Thermal Relief. В этих местах также 
имеются отверстия. Если совместить слой GND со слоем DRL, Вы увидите их. 

 
рис.  7-29 

PWR (рис.  7-29). То же самое. Plain-слой, разделённый на две зоны различного пита-
ния obstacle Copper Pour. Толщина obstacle, как Вы знаете, определяет зазор между зонами. 

Обратите внимание, что справа видно название слоя и его порядковый номер. Именно в 
этом месте в нашем дизайне  расположена таблица Layers Stack. 
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рис.  7-30 

SMT (рис.  7-30), Solder Mask TOP, верхний слой маски. Плата будет покрыта краской 
зелёного цвета, исключая закрашенные (на рисунке – чёрные) места. 

 
рис.  7-31 

SMB (рис.  7-31), Solder Mask Bottom. 

 
рис.  7-32 

SPT (рис.  7-32), Solder Paste TOP. Видны pad-ы только SMT-компонентов. Информа-
ция этого слоя используется для изготовления трафарета для нанесения на площадки паяль-
ной пасты – специального припоя. 

 
рис.  7-33 

SPB (рис.  7-33), Solder Paste BOTTOM. Слои Solder Paste не нужны, если плата будет 
собираться вручную. 
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рис.  7-34 

SST (рис.  7-34), Silkscreen TOP. Всё, что Вы видите в этом слое, будет нарисовано на 
верхней стороне платы. 

 
рис.  7-35 

SSB (рис.  7-35), Silkscreen BOTTOM. Рисунки и надписи, которые будут нанесены на 
нижней стороне. 

 
рис.  7-36 

AST (рис.  7-36), Assembly TOP. Верхний монтажный слой. В слое продублирована 
Board Outline, даны изображения компонентов с указанием полярности, проставлены разме-
ры. 
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рис.  7-37 

AST (рис.  7-37), Assembly BOTTOM. Нижний монтажный слой. 

 
рис.  7-38 

DRD (рис.  7-38), Drill Drawing. Таблица сверлений и отверстия на плате, обозначенные 
условными символами. 

 
рис.  7-39 

DRL (рис.  7-39), Drills. Слой, в котором показаны отверстия в натуральную величину. 
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рис.  7-40 

FAB (рис.  7-40), Fabrication Drawing. Механический чертёж. Слой содержит информа-
цию, необходимую для изготовления платы на заводе: материал PCB, необходимые размеры, 
погрешности и пр. В этом же слое указываются данные для фрезерования, о чём мы погово-
рим в главе @@@. 

Пусть Вас не удивляет, что на чертеже видны размеры платы, а сама плата отсутствует. 
В главе  7.8 Post Processing. всё встанет на свои места. 

7.6. Оптимизация отверстий. 
И снова мы возвращаемся к таблице Drill Chart! 
Взгляните на рис.  7-21. Имеются отверстия одинакового размера, которые почему-то 

обозначаются по-разному. Новая загадка! 
Измените текущую систему измерений из милей в миллиметры и обновите экран с по-

мощью кнопки Refresh All. Проверьте теперь таблицу сверлений (рис.  7-41). 
Всё-таки, отверстия имеют разный диаметр. Но разница очень незначительна, всего 

0.012 мм. Почему так произошло? Да и зачем нам такая точность? Разве мы предусматривали 
отверстия размером 0.838 мм? 

Ответ прост. Когда мы создавали footprint-ы компонентов, то в некоторых случаях ука-
зывали размеры padstack-а в милях, а в некоторых – в миллиметрах. Отсюда и путаница. 
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рис.  7-41 

Вот ещё: имеются три типа отверстий, почти одинакового размера. А именно: 0.940, 1 и 
1.067 мм. Не будет ли лучше указать для всех трёх одинаковый размер, равный 1 мм? 

Вот как это сделать. Для начала найдём на PCB символы, соответствующие сверлению 
0.838 мм. Они обозначаются маленьким знаком «+». 

 
рис.  7-42 

Это – выводы семисегментных индикаторов (рис.  7-42). Чтобы изменить диаметр от-
верстий, нужно отредактировать padstack выводов. 

Включите слой TOP. Теперь выберите инструмент Pin Tool и щёлкните по одному из 
pad-ов. Нажмите клавишу <ESC>, чтобы снять выделение и откройте таблицу Padstack. 
Нужный нам padstack будет выделен. Измените размера pad-а в строчках DRLDWG и DRILL 
со значения 0.8382 на 0.85. 

Операцию придётся повторить дважды, так как имеется два типа padstack-ов: с круг-
лыми и квадратными pad-ами. 

Обновите дизайн и проверьте Drill Chart (рис.  7-43): 

 
рис.  7-43 

Проделайте аналогичную процедуру для отверстий диаметром 0.940, 1 и 1.067 мм. В 
результате таблица сверлений примет вид, как на рис.  7-44. 

Вместо семи различных свёрел, мы можем использовать только 4. Плата стала более 
технологичной. Кроме того, чем меньше различного инструмента будет использовано, тем 
дешевле производство. 
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Вот так, потратив всего несколько минут, можно значительно снизить цену изделия! 

 
рис.  7-44 

Завершите работу операцией Cleanup Database, чтобы удалить из дизайна не исполь-
зующиеся более padstacks и footprints. 

Проверьте, что не появились ошибки. Проверьте, что не нарушилась разводка, и сохра-
ните дизайн. 

7.7. Fiducials. 
Возьмите какую-нибудь готовую плату и внимательно рассмотрите её. 

 
рис.  7-45 

Замечали ли Вы когда-нибудь маленькие металлические площадки в произвольных 
местах на PCB вроде тех, на которые показывают указатели на рис.  7-45? Эти площадки ни с 
чем не соединены, не участвуют в маршрутизации и не являются контрольными точками. 
Так для чего же они нужны? 

На рис.  7-46 я увеличу участок c. 

1

2 
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рис.  7-46 

Теперь видно, что это – круглые металлические площадки примерно 0.5~1 мм в диа-
метре, освобождённые от маски. Называется такая площадка «Fiducial»84. 

Fiducials необходимы, если монтаж компонентов на плату будет производиться с по-
мощью автоматов, так называемых Pick-and-Place машин. Машина следит за правильным 
расположением PCB с помощью оптических датчиков. Именно fiducials служат ориентирами 
для «электронных глаз». 

 
рис.  7-47 

Располагаться fiducials могут в любом свободном месте. Однако расположение их и ко-
личество должно быть таково, чтобы плату нельзя было установить неправильно. Оптималь-
но, fiducials должны быть размещены как можно дальше друг от друга, чтобы обеспечить 
максимальную точность позиционирования PCB, и образовывать несимметричную фигуру. 

На рис.  7-47 fiducials расположены в виде треугольника. 

Если на обратной стороне платы компонентов нет, то fiducials предусматриваются 
только на Component Side. 

Как я уже сказал, машина следит за ориентацией PCB с помощью оптических датчиков. 
По этой причине, fiducials должны быть хорошо различимы. Металлическая площадка отра-
жает свет (рис.  7-48, c). Пространство вокруг неё можно освободить от маски (d) для до-

                                                 
84 Fiducial Mark – координатная метка; опорная точка. 
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полнительного увеличения контрастности, поскольку материал платы является матовым и 
отражает свет хуже, чем краска. 

 
рис.  7-48 

Для наглядности, fiducial можно обвести колечком e, но делать это необязательно. 

Расставим fiducials на нашей плате, для чего создадим необходимый footprint. 

 
рис.  7-49 

 
рис.  7-50 

В библиотеке LAYOUT.LLB имеется footprint с именем FIDUCIAL (рис.  7-49), однако 
это не то, что нам нужно. Сделайте новый footprint, как показано на рис.  7-50. 

 
рис.  7-51 

Свойства padstack приведены на рис.  7-51. Все размеры указаны в миллиметрах. 

Теперь установим fiducials на плату. Включите Component Tool, щёлкните правой 
кнопкой мыши в произвольном месте и выберите из меню команду New…. В открывшемся 

1 2
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окне (рис.  7-52) укажите название Reference Designator нового компонента и выберите его 
footprint. 

 
рис.  7-52 

Не забудьте установить флаг Not in Netlist. 

Разместите fiducials на верхней стороне платы, как показано на рис.  7-53: 

 
рис.  7-53 

… и на нижней стороне тоже (рис.  7-54). 

 
рис.  7-54 
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7.8. Post Processing. 
Пришло время подготовить файлы, которые можно будет отправить на завод для изго-

товления PCB. В системе OrCAD Layout Plus это делается с помощью утилиты Post Proces-
sor, а сама процедура называется Post Processing85. 

Для каждого слоя генерируется отдельный файл в так называемом Gerber-формате86. 
Кроме того, создаются необходимые файлы сверлений (их может быть несколько) и отчёты. 

Итак, всё начинается, как обычно, с настроек. Войдите в: «Options → Gerber Set-
tings…». Откроется окно Gerber Preferences (рис.  7-55): 

 
рис.  7-55 

Это окно служит для уточнения некоторых параметров Gerber-стиля. Убедитесь, что 
настройки совпадают с теми, которые показаны на рисунке и нажмите кнопку <OK>. 

 
рис.  7-56 

                                                 
85 К сожалеию, в разных CAD-системах применяется различная терминология. В Allegro – Artwork; в PADS 

Layout – Export to CAM350; в P-CAD PCB – Export to Gerber; Altium DXP – Fabrication Outputs. Вообще, отсут-
ствие единой системы терминов является значительным препятствием в изучении новых программ. 

86 См. гл.  8.4 Установка Gerber-формата в Layout Plus. 
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Следующая команда: «Options → Post Process Settings…» (рис.  7-56). В этой таблице 
указывается список создаваемых Gerber-файлов, выбор формата или устройства вывода, а 
также соответствие содержимого этих файлов слоям OrCAD Layout Plus. 

Щёлкните дважды по строчке TOP, чтобы открылось окно свойств (рис.  7-57): 

 
рис.  7-57 

В поле Format имеется возможность выбора между двумя Gerber-стандартами: Gerber 
RS-274D и Extended Gerber. Вы должны выбрать Extended Gerber87. 

Вариант DXF88 позволяет создать файл в формате, понятном Вашему инженеру-
механику, который работает в программе AutoCAD или SolidWorks. 

Если выбрать вариант Print Manager, то файл (слой) будет послан на печатающее уст-
ройство – принтер или графопостроитель (плоттер). 

Флаг Enable for Post Processing в поле Options включает или исключает обработку со-
ответствующего файла постпроцессором. 

Если установлен флаг Keep Drill Holes Open, отверстия на распечатке будут выглядеть 
в виде незакрашенных окружностей. 

Установленный флаг Create Drill Files указывает постпроцессору на необходимость 
создания файла сверлений для данного слоя. 

В поле File Name указывается имя для генерируемого файла. По умолчанию постпро-
цессор создаёт все файлы с одинаковым именем, совпадающим с именем проекта, но с раз-
личными расширениями. Если это кажется Вам неудобным, переименуйте выходные файлы 
в соответствии с именем слоя, из которого они образованы. А расширение определите у всех 
одинаковое. Тогда Gerber-файл, образованный из слоя TOP может называться, к примеру, 
01_TOP.GRB; файл, образованный из слоя Bottom – 02_BOT.GRB и т.д.. 

В поле Plot Title даётся краткое описание файла. 

Смысл остальных полей достаточно прозрачен, подробно описывать их нет никакого 
смысла. 

Приведите, пожалуйста, таблицу к виду, показанному на рис.  7-58. Обратите внимание 
на названия выходных файлов. Файлы, образуемые из маршрутизируемых слоёв, начинаются 

                                                 
87 Форматы Gerber-файлов подробно описываются в разделе @@@. 
88 Drawing eXchange Format – файл обмена чертежными графическими данными. 
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с номера, соответствующего их расположению в стеке слоёв. Далее следует название слоя. 
Остальные слои также пронумерованы, но начинаются с буквы «D», что значит 

«Documentation». Именованные таким образом файлы удобно, по порядку, расположатся в 
папке назначения89. 

 
рис.  7-58 

Щёлкните теперь правой кнопкой мыши по строчке 01_TOP.GBR и выберите команду 
Preview. Вы увидите картину, как на рис.  7-59.  

 
рис.  7-59 

Рисунок практически совпадает с рис.  7-26. Сравните оба рисунка. На рис.  7-59 отсут-
ствует Datum и нет линий Place Outlines. Остались только дорожки и pad-ы. Надпись в пра-
вом верхнем углу не в счёт, потому что она находится за пределами платы. 

Это и есть слой TOP. Именно так его увидит инженер на заводе, получивший Ваш за-
каз, и именно так слой TOP будет изготовлен. 

Восстановить прежний вид PCB можно командой Restore Original Colors. Если же Вы 
закрыли таблицу Post Process, выполните: «Window → Reset All». 

Аналогичным образом сделайте Preview файла D09_DRD.GBR. Вот что Вы увидите 
(рис.  7-60). На первый взгляд, то же самое, что и на рис.  7-38. Слой DRD. Символы сверле-

                                                 
89 Когда мы будем разбираться с редактором Gerber-файлов, думаю, Вы ещё не раз поблагодарите меня за 

этот совет. 
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ния, Drill Chart… Минутку! Откуда взялась граница платы? В слое DRD её нет!  

 
рис.  7-60 

Так-так… Становится интересно! 
Так откуда же взялась граница платы в слое DRD? 
Дело в том, что файл D09_DRD.GBR не является копией слоя DRD. Любой файл 

постпроцессор формирует из заданного набора слоёв и/или отдельных элементов любого 
слоя. Можно создать выходные файлы произвольной конфигурации. Например, файл, обра-
зованный из слоя Silkscreen, но без Reference Designators компонентов. Или файл, показы-
вающий только зоны заливки медью. 

Для того, чтобы узнать из каких элементов сформирован файл D09_DRD.GBR открой-
те таблицу цветовых настроек (рис.  7-61): 

 
рис.  7-61 

Теперь хорошо видно, что D09_DRD.GBR складывается из содержимого слоя DRD 
(DRLDWG), плюс Board Outline, плюс Free Text, если он расположен в слое Global. 

Цвет в данном случае никакой роли не играет. Gerber-файлы не сохраняют информа-
цию о цвете. Если какой-либо элемент определён в цветовой таблице как Visible, он будет 
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обработан постпроцессором. 

Создайте новое правило для слоя FAB, как показано на рис.  7-62 и рис.  7-63. 

 
рис.  7-62  

рис.  7-63 
Сохраните настройки, щёлкнув правой кнопкой мыши по названию файла. Из рас-

крывшегося меню выберите команду Save Colors. 

 
рис.  7-64 

Не спутайте команду Save Colors с командой Save Color Setup…, которая «всего 
лишь» сохраняет конфигурацию цветовой таблицы. 

Сделайте Preview файла D09_DRD.GBR (рис.  7-65). Перед нами – механический чер-
тёж. Именно так его увидят на заводе, а не так, как было показано на рис.  7-40. 

Командой Save Post Processing Setup… можно сохранить настройки постпроцессора 
для использования в других дизайнах. 
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рис.  7-65 

Команда Run Batch запускает постпроцессор. 
Команда Plot to Print Manager… отправляет на принтер или плоттер выделенный 

файл. 
Командой New… можно создать новую запись в таблице Post Process или сделать ко-

пию существующей. 

Иногда заказчику важно иметь DXF-файл монтажного чертежа, чтобы механик мог 
проверить форму платы, расположение отверстий, компонентов и сравнить с 3D-моделью 
корпуса будущего устройства. Поэтому в настройках постпроцессора неплохо предусмотреть 
выпуск двух DXF-файлов: слоёв ASYTOP и ASYBOT. 

Откройте таблицу Post Process и щёлкните по строке D07_AST.GBR, чтобы выделить 
её. Щёлкните ещё раз правой кнопкой мыши и из контекстного меню выберите команду 
New… Запись скопируется. Дважды щёлкните по вновь созданной строке, чтобы открыть 
окно настроек. В поле Format установите флаг DXF. В поле File Name напишите: 
ASSEMBLY_TOP.DXF (рис.  7-66). 

Такую же операцию проделайте для записи D08_ASB.GBR. Здесь можно для удобства 
просмотра установить флаг Mirror. 

Сохраните настройки постпроцессора, закройте все окна и сохраните дизайн под оче-
редным именем-версией. 
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рис.  7-66 

7.9. Отчёты. 
Для вызова мастера создания отчётов выполните команду: «Auto → Create Reports…». 

Откроется окно Generate Reports (рис.  7-67). 

 
рис.  7-67 

Окно разделено на две части. В поле c предоставляется выбор из 20 стандартных отчё-
тов. Поле d служит для выбора дополнительных, в том числе – «User Defined» – созданных 
пользователем. 

Рассмотрим некоторые из них. 

Отчёты об используемых компонентах. 

1 

2
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Comp All – создаётся перечень всех компонентов. В отчёт включается Reference Desig-
nator компонента, его Value, Package, название используемого Footprint-а и координаты. В 
качестве координат компонента указывается координаты Datum-а footprint-а. Для большин-
ства микросхем, взятых из библиотек Layout Plus, это – координаты первого вывода. 

Comp Insertion – аналогичный отчёт. Создаётся перечень всех компонентов с указани-
ем их Reference Designator-ов, Values, Footprints, координат Insertion Origins и указанием сто-
роны PCB, на которой монтируется компонент. 

Обратите внимание на различие в указании координат компонентов. Для примера, в 
первом случае координаты микросхемы U1 равны {43.82 mm; 24.77 mm}, а во втором – 
{49.53 mm; 29.59 mm}. Откройте footprint MC14489DW CASE-751D из библиотеки 
CLOCK.LLB (или footprint SOG.050/20/WG.420/L.500 из библиотеки SOG.LLB) и убедитесь, 
что координаты точки Insertion Origin относительно Datum footprint-а составляют (округлён-
но) {5.72 mm; 4.83 mm}. 

Part List – что-то вроде Bill of Materials, списка используемых компонентов, сгруппи-
рованных по признаку Part Number. Part Number компонентов передаётся в Layout Plus из 
Capture посредством netlist-а. 

Comp TOP SMT – отчёт об SMT-компонентах, расположенных на верхней стороне 
платы. 

Comp Bottom SMT – отчёт об SMT-компонентах, расположенных на нижней стороне 
платы. 

Pick and Place Report – дополнительный отчёт, создаваемый по специальному шабло-
ну. В него включаются только SMT-компоненты. 

Comp TOP Thru и Comp Bottom Thru – отчёт о thruhole-компонентах, расположен-
ных на верхней и нижней стороне PCB соответственно. 

Отчёты о соединениях. 
Net List – netlist, создаваемый Layout Plus. Этот netlist может отличаться от созданного 

Capture из-за дополнительных компонентов, отсутствующих на принципиальной схеме. Это 
могут быть, например, крепёжные отверстия, подключённые к общей «земле». Различия воз-
можны из-за наличия компонентов с параллельно подключёнными выводами, которые также 
не были указаны в Capture (вспомните о кнопках SW1-SW4). 

Connections – отчёт о соединениях pin-to-pin, от вывода к выводу попарно. 

Cross References – перечень всех выводов с указанием координат и принадлежности 
цепям. 

Conns Unrouted – отчёт об отсутствующих соединениях. 

Nets Lenghts – отчёт включает в себя название цепи, протяжённость по слоям и рас-
чётное значение неразведённых соединений. Последняя величина может быть отличной от 
нуля, если соединение осуществляется посредством Copper Pours или Plane Layers. Указыва-
ется также количество vias для каждой цепи и некоторая дополнительная информация. 

Другие отчёты. 
Drills и Drill Pairs – отчёты об отверстиях. 

Padstacks – перечень используемых padstacks. 

Pins Unused – отчёт о выводах компонентов, «висящих в воздухе». 

Renames – отчёт о переименованных компонентах. 

Statistics – знакомая нам таблица статистики. 

Test Poins – отчёт о контрольных точках. 
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Vias – отчёт об используемых в дизайне vias. 

Правила формирования отчётов указываются в файле layout.ini в секции 
[REPORTS]90. Там же присутствуют необходимые комментарии. Тем не менее, я считаю 
нужным дать некоторые пояснения. 

Секция [REPORTS] содержит две подсекции. В первой подсекции определяются заго-
ловки отчётов, во второй – их формат. Подсекция заголовков также разделена на две части. В 
первой (STANDARD REPORTS) жёстко заданы – и изменять их нельзя – заголовки стандарт-
ных отчётов. Во второй (CUSTOM REPORTS)  указываются имена и текстовые комментарии 
дополнительных отчётов. Вы можете добавлять сюда собственные отчёты. 

Вторая подсекция, которая называется REPORT DEFINITIONS, служит для подробно-
го описания отчёта. 

Вот пример описания отчёта Component Properties: 
#-------------------------------------------------------------------- 
# CUSTOM REPORTS: ADD NEW REPORT TYPES HERE 
 
COMPATTR=Component Properties Report 
#COMPLIST is user definable, defined above 
 
#---------------------------------------------------------------- 
# REPORT DEFINITIONS: THESE CAN BE IN ANY ORDER AND CAN BE EDITED 
# BUT THERE MUST BE ONE DEFINITION FOR EACH REPORT LISTED ABOVE 
 
[COMPATTR] 
KIND=COMPLIST 
DEFEXT=Compprop 
FIELD=REFDES    10 L ' ' "Ref Des" 
FIELD=VALUE     12 L ' ' "Value" 
ATTR=PARTNUM    12 L ' ' "Part No." 
ATTR=TOLERANCE  12 L ' ' "Tolerance" 
ATTR=COMPSIDE   12 L ' ' "Complayer" 
ATTR=DECOUPLER  12 L ' ' "Decoupler" 

В подсекции CUSTOM REPORTS создаётся новый заголовок. В данном случае – 
COMPATTR. Через знак равенства указывается текстовый комментарий, который будет виден 
в окне Select Custom Reports (рис.  7-67, d). 

Далее, в подсекции REPORT DEFINITIONS следует описание отчёта. Начинается оно 
с заголовка. Далее следуют переменные-операторы Layout Plus. 

KIND – указание используемого шаблона для формирования отчёта. 
DEFEXT – имя файла, в котором будет сохранён отчёт. 
FIELD – свойство объекта, представленного в отчёте. Данные будут взяты из ло-

кальной базы данных Layout Plus. 
ATTR – свойство объекта, представленного в отчёте, но в этом случае данные будут 

извлечены из netlist-а, переданного Capture. 

Переменные FIELD и ATTR позволяют модифицировать отчёт, но их применение до-
пустимо только для шаблонов, описанных ниже. 

Параметр переменной KIND для модифицируемых отчётов может принимать следую-
щие значения: 

COMPLIST – отчёт о всех компонентах дизайна. 
COMPSTOP – в отчёт будут включены только SMT-компоненты, расположенные на 

слое TOP. 
COMPSBOT – в отчёт будут включены только SMT-компоненты, расположенные на 

                                                 
90 Подробнее см. OrCAD Layout User’s Guide, page 483. 
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слое BOTTOM. 
COMPTTOP – в отчёт будут включены только thruhole-компоненты, расположенные на 

слое TOP. 
COMPTBOT – в отчёт будут включены только thruhole-компоненты, расположенные на 

слое BOTTOM. 
NETLIST – отчёт о соединениях. 

Остальные шаблоны являются неизменяемыми, исключая шаблон PICKANDPLACE, ко-
торый выводит информацию обо всех SMT-компонентах: как слоя TOP, так и BOTTOM. 
Описание параметров этого шаблона см. непосредственно в файле layout.ini. 

О возможных значениях переменных FIELD и ATTR я также рекомендую свериться с 
файлом layout.ini, поскольку допускаю, что в различных версиях могут быть дополнения. 
Однако, для полноты картины, опишу и их. 

Параметры переменной FIELD: 
REFDES – Reference Designator. 
X – координата компонента X. 
Y – координата компонента Y. 
XINSERT – координата X Insertion Origin компонента. 
YINSERT – координата Y Insertion Origin компонента. 
ROT – угол поворота компонента. 
PACKAGE – Package компонента. 
COMPSIDE – сторона платы, на которой установлен компонент. 
UID – внутренний идентификатор компонента в базе данных Layout Plus. 
FOOTPRINT – Footprint компонента. 
GROUP – принадлежность группе. 
CLUSTER – принадлежность к кластеру. 
UNUSEDPINS – неподключённые выводы. 

Параметры переменной ATTR: 
VALUE – Value. 
ALTSYM – альтернативный footprint. 
PARTNUM – Part Number. 
PREFIX – Префикс, использующийся для формирования Reference designator. 

При помощи переменной ATTR можно выводить в отчёте любые свойства компонента, 
при условии, что это свойство определено на уровне дизайна Capture и описано в секции 
[SYMATTR] файла layout.ini. 

Параметры переменной FIELD для цепей: 
NETNAME – имя цепи. 
NETPINS – выводы компонентов, подключённые к данной цепи. 
ROUTEDLEN – длина соединения. 
UNROUTEDLEN – расчётная длина ещё неразведённых соединений, относящихся к 

данной цепи. 
VIAS – vias. 
CONNECTIONS – количество парных соединений. 
COMPPINS – выводятся попарно соединённые выводы. 
PERCENTAGE – % от общего количества соединений. 
NETGROUP – указывается номер группы, к которой принадлежит цепь. 

Отчёты записываются в текстовый файл в виде таблицы. Данные параметров FIELD и 
ATTR формируют столбцы. Число, следующее за параметром указывает на ширину столбца. 
Буква «L» указывает на необходимость выравнивания столбца по левому краю. Данные, ко-
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торые не помещаются в столбце, будут обрезаны. 

Варианты форматирования: 
L – выравнивание по левому краю. 
R – выравнивание по правому краю. 
C – выравнивание по центру. 
LW – выравнивание по левому краю с переносом текста. 
RW – выравнивание по правому краю с переносом текста. 
CW – выравнивание по центру с переносом текста. 

После буквы указания формата следует символ-разделитель, заключённый между апо-
строфами. По умолчанию это – пробел. Если Вы планируете делать импорт отчётов в MS-
Excel, возможно, будет удобнее поменять пробел на запятую. 

Текст, заключённый в кавычки – заголовок столбца. 

7.10. Печать. 
Распечатать дизайн в Layout Plus можно двумя способами. Во-первых, с помощью ко-

манды: «File → Print/Plot» (рис.  7-68). Во-вторых, с помощью Post Processor-а (см. главу  7.8 
Post Processing.). 

Если мы выбираем первый способ, то на печать будут выведены все слои и элементы 
дизайна, определённые в таблице Color как видимые. Вы можете описать особое правило, 
чтобы распечатать именно то, что хотите увидеть на бумаге. Например, дорожки слоя TOP и 
BOTTOM, контур платы и границы компонентов. Созданное цветовое правило можно сохра-
нить для последующего использования. 

Дополнительные настройки позволяют отменить цветную печать (Force Black & 
White), расположить рисунок в центре листа (Center on Page), повернуть его (Rotation)  или 
напечатать в зеркальном отображении (Mirror), что может понадобиться при работе со сло-
ем BOTTOM. 

 
рис.  7-68 

Флаг Print/Plot Current View позволяет вывести на печать только тот участок PCB, ко-
торый виден в данный момент на экране. В противном случае плата будет напечатана полно-
стью. 

Не предусмотрена опция подгонки изображения под размер листа, что неудобно. Вме-
сто этого можно воспользоваться коэффициентами увеличения (c) и уменьшения (d) мас-
штаба (Scale Ratio). 

1 2 
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Коэффициенты задаются с помощью целых чисел, поэтому чтобы увеличить изображе-
ние, например, в 1.5 раза, Вы должны указать числа 3 и 2. 

Если Вы хотите распечатать плату в натуральную величину, укажите коэффициенты 
масштабирования 1 и 1. В этом случае распечатка будет точно совпадать по размерам с бу-
дущей платой, и на ней можно попробовать расположить реальные детали и компоненты, 
чтобы убедиться в отсутствии ошибок компоновки. 

Флаг DXF позволяет вместо вывода на печать, создать DXF-файл. 

Совет. Иногда заказчик хочет получить для проверки не распечатку будущей платы, а 
какие-либо файлы, которые можно просматривать, не имея установленного Layout. Самое 
простое, это снять графическую копию экрана с помощью клавиши Print Screen и сохранить 
полученное изображение в формате GIF. 

Если плата настолько мала, что её хорошо видно на экране целиком, такой способ 
вполне приемлем. Но как быть, если плата велика, и изображение получается слишком мел-
кое? 

Если на Вашем компьютере установлена программа Adobe Acrobat91, то Вы можете от-
править задание на виртуальный PDF-принтер и получить изображение в PDF92-формате. 
Программа Adobe Acrobat Reader является свободно распространяемой93, и поэтому никаких 
проблем с просмотром Ваших файлов не возникнет. Кроме того, изображение будет сохра-
нено в векторном формате, а значит, во время просмотра его можно будет увеличивать сколь 
угодно много без искажения картинки. 

7.11. Дистрибутив. 
Работа над платой завершена. Теперь нужно навести порядок, заархивировать проект 

со всеми необходимыми библиотеками, чтобы при необходимости можно было вернуться к 
нему вновь. Ну и, наконец, отправить необходимые файлы на завод. 

Я предлагаю один из возможных вариантов оформления проекта. 

Создайте у себя в компьютере новую папку, которую назовите, скажем, Clock_Out. 
Создайте в ней ещё четыре подпапки: DXF, Gerber, IPC356 и Reports. Теперь: 

– Запустите Post Processor и создайте выходные Gerber-файлы. Переместите их все в 
папку Gerber. 

– Созданные постпроцессором DXF-файлы перенесите в папку DXF. 

– Создайте необходимые отчёты и переместите их в папку Reports. 

– В папку Clock_Out скопируйте файлы схем OrCAD Capture, последнюю версию 
PCB, библиотеки Capture и Layout Plus. Очень хорошо, если Вы создадите дополнительную 
копию схемы в формате Capture v7.2. Если Вы работаете с OrCAD Capture версии 10 и выше, 
то Ваши файлы невозможно будет открыть в более ранних версиях. 

– Из окна Layout Session выполните команду: «File → Export → MIN Interchange». 
Это – файл Вашей PCB, записанный в текстовом формате. Некоторые CAD-программы осу-
ществляют импорт плат, разработанных в OrCAD Layout именно из этого формата. Возмож-
но, в будущем Ваша работа потребует изменений и попадёт к другому человеку, который 
Layout не использует. Наличие в архиве файла .MIN облегчит перенос данных на другую 
платформу. 

При экспорте используйте настройки, как показано на рис.  7-69. 

                                                 
91 © Adobe Systems Inc. 
92 Portable Document Format. 
93 http://www.adobe.com/acrobat/reader 
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– Из окна Layout Session выполните команду: «File → Export → MAX ASCII Netlist». 
Это – netlist OrCAD Capture, преобразованный в текстовый формат. Создавать его, как и пре-
дыдущий файл, не обязательно, но и необременительно. 

 
рис.  7-69 

– Для сложных или многослойных плат Вы должны приготовить ещё один файл, кото-
рый будет использован для ряда проверок. Это файл, так называемых, «внешних соедине-
ний» или, как его ещё называют, «intelligent form of a netlist». Речь идёт о файле формата IPC-
356. В одной из последующих глав мы вернёмся к этой теме и посмотрим, как можно прове-
рить Gerber-ы с его помощью. А сейчас просто выполните команду: «File → Export → Lay-
out to IPC-356». 

 
рис.  7-70 

Проконсультируйтесь с технологом завода по поводу параметров окна, приведённого 
на рис.  7-70, хотя, думаю, проблем с совместимостью форматов у Вас не должно возникнуть. 

Укажите расширение файла как .IPC и переместите его после создания в папку IPC356. 

– Последнее, что Вы должны сделать – сопроводить свой проект описанием. Создайте 
обычный текстовый файл, который назовите !!!Readme.TXT и заполните его по нижеприве-
дённому образцу: 
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30.01.2006 

-= CLOCK Training. =- 

---------------------------------------------------------------------------- 
Cadence PSD 15.1: 
                OrCAD Capture CIS 10.1.0 
                OrCAD Layout 10.1.0 

Gerber version: WISE GerbTool 14.0 SR2 

---------------------------------------------------------------------------- 
Files: 

OrCAD project:          *.opj 
Capture design:         *.DSN 
Capture v7.2 design     *_v7.DSN 
Capture Library         *.OLB 
Capture Netlist:        *.MNL 
Capture ASCII Netlist:  *.ASC 
OrCAD Layout board:     *.MAX 
Layout Interchange:     *.MIN 
OrCAD Layout Library:   *.LLB 

Layout Reports:         Reports\*.TXT 
Layout ASCII Netlist:   Reports\NETLIST.TXT 

GerbTool Design:        Gerber\*.GTD 
PostProcessor Report:   Gerber\*.LIS 

IPC-D-356 Netlist:      IPC356\*.IPC 

Assembly DXF (inch):    DXF\*.DXF 
---------------------------------------------------------------------------- 

Gerbers: 
  Important! File *.GTD is layers configured only. May be ignored for Gerber 
processing. 

 

#  File           Layer                 Type     Format 

1  01_TOP.GBR     TOP                   Gerber   RS274X,3.4,Abs,Inch,Leading 
2  02_GND.GBR     PLANE Negative        Gerber   RS274X,3.4,Abs,Inch,Leading 
3  03_PWR.GBR     PLANE Negative        Gerber   RS274X,3.4,Abs,Inch,Leading 
4  04_BOT.GBR     BOTTOM                Gerber   RS274X,3.4,Abs,Inch,Leading 

5  D01_SMT.GBR    Soldermask Top        Gerber   RS274X,3.4,Abs,Inch,Leading 
6  D02_SMB.GBR    Soldermask Bottom     Gerber   RS274X,3.4,Abs,Inch,Leading 
7  D03_SPT.GBR    Solder Paste Top      Gerber   RS274X,3.4,Abs,Inch,Leading 
8  D04_SPB.GBR    Solder Paste Bottom   Gerber   RS274X,3.4,Abs,Inch,Leading 
9  D05_SST.GBR    Silkscreen Top        Gerber   RS274X,3.4,Abs,Inch,Leading 
10 D06_SSB.GBR    Silkscreen Bottom     Gerber   RS274X,3.4,Abs,Inch,Leading 
11 D07_AST.GBR    Assembly Top          Gerber   RS274X,3.4,Abs,Inch,Leading 
12 D08_ASB.GBR    Assembly Bottom       Gerber   RS274X,3.4,Abs,Inch,Leading 
13 D09_DRD.GBR    Drill Drawing         Gerber   RS274X,3.4,Abs,Inch,Leading 

14  thruhole.tap  Plated Drill          Drill    Excellon 2,2.4,Abs,Inch,None 

------------------------------------------------------------- 

  ================================ 
  !    CRAB CAM Ltd.             ! 
  ! Tel: +972-1234567            ! 
  ! Fax: +972-1234568            ! 
  ! E-Mail: clients@crabcam.com  ! 
  ================================ 

--------------------------------------------------------------------------- 

– В начале указаны дата и название проекта. 
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– Далее приведена информация об используемом программном обеспечении. 
– Следом перечислены файлы, вошедшие в архив. 
– После этого указываются Gerber-файлы и файлы сверления с указанием типа и фор-

мата. 
– В конце проставляются реквизиты фирмы и, возможно, ваши собственные данные, 

как ответственного за проект. 

 
рис.  7-71 

Теперь можно упаковать папку Clock_Out (рис.  7-71) архиватором WinZip в один файл 
и в таком виде отдать своему шефу, переслать на завод и сохранить в резервном хранилище у 
себя на компьютере или на сервере фирмы. 

7.12. Congratulations! 
Позвольте поздравить Вас с окончанием работы! Вы только что закончили разработку 

своей первой печатной платы. Если Вы делали всё синхронно со мной, то у Вас накопилось 
достаточно знаний, чтобы двигаться дальше самостоятельно. А двигаться дальше есть куда, 
поверьте мне! 

Во-первых, мы ещё не исчерпали все возможности Layout Plus. Один из последующих 
разделов будет целиком посвящён описанию нюансов работы в Layout и профессиональных 
приёмов. Во-вторых, нас ждёт             . В-третьих, мы так и не разобрались по существу что 
такое – Gerber-файлы, что с ними делать и нужно ли с ними что-то делать? 

Таким образом, книга не заканчивается. Оставайтесь с нами, как говорят в телевизион-
ных новостях! 
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8. Gerbers. 

Постпроцессинг – завершающий этап работы над PCB. Файлы, созданные постпроцес-
сором отправляются на завод – изготовитель печатных плат (Board House). Дальнейшее про-
исходит без Вашего участия. И всё-таки, Ваши знания будут неполными, если мы опустим 
этот вопрос. 

Тема эта достойна отдельной книги, но Вам, как разработчику PCB, к счастью, совер-
шенно необязательно знать досконально все аспекты подготовки данных для непосредствен-
ного изготовления плат. Это дело техников и инженеров, работающих на заводе. 

В этой главе мы рассмотрим лишь основные понятия, чтобы Вы могли общаться с че-
ловеком, принявшим Ваш заказ, на одном языке. 

Кроме того, мы рассмотрим некоторые задачи, которые Вам – именно Вам – возможно, 
понадобится решать, прежде чем данные по электронной почте уйдут на завод. 

8.1. WISE GerbTool. 
Для просмотра и редактирования Gerber-файлов мы будем пользоваться программой 

GerbTool от WISE Software Solutions94. Эта программа лицензирована для использования с 
OrCAD и входит в стандартный пакет среды разработки. В книге описана 14-я версия. 

Запустить программу можно из Layout Session командой: «Tools → GerbTool → New». 
Обычно программа лицензирована только для использования в среде Layout-сессии, поэтому 
не пытайтесь запустить её каким-либо иным способом. 

На рис.  8-1 представлено основное окно программы. В верхней части экрана, как все-
гда, расположено главное меню. Прямо под ним – панель инструментов. Маркерами обозна-
чены: 

 – рабочая зона95, окно дизайна. 
                                                 

94 Полное название: GerbTool Fabricator или GT-Fabricator. http://www.wssi.com 
95 Workspace. 
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 – в нижней части экрана расположены View Tabs, вкладки просмотра. Вкладок ми-
нимально может быть две: Log и Main. Щелчок по вкладке Log открывает окно протокола 
работы. Вкладка Main открывает Workspace. 

Как Вы понимаете, ради только двух вкладок не стоило бы занимать так много драго-
ценного места, поэтому можно предположить, что вкладок может быть гораздо больше. Это 
действительно так. Командой «View → View Tabs → Add…» создаются дополнительные 
вкладки. В каждой из них Вы можете держать именно тот вид PCB (включая масштаб и ви-
димые слои), который Вам нужен. 

Конфигурация рабочего поля сохраняется при выходе из программы, что очень удобно. 
Продолжив на следующий день работу над проектом, Вы увидите его именно в том виде, в 
каком оставили вчера. 

 
рис.  8-1 

 Жёлтая рамка – это «фильм»96. На заводе платы вырезают из заготовок определённо-
го размера. Фильм – это, фактически, и есть заготовка. 

Вы, как PCB-дизайнер, можете и не знать, заготовки какого размера будут использова-
ны при производстве Вашей платы, поэтому для Вас это не существенно. Тем не менее, в од-
ной из последующих глав мы вернёмся к этому вопросу. 

 – курсор. Рядом с курсором указываются его координаты. Отсчёт координат произ-
водится от левого нижнего угла фильма. 

 – панель инструментов для просмотра и масштабирования рабочей области97. 

 – панель инструментов для получения информации об объекте98. Собственно ин-
формация выводится в окне  – Item Properties. В окне Select Filter ( ) указывается, как 

                                                 
96 Film Box. 
97 View Toolbar. 
98 Query Toolbar. 
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ясно из названия, фильтр, разрешающий или запрещающий выбор объектов того или иного 
типа. Ну, например, можно указать фильтр, разрешающий выборку только прямых линий и 
запрещающий выбор дуг. При работе со сложными PCB применение фильтров оказывается 
весьма и весьма полезным. 

 В правой части экрана расположено окно Color Bar, которое по своим функциям 
схоже с селектром слоёв Layout Plus. Здесь Вы можете назначить цвет слою, сделать слой 
активным или скрыть его. 

 – окно навигатора. Навигатор предоставляет быстрый доступ ко многим элементам 
дизайна. Сюда же выводятся результаты анализа PCB. 

Разумеется, Вам не терпится взглянуть на свою плату не из Layout. Давайте сделаем 
это. Если программа GerbTool уже открыта, то выполните команду: «File → Open…», если 
же нет, то из Layout Session: «Tools → GerbTool → Open…». Найдите файл CLOCK.GTD в 
папке Gerber и откройте его. 

 
рис.  8-2 

На рис.  8-2 показана рабочая зона с Вашим дизайном. Изменять масштаб можно с по-
мощью кнопок, расположенных на View Toolbar или горячими клавишами: 

I, Num + – Zoom In 
O, Num - – Zoom Out 
P – Pan (Center) 
<Ctrl> + <P> – AutoPan 
<Ctrl> + <R> – All View (Fit to Workspace) 
R – Redraw 

Справа (Color bar, рис.  8-3) и слева (Navigator, рис.  8-4) мы видим список слоёв, из ко-
торых состоит дизайн. Щёлкните по знаку «+» рядом с Layers в окне Навигатора, чтобы спи-
сок раскрылся. Раскройте дополнительно некоторые из слоёв, чтобы увидеть дополнитель-
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ную информацию, как показано на рис.  8-5. 

 
рис.  8-3 

 
рис.  8-4 

 
рис.  8-5

Можно заметить, что маршрутизируемые слои выделяются среди прочих особыми пик-
тограммами. В окне Навигатора под названием слоя указан его тип. Например, слой L2 на-
зывается 02_GND и имеет тип Plane Neg (Negative). «Negative», как несложно догадаться, 
означает, что слой нарисован инверсно. 

Все остальные слои имеют тип Other. Layout Plus передаёт в файле Gerber-дизайна 
*.GTD только часть информации о проекте. А именно: конфигурацию маршрутизируемых 
слоёв и цветовую таблицу. Остальные слои нужно конфигурировать вручную. Если Вы пла-
нируете доработку своей платы в GerbTool, то придётся сделать это. Без правильной конфи-
гурации всех слоёв будет невозможна работа мастеров и утилит, входящих в состав про-
граммы. 

Выполните команду: «Setup → Layers…» или нажмите клавишу Y, чтобы вызвать окно 
Layer Setup (рис.  8-6). 

 
рис.  8-6 

В столбце Layer указан номер слоя. Установленная галочка-флаг означает, что слой 
видим. В столбце Name приводится название слоя, в столбце Type – его тип. Щёлкните по 
ячейке Type слоя D01_SMT и из раскрывшегося списка выберите тип Mask Top. Это – верх-
ний слой Solder Mask. 

Аналогичным образом укажите правильный тип для всех остальных слоёв. 
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Для Вас будет неожиданностью, наличие двух столбцов Flash и Draw, которые опре-
деляют цвет слоя. Почему слой обозначается двумя цветами, а не одним, мы разберёмся чуть 
позже. В данный момент пусть цвета Flash и Draw для каждого слоя будут одинаковыми. Вы 
можете менять их, щёлкнув мышкой по соответствующей ячейке99. 

Наш дизайн состоит из слоёв следующих типов: 
01_TOP – TOP 
02_GND – Plane Neg 
03_PWR – Plane Neg 
04_BOT – Bottom 
D01_SMT – Mask Top 
D02_SMB – Mask Bot 
D03_SPT – Paste Top 
D04_SPB – Paste Bot 
D05_SST – Silk Top 
D06_SSB – Silk Bot 
D07_AST – Drawing 
D08_ASB – Drawing 
D09_DRD – Drawing 

Последние три слоя имеют тип Drawing, т.е. «Рисунок» или «Чертёж». Слои AST и 
ASB – это монтажные слои. Тут всё понятно. Но почему слой DRD тоже имеет тип Drawing? 

Вспомните, как выглядел слой DRD в Layout Plus (рис.  7-65). Чтобы увидеть его от-
дельно, закройте окно Layer Setup. 

 
рис.  8-7 

Сделайте слой D09_DRD активным. Для этого дважды щёлкните по его названию в 
                                                 

99 Как в любой развитой программе, в GerbTool одно и то же действие можно сделать разными способами. 
Так, тип слоя можно задать с помощью Навигатора, а цвет – с помощью панели Color Bar. 
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Color Bar. Название слоя выделится красным. Теперь нажмите комбинацию клавиш <Ctrl>-
<A>. По этой команде все остальные слои станут невидимы (рис.  8-7). 

Это – механический чертёж платы, содержащий размеры и пояснения. Всё правильно, 
он и должен быть типа Drawing. 

Как же так? Выходит, что все слои – графические? А как же отверстия? Неужели, если 
понадобится удалить ненужное отверстие с платы, достаточно будет стереть его символ 
(крестик или квадратик) из слоя D09_DRD?! А как же таблица Drill Chart? Разве она обно-
вится? А если нужно не удалить а добавить отверстие или перенести существующее? 

Похоже, что в дизайне не хватает ещё каких-то данных, Вы не находите? 
Это действительно так. Мы забыли про файл сверлений, который был создан Постпро-

цессором Layout Plus. Этот файл лежит в папке с остальными Гербер-файлами. Мы должны 
вручную добавить его в дизайн, используя мастер импорта файлов. 

Выполните команду: «File → Import → NC (Drill/Mill)…»100 и укажите на файл 
thruhole.tap. 

 
рис.  8-8 

Откроется окно мастера импорта (рис.  8-8). Сверяясь с файлом !!!ReadMe.txt, который 
мы создали на стр. 316, проверим, что thruhole.tap будет прочитан как файл формата Excel-
lon 2, 2.4, что указано в полях Dialect и m.n.. 

Mode: Absolute; Units: Inch; Zero Suppresion: None (в файле !!!Readme.txt формат ука-
зан как Excellon 2, 2.4, Abs, Inch, None). 

Layout Plus создаёт файлы сверловки именно в таком формате. Это нужно просто знать. 
Что означают эти данные, мы разберёмся позже. 

Дополнительно укажите, что импортируется файл отверстий с металлизацией (Plated) 
и нажмите <OK>. 

                                                 
100 NC – Numerical Control, числовое управление. В данном контексте – файл данных для станков с числовым 

программным управлением, содержащий информацию о сверлении или фрезеровании. 
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В GerbTool появится новый слой под номером 14. Тип слоя – NC, Thruhole (рис.  8-9). 

 
рис.  8-9 

 
рис.  8-10 

А вот как выглядит плата. На рис.  8-11 включены слои DRD и NC, на рис.  8-12 – толь-
ко NC. 

 
рис.  8-11 

 
рис.  8-12 

Посмотрите на рис.  8-11. Как и должно быть, все отверстия слоя NC совпадают с сим-
волами сверлений слоя DRD. Для удобства, большие отверстия изображаются в натуральную 
величину, а маленькие – в виде перекрестий. 

Теперь обратите внимание на рис.  8-12 и на рис.  8-10. Несмотря на то, что цвет слоя 
синий, отверстия имеют различную раскраску. 

Назначить каждому типу отверстий свой цвет можно в таблице NC Tool Setup, которая 
вызывается командой: «Setup → NC Tools…» (рис.  8-13). 

 
рис.  8-13 

Более общие настройки для отображения NC-слоёв находятся в меню конфигурации: 
«Options → Configure… → NC Settings» (рис.  8-14). Так, установив переключатель Use col-
ors from в положение Layer, можно добиться, что все отверстия примут цвет слоя. 

Убрав флаг Display cross-hair…, мы выключим режим отображения маленьких отвер-
стий в виде перекрестий. 
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рис.  8-14 

Ещё несколько слов об окне Configuration. 
Вкладка Units and Precision позволяет переключаться между различными системами 

измерений (рис.  8-15). 

 
рис.  8-15 

Вкладка Display (рис.  8-16) даёт доступ к функциям настройки отображения сетки 
привязки (Grid), размера и цвета Filmbox (Film box), фактора масштабирования (Zoom), цве-
та выделения (Highlight Colors) и др. 

В поле Cross Hair можно задать размер курсора и отключить отображение координат 
рядом с ним. 

Другие вкладки окна Configuration дают доступ к меню настроек мыши, клавиатуры и 
ряду других параметров программы.  

С помощью команды: «Options → Customize Toolbar…» можно практически полно-
стью изменить внешний вид программы. Приобретя некоторый опыт работы с GerbTool. Вы 
наверняка захотите оставить на виду часто используемые инструменты и скрыть ненужные. 

Я не вижу необходимости в подробном описании здесь каждого пункта всех меню. 
Смысл полей интуитивно ясен, в крайнем случае – в Вашем распоряжении удобная и очень 
подробная справочная система. И всё же, завершая эту главу, хочу сказать дополнительно 
пару слов. 

Откройте директорию, в которую у Вас установлен GerbTool. Возможно, это: 
“C:\Cadence\PSD_15.1\tools\layout_plus\gtool” 
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Войдите в папку System. В ней находятся три файла. Если Вы запутаетесь в настрой-
ках настолько, что не сможете самостоятельно вернуть программу к нормальному виду, эти 
файлы помогут Вам. Просто запустите их по очереди, один за другим. 

 
рис.  8-16 

8.2. Что такое – «Герберы»? Импорт. 
Разобравшись в общих чертах в предыдущей главе с программой GerbTool, позволяю-

щей просматривать и редактировать содержимое Гербер-файлов, перейдём к вопросу: что же 
такое – файлы в формате Gerber? 

Файлы формата Gerber предназначены для представления векторной графической ин-
формации. Отличие «Герберов» от других форматов векторной графики, например, WMF101, 
EMF102 или AI103 заключается в том, что этот формат создавался для фотоплоттеров. Факти-
чески, Гербер-файл – это набор команд фотоплоттера. 

В отличие от других форматов, «Герберы» не несут в себе информацию о цвете объек-
та. Вспомните, в главе  7.8 Post Processing. на стр. 307 мы говорили об этом. 

В отличие от других графических форматов, «Герберы» не несут информацию о слоях. 
В самом деле, не может же плоттер рисовать несколько слоёв одновременно! По этой причи-
не все CAD-программы формируют для каждого слоя отдельный гербер-файл. 

Таким образом, после того, как разводчик закончит работу над платой, результатом его 
работы будет «всего-навсего» набор графических файлов. Картинок, если хотите! В этих 
«картинках» не содержится никакой информации о том, какому слою они принадлежат – 
TOP или MASK. Как это ни ужасно, но «Герберы» не помнят ничего о Вашей PCB – ни спи-
ска соединений, ни правил размещения и маршрутизации, ни критических зон, которые Вы 
так тщательно обозначали в Layout Plus. Не осталось никакой информации ни о компонен-
тах, ни о footprint-ах. Глядя на изображение слоя TOP в GerbTool, Вы даже не сможете пору-
читься, что два соседних pad-а принадлежат одному компоненту, а не разным! 

                                                 
101 Windows Metafile. 
102 Windows Enhanced Metafile. 
103 Файл векторной графики, создаваемый программой Adobe Illustrator. 
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Это – просто картинки! В таком виде они поступают на завод, и чтобы человек, при-
нявший Ваш заказ не запутался, Вы должны правильно оформить свою работу. 

Частично Вам помогает Layout Plus. Постпроцессор создаёт файл дизайна с расшире-
нием GTD. Этот файл понятен программе GerbTool, и в нём, как мы видели, уже содержится 
информация о важнейших – маршрутизируемых слоях. Остальные слои мы конфигурируем 
вручную. 

На заводе, скорее всего, пользуются какой-то иной программой. Чтобы Вы правильно 
поняли все нюансы оформления задания, я предлагаю провести следующий опыт. Пред-
ставьте, что Вам принесли чужой проект и просят правильно его сконфигурировать. Если 
проект оформлен аккуратно, то сделать это будет легко. 

Выполните команду: «File → New…», а затем: «File → Import → Import Wizard…» и 
укажите путь к папке, в которой лежат Гербер-файлы и файлы сверлений. 

 
рис.  8-17 

Нажмите кнопку Next >, после чего откроется список импортируемых файлов (рис. 
 8-17 и рис.  8-18). 

 
рис.  8-18 

Вот Вам и первый урок! Благодаря тому, что в главе  7.8 Post Processing. мы пронуме-
ровали файлы, они расположились в удобном порядке по алфавиту. 

Урок номер два. Мастер импорта, как правило, правильно распознаёт формат данных, 
но иногда он делает ошибки. Для этого в файле !!!ReadMe.txt создаётся список импортируе-
мых файлов, их назначение и формат. 
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рис.  8-19 

Что такое: CLOCK.DTS? Щёлкните мышкой по его ячейке Data Format. В открыв-
шемся окне (рис.  8-19) в поле Format Sample выводится содержимое файла. Файл *.DTS – 
это отчёт об используемых инструментах для сверловки. Это – просто текстовый файл, и им-
портировать его не нужно. Снимите флажок около его имени (рис.  8-17) и нажмите кнопку 
Next >. 

 
рис.  8-20 

В следующем окне предлагается упорядочить файлы-слои по порядку. При необходи-
мости, это делается мышкой. Поскольку порядок уже установлен, нажимаем кнопку Finish. 
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рис.  8-21 

Наконец-то мы видим наш дизайн (рис.  8-21)! Определим для каждого слоя его тип и 
назначим привычную цветовую таблицу, а заодно выполним ряд проверок. 

Во-1, убедимся, что количество слоёв совпадает с описанным в !!!ReadMe.txt. 
Во-2, проверим, что все отверстия слоя thruhole.tap совпадают со своими символами 

слоя D09_DRD. 

В-3, по таблице Layers Stack, присутствующей в дизайне, убедимся, что слои действи-
тельно соответствуют своим названиям. Для этого включим слой D09_DRD, в котором рас-
положена таблица, и, зажигая по очереди слой за слоем, наблюдаем, как название слоя появ-
ляется в таблице (рис.  8-25). 

В-4, проверим, размеры платы, чтобы убедиться, что во время импорта не исказился 
масштаб чертежа. 

Во время работы над проектом, мы сохранили размеры платы в слоях D09_DRD и 
D07_AST. Зажгите один из этих слоёв сейчас. 

 
рис.  8-22 

 
рис.  8-23  

рис.  8-24
Поскольку размеры на чертеже указаны в миллиметрах, установите соответствующую 

систему измерений. Для этого найдите на панели инструментов кнопку Units/Precision (рис. 
 8-22) или откройте окно Configuration через систему меню. 

Выберите Millimeters. 
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рис.  8-25 

Освободите курсор от сетки привязки, выключив кнопку Toggle Grid Snap (рис.  8-23). 

На панели инструментов Query Toolbar щёлкните кнопку Center To Center (рис. 
 8-24). 

 
рис.  8-26 

Укажите курсором на нижнюю границу платы (рис.  8-26, ). Она должна выделиться. 
Потом укажите на верхнюю границу ( ). В строке состояния прочитайте результат измере-
ния. 

1 

2 
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Аналогичным образом измерьте плату по горизонтали. 

Если под курсором окажется несколько объектов, программа GerbTool может не понять 
Вас. В этом случае Вы увидите окно Choose Selection (рис.  8-27). 

 
рис.  8-27 

Выбирая из предложенных объектов, следите за подсветкой элементов на чертеже. 

Сохраните файл дизайна GerbTool. 

Используя возможности импорта, Вы, разумеется, можете просматривать и редактиро-
вать Гербер-файлы, созданные не только в системе OrCAD Layout. Все CAD-программы под-
готавливают данные в таком формате. 

8.3. Gerber RS-274D. 
OrCAD Layout Plus выпускает файлы в двух форматах: Gerber RS-274D и Extended 

Gerber (рис.  7-57). Рассмотрим первый из них. 
Как я уже говорил, Герберы – это данные, представленные в виде команд для фото-

плоттера. В настоящее время существует много способов изготовления PCB, но в общих чер-
тах процесс выглядит следующим образом. С помощью фотоплоттера создаётся рисунок од-
ного из слоёв на светочувствительном материале (фоторезисте104). Рисунок переносится на 
заготовку PCB, после чего незакрашенные участки вытравливаются химическим способом. 

Фоторезист, который под влиянием света не темнеет, а наоборот, становится прозрач-
ным, можно использовать для подготовки негативных слоёв. Например, внутренних, типа 
Plain. 

Классический векторный фотоплоттер создаёт изображение с помощью ультрафиоле-
тового луча, причём луч проецируется на поверхность фоторезиста не в виде точки, а в виде 
определённой геометрической фигуры – круга, прямоугольника и др.. Для этого в фотоплот-
тере существует специальное устройство, которое называется Aperture Wheel. Aperture 
Wheel – представляет собой набор диафрагм (апертур) различного размера и формы. Чтобы 
получить луч другой формы, нужно сменить апертуру. 

 Поскольку Aperture wheel – это механическое устройство, то набор используемых 
апертур во время одной сессии ограничен. А именно – 24 апертуры. Для каждого слоя может 
быть использован свой набор апертур, но в каждом наборе – не больше 24. 

Чтобы нарисовать pad нужной формы, плоттер выбирает соответствующую апертуру, 
перемещается в необходимую позицию, затвор открывается, происходит засветка выбранной 
области, после чего затвор закрывается. Такое действие называется «Flash», засветка. 

Если плоттер перемещается, в то время, когда затвор открыт, то такое действие обозна-
чается термином «Draw», рисование. 

                                                 
104 Etch-Resist. 

OrCAD Layout Plus 

 Стр. 333 

Рисовать можно, используя апертуры любого типа, но, как правило, все проводники 
(дорожки) на печатной плате рисуются с помощью апертур круглой формы. 

Начните, пожалуйста, новую сессию в Layout Plus и нарисуйте вот такую несложную 
однослойную печатную плату (рис.  8-28): 

 
рис.  8-28 

Два pad-а соединены дорожкой. Pad #1: oblong, 100x50 mil. Pad #2: rectangle, 100x50 
mil. Толщина горизонтального участка дорожки равна 20 mil, толщина вертикального – 30 
mil. 

Теперь запустите Postprocessor, предварительно указав формат Gerber RS-274D. 
Что мы увидим? 

В Layout Plus откройте таблицу Apertures. Вначале эта таблица была пуста, однако по-
сле работы Постпроцессора в ней появились данные (рис.  8-29): 

 
рис.  8-29 

Были созданы 4 апертуры. Указывается их обозначение (‘D’ Code), размер и форма. 
Аналогичная информация содержится в созданном Постпроцессором файле *.APP: 

#      Shape     Width    Height  Type   Tool  Tool_Size   Legend   R90 

# 

D10   Oblong    0.10000  0.05000   TH      0    0.0000      D10      0 

D11   Rectangle 0.05000  0.10000   TH      0    0.0000      D11      0 

D12   Round     0.02000  0.02000   TH      0    0.0000      D12      0 

D13   Round     0.03000  0.03000   TH      0    0.0000      D13      0 

Ещё один подробный отчёт об используемых апертурах Вы найдёте в файле *.LIS. 

Теперь откройте текстовым редактором Гербер-файл слоя TOP. Вот его содержимое: 

G54D12* Выбрать апертуру D12 (команда G54). Из приведённой выше 
информации видно, что D12 – апертура круглой формы, диа-
метром 20 mil. 

G01X0004000Y0002000D02* Перейти к координатам (G01) X=400 (X0004000), Y=200 
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(Y0002000). Затвор закрыт (D02). 
X0002000D01* Переместиться к координате X=200 (X0002000). Затвор от-

крыт (D01). Нарисовали горизонтальный участок дорожки 
толщиной 20 mil. 

G54D13* Сменить апертуру на D13. Затвор во время этой операции за-
крывается. D13 – апертура круглой формы, диаметром 30 mil. 

G01X0004000Y0005000D02* Перейти на X=400, Y=500. Затвор закрыт. 
Y0002000D01* Нарисовать линию до координаты Y=200. Вертикальный уча-

сток дорожки толщиной 30 mil. 
G54D10* Сменить апертуру на D10. Форма oblong, размер 100х50 mil. 
X0002000D03* Сместиться по горизонтали до точки X=200 и сделать засвет-

ку (команда D03 означает Flash). Поставили первый pad. 
G54D11* Сменить апертуру на D11. Форма rectangle, размер 100х50 mil. 
X0004000Y0005000D03* Сделать засветку в точке X=400, Y=500. Поставили второй 

pad. 
M02* Конец программы. 

Астериск, как легко догадаться, означает конец оператора. 
Полный список команд Gerber RS-274D, если Вам интересно, можно найти в справоч-

ной системе GerbTool в разделе «Tutorials → Gerber for Beginners». Скажу только, что 
апертуры всегда обозначаются D10, D11 и т.д.. Это так называемые D-codes. Значения мень-
шие, чем D10 интерпретируются как команда. 

Формат нашего файла можно представить как: Gerber RS-274D, 3.4, Abs, Inch, None. 
Обратите внимание на форму записи координат. Например, X0004000 означает переход 

по горизонтали к точке X=400. Это можно было бы записать как X=000.4000 (в дюймах). Та-
ким образом, число 3.4 в представлении формата показывает, что все данные представлены в 
виде семизначных чисел с фиксированной запятой после третьего знака. 

Слово None означает, что данные всегда представлены семизначными числами, без от-
броса незначащих нулей. Если бы та же координата была представлена в форме X4000, то 
вместо None следовало написать Leading. В случае X0004 формат обозначался бы как Trail-
ing. 

Abs означает, что координаты представлены абсолютным значением, относительно Da-
tum (начала координат). Incr (Incremental) показывает смещение относительно текущей по-
зиции. 

 
рис.  8-30 

 
рис.  8-31 

 
рис.  8-32 

Inch или Metric указывают на использование дюймовой или метрической системы из-
мерений. 

Откройте теперь плату в GerbTool. Определите разные цвета для Flash и Draw, как это 
показано на рис.  8-30. Вот, что Вы должны увидеть (рис.  8-33): 
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рис.  8-33 

В окне Навигатора найдите и раскройте список апертур (рис.  8-31). 

И, наконец, щёлкните по кнопке Query Item и выберите мышкой нижний pad. В окне 
Item Properties (рис.  8-32) Вы увидите полную информацию о выбранном объекте. 

Обратите внимание, чтобы в окне Select Filter были установлены флажки рядом с объ-
ектами типа Flash и Draw, иначе выбрать pad не удастся. 

Поэкспериментируйте самостоятельно. Советую также заглянуть в таблицу Aperture 
Setup: «Setup → Apertures…». 

8.4. Установка Gerber-формата в Layout Plus. 
Вернёмся к окну Gerber Preferences в Layout Plus, которое мы пропустили в главе  7.8 

Post Processing. Выполните команду: «Options → Gerber Settings…» (рис.  8-34). 
Многие поля этого окна теперь понятны. Подытожим уже известную информацию и 

остановимся на новой. 

Maximum Apertures. Выше я говорил, что количество апертур фотоплоттера во время 
каждой сессии ограничено числом 24. Это справедливо для классических машин с механиче-
ским переключением апертур. Современные лазерные плоттеры освобождают от этого огра-
ничения, поэтому значение, выставленное в этом поле – 999. 

Gerber Creation → Create Apertures as Needed. Если установлена эта опция, Layout 
самостоятельно создаст список апертур и назначит им D-codes. 

Use Existing Apertures Only. Вынуждает Постпроцессор использовать список апертур, 
созданный ранее и содержащийся в дизайне (в файле *.MAX). 

Установите эту опцию. Теперь измените толщину вертикальной дорожки из примера, 
рассмотренного в прошлой главе, с 30 mil на 40 mil. Апертуры диаметром 40 mil в таблице 
нет. Как выйдет Layout Plus из сложившейся ситуации? 
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рис.  8-34 

Запустите Постпроцессор, а потом откройте файлы программой GerbTool. 

 
рис.  8-35 

 
рис.  8-36

Воспользуйтесь уже знакомым нам инструментом Query Item чтобы посмотреть 
структуру вертикальной дорожки. 

Хорошо видно, что дорожка прорисовывается дважды апертурой D13. Плоттер прове-
дёт две параллельные линии со смещением 10 mil (рис.  8-35). Дополнительно, концы дорож-
ки закругляются при помощи той же апертуры (рис.  8-36). 

Созданную Layout Plus таблицу апертур можно сохранить в отдельном файле. Для это-
го откройте Apertures, щёлкните правой кнопкой мыши и из контекстного меню выберите 
пункт Write Gerbtool apertures… (рис.  8-37). Список апертур будет сохранён в файле с 
расширением *.APP. 

Понятно, что восстановить таблицу или перенести её в другой дизайн можно командой 
Read Gerbtool apertures…. 
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рис.  8-37 

Опция Using Master Aperture List служит практически для той же цели, что и преды-
дущая. Список апертур берётся из внешнего файла. Отдельный интерес представляет опция 
Retain D Сodes From Master List. Если флаг установлен, то все апертуры сохранят своё на-
звание. Если сброшен, Постпроцессор переименует их, начиная с D10. 

Xsize и Ysize определяют максимальную рабочую зону фотоплоттера в милях. 

Остальные опции определяют формат Гербер-файлов. 

8.5. Дополнительные примеры. 
Ряд дополнительных примеров. На рис.  8-38 показано, как с помощью дуги (Arc) и ли-

нии (Draw) создаётся изогнутая дорожка. 

 
рис.  8-38 

Следующий пример поясняет, как создаётся зона Copper Pour. 

 
рис.  8-39

 
рис.  8-40 

 
рис.  8-41 

Вы не должны забывать, что Гербер-файлы – это не просто графический формат. Это 
формат машинный. Copper Pour была создана с помощью obstacle толщиной 10 mil. Плоттер 
обводит указанную область по периметру, используя апертуру круглой формы диаметром 10 
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mil, а затем, используя эту же апертуру, производит штриховку зоны. На рис.  8-39 - рис.  8-41 
хорошо видно, как создаётся заливка с помощью дуг и отрезков, тесно «прижатых» друг к 
другу. 

Если Вы укажете толщину obstacle Copper Pour или Copper area равной 1 mil, то чтобы 
обеспечить точность рисунка, будет создана апертура диаметром 1 mil. Отрезками соответ-
ствующей ширины будет штриховаться вся зона. Для механических плоттеров это настоящая 
проблема! Время работы плоттера может увеличиться многократно и занять часы! 

К счастью, такие машины встретишь сейчас не часто. Современные лазерные фото-
плоттеры работают аналогично обычным лазерным принтерам. Векторное изображение пре-
образуется в растровое, после чего процесс напоминает обычную распечатку. Ни толщина 
линий, ни сложность платы на скорость работы таких устройств практически не влияет. 

Ещё два примера. На рис.  8-43 показано, как создаётся соединение Thermal Relief в 
слое TOP или INNER. Это – слои типа Positive. Два pad-а соединяются посредством Copper 
Pour. Нам достаточно всего двух апертур (рис.  8-42). Одна используется для создания pad-а, 
вторая – для создания Copper Pour и перемычек Thermal Relief (рис.  8-43). 

 
рис.  8-42 

 
рис.  8-43 

То же соединение с Plain-слоем (рис.  8-45). Слои Plain – это слои типа Negative. Плот-
тер не может нарисовать колечко Thermal Relief правильно, с помощью дуг, потому что кон-
цы дуг будут скруглённые. По этой причине была создана апертура типа Thermal (рис.  8-44). 

 
рис.  8-44 

 
рис.  8-45

Возможно, Вы задумывались, почему Layout Plus позволяет работать в дизайне только 
с двумя типами Thermal Relief – Small и Large? Теперь это должно быть понятно. Апертуры 
круглой формы являются универсальными. Их можно использовать не только для проста-
новки pad-ов (режим Flash), но и для рисования дорожек, штриховки зон медной заливки 
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(режим Draw) и т.д.. Апертурами Thermal рисовать нельзя. Если Вам вздумается для каждого 
вывода создать своё особое соединение по типу Thermal Relief, то для каждого вывода при-
дётся создавать собственную уникальную апертуру. При ограничении общего количества 
апертур, может возникнуть ситуация, когда создание Гербер-файлов станет невозможным. 

Ещё один вопрос, который, вероятно Вы хотели бы задать: смысл использования слоёв 
PLAIN вместо INNER? Ответ очевиден. Впрочем, Вы уже, наверно, догадались самостоя-
тельно. Нарисовать Plain-слой не займёт много времени. Достаточно лишь проставить pad-ы 
переходных отверстий и соединений Thermal. Inner-слой придётся полностью заштриховы-
вать, обходя vias и прочие «неоднородности», а это – гораздо более трудоёмкий процесс. 

Впрочем, как говорилось выше, повсеместное использование лазерных или «растро-
вых» фотоплоттеров позволяет нам не задумываться о таких проблемах, а, равно как, и о ко-
личестве используемых апертур. 

8.6. Текст. 
Почему в Layout Plus используется такой некрасивый шрифт? Если мы работаем в сре-

де Microsoft Windows, так почему бы не воспользоваться набором системных шрифтов True 
Type? 

Посмотрите любой из чертежей, подготовленных инженером-механиком, работающим 
в AutoCAD или SolidWorks. На его чертеже Вы не найдёте ни одной надписи, оформленной 
шрифтом True Type. Надписи как будто нарисованы. Что это: какой-то стандарт или истори-
чески сложившаяся традиция, сохранившаяся ещё с тех времён, когда чертежи рисовали ка-
рандашом? 

Конечно же, нет. Шрифт, используемый в CAD105-программах так и называется – «чер-
тёжный». Отличие чертёжного шрифта от остальных состоит в том, что буквы рисуются ли-
ниями одинаковой толщины. 

 
рис.  8-46 

Я не случайно употребил слово «рисуются», а не «печатаются». Любой механический 
чертёж – и чертёж PCB в том числе – хранится в векторном формате с целью возможности 

                                                 
105 CAD – Computer-Aided Design. Система автоматизированного проектирования. В отличие от OrCAD, Gerb-

Tool является CAM – Computer-Aided Manufacturing, программой для автоматизированного производства. 
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вывода его на плоттер или графопострои
ны пером графопостроителя. Механиче
платы – ультрафиолетовым лучом на фот
вания изменять свою толщину, поэтому в

А как же растровые принтеры и пл
позволяет использовать растровые данн
избегать подобных ситуаций. 

 Итак, нарисуйте что-то похожее н
как показано на рис.  8-47. Параметры те
для слоя TOP и откройте его программой

Теперь воспользуйтесь инструмент
(рис.  8-49). 

Можно увидеть, что буквы были с
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рис.  8-47 

оттеры? В этой главе мы увидим, что форм
ные. Однако, из соображений совместимос

на рис.  8-28 и добавьте рядом произвольн
екста приведены на рис.  8-46. Создайте гер
й GerbTool (рис.  8-48). 

 
рис.  8-48 
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рис.  8-49 
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mil. Номер апертуры – D14. 

Как добавить текст в уже готовый Gerber? Для этого войдите в меню: «Add → Text…». 
Откроется окно, как показано на рис.  8-50. 

 
рис.  8-50 

Текст вносится в виде объекта, атрибуты которого указываются в верхней ( ) части 
окна. В поле  выбирается шрифт, а в поле  вводятся собственно данные. 

 
рис.  8-51 

На рис.  8-51 показано то, что получится. 

Буквы имеют размер 100x100 mil, как и требовалось, но как изменить толщину линий? 

 
рис.  8-52 

В верхней части экрана расположен селектор апертур (рис.  8-52). Сейчас выбрана 
апертура D13 диаметром 30 mil. Именно ей и был нарисован наш текст. Буквы получились 
слишком жирные, неразборчивые. 

Щёлкните правой кнопкой мыши по тексту и выберите Transcode… (рис.  8-53). Из 
списка доступных апертур выберите апертуру диаметром 10 mil (рис.  8-54). 

1 

2 

3 
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рис.  8-53 

Теперь всё правильно (рис.  8-55). 

То же самое действие можно сде
«Edit → Item…», после чего щёлкните по

Поменяйте апертуру в поле D-Cod
<Apply> и <Close>. 

Разберитесь самостоятельно в назн

dmitri.kaikov@g

рис.  8-54 

 
рис.  8-55 

елать более сложным способом. Войдите
о надписи (рис.  8-56): 

 
рис.  8-56 

e, как показано на рис.  8-57, затем нажмит

ачении остальных полей. 

gmail.com 
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O

 
рис.  8-57 

ы уже посмотрели, что скрывается под вы
но же увидели, что от нас скрывают богаты
ж, давайте напишем какой-либо текст шриф

рис.  8-58 
 Прекрасно получилось, а я говорил, что не
что у нас получилось. С помощью инструм

8-59): 

 
рис.  8-59 

используемую апертуру: D13, диаметром 3
овать такой шрифт апертурой 30 mil? 
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Попробуйте посмотреть структуру надписи, как мы это делали на рис.  8-49. Не получа-
ется! Текст выбирается как объект – единое целое. 

GerbTool хранит все изменения в файле дизайна с расширением GTD. Исходные гербе-
ры не изменяются. Поэтому проделаем следующее: создадим новый гербер-файл из имеюще-
гося дизайна, воспользовавшись командой: «File → Export → Gerber…». Теперь начните но-
вый дизайн и импортируйте в него только что созданные данные. 

Просмотрите структуру имеющихся в дизайне надписей. 

 
рис.  8-60 

Текст, написанный шрифтом GerbTool-Stroke, создаётся круглой апертурой D14 диа-
метром 10 mil. 

 
рис.  8-61 

Текст, написанный шрифтом Times New Roman, является набором растровых полиго-
нов. Растровые фигуры нельзя вывести на векторный плоттер. Вот и причина, по которой в 
CAD-программах не используют шрифты True Type. 

8.7. Raster to Vector. 
GerbTool позволяет преобразовывать растровые фигуры в векторный вид, используя 

имеющийся набор апертур. Понятно, чтобы максимально уменьшить искажения, для преоб-
разования нужно использовать апертуру наименьшего диаметра. Современные технологии 
позволяют работать с апертурами в 4 mil. 

Выберите: «Setup → Apertures…» (рис.  8-62). Мы видим список и параметры всех 
апертур, используемых в нашем дизайне. 

Нажмите кнопку Add D-Code… чтобы создать новую апертуру. 

Укажите параметры, как

Теперь выберите: «Tools
Используя различные на

O

рис.  8-62 
к показано на рис.  8-63. 

рис.  8-63 
s → Convert → Raster to Vector…». 
астройки, можно добиться неплохих результ
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8.8. Gerber RS-274X, Extended. 
Формат RS-274D был создан в дни векторных механических фотоплоттеров. С появле-

нием лазерных машин формат был значительно расширен, и получил название 274X или Ex-
tended. Основное отличие заключается в том, что появилась возможность комбинировать 
Positive и Negative данные. 

Очень простой пример. Требуется нарисовать вот такое колечко (рис.  8-64): 

 
рис.  8-64 

В формате 274D потребуется создание апертуры типа Annular. В формате 274X такое 
кольцо может быть создано как комбинация двух апертур Circle: первая, большего диаметра, 
типа Positive, и в ней – вторая, меньшего диаметра, Negative. 

Понятно, что классический плоттер, засветив определённую область, не может после 
этого «затемнить» в ней какой-то участок. Другое дело – растровые плоттеры. Перед нача-
лом работы, плоттер обрабатывает полученную информацию в своей памяти. Поступающие 
данные могут иметь признак как Positive, так и Negative. С помощью специальной програм-
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мы, которая называется Rasterized Image Processor (RIP), изображение преобразуется из век-
торной формы в растровую, после чего происходит печать на фильм подобно тому, как это 
делают обычные лазерные принтеры. 

Недостаток растровых машин, как мы видели в гл.  6.12, заключается в том, что во вре-
мя преобразования векторного изображения в растр, информация непременно искажается 
(рис.  6-59 - рис.  6-61). Тем не менее, разрешающая способность растрового плоттера такова, 
что он в состоянии обеспечить качество печати линий толщиной в 1 mil без видимых иска-
жений.106 

Я прошу прощения, если повторяюсь. Я также не собираюсь описывать здесь синтак-
сис Gerber 274X. Практической пользы от такого знания никакой нет. Если Вас это интересу-
ет, обратитесь к справочной системе GerbTool. 

Вместо этого, в продолжение темы, мы рассмотрим один очень интересный пример. 

8.9. Композитные и смешанные слои. 
В OrCAD Layout Plus начните новую плату и нарисуйте в слоях TOP, INNER1 и 

INNER2 зоны Copper Areas, как показано на рис.  8-65. Напишите рядом с каждой зоной на-
звание слоя. Сделайте это именно так, как показано на рисунке. 

 
рис.  8-65 

Запустите PostProcessor и выпустите Герберы только этих трёх слоёв в любом формате 
– 274D или 274X. 

 
рис.  8-66 

                                                 
106 Это, однако, совсем не означает, что можно рисовать дорожки такой толщины. Позже мы вернёмся к этому 

вопросу. 
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Теперь откройте то, что получилось в GerbTool (рис.  8-66). 
Выполните команду: «Setup → Composites…» (рис.  8-67). Composite – это, так назы-

ваемый, композитный слой, т.е. слой, составленный из нескольких слоёв разной полярности. 
Слои, образующие композитный слой могут иметь атрибут Dark. В этом случае информация 
этого слоя будет распечатана плоттером. Если слой имеет атрибут Clear, то он «вычитается» 
из слоя Dark. 

Попробуем скомбинировать наши три слоя в один таким образом, чтобы зона TOP ока-
залась изолированной от зоны IN2. 

 
рис.  8-67 

В окне Composite Setup нажмите кнопку New Composite. Появится новая группа 
Composite 1. Перенесите в неё из списка Layer List наши три слоя (рис.  8-68). 

 
рис.  8-68 

Щёлкнув правой кнопкой мыши по названию слоя, укажите его полярность. TOP и IN2 
должны быть Dark, а IN1 – Clear. 

Важен порядок расположения слоёв в наборе Composite! Если Вы расположили их так, 
как показано на рисунке, то порядок построения результирующего слоя будет такой: из слоя 
IN2 будет вычтен IN1, затем прибавлен TOP. Если у Вас получилось иначе, перетащите ле-
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вой кнопкой мыши название слоя в нужную позицию. 

Теперь нажмите кнопку OK и посмотрите, что получилось (рис.  8-69). 

 
рис.  8-69 

Особо обратите внимание на надпись «IN1» ( ), которая оказалась вырезана из зоны 
IN2. Вам не удастся сделать такое в Layout Plus! 

Если картина на Вашем мониторе отличается от рис.  8-69, проверьте положение кно-
пок-переключателей на панели инструментов. 

 
рис.  8-70

 
рис.  8-71 

Кнопка Toggle Overlay mode (рис.  8-70) аналогична опции Use Opaque Graphics в 
Layout Plus. Она управляет прозрачностью слоёв. Кнопка Toggle composite viewing (рис. 
 8-71) включает или выключает режим «вычитания» данных типа Clear. 

 
рис.  8-72 

Теперь откройте окно Layer Setup (рис.  8-72). В цветовой таблице слоя IN1 появились 

1 
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символы в виде ромбов. Так обозначаются слои, содержащие полярную информацию. 

Вопрос. Результирующий Composite-слой где должен располагаться на печатной плате? 
Если слой имеет тип TOP или INNER, его назначение совершенно понятно. А что такое 
Composite? Нужно ли его расценивать как один из маршрутизируемых слоёв или это слой 
маски? А может быть, мы хотим, чтобы содержимое этого слоя было нарисовано на плате, 
т.е. это слой Silk? 

И ещё вопрос. Как правильно описать Layers Stack, если у нас один слой состоит из 
трёх? 

Вот одно из решений. Набор Composite можно преобразовать в один слой командой: 
«Tools → Convert → Composite to Layer…». Однако этот метод имеет серьёзный недостаток: 
результирующий слой получается не векторный, а растровый. Использование в Гербер-
файлах растровых фигур резко не приветствуется. Могут возникнуть и проблемы совмести-
мости с оборудованием, имеющимся на заводе. 

Правильное решение заключается в экспорте данных и создании новых Герберов. 

 
рис.  8-73 

Создайте новую папку для экспорта. Теперь выполните: «File → Export → Gerber…». 
Выходной формат обязательно укажите как Extended (RS274X) (рис.  8-73). Ответьте на до-
полнительные вопросы и нажмите OK. 

Теперь начните новый дизайн и импортируйте только что созданные файлы. 
Полученный слой имеет тип Mixed (Смешанный). Никаких проблем с его описанием и 

конфигурацией у Вас больше возникнуть не должно. На рис.  8-74 импортированный слой 
имеет тип TOP и имя Component Side. 

8.10. Маршрутизация в Plain-Layers. 
Применение композитных слоёв может быть самым разнообразным. Обычно говорят, 

что главное их назначение – возможность прокладки дорожек в слоях типа Plain. Посмотрим, 
как это делается. 

Допустим, имеется 3-слойная плата, причём, внутренний слой – GND типа Plain. На 
плате располагается 8 thruhole-выводов. Выводы соединяются между собой следующим по-
рядком (рис.  8-75): 

– выводы #1 и #2 соединяются через Plain-слой GND; 
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рис.  8-74 

– выводы #5 и #8 соединяются дорожкой в слое TOP; 
– выводы #6 и #7 соединяются дорожкой в слое BOTTOM; 
– нужно соединить выводы #3 и #4. Как это сделать? 

 
рис.  8-75 

Существует несколько вариантов. Первый – обогнуть существующие дорожки (рис. 
 8-76). 

 
рис.  8-76

 
рис.  8-77

Вариант номер два – сделать переход со слоя Top на Bottom, используя via, как показа-
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но на рис.  8-77. 
Третий способ – использовать внутренний слой не Plain, а Inner или просто добавить 

ещё один слой. 
По ряду причин, все эти три метода могут оказаться неприемлемы. В этом случае, вы-

ход может быть найден с помощью очень оригинального и изящного решения.107 

Добавьте в плату два дополнительных слоя: INNER1 и INNER2. Слой INNER1 сделай-
те типа Routing, а слой INNER2 – Documentation. 

Соедините выводы #3 и #4 дорожкой в слое IN1, а в слое IN2 нарисуйте зону, как пока-
зано на рис.  8-78, используя obstacle Copper Area. 

 
рис.  8-78 

Если бы слой IN2 был типа Routing, то проверка DRC показала бы ошибку соединения 
выводов #3 и #4 с неизвестной зоной в слое IN2. А поскольку слой IN2 имеет тип Documenta-
tion, то считается, что в маршрутизации он не участвует. Ошибок нет. 

 
рис.  8-79 

Сконфигурируйте PostProcessor (рис.  8-79). Добавьте также в таблицу слой Silk Top с 
именем D01_SST.GBR и Drill Drawing с именем D02_DRD.GBR. 

 
рис.  8-80 

                                                 
107 Подумайте до конца главы, каким ещё способом можно соединить два вывода через Plain-слой? 

Запустите PostProcessor
забудьте импортировать файл

рис.  8-81 

На рис.  8-81 отдельно по

Определим Composite. П
гда имеет тип Dark. 

O

и потом откройте полученные файлы прогр
 сверлений (рис.  8-80). 

 

рис.  8-
оказан слой GND, а на рис.  8-82 – слой DRD

рис.  8-83 
Первым в наборе стоит слой GND. Первый

рис.  8-84 
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раммой GerbTool. Не 

 
-82 
D. 

 

слой в наборе – все-
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Мы хотим, чтобы дорожка, расположенная в IN1 и соединяющая выводы #3 и #4 про-
ходила в слое GND и была бы изолирована от него зоной, которая располагается сейчас в 
слое IN2. Поэтому из слоя GND надо вычесть слой IN2 (он в Composite располагается вто-
рым) и прибавить слой IN1 (последний). Поскольку GND – инверсный слой типа Plain, то и 
слои IN2 и IN1 следует добавить со знаком «минус». Т.е. IN2 – Dark, а IN1 – Clear. 

Проверьте (рис.  8-84). 
На рис.  8-85 показано окно Навигатора, а на рис.  8-86 – цветовая таблица. 

 
рис.  8-85  

рис.  8-86
Делаем экспорт файлов, затем – импорт в новый проект и видим, что Композитный на-

бор объединился в один Mixed-слой. Осталось только сконфигурировать данные (рис.  8-87). 

 
рис.  8-87 

Новый слой имеет тип Plane Negative. Я обозначил его сиреневым цветом (рис.  8-88). 

Тот же слой вместе с отв

Поскольку слой изображ
и #4 соединены друг с другом

Общий вид (рис.  8-90): 

Постпроцессор Layout P

O

рис.  8-88 
верстиями (рис.  8-89): 

рис.  8-89 
жается инверсно, то всё чёрное внутри – это
, но изолированы от слоя. 

рис.  8-90 
Plus не создаёт Mixed-слои. Рассмотренный
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о медь. Отверстия #3 

 

в этой главе пример 
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может никогда Вам в жизни не пригодиться. Однако, возможно, Вам придётся дорабатывать 
герберы, созданные другими CAD-системами, которые это делают. Например, Cadence Alle-
gro. Поэтому я считаю, что мы не зря потратили время. 

Скажите, Вы догадались, как соединить выводы #3 и #4 через Plain-слой в Layout Plus, 
не используя возможности GerbTool? 

Ну конечно же! Ведь мы уже делали это в главе  6.2 Разводка цепей питания. В про-
стых случаях для этой цели можно использовать obstacle Copper Pour. 

8.11. Netlist Compare. Проверка соединений. 
Если Вы разрабатываете достаточно сложную плату – многослойную, со множеством 

компонентов – наверняка у Вас попросят, так называемый, «файл внешних соединений»108 
или «IPC-файл». На стр. 316 мы создали такой файл. Для чего он служит? 

Вспомните, разрабатывая свою плату, мы вручную подключили к земле крепёжные от-
верстия. После этого мы дополнительно соединили попарно выводы копок (стр. 227). Кроме 
того, на плату были добавлены fiducials (стр. 300). Подобные изменения никак не отражают-
ся на принципиальной схеме, поэтому Layout Plus создаёт свой собственный netlist, отлич-
ный от netlist-а Capture. Это и есть IPC-файл. 

 
рис.  8-91 

Откройте, пожалуйста, Gerber-дизайн нашей платы. 
Обратите внимание, в окне навигатора есть два 

пункта: Nets и External Nets (рис.  8-91). Сейчас напротив 
каждой строчки стоят нули. Это значит, что Гербер-дизайн 
не имеет информации о цепях. 

Несмотря на то, что каждый слой-файл, в отдельности 
входящий в набор герберов, это всего лишь картинка в 
векторном формате, в совокупности они несут довольно 
много информации, в чём мы сейчас убедимся. GerbTool 
имеет в своём наборе обширный арсенал разнообразных 
инструментов и средств анализа, позволяющих 
автоматизировать процесс подготовки данных к 
производству, провести ряд проверок и внести 
исправления в существующий дизайн. В ряде случаев, это 
помогает повысить технологичность изготавливаемой 
платы, а иногда даже избежать критических ошибок на 
этапе производства. В этой главе мы рассмотрим утилиту сравнения 
netlist-ов. 

Найдите и нажмите на панели инструментов кнопку Build Netlist (рис.  8-92)… 

 
рис.  8-92 

…или выполните команду: «Tools → Netlist → Generate…». 

                                                 
108 External netlist. 
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рис.  8-93 

В открывшемся окне установите параметры, как показано на рис.  8-93. В поле Thru-
hole Drill Layer укажите слой сверлений и нажмите <OK>. GerbTool создаст собственный 
список соединений. 

Посмотрите, что есть в этом списке. Для этого используйте команду: «Tools → Netlist 
→ Save…». 

Как видно, GerbTool ничего не знает о компонентах. Netlist описывает лишь соедине-
ния между pad-ами. А ещё точнее – между Flash-ами. 

 
рис.  8-94 

В окне Навигатора можно увидеть список цепей 
(рис.  8-95). Кроме того, теперь работает кнопка 
Query Net. Воспользуйтесь ей и укажите на какую-
либо цепь (рис.  8-96). Цепь подсветится, а в новом 
окне будет выведена дополнительная информация 
(рис.  8-97). 

 

 
рис.  8-95 

 
рис.  8-96 

 
рис.  8-97 

Теперь можно загрузить IPC-файл, который был подготовлен Layout Plus и сравнить 
netlist-ы. Выполните команду: «File → Import → Netlist → IPC-D-356…» и укажите путь к 
файлу CLOCK.IPC. 
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рис.  8-98 

 
рис.  8-99 

 
рис.  8-100 

 
рис.  8-101 

Будет создан новый «виртуальный» слой списка внешних соединений – External Nets 
(рис.  8-99, рис.  8-100, рис.  8-101). 

рис
Информация этого слоя

маршрутизируемыми слоями.
подключения (pads), располож

Теперь у нас есть два N
созданный GerbTool. Мы до
Compare…» (рис.  8-105). Оши

Сохраните дизайн, посл
верку снова. Найдите на пане
lete…». 

рис.  8-105
Убедитесь, что в окне 

слой (рис.  8-106), после чего щ

O

 
.  8-102
я выводится только в совокупности с одни
. Символами, показанными на рис.  8-103 
женные в слоях TOP, BOTTOM, INNER или

Netlist-а: один – «внешний», созданный Lay
олжны сравнить их. Выполните команду:
ибок быть не должно. 

 
рис.  8-104 

ле чего попробуйте разорвать одну из доро
ели инструментов кнопку «Delete» или вып

 
рис.  8-1

Select Filter выбран режим Mode, Draw и
щёлкните мышкой по одной из дорожек (ри
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рис.  8-103 

 

им или несколькими 
обозначаются точки 
и же thruhole. 

yout Plus, и второй – 
«Analysis → Netlist 

ожек и сделайте про-
полните: «Edit → De-

 
106 

и необходимый Вам 
ис.  8-107). 
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рис.  8-107 

GerbTool обновит внутренний список соединений, сравнит его с внешним и выдаст со-
общение об ошибке. 

 
рис.  8-108 

 
рис.  8-109

Все ошибки, а также сообщения выводятся в окне Навигатора в разделе Analysis (рис. 
 8-108). Щёлкните правой кнопкой по ошибке и выберите Properties. Откроется окно с под-
робным описанием ошибки (рис.  8-109). А именно: 

– Тип ошибки (Name): обрыв (Net Open); 
– Состояние (Fix State): неустранимая (Unfixable). Об этом же говорит крестик на 
красном фоне в окне Навигатора. Это значит, что программа не знает, как автоматиче-
ски исправить возникшую проблему. 
– Название цепи в Layout Plus (External Net): BZR. 
– Внутреннее название цепи (Gerbtool Nets): 7. 
– Координаты. 
– Светящаяся лампочка в окне Навигатора показывает, что указанная цепь выделена 
(Highlighted). 

Для удобства дальнейшей работы лучше всего переименовать все цепи в так, как они 
назывались в Layout Plus. Вернитесь к сохранённому дизайну и выполните команду: 
«Tools → Netlist → Apply External Net Names». 
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рис.  8-110 

Найдите, к примеру, цепь +6V. 

8.12. Дополнительные инструменты. 
Всё, что было сказано выше, преследовало только одну цель: понять, что такое «Гербе-

ры», принцип работы с ними, почему выбран именно такой формат, а также какие этот фор-
мат накладывает ограничения. Понять, что можно сделать, а что – нельзя в принципе. Полу-
ченные знания будут Вам одинаково полезны независимо от редактора, который Вы исполь-
зуете. Кроме того, имея чёткое представление о структуре данных формата, Вы заранее мо-
жете знать, можете предположить, какие  возможности должен предоставить Вам редактор. 

Например, зная, что все фигуры создаются с помощью апертур, Вы не будете пытаться 
рисовать линии произвольной толщины. Нужно либо использовать имеющиеся апертуры, 
либо создать новую. 

Также и с возникающими проблемами. Вспомните, когда мы пытались добавить на 
чертёж произвольный текст, буквы получились очень жирные и неразборчивые. Ошибкой 
было бы искать какие-либо дополнительные настройки в свойствах текста. Их там не может 
быть. Однако, понимая, что буквы, как и дорожки, также создаются с помощью апертур, 
нужно просто поменять апертуру, которой был нарисован текст. 

Я думаю, что у Вас сложилась уже достаточно чёткая картина, поэтому вкратце пред-
лагаю ознакомиться с основными инструментами GerbTool. Часто бывает так, что люди не 
пользуются некоторыми возможностями программы лишь потому, что не подозревают об их 
существовании. Вот несколько полезных мастеров. 

Teardrops позволяет сделать соединение pad-ов с дорожками плавным. При этом pads 
круглой формы становятся похожи на капельки. Улучшается надёжность соединений. Дело в 
том, что при неаккуратной пайке можно перегреть pad и оторвать его от трека109. Вызывается 
инструмент кнопкой на панели инструментов (рис.  8-111) или командой: «Tools → 

                                                 
109 Игра слов. «Tear» имеет перевод как «капля» и как «разрыв». 
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Teardrops…». 

Откроется окно настроек (рис.  8-11

После работы мастера, Ваша плата 

рис.  8-113
А вот, на рис.  8-115 показана струк

После работы мастера Teardrops у м
на рис.  8-114  есть какая-то проблема. 
«капельку» не удалось поставить так, как
можность познакомиться ещё с одним ин

Join Lines служит для соединения д
Отмените предыдущее действие с 

инструментом Teardrop, выбрав опцию D

dmitri.kaikov@g

 
рис.  8-111 

12), с которыми Вы можете поэксперименти

 
рис.  8-112 
(рис.  8-113) примет вид, как на рис.  8-114.

 
рис.  8-114 

ктура «капельки» . 

 
рис.  8-115 
меня появилось сообщение, что в месте, по
Очевидно, что из-за того, что трек резко из
к я требовал в окне настроек. Что ж, прекра
нструментом! 

двух отрезков. 
помощью операции Undo (рис.  8-116) ил

Delete Existing Teardrops. 

2

3

gmail.com 

ировать. 

 

оказанном
згибается,
асная воз-

ли тем же 

1

 
рис.  8-116 

Сотрите часть дорожки (

Теперь выберите Join Li
В окне настроек (рис.  8-

личина скоса) 10 mil. Режим
Fillet – со скруглением. 

Теперь щёлкните мышко
Вот что получится (рис.

Повторите операцию T
диться, что соединение не нар

O

 
рис.  8-117 

(рис.  8-119). 

 
рис.  8-119 

ines (рис.  8-118). 
-120) укажите режим Chamfer (соединение
Normal означает, что линии соединятся п

 
рис.  8-120 

ой по двум частям разорванной дорожки (р
  8-121): 

 
рис.  8-121 

eardrop (рис.  8-122), а потом – Netlist C
рушилось. Всё должно быть в порядке. 

1

2
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рис.  8-118 

 со скосом). Size (ве-
под прямым углом, а 

ис.  8-119,  и ). 

Compare, чтобы убе-
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Snowman – Снеговик. Инструмент
качества соединения дорожек с pad-ами. 
кой ставится Flash круглой апертурой ме
выбирается из набора уже имеющихся. И
снеговику, составленного из нескольких 
лыми flash-ами. 

На рис.  8-123 показан один из участ

Найдите на панели инструментов к
гда, откроется окно настроек (рис.  8-125)

 
рис.  8-124 

 
рис.  8-126 

Применив настройки по умолчанию
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рис.  8-122 

т служит той же цели, что и Teardrop – ул
В отличие от Teardrop, в месте соединения
еньшего диаметра. Подходящая по размеру
Инструмент получил название, потому что
снежных шаров, pad-ы рисуются нескольки

тков платы. 

 
рис.  8-123 

кнопку Snowman (рис.  8-124) и нажмите её
). 

рис.  8-125
ю, получите картину, как на рис.  8-127: 

gmail.com 

лучшению
я с дорож-
у апертура 
, подобно
ими круг-

ё. Как все-

 

рис.  8-127
Структуру pad-ов очень

Sketch110 (рис.  8-128), восполь
(рис.  8-126). 

Fix SilkScreen (рис.  8-1
ных площадок. 

На рис.  8-130 показан уч

Слой TOP показан голу
слоя SilkScreen нанесена повер

рис.  8-131 

Мы могли бы, конечно,

                                                 
110 Очертание, контур. 

O

 
рис.  8-1

ь хорошо можно рассмотреть, если пере
ьзовавшись соответствующей кнопкой на п

29) – позволяет убрать текст и нарисованн

 
рис.  8-129 

часток платы. 

рис.  8-130 
убым, слой маски – зелёным. Хорошо видн
рх pad-ов и будет мешать последующей пай

 
рис.  8-1

, подготовить все footprints так, чтобы рис
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128 
еключиться в режим 
панели инструментов 

ные линии с контакт-

 

но, что белая краска 
йке. 

 
132 
сунок компонента не 
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закрывал контактные площадки, но для этого нужно было бы потратить гораздо больше вре-
мени. Значительно проще откорректировать Гербер-чертёж. 

В окне настроек (рис.  8-131) мастера на вопрос Pad Layer укажите не TOP, а слой мас-
ки (рис.  8-132). Почему, Вы легко поймёте, если сравните рис.  8-133 и рис.  8-134. 

 
рис.  8-133 

 
рис.  8-134

На первом рисунке в качестве Pad Layer был указан слой SMT, на втором – слой TOP. 
Как видите, во втором случае, мастер Fix SilkScreen немного переусердствовал и убрал рису-
нок даже с vias, которые находятся под маской. Этого делать не требовалось. 

Remove Isolated Pads (рис.  8-135) – позволяет убрать неиспользуемые контактные 
площадки во внутренних слоях. 

 
рис.  8-135 

Пример. Имеется многослойная плата с thruhole-разъёмом (рис.  8-136). 

 
рис.  8-136 

Некоторые выводы разъёма соединяются с Copper Pour, расположенной в одном из 
внутренних слоёв (рис.  8-137). 

 
рис.  8-137 
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Активируйте мастер Remove Isolated Pads с панели инструментов. В окне настроек вы-
берите Window (рис.  8-138), после чего обведите разъём мышкой, взяв его в рамочку. 

 
рис.  8-138 

Все неподключённые pad-ы исчезнут (рис.  8-139). 

 
рис.  8-139 

На рис.  8-140 для наглядности включен слой DRILL. 

 
рис.  8-140 

Теперь компонент будет значительно легче запаять в плату, а при необходимости – вы-
паять обратно. 

Инструмент Remove Isolated Pads не работает в слоях TOP, BOTTOM или слоях типа 
PLANE. Инструмент позволяет обработать все слои INNER одновременно или в отдельности 
(слой должен быть видим на экране). Кроме того, можно указать набор апертур, которые бу-
дут игнорироваться мастером, чтобы, например, не убирать площадки vias, расположенные 
во внутренних слоях. 

Solder Mask Optimization. 
Программа GerbTool позволяет в автоматическом режиме откорректировать слои Sol-

derMask или даже создать их заново. Для этого служат команды: «Tools → Solder Mask → 
Optimize…» и «Tools → Solder Mask → Generate…». 

При подготовке padstacks какого-либо компонента, мы указывали размеры pad-а в сло-
ях TOP, BOTTOM и SolderMask одинаковыми. Это не является ошибкой, однако, из-за по-
грешностей нанесения маски во время изготовления PCB, может случиться так, что краска 
попадёт на контактную площадку. При пайке это вызовет её пригорание, поэтому рекомен-
дуется маску делать немного большего размера, чем pad. 
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Кроме того, если маска сделана с з
углублении, окружённая узкой канавкой
излишек не растечётся и не замкнёт с сос
канавке вокруг pad-а. 

В качестве примера хорошо взять 
достаточно высокой плотностью выводов

На рисунке слой TOP показан гол
белым. 

В центре присутствует микросхем
17.7 x 68.8 mil. Расстояние между pad-а
pad-ов: 25.6 mil. 

Ёмкости и сопротивления: footprint
И, наконец, vias. Диаметр контактн

Выполните команду: «Tools → Sold

dmitri.kaikov@g
запасом, контактная площадка оказывается
й со всех сторон. При пайке с избытком пр
седними выводами, а аккуратно расположит

какую-нибудь плату, на которой есть комп
в. Например, такую (рис.  8-141): 

 
рис.  8-141 

лубым цветом, SolderMask – зелёным, Silk

ма в корпусе PQFP-100. Размер pad-ов с
ами: 7.9 mil; расстояние между центрами

t 0603. Размер площадок: 38 x 32 mil. 
ной площадки: 25 mil. Диаметр отверстия: 1

der Mask → Optimize…». 

 
рис.  8-142 

gmail.com 
я как бы в 
рипоя, его
тся в этой

поненты с

kSkreen – 

составляет 
соседних

2 mil. 
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Рассмотрите окно настроек (рис.  8-142). Произведём оптимизацию слоя SolderMask 
TOP, для чего установим флаг TOP в поле Optimize. Поле Maximum Errors определяет мак-
симальное число ошибок и предупреждений, которые могут возникнуть во время работы 
мастера. Если это количество будет достигнуто, работа мастера прекращается. Все сообще-
ния выводятся в окно Навигатора в поле Analysis. 

В поле Oversize задаётся желаемое (Desired) и минимальное (Minimum) значение, на 
которое будет увеличена маска вокруг pad-а. Например, при величине 6 mil, маска будет 
расширена на 3 mil с каждой стороны. 

В поле Minimum Spacing указывается минимальное расстояние от открытой маски до 
другой ближайшей открытой маски (Mask Opening) или до «чужой» дорожки (Mask to 
Trace). Если какое-либо из этих условий невозможно выдержать, мастер попытается решить 
проблему одним из способов, указанных в поле Fix Error by. А именно: уменьшить размер 
открытой маски (Resizing Opening) или «подрезать» её с одной из сторон (Shaving Opening). 

Если на плате существует группа из pad-ов расположенных очень близко друг к другу, 
то есть возможность открыть сразу всю группу, а не создавать маску для каждого pad-а в от-
дельности (поле Detect Fine Pitch Pads). Делать это стоит только тогда, если расстояния ме-
жду выводами столь малы, что нанести краску между ними затруднительно. Однако, в этом 
случае очень легко случайно замкнуть вовремя пайки соседние выводы. 

Флаг Ignore pads on electrical layer less than в поле Data Control позволяет исключить 
из обработки pad-ы, меньше указанного размера. Это, обычно, vias. 

Вот результаты работы мастера (рис.  8-143). 

 
рис.  8-143 

Вокруг всех pad-ов маска увеличилась ( ) на величину, указанную в поле Oversized. 
Vias, согласно параметру Data Control, были проигнорированы мастером ( ). 

 
рис.  8-144 

Площадки под микросхемой тоже подверглись обработке. Сравните правую ( ) и ле-
вую ( ) сторону pad-а, показанного на рис.  8-144. Чтобы сохранить указанное расстояние 
между масками (Mask Opening), программа подрезала их (Shaving Opening) ( , ). 

 Маски нарисованы с помощью Flash-ей. Для этого программе понадобилось создать 
дополнительно несколько апертур произвольной формы, Custom Apertures. Чтобы узнать, 
например, какая апертура была использована для маски крайнего pad-а, нажмите кнопку 
Query Item и щёлкните по этому pad-у. 

1
2

1
2

3
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Как видно на рис.  8-145, это апертура D97. В окне Item Properties выводятся её свойст-
ва (рис.  8-146). 

 
рис.  8-145

 
рис.  8-146 

Список всех Custom Apertures выводятся в окне Навигатора (рис.  8-147): 

 
рис.  8-147 

Ну и, конечно, мы можем найти интересующую нас информацию обо всех апертурах, 
используемых в дизайне, в таблице Aperture Setup (рис.  8-148). 

Выше было сказано, что расстояние между pad-ами микросхемы составляет 7.9 mil. 
Попробуйте проделать операцию оптимизации маски ещё раз, но в поле Detect Fine Pitch 
Pads окна настроек установите параметры: Edge to Edge, Spacing = 10 mil. 

Взгляните на рис.  8-149. Однотипные pad-ы, расстояние между которыми оказалось 
меньше заданного, были вскрыты группой. 

 

Убедившись, что слой M
манда инвертирует изображен
он выглядит на самом деле. 

Отдельно слой Mask TO

рис.  8-150 

Solder Paste Optimizatio
Аналогично действует м

вать уже существующие данн
служат команды: «Tools →
Generate…». 

Так же, как в случае с
площадки в слое Solder Paste р
как всегда, показан слой TOP,

При сборке PCB, на все

O

рис.  8-148 
Mask TOP является активным, нажмите кл
ние. Таким образом, Вы сейчас видите слой

рис.  8-149 
OP (рис.  8-151): 

 
рис.  8-1

on. 
мастер оптимизации Solder Paste. GerbTool
ные или создать слои Paste Top и Paste Botto

Paste Mask → Optimize…» и «Tools

маской, при описании padstacks мы всегд
равной размеру слоя TOP. Посмотрите на р
, а синим – Paste Top. 
е площадки, описанные в слое Paste, буде
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→ Paste Mask → 
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паста. Сверху устанавливаются компоне
циальную печь, паста плавится, и выводы
площадкам. 

рис.  8-152 

Сейчас видно, что паста будет нан
выводы компонентов прижмутся к площ
слое Solder Paste рекомендуется немного 

Вот как это делает программа GerbT
ize…» укажите параметры, как на рис.  8-

Вот что получится (рис.  8-153). Рас
На рис.  8-155 видно, что площадка 

34 x 28 mil, то есть, меньше на 4 mil, как
ки площадки скруглены (Undersize → Ro

Контактные площадки микросхемы
лучился размером 16.2 x 62.8 mil согласн
pad был уменьшен на 6 mil (параметр Per

Отчёт о работе мастера, как обычно

dmitri.kaikov@g
енты, после чего собранная плата помещает
ы компонентов оказываются припаяны к ко

 
рис.  8-153

несена по всей площади pad-ов, с избытко
щадкам, они выдавят часть пасты наружу. П
уменьшать размер pad-ов. 

Tool. После команды «Tools → Paste Mask
154. Нажмите <OK>. 

 
рис.  8-154 

ссмотрим поближе. 
в слое TOP имеет размер 38 x 32 mil, а в сл

к указано в поле Undersize → Desired → 4 m
ound Corners). 

ы имеют размер 17.7 x 68.8 mil. Pad в слое
но установкам Detect Fine Pitch Pads. По в
rpendicular), а по горизонтали – на 1.5 mil (

о, выводится в окне Навигатора в поле Anal
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тся в спе-
нтактным

 

ом. Когда
Поэтому в 

→ Optim-

лое Paste – 
mil. Угол-

 Paste по-
вертикали
(Parallel). 

lysis. 
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рис.  8-155 

Как видите, мы потратили совсем мало времени на то, чтобы исправить все недочёты, 
связанные с SilkScreen, Solder Mask и Solder Paste. Мы не стали заниматься этим вопросом на 
этапе создания footprint-ов, и, как видите, поступили очень правильно.  

 
рис.  8-156 

На рис.  8-157 показаны одновременно слои TOP ( ), Mask ( ) и Paste ( ). 

 
рис.  8-157 

21

3



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 374 

8.13. Align Layers. 
Очень полезно изучать чужие работы. Смотреть, как люди оформляют свои проекты, 

какие приёмы используют. Иногда бывает так, что Вы сомневаетесь в правильности какого-
либо footprint-а и хотели бы посмотреть, как его сделал в одном из проектов тот, кто работал 
до Вас. 

Возможно, всё, что у Вас есть – это Гербер-файлы от прошлого проекта. Каково же бу-
дет Ваше негодование, когда после импорта данных, Вы видите подобную картину (рис. 
 8-158): 

 
рис.  8-158 

По неведомой причине все слои разъехались в разные стороны. Мастер импорта опре-
делил формат данных правильно, и искажения масштаба нет, но слои DRILL и DRAWING 
сильно смещены от остальных слоёв. 

Честно скажу: я не знаю причину данного явления, хотя сталкивался с ним неодно-
кратно. Единственно, что могу сказать – эти Герберы были созданы не в системе OrCAD 
Layout. 

Видимо, проблема эта известна не только мне (а иначе, я не стал бы на ней останавли-
ваться), потому что для её решения предусмотрен очень удобный инструмент. 

Найдите на панели инструментов кнопку Align layers, как на рис.  8-159 или выполните 
команду: «Edit → Align Layers». 

 
рис.  8-159 

В строке состояния появится приглашение: Align Layer: select base item… Увеличьте 
изображение (клавиши <I>, <O>, <P>) и найдите на чертеже какой-нибудь элемент, который 
присутствует одновременно в обоих совмещаемых слоях и который должен совпадать (рис. 
 8-160). 

Мне повезло! Я нашёл логотип фирмы. Щёлкнем первый раз по линии  и второй – по 
линии . Слои совместятся (рис.  8-161). 

Теперь нужно совместить слой DRILL с остальными слоями. Понятно, логотипа в нём 
нет. Что же делать? 

В слое DRILL очень мн
найти какое-то отверстие, кот
пёжных отверстий. 

Увеличим левый нижний

Мы видим, что такое отв

Теперь найдём то место

2

O

рис.  8-160 
ного различных отверстий. Большинство и
торое легко можно определить на плате. Нап

рис.  8-161 
й угол. 

 
рис.  8-162 

верстие есть (рис.  8-162, ). 

о, где оно должно находиться на PCB. Очев

1
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из них – vias. Нужно 
пример, одно из кре-

 

видно, что отверстие 

1 
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должно совпадать с flash, показанной на р

Совместим слои (рис.  8-164). 

Кажется, всё правильно! Осталось т
угол платы (рис.  8-164, ). Начало ко
Layout Plus, а «Origin». 

Выполните команду: «Edit → Origi

 
рис.  8-165 

На вопрос, согласны ли Вы обнов
утвердительно (рис.  8-166), чтобы прог
элементов чертежа. 

Теперь всё в порядке (рис.  8-167). 

2

1 

dmitri.kaikov@g
рис.  8-163, . 

 
рис.  8-163 

рис.  8-164 
только перенести начало координат в левы
оординат в GerbTool называется не «Datum

in» или найдите кнопку Change origin (рис.

рис.  8-166
вить информацию в базе данных GerbTool,
грамма смогла пересчитать новые координ

 
рис.  8-167 

gmail.com 

 

й нижний
m», как в 

.  8-165). 

 

, ответьте 
наты всех
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8.14. ProtoMat. 
«Протомат»-ами в разговорной речи обычно называют машины для «домашнего» изго-

товления печатных плат, или, так называемые, «art milling machines for the in-house produc-
tion of prototype PCB».111 Печатные платы в таких машинах получаются в результате не хи-
мической обработки, как это делается на заводе при массовом изготовлении, а механическим 
способом. Проще говоря, Протомат – это станок, который с помощью специальных фрез вы-
резает дорожки на фольгированном текстолите. Кроме того, такая машина может вырезать 
плату по контуру, просверлить в ней необходимые отверстия, vias, сделать слоты нужной 
формы. 

В небольшой фирме, которая занимается разработкой электронных устройств, такая 
машина незаменима. Она экономит очень много средств и времени при создании, к примеру, 
опытных образцов. 

 
рис.  8-168 

На рис.  8-168 показана одна из многочисленных моделей семейства. 

 
рис.  8-169 

На рис.  8-169 – небольшой участок вырезанной PCB. 
                                                 

111 Фирма LPKF Laser & Electronics AG. Веб-адрес: www.lpkf.com 
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LPKF Laser & Electronics AG представляет как механические станки так и лазерные 
машины, а также решения для изготовления в «домашних условиях» многослойных PCB. 
Однако, в простейшем случае, мы получаем двухслойную печатную плату с неметаллизиро-
ванными vias. Это значит, что дорожки, расположенные на разных слоях, соединяться друг с 
другом не будут. Мы будем должны в каждую via впаять перемычку, соединяющую слой 
TOP со слоем BOTTOM. 

Если мы планируем изготовить будущую плату на Протомате, желательно, чтобы vias 
не располагались под микросхемами. Это – во-первых. 

Во-вторых, для ускорения работы машины и для уменьшения износа фрез, желательно 
залить всё свободное место на плате медью. Например, так, как показано на рис.  8-170. 

 
рис.  8-170 

Вот как можно решить эту задачу непосредственно в GerbTools. 

 
рис.  8-171 

На рис.  8-171 показана исходная плата. Видны слои TOP и Drill Drawing. Убедитесь, 
что активный слой – TOP и нажмите на панели инструментов кнопку Add Polygon (рис. 
 8-172). Или выполните команду: «Add → Polygon…». 

 
рис.  8-172 

В окне настроек (рис.  8-173, рис.  8-174) укажите: 
o Polygon Border – Draw. Это значит, что границы полигона будут заданы вруч-

ную. 
o Destination Layer – Same. Полигон будет размещён в исходном слое. 
o Fill Method – Pour Around. То есть, заполнить пространство вокруг существую-

щих объектов. 
o Draw и Flash Clearance. Укажите желаемые зазоры между заливкой и дорожка-
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ми, заливкой и pad-ами. 
o Fill Type – Vector, векторный. 
o Vector Fill Pattern – Solid, сплошная заливка. 
o Border D-Code – выберите из списка апертуру, которой будет нарисована гра-

ница полигона. Понятно, что размер апертуры должен быть меньше, чем вели-
чина Clearance. 

o Fill D-Code – этой апертурой полигон будет закрашен. 
o Fill Style – способ заливки. Вы можете указать любой. 

 
рис.  8-173

 
рис.  8-174 

Теперь мышкой укажите прямоугольную зону вокруг слоя TOP. Вот что получится 
(рис.  8-175): 

 
рис.  8-175 

Не беспокойтесь, что полигон получился больше, чем плата. Плату вырежут по конту-
ру, указанном в слое Drill Drawing, и всё будет в порядке! Не забудьте только повторить эту 
же операцию для слоя BOTTOM. 

Всё-таки Вам хочется сделать по-другому или Вы беспокоитесь, что человек, получив-
ший Ваши Герберы, что-то не поймёт? Ну, хорошо. Отмените последнее действие и перей-
дите в слой Drill Drawing, в котором нарисована граница PCB. 
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Выполните команду: «Edit → Select → New Group…». Теперь, используя настройки Se-
lect Filter – Window (выбирать только те объекты, которые полностью попадают в рамку) 
или Window+Xing (выбирать также объекты, которых рамка лишь касается) (рис.  8-177), 
выделите границу платы (рис.  8-176). 

 
рис.  8-176

 
рис.  8-177  

рис.  8-178 

Сейчас Board Outline представляет собой набор отрезков. Чтобы превратить её в одну 
замкнутую линию, щёлкните правой кнопкой мыши и выберите команду Convert to Polyline 
(рис.  8-178). 

Теперь такая хитрость: мы будем копировать полученную полилинию из одного слоя в 
другой. Чтобы сделать это точно, включите сетку (Toggle grid display, рис.  8-179) и устано-
вите привязку курсора к сетке (Toggle grid snap, рис.  8-180): 

 
рис.  8-179 

 
рис.  8-180

Щёлкните правой кнопкой мыши по Board Outline и выберите команду Copy (рис. 
 8-181). 

 
рис.  8-181 
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Расположите копию линии рядом с оригиналом (рис.  8-182). 

 
рис.  8-182 

Выполните команду: «Edit → Item…» и щёлкните по копии. В появившемся окне ука-
жите Layer 1 (TOP) и нажмите <Apply> (рис.  8-183). 

 
рис.  8-183 

Линия переместится в слой TOP (рис.  8-184). 

 
рис.  8-184 

Теперь, аналогично копированию, выполните операцию сдвига – Move (рис.  8-185). 



Кайков Д.М. dmitri.kaikov@gmail.com 

 Стр. 382 

 
рис.  8-185 

Совместите линию слоя TOP с линией слоя Drill Drawing. 
Теперь привязку курсора к сетке можете отключить. 

 
рис.  8-186 

Повторите операцию Add Polygon, как мы делали раньше, только вместо опции Poly-
gon Border Draw укажите Select и щёлкните мышкой по только что созданной границе пла-
ты в слое TOP. 

Результат показан на рис.  8-186. Мы ведь этого добивались? 
Повторите те же действия для слоя BOTTOM. 
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